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Change Log

Change Log

Date Change Description

07/01/2020 FortiCASB 20.2 Handbook release. Cloud Account Activity and Alert Reports are
now available for export from Reports.

04/03/2020 FortiCASB 20.1 Handbook release. FortiCASB REST API reference added and
Compliance Report feature upgraded in this revision.

09/07/2019 FortiCASB 4.2 Handbook release. |AAS applications and features migrated to
FortiCWP.

04/05/2019 FortiCASB 4.1 Handbook release. Revised Getting Started documentation for Basic

Setup and Install IAAS applications. Added documentations for Topology, Resource,
Resource Profile, and Traffic. Configuration merged into Risk Assessment .

01/08/2019 FortiCASB 2.1 Handbook. First edition. Changing EU Users IP address from
52.59.74.73 or

18.195.109.67 to 34.254.217.50 or 52.18.7.98, in the section "Show IT discovery".
06/20/2023 FortiCASB 22.2.b release
08/11/2023 FortiCASB 23.3.a release
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What's New

What's New

FortiCASB 24.3.b Release Highlights

« Data Security Policy Management — FortiCASB now support Microsoft 365 AIP (Azure Information
Protection) Labels.

« Label Triggers now identifies Office 365 files with specific meta-data labels in data protection
policies, only files with matched labels will trigger data scan.

« Write Labels to Files will tag meta-data labels to indicate their content or status with Office 365
files matching the data security policy criteria.

o FortiSASE Integration — FortiSASE customers can now access some of the FortiCASB functionality
directly from the FortiSASE Console.
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Introduction

Introduction

Welcome, and thank you for selecting FortiCASB for your cloud security and monitoring needs.

FortiCASB is Fortinet's cloud-native Cloud Access Security Broker (CASB) service, which provides visibility,
compliance, data security, and threat protection for cloud-based services.

Using direct API access, FortiCASB enables deep inspection and policy management for data stored in cloud
application platforms. It also provides detailed user analytics and management tools to ensure that policies are
enforced and that your organization’s data is secure.

FortiCASB works by focusing on Gartner's four pillars of security: visibility, compliance, data security, and threat
protection.

« Visibility—Visibility is one of the most important aspects of cloud security. FortiCASB uses a series of
methods such as data scans and analytics to answer the questions: who accessed information, what was
accessed, when it was accessed, and from where did the access originate.

« Compliance—FortiCASB provides file content monitoring to find and report on regulated data in the
cloud.

« Data security—FortiCASB runs scans to check for sensitive data, such as social security numbers or
credit card numbers. It then classifies this data under different levels of sensitivity and sends different
alerts depending on the sensitivity level of the data accessed.

o Threat protection—FortiCASB uses User Entity Behavior Analytics to watch for suspicious or irregular
user behavior. It also sends out alerts for malicious behavior.

Cloud Security Features

FortiCASB comes with a series of features that give you visibility of data access and usage, control over data
security and threat protection, and peace of mind over compliance with standards and federal regulations.

Visibility

« Automatic on-demand data scan—FortiCASB examines existing content in all folders to identify
sensitive data subjects or security policies.

« Cloud usage analytics— FortiCASB visually summarizes key usage statistics, including trends over
different time periods as well as drilldown, access count, and usage over time.

« User entitlements review— FortiCASB gives visibility of privileged users, dormant users, and external
users.

« File exposure— FortiCASB highlights the most shared files overall, as well as each user's most shared
files.

FortiCASB 24.3.b Admin Guide
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Data security and threat protection

« Cloud data loss prevention— FortiCASB enforces DLP policies based on data identifiers, keywords,
and regular expressions for data at rest.

o Threat detection—FortiCASB offers an abundant number of out-of-the-box policies to immediately
detect account-centric threats.

« Malware detection— FortiCASB features a malware detection policy to detect malicious files before they
compromise sensitive data.

« Geo-location analytics—FortiCASB visualizes global access patterns and analyzes activity to identify
unlikely cross-region access attempts indicative of compromised accounts.

o Shadow IT discovery — FortiCASB offers an overview of unsanctioned cloud applications used in the
organization and gives users the ability to control application usage.

« Configuration assessment —FortiCASB offers an large number of out-of-the-box policies for
automated validation of best security practices against the your cloud storage account.

Compliance

« Predefined compliance policies—FortiCASB provides predefined compliance policies designed to
help maintain compliance with ISO 270001, NIST 800-53 V4, and NIST 800-171 regulations.

o Compliance report—FortiCASB can produce compliance reports for audit purposes. These reports show
compliance with ISO 270001, NIST 800-53 V4, and NIST 800-171 regulations.

FortiCASB License Subscription

There are two types of FortiCASB license subscription: FortiCASB Saa$S Protection License and
FortiCASB Data Protection License.

FortiCASB license usage is based on the number of protected users as well as volume of DLP data scanning
performed by FortiCASB.

Data scans are triggered by the Data Security Policy applied to the protected SaaS applications.

FortiCASB SaaS Protection License

FortiCASB SaaS Protection license provides license seats to monitor SaaS application user activities and
detect suspicious behavior. Additionally the SaaS protection license provides Data protection scanning capacity
to perform DLP and malware/AV scanning.

FortiCASB 24.3.b Admin Guide
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After the DLP scan capacity is depleted, only more DLP scan capacity is required through purchase of
FortiCASB Data Protection License.

FC1-10-FCASB-145- Protection and monitoring of 100 SaaS users including
02-DD Data Scanning of 1TB

FC2-10-FCASB-145- Protection and monitoring of 500 SaaS users including
02-DD Data Scanning of 5TB

If the number of users in onboarded cloud applications exceeds the total user capacity
allowed by the FortiCASB SaaS Protection license, the ability to onboard new cloud

applications will be temporarily suspended until an additional license is purchased.
This behavior is expected during the cloud application onboarding process. However,
existing cloud applications that are already onboarded will remain unaffected.

FortiCASB Data Protection License

During day-to-day operation, Data scans triggered by FortiCASB Data Security Policies consume scan capacity
based on the volume of scanned files. Once the initial scan capacity which is included with the FortiCASB SaaS
Protection license is depleted, customers will need to add FortiCASB Data Protection license to continue
scanning data.

FortiCASB Data Protection License is an add-on license for the existing FortiCASB Saa$S Protection License
users and/or FortiClient ZTNA users when the Data scan capacity is depleted.

FC1-10-FCASB-307- 100GB Data scan add-on for FortiCASB SaaS Protection
02-DD users or FortiClient ZTNA users

FC5-10-FCASB-307- 1TB Data scan add-on for FortiCASB SaaS Protection users
02-DD or FortiClient ZTNA users

FortiCASB License For FortiClient ZTNA Users

Customers that have purchased the FortiClient ZTNA license are entitled to the equivalent number of
FortiCASB SaaS protection seats (500 FortiClient ZTNA seats will entitle customers to 500 Protected SaaS
users in FortiCASB). As part of the ZTNA license customers will be entitled to the equivalent of 1GB of data
scanning per user seat.

As an example, a FortiClient ZTNA customer with 500 user seats, will also be entitled to 500GB of Data
Protection. For further Data scanning capacity customers will need to purchase the FortiCASB Data Protection
license.

When there is insufficient DLP data scan capacity, only FortiCASB Data Protection License is required for
additional DLP data scan capacity. It is not necessary to purchase FortiCASB SaaS Protection License for
FortiClient ZTNA users.
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Ny AWS S3, Google Workspace, and Azure Storage only requires
‘Q' FortiCASB Data Protection License to perform DLP scan. All other
- SaaS applications require both user license seat and DLP scan
- capacity licenses.

Purchase Option

Contact your local sales representative and ask for a quote for the FortiCASB SaaS Protection license or
FortiCASB Data Protection license.

If you don't have a sales contact, please kindly visit the link below to find your nearest sales contact.

https://www.fortinet.com/partners/partner-program/find-a-partner

Cloud Application Native Apps Support

In enterprise scale applications, like Google Workspace, Office 365, AWS S3, etc. they offer cloud application
subscriptions in a package where they also support other native apps. For example, Google Workspace
supports drive, gmail, meet, etc.

FortiCASB does not support monitoring for all cloud application native apps, but only provides monitoring in
areas that are close to the core of FortiCASB's fundamental. Every cloud application's native apps support
varies, here are details on what is being supported specifically to each cloud application.

What Cloud Data Are Scanned?

Generally, for all cloud applications supported by FortiCASB data scan and monitoring only starts after the
cloud application is onboarded in FortiCASB. All data resides on the cloud application prior to onboarding is not
supported for data scan.

However, all user activities including but not limited to file access are supported in FortiCASB data scan
through Data Security, Threat Protection, and Compliance policies.
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Google Workspace Native Apps Support

There are two Google Workspace native apps that FortiCASB supports:

o Google Drive
o Google Workspace Marketplace

FortiCASB monitors file activities and file access conducted on these two Google Workspace native apps
through the method of API polling every 15 minutes.

Cloud Application Polling Intervals

Introduction

Polling Interval is the frequency in which FortiCASB communicates with the cloud application host onboarded
to retrieve real time data. This process ensures that the data that FortiCASB monitors is in synchronization with
the cloud application data.

There are two types of polling:

1. API Polling - FortiCASB queries the cloud application host according to a fixed interval regardless an
event occurs or not. The shorter the polling interval, the closer it is to real-time update.

2. Webhook Polling - Query requests automatically made by the source or the cloud application server
when an event occurs thus there is no delay in synchronization between the cloud application host and
data monitored by FortiCASB.

Cloud Applications with API Polling and the Polling Intervals

Cloud Polling Inter-
Application val (min)
AWS S3 10
gtz::ge 20
Box 10
Dropbox 2
Egnyte 10
GCP
Storage
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Cloud Polling Inter-
Application val (min)
Google
Workspace
Office 365 1

Salesforce 4

SAP IAS 10
SAP

Success 4
Factors

ServiceNow | 2

Zendesk 10

Cloud Applications with Webhook Integration

« Citrix

« Confluence

« Facebook Workplace
o Github

o Jira

« Webex

« Zoom
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Company Management

Company system configuration, business unit and user management of FortiCASB.
In Company, these are the key functionality of Company management:

« View License Purchased

« Data Protection Usage

« Company and Business Unit Configuration

« User Management

e Microsoft Entra ID AU (Administrative Unit) Management
« Generate and Manage API Credentials

When you first log into FortiCASB, you are prompted to create a company, business unit(s), and users.

FortiCASB account permissions can have one of the following:

« Administrator— can have full permissions, including the ability to create,
access, assign companies and organizations.

« Business users with full access— business users from FortiCloud who have

\ﬂ been granted full access also have full permissions, including the ability to create,

access, assign companies and organizations.
Business users with limited access— business users from FortiCloud who
have been granted limited access can only view companies they are a part of.
If you are an administrator, continue to First Time Setup on page 23.
If you are a business user with limited access, not an administrator in charge of setup
or a user with full access, skip to Switch between business units on page 29.

FortiCASB requires different setup procedures, depending on your organization's hierarchy and needs. A
company with a branched hierarchy, such as a company with multiple branch offices or a compartmentalized
organizational structure, will have different requirements than a company with only one unified office.

First Time Setup

To set up your FortiCASB for the first time, you or your organization must have the following in place:

« Avalid FortiCASB license. Contact your primary Fortinet Service Provider to obtain a license if you do not
already have one.
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« An administrator with a Primary FortiCloud account to add your company, business units, and users in

FortiCASB.
In accordance with European Union laws and regulations, all data that FortiCASB
ﬂ collected for European Union (EU) companies must be located in the EU region. To
I accommodate for this, you can choose to host your CASB cloud service either on the

Global site or the EU site.

First Time Setup Steps

In the first time setup, a default company and business unit will be created using your admin account.

1. Go to https://www.forticasb.com/.
2. Click Login. You will be redirected to the Fortinet single sign-on webpage.

3. Log into FortiCASB with your admin account, or create a new admin account if you do not already have
one.

4. If applicable, in FortiCASB account selection page, select an account.
5. A popup prompts you to create a company, enter a company name and description.
6. Click Add Company to finish creating a company.

Add Company

General

Company ID * Region *
Company Name *

Company Description

Add
Company

7. After the default Company is created, a default Business Unit needs to be created. (Important)

In the Company page, click Set as Default to make the first business unit as default.
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Company
Company ID 115633286 Company Name Fortinet
Manage Company
Region Global Company Description -
Fortinet Gota this BU

0 Cloud Apps
No Cloud App added I
Add Business Unit
®

User Management hd

Grant users access to Business Unit here. After you make any changes, make sure to click the Save button to save all changes made.

8. Click Go to this BU to verify that the default Business Unit is created successfully.

After the default company and business unit are created, proceed to Add a Business Units on page 25 to
create additional business unit(s).

If you have a pop-up blocker, it will block the FortiCASB GUI.
A Set an exception for the FortiCASB GUI, or open the GUI manually.

Add a Business Units
After a default company and business unit are created, log into FortiCASB to add additional business unit.

To add a business unit:

1. Loginto FortiCASB with your primary FortiCloud account.
2. Click on Company from the top right hand side.

S 90 B M @

3. Clickon +Add Business Unit under Company management.
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Company
Company ID 330238 Company Name IAMTEST
Region Global Company Description 20.1.1test
10 Cloud Apps 1 Cloud Apps +

Qe oLl ™ AR 1 |

Add Business Unit

@ SetasDefaulc & O Setes Default o

User Management

Grant users access to Business Unit here. After you make any changes, make sure to click the Save button to save all changes made.

4. Enter the Business Unit ID and a name, then click Add BU to complete adding the business unit.

Add Business Unit *

Business Unit ID *

Generate

Business Unit Name *

Repeat this process to add additional business units if applicable.

Create a Business User

You must create business users on FortiCloud. Only FortiCloud primary account user can create business user.
After you create a business user, it will be appear in User Management on FortiCASB.

1. Loginto FortiCloud. (https://support.fortinet.com)
(Alternatively, you can access FortiCloud after you log into FortiCASB by clicking the account drop down
menu button at the right hand side and select My Account.)
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)

Y User Information
@ Security Credentials
Subscriptions

@ z: 2&  Switch Accounts
>
9]

Logout

Salesfarce Dropbiox

al A Q

Google Cloua Storage Azure Storage Wenex Teams

No cloud sccount No cloud account

2. On FortiCloud, click on Mange User at the left hand side, then a list of users will display.

Account )
Account Profile
# Change Account ID (Email) Account Information

| & Manage User |

&8 My Account (JAM version)

Phone: -
Industry: Technology

Organization Size: 2500-9929 employees

Master User

Email:

Name:

Title: QA

All ticket process via Email: Y

For more information about Email interaction, please Click Here

+
3. Click on add user button on the right hand side:
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Add User

User Information

User Name:* Telephone:*

Email (Account ID):* Confirm Email (Account ID):*
Description:

Permissions

Customer Service

4. Fillin the User Name, E-mail, and Telephone for the user you would like to set up.
5. a. Select Full Access to grant the user full permissions, including the ability to create/access/assign
companies and business units.
b. Select Limited Access to only grant the user basic access. Then click Save.
6. If Limited Access is selected, click on Add More Products to select a license.

O Full Access@ Limit Access

Access List

Filters:

Serial Number Description

FortiAnalyze

0o oo oo o o oo

7. Click Save.
Repeat this process to create more users.

After business user(s) are created, you may assign the new users to the business units through Assign users to
a business unit on page 29.
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Assign users to a business unit

After you create business users on FortiCloud, they will appear in User Management on FortiCASB.

(If you just created the user on FortiCloud, make sure you log out of FortiCASB and log back in to see the new
users in User Management.)

1.

Log into FortiCASB with your primary FortiCloud account.

2. Atthe FortiCASB Dashboard, click Company == atthe top right hand corner.
3. Scroll down to User Management section, grant the user access to a business unit by checking the

business unit check box, uncheck the check box to remove the user.

User Management

Grant users access to Business Unit here. After you make any changes, make sure to click the Save button to save all changes made.

User User Type QATest test123
test2434 Full Access
fimited Limit Access O

BinXu Master User

4. Click Save to save the configurations.

Switch between business units

Only Business Unit users created by FortiCloud primary account are able to access FortiCASB. If you have
not created an user, please contact your administrator to help you create one.

1.

Go to FortiCASB, at the sign-in page, sign in with your business user account.

2. Select a FortiCASB user account (if applicable).
3. Select your business unit, then you will be brought to the FortiCASB dashboard.
4. If you need to switch to different business unit, click on Company == atthe top right hand side.
= o B G
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5. Look for the Business unit that you want to switch to and click Go to this BU.

Company ID 330238 Company Name IAMTEST

Region Global Company Description 20.1.1test

QA Test test123 test345

10 Cloud Apps 1 Cloud Apps 0 Cloud Apps
& L OO ™ A 1} No Cloud App added

@ SetssDefauit o O SetesDefault % O SetasDefault o

Please contact your administrator with primary FortiCloud account to add you into the
business unit.

\ﬂ If your account hasn't been assigned to a business unit, an error message will appear.

Microsoft Entra ID Administrative Units Integration

Introduction

Microsoft Entra ID Administrative Units allow users to be grouped together with the same management scope.

Instead of monitoring all cloud account users' activities, create Microsoft Entra ID Administrative Units to define
the list of users that should be monitored for user activities.

If the Azure account on FortiCASB is onboarded prior to 2024, and

x this is your first time using Microsoft Entra ID AU Management in

FortiCASB, please first update your Azure Storage account.
Please see Update Azure Storage Account on page 79

Steps to monitor through Microsoft Entra ID Administrative Unit

1. Create Administrative Unit and add users on a Microsoft Entra ID account.
Detailed instructions provided by Microsoft - https://learn.microsoft.com/en-us/entra/identity/role-based-
access-control/admin-units-manage?tabs=ms-powershell

2. Add New Microsoft Entra Administrative Unit To FortiCASB on page 31
Add Microsoft Entra ID AU to Business Unit on page 33
4. Apply Microsoft Entra ID Administrative Units to Cloud Account on page 36

g
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List of Supported Cloud Accounts

Currently, only the following cloud accounts support Microsoft Entra ID Administrative Units Integration in
FortiCASB.

Accounts
Salesforce
Office365
Box
Dropbox
Google
Jira

Webex
GitHub
Zoom
ServiceNow
Egnyte
Confluence

SAP IAS

Add New Microsoft Entra Administrative Unit To FortiCASB

Microsoft Entra ID AU (Administrative Unit) Management

Microsoft Entra ID (formerly known as Azure AD) Administrative Unit management allows you to manage all the
Microsoft Entra ID administrative units in one place and add them to different FortiCASB Business units. When
a Microsoft Entra ID administrative unit is added to the Microsoft Entra ID AU Management, all users under the
administrative unit will be added simultaneously.
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Microsoft Entra ID AU (Administrative Unit) Management

Feel free to add new or manage added Microsoft Entra ID AU (Administrative Unit) here.

Q, Search
AU Name Users in AU Added to Business Unit Sync Status Microsoft Entra ID Account Last Synced On
3 - @ Complete 2023/10/11,04:18
5 — @ Complete 2023/10/12,02:26

Before the Microsoft Entra Administrative Unit can be added to a FortiCASB Business unit, it needs to be added
to FortiCASB first.

1. Log into FortiCASB, and click on Company button
2. Scroll down to Microsoft Entra ID AU (Administrative Unit) Management and click + Add New.

Microsoft Entra ID AU (Administrative Unit) Management

Feel free to add new or manage added Microsoft Entra ID AU (Administrative Unit) here.

Q, Search

3. Click Login @Microsoft Entra ID to grant FortiCASB access to the Microsoft Entra ID account.

4. Once you sign in with your Azure admin account, you will be re-directed back to FortiCASB to select the
Microsoft Entra ID Administrative Unit to be added to FortiCASB.

The following AUs are found in this Microsoft Entra 1D account.

Please select the ones you'd like to add to FortiCASB.

B AuName Description Status in CASB
= Monitored
= Monitored
fourAU - Not Monitored
another_AU - Not Monitored
1-4of4

Add Selected AUs

5. Select the administrative unit(s) to be added and click Add Selected AUs.
6. Click Done and wait for a few minutes to sync all users in those Administrative Units.
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Add Microsoft Entra ID AU to Business Unit

Add To BU is a feature to add Microsoft Entra ID Administrative Unit to FortiCASB Business Unit.

Steps to Add Microsoft Entra ID AU to Business Unit

1. Obtain FortiCASB Business Unit ID on page 33
2. Add the Administrative Unit to the Business Unit on page 34
3. Check the Administrative Unit added to Business Unit on page 35

1. Obtain FortiCASB Business Unit ID

Before adding the Administrative Unit to Business Unit, first obtain the Business Unit ID (BU ID).

1. Switch to the Business Unit where the Administrative Unit is going to be added to.

#H 0 B B 0

See Added AL Switch Business Unit
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2. Record down the Business Unit ID located in the Dashboard.

©@ Overview

Business Unit Overview

Dashboard

Application Usage BUName testassign BUID 480756
Report

Audit Log o
Shadow IT Google Workspace

Trusted List

Fabric Integration

B Data Protection

2. Add the Administrative Unit to the Business Unit

including

GO

@ Disconnected

1. Goto Company Management, scroll down to Microsoft Entra ID AU (Administrative Unit)

Management
Microsoft Entra ID AU (Administrative Unit) Management

Feel free to add new or manage added Microsoft Entra ID AU (Administrative Unit) here.

Q Search
AU Name Usersin AU Added to Business Unit Sync Status
3 - ° Complete
5 - @ Complete

2. Select an Administrative Unit to add from the list.
3. Click Add To BU to add the Administrative Unit.

Microsoft Entra ID Account Last Synced On

2023/10/11,04:18

2023/10/12,02:26

Add To BU Sync Users in Selected + Add New

4. Click Select BU drop down button and select the Business Unit ID that the Administrative Unit will be

added to.
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Add Selected AU To BU X

AddtoBU *
| BU- 480756 »

Save Changes Cancel

5. Click Save Changes to finish.

3. Check the Administrative Unit added to Business Unit

1. In FortiCASB Dashboard, click Switch Business Unit in the upper right corner.

#H 0 B & 0

See Added AL Switch Business Unit

2. Scroll down to the Business Unit that the Administrative Unit is added to, and click Go to this BU.

testassign Go to this BU
1 Cloud Apps

0
() Set as Default 0

3. When switched to the new Business Unit click See Added AU in Dashboard.

See Added AU Switch Business Unit

FortiCASB 24.3.b Admin Guide
Fortinet Inc.

35



Company Management

4. The newly added Administrative Unit should be in the list.

Added AUin 480756

s Sync Users In All AU

AU Name Sync Status Last Synced On Action
@ Complete 2023/10/12,03:37 s

1-10f1

Apply Microsoft Entra ID Administrative Units to Cloud Account

After a Microsoft Entra ID Administrative Unit is added to a FortiCASB Business Unit, it is ready to be applied to
the supported cloud applications in a Business Unit.

There are two methods to apply the Microsoft Entra ID administrative units - Add or Update cloud account.

Method 1 - Apply Microsoft Entra ID Administrative Units through Add Cloud
Account

1. In FortiCASB Dashboard page, click on Switch Business Unit.

H 0 B & 0

See Added AU Switch Business Unit

2. In Company, go to the Business Unit that has the Microsoft Entra ID Administrative Unit added.
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testassign Go to this BU
1 Cloud Apps

a
() Set as Default x

3. Check the Administrative Units by clicking See Added AU to verify that the Administrative Units are
added.

See Added AU Switch Business Unit

4. In Business Unit Overview, click Add New cloud account.
5. Select the supported cloud application, e.g., Salesforce, and click Add Selected Cloud App.
6. Click the checkbox for Only monitor users that are found in Microsoft Entra ID AU.

Only monitor users that are found in Microsoft Entra ID AU.

©® Touse this feature, please make sure there are AUs added to this BU.
If MO AUs are added, then for this App, there will be NO User data.

Grant Access @Salesforce Cancel

7. Continue with the rest of the Add Cloud Account steps to finish.
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Method 2 - Apply Microsoft Entra ID Administrative Units through Update Cloud
Account

1. In FortiCASB Dashboard page, click on Switch Business Unit.

N o 2 = I 7

See Added AU Switch Business Unit

2. In Company, go to the Business Unit that has the Microsoft Entra ID Administrative Unit added.

testassign Go to this BU
1 Cloud Apps

a
() Set as Default x

3. Check the Administrative Units by clicking See Added AU to verify that the Administrative Units are
added.

See Added AL Switch Business Unit

4. InBusiness Unit Overview, Select the supported cloud application, e.g., Salesforce, and click the e

setting button and select Update Cloud Account.
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@ Update Cloud Account

View Account Detail

Salesforce

View Change History

Delete Account

5. Click the checkbox for Only monitor users that are found in Microsoft Entra ID AU.

Only monitor users that are found in Microsoft Entra [D AU.

©® Tousethis feature, please make sure there are AUs added to this BU.
If NO AUs are added, then for this App, there will be NO User data.

Grant Access @Salesforce Cancel

6. Continue with the rest of the Update Cloud Account steps to finish.

Synchronize Microsoft Entra ID Administrative Unit Users

After the Microsoft Entra ID AU (Administrative Unit) is added to FortiCASB. When users under each
administrative unit is updated, the administrative unit can be manually synchronized.

There are two methods to synchronize administrative users.

1. Synchronize Microsoft Entra ID Administrative Unit users in Company

In Company > Microsoft Entra ID AU (Administrative Unit) Management, administrative users can
select and synchronize AU units through Sync Users in Selected button.
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AddTo BU Sync Users in Selected + Add New

Microsoft Entra 1D Account Last Synced On Action
2023/10/13,04:21 “es
2023/10/13,04:21 vee

2. Synchronize All Microsoft Entra ID Administrative Units users in the same
Business Unit

This method will synchronize all users in all administrative units within the same Business Unit.

1. Goto Overview > Dashboard
2. Clickon See Added AU in the Business Unit.

i 0 B M 0O

See fdded Al Switch Business Unit

3. Click Sync Users In All AU to synchronize all administrative units' users.
Added AU in 454532

c Sync Users In All AU

AU Name Sync Status Last Synced On Action

test_ AL © Complete 2023/10/13,05:22 c

another_AU © Complete 2023/10/13,05:22 c

foural) @ Complate 2023/ 10ij?». 05:22 c
1-30f3
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FortiCASB NAT IP Address

The FortiCASB NAT IP address is the public IP address that is being used to connect to your SaaS accounts or
added cloud accounts. The IP address can be added to your cloud account security white list to avoid alerts
being triggered when FortiCASB requests updates through API calls on the cloud accounts.

Depending on where you are located, the IP address is different for Global (US) and European Union (EU)
users:

Region  FortiCASB Site NAT IP

Address Address

Global https://www.forticasb.co 52.41.24.220

(US) m

Europea https://eu.forticasb.com 34.247.192.7
n Union 2

(EV)

Generate API Credential

FortiCASB REST API resources are free and available for development purpose. To use these API resources,
an OAuth 2.0 bearer token is required in the Authorization header. One method to get OAuth 2.0 bearer token

is to call Get Credentials Token. Before calling Get Credentials Token API, follow the steps below to
generate a credential.

1. Log into FortiCASB with your account.
2. Click on Switch Company from the top right hand side.

S 90 B M @
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3. In Company, click Manage Company to access company setting.

Company

CompanyID 330238 Company Name IAMTEST
Region Global 2011 test

Company Description

10 Cloud Apps 1 Cloud Apps 0 Cloud Apps
= ® L OO0 ™ AR 0 No Cloud App added
@ SetasDefault % O setas Default 0 O setasDefault o

4. Click on API Setting tab.
5. Click Generate New to generate a new API credential.

API Setting

Credential Name Credential Generated On
Yyuetest 2/2/2021.12:23:59 PM Revoke
testtoken e S 2/2/2021.3:28:35PM

sutotest e s 2/9/2021, 4-03:39 PM Revoke
apitest e S 2/11/2021.9-38:58 PM Revoke
Rowsperpage: 10 7 140f4

6. Enter a name for the new credential and click Generate Credential.
7. Copy down the credential to be used to call any FortiCASB API later.

Generate Credential

Please Copy and Save Immediately
]

This credential will only be displayed once. It will NOT be stored and cannot be retrieved
ater in ForiCWPP.

Note: The credential will only be shown once, please keep it at a private and secured place.

The generated credential can be used repeatedly as long as it is not revoked on FortiCASB.
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User Management

There are two major types of user classification in FortiCASB:

FortiCloud Full Access Users and IAM Admin Users - these type of users have full permission in
FortiCASB Company and Business Unit management.

FortiCloud Limit Access Users and IAM Read/Write Users - these type of users have limited permissions
in Company and Business Unit management.

FortiCASB User Type Permission Chart

Need to Add
assign BU Manage Add BU in Modify o
. . . . Applications
Permission Type firstin Company | Company | Business | . .
. in Business
Company page page Units Unit
page
No (It has
IAM user | Admin accesstoall | Yes Yes Yes Yes
BU)
IAM user | Read/Write Yes No No No Yes
Sub
Account Limited Yes No No No Yes
User
Sub No (It has
Account Full accesstoall | Yes Yes Yes Yes
User BU)

Local IAM User

Local IAM user is an IAM account created and delegated by the FortiCloud master administrative user. Local
IAM user permission access is limited to the permission profile assigned by the FortiCloud master
administrative user.
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Follow the Create Local IAM User on page 45 guide and Local IAM User First Time Login on page 47
guide to create a Local IAM user.

Create Local IAM User

1. Loginto FortiCloud Organization as the FortiCloud master user.
2. Click on Services drop down menu and select IAM.

@ Services ¥ @Support v

-~

ASSETS & ACCOUNTS
& Asset Management [&a] 1AM
%‘% Organizations ﬁ:t FortiFlex

3. Click the master user drop down menu in the upper right corner and collect the Account ID that will be used
for the IAM login credential.

&

O v

=

s My Account
T 7789 FortiCASB-US & My

@ Security Credentials

(') Logout

4. Inmain menu, select Users, and click Add New drop down menu to select IAM.
5. Input IAM user information, and click Next.

FortiCASB 24.3.b Admin Guide
Fortinet Inc.

45


https://support.fortinet.com/

User Management

1. User Details

ADOPT PERMISSIONS

AM SER INFORMATION
Apply same permissions as existing User :

Username:
Select an existing User w

victory
Full Name:

Jane Dole
Email:

janedole@gmail.com

Phone

+1 4087779999

6. In Basic Info > Select a Type, select Local.

7. InPermission Scope, keep the asset selection as My Assets.

In Permission Profile, click Select a Permission Profile drop down menu, and select a permission
profile for the IAM user. The IAM user will received the permission access through the permission profile

selected.

PERMISSION SCC

Select an Asset Folder *

My Assets

PERMISSION PROFILE
Select a Permission Profile’
Cloud_BDE_Access
SysAdmin
AP test
Cloud_BDE_Access

9. The Permission Details will show the access type of the IAM user is entitled with.

FortiAnalyzer Cloud FortiCASE

v Admin v Admin
FortiDAST FortiFlex
v Admin v Admin

10. Click Next to continue
11. In Confirmation page, review all the details and click Confirm to complete.
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12. The new IAM user should receive a verification email. Enter the verification code to verify.

Welcome to FortiCloud

To ensure access to your FortiCloud account is simple and secure, please complete the following 'quick setup' process below:

o
Please verify your Email Address
This is 2 ‘'one-time’ action - you won't be asked again for this information

(0 ACTION REQUIRED !
An email has been sent to your email address. Please enter the verification code you've received.

Email : Email Verification Code: *

Enter Verification Code

GET VERIFICATION CODE
Please enter the Captcha code below: *

Refresh Captcha

Enter Captcha Code

Local IAM User First Time Login

After the Local IAM user is created, now the Local IAM user can log into FortiCASB.

1. Goto FortiCASB login page, and select IAM LOGIN tab.
2. Enter the Account ID of the master account, IAM username and password, and click Log In.

%4 EMAIL LOGIN IAM LOGIN

IAM Login

SER

victory B

Forgot password?

LOG IN

3. Enter the security code sent to your email box and click Go.
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4. The local IAM user will be directed to the FortiCASB dashboard according to the permission profile

assigned.
@ Services ¥ @ Support ¥ v
Company 0
Product Serial No. SKU Purchased Quantity Expiration Date

2024/11/01,06:54:00 AM (120 day

FC2-10-FCASB-145-02-12 1000 users left)
sle

2028/06/13,05:12:39 PM (1441 da

FCX-15-EMS04-424-02-60 3users
ys left)

OU IAM User

Overview

OU(Organizational Unis) IAM User is a type of IAM user with Organization Scope and Permission profile
defined by the master administrative user. In comparison to IAM (Local) user, OU IAM user is able to access
other FortiCASB profiles within the same organization scope.

Follow the NCreate OU IAM User on page 49 guide and OU IAM User First Time Login on page 52 guide
to create an OU |AM user.

Switch Between Profiles

When logged into FortiCASB, the OU IAM user can seamlessly switch between different organization profiles
by clicking on the upper right account button to make a selection.
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Q ;_i} = - v victory »

v = OU_Root_Test

=

FortiCASB-US

v O pui-11

iy

Xyang

i)

Testl

NCreate OU IAM User

There are two parts to create an OU IAM User.

The first part is to create an organization unit (OU) with a FortiCloud account access to FortiCASB.

The second pat is to create an OU IAM user under the organization unit that share the same organization scope
and access permission to FortiCASB.

Organization Unit Configuration Steps

1. Create a FortiCloud Root or Sub Organization Unit(OU). Create a FortiCloud Organization unit with
a FortiCloud master user that has FortiCASB license. For FortiCloud Organization Unit creation guide,

please see Creating an organization.

2. Create a registered FortiCloud user with FortiCASB license (optional) - use an existing FortiCloud
user with FortiCASB license or create a new FortiCloud user and add FortiCASB registration, please see

Creating a FortiCloud account and Registering assets.

3. Add the new or existing FortiCloud user to the organization unit (optional)
a. Send the invitation token from the organization to the FortiCloud user. See Invitations.
b. Use the FortiCloud user to join the organization. See Joining an organization.
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User Management

Create an Organization Unit (OU) IAM User

1. Loginto FortiCloud Organization as the FortiCloud master user.
2. Click on Services drop down menu and select IAM.

@ Services * @ Support ¥
.
ASSETS & ACCOUNTS
‘,,_‘ﬁ\ Asset Management [&] 1AM
%tf_& Organizations f\?g FortiFlex

3. Click the master user drop down menu in the upper right corner and collect the Account ID that will be used
for the OU IAM login credential.

a

A v

s My A t
=~~=89)FortiCASB-US &5 My Accoun

@ Security Credentials

() Logout

4. Inmain menu, select Users, and click Add New drop down menu to select IAM.
5. Input IAM user information, and click Next.

1. User Details

IAM USER INFORMATION ADOPT PERMISSIONS
Username: * Apply same permissions as existing User :

victory Select an existing User A
Full Name: *

Jane Dole

Email:
janedole@gmail.com

Phone: *

+1 4087779999

6. In Basic Info > Select a Type, select Organization.

7. In Permission Scope, click Select an organization unit or Account drop down menu, select an
organization unit or account as the permission scope.

8. Click Select a Permission Profile drop down menu to select a permission profile.
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Select a Permission Profile”
root_ou_permission

SysAdmin

root_ou_permission

When a permission profile is selected, details below will show the access types that the profile is entitled
with.

Select the Permission Profile that has Admin Access Type for FortiCASB.

FortiCASB

v Admin

Only OU IAM user granted with Admin access type can switch to
other organization profiles in FortiCASB.

9. Click Next to continue
10. In Confirmation page, review all the details and click Confirm to complete.
11. The new OU IAM user should receive a verification email. Enter the verification code to verify
Welcome to FortiCloud

To ensure access to your FortiCloud account is simple and secure, please complete the following 'quick setup' process below:

—

) Please verify your Email Address
This is a 'one-time’ action - you won't be asked again for this information
~

(@ ACTION REQUIRED ! 2
An email has been sent to your email address. Please enter the verification code you've received.

Email : Email Verification Code:

Enter Verification Code

Please enter the Captcha code below:

Refresh Captcha

Enter Captcha Code
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OU IAM User First Time Login

After the OU IAM user is created, now the OU IAM user can log into FortiCASB.

1. Goto FortiCASB login page, and select IAM LOGIN tab.
2. Enter the Account ID of the organization, IAM username and password, and click Log In.

¥ EMAIL LOGIN 1AM LOGIN

IAM Login

victory o

sesnenee

Forgot password?

LOG IN

3. Enter the security code sent to your email box and click Go.

4. The user will be shown a 'Welcome Back' page with prompt to select an Organization Unit(OU) or a Sub
Organization Unit account.
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Make a Selection to Proceed

v = (OU_Root_Test

(Y -
= FortiCASB-US

4
W)

ou1
+ O out1

v O out11

[1i)

xyang

[3i)

Testl

5. After selection, the OU IAM user will gain access to the specific FortiCASB profile default dashboard.
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Cloud Application Onboarding

Both FortiCASB administrators and users can onboard the cloud applications to a business unit. Once added,
all users in the business unit can view the cloud application.

AWS S3

FortiCASB offers an APl-based approach, pulling data directly from AWS S3 via RESTful API. Then FortiCASB
portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently, FortiCASB
combines these data to monitor and track AWS S3 user activities, provides DLP Data Analysis for files stored
on AWS S3.

Prerequisites

1. Account Requirement

Before adding your AWS S3 account to FortiCASB, make sure the AWS account user you use is an
Administrator User. For instructions on creating an "Administrative User" in your AWS account, please refer to:

https://docs.aws.amazon.com/mediapackage/latest/ug/setting-up-create-iam-user.html

2. Activate Security Token Service (STS)

FortiCASB uses regional Security Token Service (STS) to reduce latency and provide smoother user
experience.

Follow these steps to turn on Security Token Service (STS) on AWS console.

1. From your AWS console dashboard, go to Identity and Access Management (IAM).

2. Click Account settings from the left navigation panel, and click to expand Security Token Service
(STS).
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Identity and Access » Password policy
Management (IAM) 1

« Security Token Service (STS)

Dashboard
Session Tokens from the 5TS endpoints
~ Access management AWS recommends using regional STS endpoints to reduce latency. Session tokens from regional STS endp
User groups
Session tokens from the global STS endpoint (https-/sts amazonaws com) are valid only in AWS Regions th
Users activate the global STS endpoint to issue session tokens that are valid in all AWS Regions. Learn more
Roles
Policies Endpoints Region compatibility of session tokens
Ideﬂmy pro\.fiders Global endpoint Valid only in AWS Reg\ons enabled Dy default
Account settings Regional endpoints Valid in all AWS Regions
~ Access reports .
Endpoints
Access analyzer You can enable additional endpoints fom which you can request temporary credentials. Aclivate only endpo
Archive rules
3. Based on your location, activate EU (Ireland) if you are located in European Union, otherwise, activate
US West (Oregon).

Add AWS S3 Account

Use the Administrator User to create new AWS Policy, Role, and configure the CloudTrail setting:

1. AWS Policy Creation on page 55
AWS Role Creation on page 57

3. Update AWS Role External ID (optional) on page 61
4. AWS Configure CloudTrail Setting on page 62
5. Add AWS S3 Account on page 65

AWS Policy Creation

1. Go to your AWS console dashboard, search and click IAM.
2. Click Policies from the left navigation menu.
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Identity and Access
Management (IAM) <

Dashboard

~ Access management
User groups

Users

Roles

Identity providers

Account settings

v Access reports

Access analyzer

Archive rules
Analyzers

Settings

Credential report
Organization activity

Senvice control policies (SCPs)

3. Click Create policy,

IAM dashboard

Sign-in URL for IAM users in this account

https:(/ signin aws amazen.com/console ¢7] | Customize

IAM resources

Users: 31 Roles: 133

User groups: 6 Identity providers: 3
Customer managed policies: 65

Security alerts

A The root user for this account does not have Multi-factor authentication (MFA) enabled. Enable MFA to improve security for this account

Best practices

Grant least privilege access [ Establishing a principle of least privilege ensures that identities are only permitted to perform the most minimal set of
functions necessary to fulfill a specific task, while balancing usability and efficiency.

Use AWS Organizations (7 - Centrally manage and govern your environment as you scale your AWS resources. Easily create new AWS accounts,
group accounts to organize your workfiows, and apply policies to accounts or groups for governance.

Enable Identity federation: Manage users and access across multiple services from your preferred identity source. Using AWS Single Sign-On '
centrally manage access to multiple AWS accounts and provide users with single sign-on access to all their assigned accounts from one place

Enable MFA: For extra security, we recommend that you require multi-factor authentication (MFA) for all users.

Rotate credentials regularly: Change your own passwords and access keys regularly, and make sure that all users in your account do as well.

Enable IAM Access Analyzer: Enable IAM Access Analyzer ta analyze public, Cross-account, and cross-organization access.

Learn more about all security best practices. @'

and go to JSON tab.

4. Replace the existing JSON code with the following:

{
"Version": "20
"Statement": [
{

"Action": [

12-10-17",

"s3:Get*",
"s3:List*",
"s3:Put*",
"s3:Deletex*",
"s3:CreateBucket",
"iam:List*",

"iam:Get*",
"cloudtrail:LookupEvent

S",

"cloudtrail:GetTrailStatu

S",

"cloudtrail:DescribeTrail

S",

"cloudtrail:ListTags",

"cloudtrail:GetEventSelec
tors",

"config:Get*",

"config:Describe*",

"config:Deliver*",
"config:List*"

1,

"Resource":

wkn
’

"Effect": "Allow"

}

}

5. Click Review policy.
6. Name the new policy, e.g. , "forticasb_authentication".

7. Click Create policy.

Your new policy will be created.
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}\ Please keep your policy name later for role creation.

YL
‘Q' For the purpose behind the AWS services being used to create the custom policy,
|| please refer to Appendix A - Amazon Policy Usage on page 552.

AWS Role Creation

Obtain External ID from FortiCASB

Before creating an AWS Role, you will need an external-ID generated from FortiCASB. The External ID is an
unique 32-bit token that meets AWS security requirement that protects the AWS Role.

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard, click on Add New, select AWS S3, then click Add Selected Cloud
App.

Business Unit Overview

BUName QA Test BUID 330239 #of Cloud App 16
] Office 365 Google Workspace
ncluding ncluding
[ Y- 1 RS &9
L : = b L]
> U
=2 b S ) )
Dropbox Egnyte GitHub GCP Storage
- » @gmail.com
A
Q Y4 g,
bex Teams Zendesk

Add New

Select Cloud App to Add

Google Workspace 1] Office 365
ncluding ncluding
(Yo LT Y- 1K

FortiCASB 24.3.pAdmin Guige 2 33 ¥
FOFtInet |nc- Box Citrix ShareFile Confluence Drophox Egnyte
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3. Enter your AWS Account ID and click Validate to generate External ID for AWS role creation.

AWSS3 / OAuth / Add

Add AWS S3 Account
@ Finish Configurations @Aws 2. Fillin Account Info 3 Done
To successfully add your AWS S3 account, please refer to step-by-step tutorials.

Here is a summary of key configurations that need to be accomplished:

1. Create new AWS Policies for protection from FortiCASB.

2.Create anew AWS Role and use FortiCASB-generated External ID as the External ID at AWS. (Please
keep record of the Role ARN at AWS.)

Validate

3. Create AWS CloudTrail. If you already have an AWS CloudTrail, please cross-check the configuration
with our tutorial to receive full protection from FortiCASB.

4. Return to this page after above items are completed.

Please make sure you've finished all configurations above before clicking Next button below.

Cancel

4. The external ID will be appear on the right, click copy to copy the 32-bit external ID token.

Add AWS S3 Account

o Finish Configurations @AWS 2 | Fillin Account Info 3  Done

To successfully add your AWS S3 account, please refer to step-by-step tutorials.
Here is a summary of key configurations that need to be accomplished:

1. Create new AWS Policies for protection from FortiCASB.

2. Create a new AWS Role and use FortiCASB-generated External ID as the External ID at AWS. (Please
keep record of the Role ARN at AWS.)

Validate | | JgI7DhLCGgPI7drLRPVzynX4RC3gThO ...copy

3. Create AWS CloudTrail. If you already have an AWS CloudTrail, please cross-check the configuration
with our tutorial to receive full protection from FortiCASB.

4. Return to this page after above items are completed.

Please make sure you've finished all configurations above before clicking Next button below.

m cancel

Al
‘9' If you already have an AWS Role associated with FortiCASB, and only need to update
- the External ID. Please refer to Update AWS Role External ID (optional) on page 61

Create AWS Role.

1. Click Roles from the menu on the left.
2. Click Create role.
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3. In Select trusted entity, select AWS account.
Select trusted entity e

Trusted entity type

AWS service © AWS account
E , or others to Allow entities in other AW'S accounts belonging to you

ons in this account. or a 3rd party to perform actions in this account.

SAML 2.0 federation Custom trust policy
Allow users federated with SAML 2.0 from a corporate Create a custom frust policy to enable others to perform
directory to perform actions in this account actions in this account.

4. Choose Another AWS account, and enter the following Account ID: 897379900121.

An AWS account

Allow entities in other AWS accounts belonging to you or a 2rd party to perform actions in this account.

This account (483852032277)

© Another AWS account
Account 1D

Identifier of the account that can use th

n
o

[1¢]
[75)
[3-]

897379500121

Account 1D is a 12-digit number.

Note: This is the Amazon AWS account that FortiCASB uses to monitor the new role that is being created.
5. Select the box Require external ID and enter in the External ID token generated earlier.

Options

Require external |D (Best practice when a third party will assume this role)
You can increase the security of your role by requiring an optiona mal id c
the account that can assume this role. The external ID can include any characters that
mare

External ID

VWZnJWT2ZRUJCIXKDIKT _uySoY _-INWAhX0TQpwW-IDQ==

€ Important: The console does not support using an external ID with the Switch Role feature. If you select this option
the API, CLI, or a custom federation proxy to make cross-account iam:AssumeRole calls. Learn more

Require MFA

Requires that the assuming entity use multi-factor authentication
The External ID token must be the one generated earlier through FortiCASB using
the same AWS account. If the External ID is not generated from FortiCASB, the

AWS account cannot be added to FortiCASB.
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6. Make sure the box Require MFA is not selected. Click Next to continue.
7. Click Filter, select Type, and then select Type: Customer managed.

]
=]
o

X
Type + Description
Type: Customer managed
Type: AWS managed Custom...
Type: AWS managed - job function Custom.. permissions for Ankita
8. Select the policy you created earlier.
9. Click Next.
10. Enter a role name of your preference.
Role details
Role name
Description
11. Click Create role.
12. Click the role name created, and copy the AWS Role ARN.
Example of AWS Role ARN: arn:aws:iam::123456123456:role/FortiCASBTester
Summary
Creation date ARN
March 17, 2023, 10:52 (UTC-07:00) €3] am-aws:iam ‘role/forticasbgatest
Last activity Maximum session duration
MNone 1 hour
I\ Please keep the AWS Role ARN later for AWS authentication during installation.
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Update AWS Role External ID (optional)

If you have previously created an AWS role, you will only need to update the old External ID to the new
FortiCASB generated 32-bit External ID token without creating a new AWS role.

Follow the steps below to update the External ID:

1. Log into your AWS account portal using your Administrator User.
2. Search and click on IAM (Manage Access to AWS resources) from the AWS portal page.
3. Click on Roles, search and click on the AWS Role you created for adding the AWS S3 account to

FortiCASB.

4. Click Trust Relationships tab and click on Edit trust relationship.

Roles >

Summary

Role ARN

Role description

Instance Profile ARNs

Path

Creation time

Last activity

Maximum CLI/API session duration

Give this link to users who can switch roles in the
console

Edit

4]

2020-05-14 21:24 PDT
2020-05-15 15:27 PDT (Today)
1 hour Edit

https://signin.aws.amazon.com/switchrole?roleName=

&

Tags Access Advisor Revoke sessions

You can view the trusted entities that can assume the role and the access conditions for the role. Show policy document

Edit trust relationship

Trusted entities

The fallowing trusted entities can assume this role.

Trusted entities
The account

Conditions

The following conditions define how and when trusted entities can assume the role

Condition Key Value
StringEquals  sts:Externalld |

5. Replace the External ID value in the line "sts:Externalld" with the FortiCASB generated 32-bit External

ID.
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Edit Trust Relationship

You can customize trust relationships by editing the following access control policy document.

Policy Document
-
"Version": "2012-10-17",
-~ "Statement": [

"Effect": "Allow",

= "Principal": {
"AWS": "arn:aws:iam::. :root”
1
"Action": "sts:AssumeRole”,
@ "Condition": {
@ "StringEquals": {
] "sts:ExternalTd": “Jgl7DhLCGgPI7drLRPVzykcLezCAqAPckLESOVMEYbaFpWN_ ¥ I
H
b
}
1
}

6. Click Update Trust Policy to finish updating the External ID.

AWS Configure CloudTrail Setting

1. From AWS console dashboard, search and go to "CloudTrail"
2. Clickon Trails in the left navigation pane, and click Create trail.

CloudTrail » Trails
Trails

Name &  Homeregion v  Multi-regiontrail ¥  Insights ¥  Organizationtrail ¥ 53 bucket ¥
aws-
cloudtrail-

Europe logs-

asdsdqu (Frankfurt) Yes Disabled Ne 3852791335
63-
72028093

thanh-trail- US East (N. Ver disabled o thanh-

region-test1 Virginia) bucket-test2

Log file prefix ¥

CloudWatch Logs log group ¥

am:awslogsius-east-
1:385279133563:log-
groupiaws-cloudtrail-logs-
385279133563-6b1a28d2:*

@

Status Vv

]

Logging

©

Logging

3. InGeneral details page, enter a Trail name based on your preference, keep the default selection to

Create a new S3 bucket.
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General details

A trail created in the console is a multi-region trail. Learn more Z

Trail name
Enter a display name for your trail.

forticasb

3-128 characters. Only letters, numbers, periods, underscores, and dashes are allowed.

To review accounts in your organization, open AWS Organizations. See all accounts E

Storage location  Infe

© Create new S3 bucket Use existing 53 bucket
Create a bucket to store logs for the trail. Choose an existing bucket to store logs for this trail.

Trail log bucket and folder
Enter a new 53 bucket name and folder (prefix) to store your logs. Bucket names must be globally unique

aws-cloudtrail-logs-127084573567-871224a3

Logs will be stored in aws-cloudtrail-logs-127084573567-871224a3/AWSLogs/127084573567

Log file SSE-KMS encryption Info
Enabled

¥ Additional settings

Log file validation info
Enabled

SNS notification delivery Info

Enabled

4. Uncheck the options to enable Log file SSE-LMS encryption and Log file validation.
5. Scroll down and click Next to continue.
6. In Choose log events, Events > Event type, select Mangement events and Data events types.
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Choose log events

Events info

Record API activity for individual resources, or for all current and future resources in AWS account. Additional charges apply [

Event type

Choose the type of events that you want to log

Management events Data events Insights events

Capture management operations performed Log the resource operations performed on or Identify unusual activity, errors, or user
on your AWS resources. within a resource. behavior in your account.

Management events info
Management events show information about management operations performed on resources in your AWS account.

(@ Charges apply to log management events on this trail because you are logging at least one other copy of
management events in your account.

API activity
Choose the activities you want to log.

Read Write

Exclude AWS KMS events

Exclude Amazon RDS Data AP| events

7. In Manage events > API activity: keep Read and Write options selected.
8. In Data events, click Switch to basic event selectors.

Data eventsinfo

Additional charges apply E Data events show information about the resource operations performed on or within a resource.

@ Advanced event selectors are enabled Switch to basic event selectors
Use the following fields for fine-grained control over the data
events captured by your trail.

v Data event
9. In Data event source, select S3, then click Next.

v Data event: S3

Data event type
Choose the source of data events to log.

53 v

10. Review the trail settings, make sure it is configured as multi-region trail, scroll down and click Create
Trail.
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Review and create

Step 1: Choose trail attributes

General details

Trail name

) Trail log location Log file validation
forticash aws-cloudtrail-logs-127084573567- Disabled
871224a3/AWSLogs/127084573567

ut-regiontral SNS notification delivery
E Log file SSE-KMS encryption Disabled
i o Not enabled
Apply trail to my organization
Not enabled
CloudWatch Logs
No CloudWatch Logs log groups
CloudWatch Logs is not configured for this trail
Tags
\‘ ! ’l
q You have finished all the preliminary steps to add your AWS account. Now go back to
FortiCASB and click Next.
-—
-

Add AWS S3 Account
After all the AWS S3 configurations are completed from previous sections, follow these steps to add your AWS
S3 account on FortiCASB.

1. Gobackto Add AWS S3 Account page, review the key configurations list to see if they are completed,
then click Next.
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2. Enter the "AWS Role ARN" from the AWS CloudTrail Configuration that you have completed earlier.

Add AWS 53 Account

oF\'nishConﬁgurations@AWS 2 Fillin Account Info 3 Done

To successfully add your AWS 53 account, please refer to step-by-step tutorials.
Here is a summary of key configurations that need to be accomplished:

1. Create new AWS Policies for protection from FortiCASB.

2. Create a new AWS Role and use FortiCASB-generated External ID as the External ID at AWS. (Please
keep record of the Role ARN at AWS.)

Validate | | Jgl7DhLCGgPI7drLRPVzynX4RC3gTbO ...copy

3. Create AWS CloudTrail. If you already have an AWS CloudTrail, please cross-check the configuration
with our tutorial to receive full protection from FortiCASB.

4. Return to this page after above items are completed.

Please make sure you've finished all configurations above before clicking Next button below.

Next Cancel

Add AWS 53 Account

@D Finish Configurations @AWS Fill in Account Info
AWS Account ID How to find?

AWS Role ARN

External ID

sessBRRRRRRRRRRRRRRbRRRRRenasnsnees SHOW

Add AWS 53 Account

3. Click Add AWS S3 Account to complete adding the account.
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Update AWS S3 Account

Before updating the AWS S3 account on FortiCASB, use the AWS Administrator User to complete the same
AWS configurations.

1. AWS Policy Creation on page 55

2. AWS Role Creation on page 57

3. Update AWS Role External ID (optional) on page 61
4. AWS Configure CloudTrail Setting on page 62

After all 3 steps are completed, go back to FortiCASB to finish updating the AWS S3 account.

1. In FortiCASB, go to Overview > Dashboard.
2. Click on the AWS S3 account menu and select Update Cloud Account.

adWs Update Cloud Account

AWS S3 View Account Detail
View Change History

Delete Account

3. Atthe Update AWS S3 Account page, review the key configurations list to see if they are completed,
then click Next.
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Update AWS S3 Account

o Finish Configurations @AWS 2 | Fillin Account Info 3  Done

To successfully update your AWS S3 account, please refer to step-by-step tutorials.
Here is a summary of key configurations that need to be accomplished:

1. Create new AWS Policies for protection from FortiCASB.

2. Create a new AWS Role and use FortiCASB-generated External ID as the External ID at AWS. (Please
keep record of the Role ARN at AWS.)

Validate

3. Create AWS CloudTrail. If you already have an AWS CloudTrail, please cross-check the configuration
with our tutorial to receive full protection from FortiCASB.

4. Return to this page after above items are completed.

Please make sure you've finished all configurations above before clicking Next button below.

Cancel

4. Enterthe "AWS Role ARN" from the AWS CloudTrail Configuration that you have completed earlier.

Add AWS S3 Account

Finish Configurations @AWS Fill in Account Info & Done
AWS Account ID How to find?

AWS Role ARN

External ID

sEsbBRRRRRRRRRRRRRRRRRRRRRRansnees SHOW

Add AWS 53 Account

5. Click Update AWS S3 Account to complete Updating the account.
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Azure Storage

FortiCASB offers an API-based approach, pulling data directly from Azure Storage via RESTful API. Then
FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently,
FortiCASB combines these data to monitor and track Azure Storage user activities, provide DLP Data Analysis
for files on Azure Storage.

Prerequisites

You may use an existing Azure AD account or create a new account. If you create a new account, wait for at
least 24 hours for the new account to take effect before granting access to FortiCASB.

Make sure the user account that will be used on FortiCASB has a Global Administrator role or Cloud
Application Administrator + Global Reader roles.

You will also need to set up the Azure AD Privileged Identity Management application. For more information on
how to do so, go to:

https://docs.microsoft.com/en-us/azure/active-directory/privileged-identity-management/pim-configure.

FortiCASB supports all types of Azure AD licenses. However, depending on the features supported by the Azure
AD license, FortiCASB will only integrate features available to that license. For example, a free Azure AD
license does not include sign-in activity report, thus FortiCASB cannot provide sign-in activities from the free
Azure AD account.

Follow each section below to help you setup the Azure Subscription, Roles, and configure the Blob Storage in
preparation to add the Azure Subscription to FortiCASB:

Setup Azure Subscription on page 70

Add Reader role to the Subscription on page 71

Add Reader roles to multiple subscriptions simultaneously (optional) on page 72

Collect Subscription and Tenant IDs on page 74

Setup Blob Storage on page 75

Enable Blob Log Monitoring on page 76

Setup Storage Blob Data Reader on page 77

© N R~ WODN=

Add Azure Storage Account on page 78
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Setup Azure Subscription

Once you have your Azure license ready, you will need a subscription ID to use FortiCASB. If you do not have a
subscription yet, please follow these steps:

1. Log into the Azure Portal using your Azure account.
2. Search and click on Subscriptions.
3. Click on +Add button to add a subscription.

Home > Subscriptions

Subscriptions

fortinet
=+ ~dd

Showing subscriptions in fortinet. Don't see a subscription? Switch directories
My role @
| 8 selected

Apply
Show only subscriptions selected in the global subscriptions filter @

| /O |Ssc.rch to filter items...

SUEBSCRIPTIOM SUBSCRIPTION ID

You don't have any subscriptions

4. Select the subscription desired and complete the rest of the billing steps.

Add subscription SELECT AN OFFER

Microsoft Azure

Free Trial
Full access to all services,
Explore any service that you want.

© Learn more

B

Pay-As-You-Go

i

This fiexible pay-as-you-ge plan invalves ne up-front costs, and na long term commitment, You pay enly for the
resources that you use.

@ Leam mere

Developer support
Purchase Developer support, appropriate for individuals or companies using Azure in a non-production
environment or for evaluation. Includes reactive technical support only during business hours.

@ Learn more

Professional Direct support
Purchase Professional Direct support, ideal for companies with substantial business critical dependence on Azure.
Includes faster initial response for technical issues, escalation management and account management.

@ Learn more

Standard support
Purchase Standard support, appropriate for companies with business critical dependence on Azure. Includes
reactive 24 x 7 technical support, fast initial response and ability to set severity of issues.

© Learn more

Azure in Open

oMo No

Purchase Microsaft Azure services from your Partner, using Microsoft's Open Volume Licensing program.
~

Note: You will need a minimum of "Pay-As-You-Go" subscription to use FortiCASB.
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Add Reader role to the Subscription

Add a Reader role to the Subscription that is going to be added FortiCASB. The purpose is to provide
FortiCASB with read access to the resources under the Subscription.

1. Search and click on Subscriptions.
2. Click on the Subscription that is going to be used on FortiCASB.
3. Inthe Subscription menu, click on Access control (IAM).

Microsoft Azure [[#] sesreh resources, services, and docs (6= ] B Q0 § 7 @ bnwortin@binfor. 0
» Home > Sub: ti > P s- - Access control (IAM)
+ Subscriptions « X PR As-You-Go - Access control (IAM) X
+ Add [ + Add Fz Edit columns () Refresh | X Remove l(? Got feedback?
Showing subscriptions in Fortinet. Don't see a P 1
= | e " Check access | Role Deny Classic Roles
*
@ Check access
= v Review the level of access a user, group, sevice principal, or Add a role assignment
) managed identity has to this resource. Learn more o
{V]  Grant access to resources at tis scope by
b of 5 subscriptions [ global ¢ Diagnose and solve problems Find @ assigning a role to a user, group, service
ubscripti in th . . rincipal, or managed identit
. subscriptions selected in the O security Azu ser, group, or service principal v \ princip ged Y.
ter ©
- Events Search by name or email address ]
Learn more 7
@ Subscription na... ™y Subscription ID ™ Cost Management
5 Access to Azure Acti..  e6925159-56b4-42fe & Cost analysis ) View role assignments
@ department! Sefded 1 ‘ View the users, groups, service principals
department2 and managed identities that have role
° @ Advisor recommendations assignments granting them access at this
o first subscription 15e8224-790¢-48c! scope.
Billing
] Pay-As-You-Go a 46 Leam more 7
Invoices e mere
(S - . N
¢ View deny assignments
5 Payment methods
2 ) Q  view the users, groups.service prncipals
AR Partner information and managed identities that have been
® denied access to specific actions at this
— Settings scope.
p & Programmatic deployment
? Breg olo View Learn more
(4 Resource gr
o Resource groups

4. Click on +Add and select Add role assignment.
In Add role assignment drop down menu, click on Select a role and select Reader.

o

6. Leave Assign access to as User, group, or service principal.
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Add role assignment X

Assign access to (0

‘ Azure AD user. group. or service principal v ‘
Select @
‘ Search by name or email address |

.

Selected members:
MNo members selected. Search for and add one or more
members you want to assign to the role for this resource.

Learn more about RBAC

7. In Select field, search and select a member (user account) that will be associated with the role.

Ay
‘Q' The member (user account) should have a Global Administrator role or Cloud
|| Application Administrator + Global Reader roles.

8. Click Save to finish creating the Reader role.

Add Reader roles to multiple subscriptions simultaneously (optional)

To add multiple subscriptions to FortiCASB with one user account simultaneously, follow these steps to
configure the subscriptions with read access. If the user account has Global Administrator role, only do step

6-9.

1. Login to Azure portal as the master account user.

2. Inthe search field, search and click on "users".

3. Click on the user that will be used when adding the Subscriptions to FortiCASB.
4. Inthe middle Profile navigation menu, click on Assigned roles.
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5. Click +Add assignments to add Global reader role and Global Administrator role to the user.
(Global Administrator role will be removed later)

- Assigned roles

© o N O

e Assigned roles

K Diagnose and salve problems

Manage

2 Groups

B Applications

X
D & back
. {o Azure AD and other Microsof sevices. Learn m
ol . Descrption N ResouceType N Type "N
0] s Global dministrator c suitn
O] e Globalreader Can read everybing that a global administrator can, but not update anything, Organization saiin

Log out of the master account user, and log back in as the user whom the new roles are assigned to.

Search and click on "Azure Active Directory".

In the middle Azure Active Directory navigation menu, click on Properties.

Click Yes under Access management for Azure resources, and click Save. This step allows the user
to manage access of all Subscriptions under the Azure account.

Home > Properties

. - Properties

re Active Directory

Hi Enterprise applications

W Devices
8, App registrations
fZ] Identity Governance
" Application proxy
4 Licenses
b Azure AD Connect
&= Custom domain names
@ Mobility (MDM and MAM)
Password reset
M Company branding
€82 User settings
Notifications settings
@ Security
Monitoring
D Ssign-ins
& Auditiogs
M Provisioning logs (Preview)
® Logs

& Diagnostic settings

Directory properties
Name *

Country or region

United States

Location
United States datacenters

Notification language

[ Engish v

Directory ID
| [ 0]

Technical contact

Global privacy contact

Privacy statement URL

Access management for Azure resources

Bin Xu (binxufortinet@binxufortinet.onmicrosoft.com) can manage access to all Azure subscriptions and management
groups in this directory. Learn more

[[  Yes No )

Wianage secunty deraults

10. Log out of the user account, and log back in as the master account.

11. Follow the steps 2-4 above, and remove the Global administrator role.

Now all the Subscriptions under the user account have Reader role, and you can add multiple Azure
Subscriptions at the same time.
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Collect Subscription and Tenant IDs

ID.

View Subscription ID

To view your subscription ID after you have setup subscription, please follow these steps:

1.
2.

From the portal page, search and click on Subscriptions.
Once Subscriptions page opens, record down the subscription ID.

Subscriptions

+ add

~ || 3selected

iptions selected in the global subscriptions filter @

SUBSCRIFTION

SUBSCRIPTION ID MY ROLE

Pay-As-You-Go Account admin

View Tenant ID

Obtain Tenant ID following the steps below:

1.

From the portal page, search and click on Azure Active Directory.

2. Clickon MANAGE > Properties.

FortiCASB 24.3.b Admin Guide
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CURRENT COST

$485.53

For Azure Authentication during installation, please find and record down Azure Subscription ID and Tenant

STATUS

@ Active
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3. Under Directory properties, you will find Tenant ID.

I|' Fortinet_Inc | Properties

Azure Active Directory

« & save X Discarc
8E External Identities
&b, Roles and administrators Tenant properties
& Administrative units Name *
Fortinet_Inc v
#5 Enterprise applications
@ Devices Country or region

United States
8 App registrations

Location
{&) Identity Governance United States datacenters
1 Application proxy Notification language
a2 Licenses | English hd |
B Azure AD Connect Tenant ID
"
&= Custom domain names | = |
2 Mobility (MDM and MAM) fechnical contact
| binxu@fortinet.com /|
Password reset
. . Global privacy contact
Il Company branding privacy
| /]
&F User settings
mn Privacy statement URL
il! Properties
| /]
. Security
Monitoring Access management for Azure resources

Bin Xu (binxufortinet@binxufortinet.onmicrosoft.com) can manage access to all Azure subscriptions and

D sign-i 5
:) Sign-in logs management groups in this tenant. Learn more

p \
& Provisi I ity def
M Frovisioning logs Manage Security defaults

# Log Analytics

Setup Blob Storage

An Azure storage account with blob log monitoring enabled is required to before adding the account FortiCASB.
If you do not have a storage account yet, please follow the steps below to create a storage account:

1. From the portal page, search and click on storage accounts.

2. Click +Create to create a storage account.

3. In Basics tab, under Project details, select the subscription that is linked to your subscription ID.
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Create storage account

| Basics | Advanced Tags Review + create

Azure Storage is a Microsoft-managed service providing cloud storage that is highly available, secure, dursble, scalable, and redundant,
Azure Storage includes Azure BIoI:sI(:I:Jects} Azure Data Lake Storage Gen2, Azure Files, Azure Queues, and Azure Tables. The cost of
your storage account depends on the usage and the options you choose below. Learn more

PROJECT DETAILS

Select the subscription to manage deployed resources and costs. Use resource groups like folders to organize and manage all your
resources,

* Subscription Pay-As-You-Go ha

roup autotest-nsggroup >

INSTANCE DETAILS

The default deployment model is Re:
deployment model instead. Choose ¢

rce Manager,
assic deploy

ich supports the latest Azure features. You may choose to deploy using the classic
t model

* Storage account name @

* Location West US i
Performance @ 'é' Standard ‘i' Premium

Account kind @ StorageV'2 (general purpose v2) v
Replication @ Read-access geo-redundant storage (RA-GRS) ~

Access tier (default) @ () Cool (@) Hot

4. In Resource group field, select a resource group based on your preference or create a new one.
5. InlInstance details > Storage account name field , enter an account name based on your preference.
6. Click Review + create. Once validation passed, click Create.

Enable Blob Log Monitoring

Once storage account is created, now you can enable blob log monitoring:

1. Select the storage account created earlier.
2. Inthe middle pane, scroll down to Monitoring (classic) and click on Diagnostic settings (classic).
3. Turn On diagnostic logs. In Blob properties tab, under Logging, select Read/Write/Delete.
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4. Click Save to finish the configuration.

Storage accounts « 2 X

= add  EE Edit columns -+ More

NAME

3 autotestnsggroupdiag
3 forticash

o forticasbdiag

5 forticasbdiagd46

3 forticasbresearch

S forticasbtest0220

3 michelleh

3 productiontest

xusj

-

BIODS

icasbtest0220 -

Custom domain

W Soft delete

& Azure CON

Add Azure Search

&l Lifecycle Management (previ...

File service
Files
Table service
0 Tables
Queue service
Wl Queues
Menitoring
Alerts

il Metrics

@ Advisor recommendations

Monitoring (classic)

Alerts (classic)

L

iiii Metrics (classic)

il Usage (classic)

Cuvmnnrs + trmssblachansinn

Diagnostic logs (classic)

“  Hseve ¥opiscard O Refresh

Blob properties  File properties  Table properties

Hour metrics
/| Enable
V| Include API metrics

|v/| Delete data

atter (O 7 | cays

Minute metrics

Enable

E Diagnostic logs (classic)

Setup Storage Blob Data Reader

The last step is to grant Storage Blob Data Reader permission to the Azure AD user. This is a necessary step
for FortiCASB DLP Data Analysis and virus scan to read and analyze the data stored in the Storage Blob

account as well as integrating Azure cloud traffic in FortiCASB.

o0k~ ODdN-=
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From the Azure portal page, search and click Subscriptions.
Select your subscription.
Select Access Control (IAM), and click +Add, then Add role assignment pane will pop-up.
In Role field, type and select Storage Blob Data Reader.
In Assign access to field, leave it as User, group, or service principal.

In Select field, type and select the name or e-mail address of the Azure AD user.

Queue properties
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ntrol (IAM) Add role assignment

Fb\ Pay-As-You-Go - Access control (IAM)

Role @
“ + Add  ==Editcolumns () Refres ] Remove QD Got feedback? \ Storage Blob Data Reader v |
Assign access to ()
© Overview Check access  Role Deny assignmer Classic i Roles ‘ ‘Azure AD user, group, or sevice principal - ‘
B Activity log .
clec
f. Access control (JAM) Check access i Feareh by name o
Review the level of access a user, group, service principal, or ®  Addarole assignment
# Diagnose and solve problems managed identity has to this resource. Learn more of r
. Grant access to resources at this scope by . 1231production
@ Security Find O assigning a role to 3 user, group, service
Events [ zure AD user, group, or senvice princizal v principal, or managed identiy. poes
]
Cost Management [Lsearen oy name or emat acerese ] m Learn mere of
4 Cost analysis . =
© Budgets . View role assignments AAD DC Administrators
o
@ Advisor recommendations -“ View the users, groups, service principals
and managed identities that have role ° achow-ad-admin
3illing assignments granting them access at this
scope.
| . achow-adfs-admin
nvoices R
Learn mere '
4 External services -
A Admin -
B Payment methods
@  View deny assignments Selected members:
Ba. Partner information % No mermbers selected. Search for and add one or more
E s members you want to assign to the role for this resource.

Settings
Learn more about RBAC

3 Programmatic deployment

4 Resource groups Learn more off

7. Click Save to complete granting the role to the Azure AD user.

Add Azure Storage Account

Once you have all the Azure Storage Configurations, you can add Azure Storage account on FortiCASB
following these following steps:

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard, click on Add New, select Azure Storage, then click Add Selected
Cloud App.

Google Workspace IJ Office 365 aws

including including

L’) “‘*ﬁ ! AWS 53

A box 4 e Y

Azure Storage Box Confluence Dropbox Egnyte
3. Review the key configurations list to see if you have finish all the required configurations, then click Next.
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4. Enter your subscription ID you saved earlier in Subscription ID field.

Add Azure Storage Account

° Finish Configurations @Azure e Fill in Account Info

Subscription Id

5. Click Add Azure Storage Account.

Update Azure Storage Account

Before updating the Azure Storage account on FortiCASB, complete the same Azure Storage Configurations.

Setup Azure Subscription on page 70

Add Reader role to the Subscription on page 71

Add Reader roles to multiple subscriptions simultaneously (optional) on page 72
Collect Subscription and Tenant IDs on page 74

Setup Blob Storage on page 75

Enable Blob Log Monitoring on page 76

No a ks~ obd-=

Setup Storage Blob Data Reader on page 77

Once you finish all the Azure Storage Configurations, follow these stesp to update the Azure Storage account.

1. In FortiCASB, go to Overview > Dashboard.
2. Click on Azure Storage Account menu and select Update Cloud Account.
3. Review the key configurations list to see if you have finish all the required configurations, then click Next.
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Finish Configurations @Azure @& Fillin Account Info & Dpone

To successfully add your Azure cloud account, please do the following at Azure Portal and refer to
the step-by-step tutorial:

Here is a summary of key configurations that need to be accomplished:

1. The Azure account must have a Global Administrator, Application Administrator + Global Reader,

or Cloud Application Administrator + Global Reader roles.

2. Enable Blob Log monitoring for the Storage Account. (This allows FortiCASB to monitor activity in
the storage account.)

3. Assign Role (Reader, Owner, or User Access Administrator) to Azure AD Account Subscription.

4. Give the Azure AD user the permission to access Storage Blob Data Reader.

Please make sure you've finished all configurations above before clicking Next button below.

4. Enter your subscription ID you saved earlier in Subscription ID field.

Add Azure Storage Account

Finish Configurations @Azure Fill in Account Info &P Done

Subscription ID

Add Azure Storage Account

5. Click Update Azure Storage Account.
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Box

FortiCASB offers an API-based approach, pulling data directly from Box via RESTful API. Then FortiCASB
portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently, FortiCASB
combines these data to monitor and track Box user activities, provides DLP Data Analysis for files stored on
Box.

Prerequisites

To use API access, your organization must be using one of the following editions (the API is enabled by
default):

« Business Edition

« Enterprise Edition

« Developer Edition

The user account installed in FortiCASB must have the following permissions:
« Read and write all files and folders stored in Box
« Manage users
« Manage groups
« Manage enterprise properties

You may either use an existing account or create a new account. If you create a new account, wait at least 24
hours for the new account to take effect before granting access to FortiCASB.

The following features require "Admin User" permission as well:
« Userlogin tracking
« User IP address tracking
ﬂ « Geographical location tracking
I « User password change tracking
« Change admin role tracking

Without "Admin User" permissions, FortiCASB cannot obtain user login IPs. Therefore,
any user activity will not appear on the Activity map.

After you have verified the account prerequisite, follow the guides below to Add or Update the account on
FortiCASB:

Add Box Account on page 83
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Update Box Account on page 85
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Add Box Account

1. Loginto FortiCASB with your account.
2. Goto Overview > Dashboard, click on Add New, select Box, then click Add Selected Cloud App.

Business Unit Overview

BUName QATest BUID 330239 #of Cloud App 16
] Office 365 Google Workspace
including including
% ad s &9
LS s » - i -
> |
L= X O 2
Dropbax Egnyte GitHub GCP Storage
- » @gmail.com
-
Q 4 +
Webex Teams Zendesk Add New
- L

Select Cloud Appto Add

Google Workspace 1] office 365 aws

including including
L) L LY 1 B3

box S} & 2
x ] (9] ) <
Egnyte epls GitHub GCP Storage
&> Sand Q
Salesforce  SAPIAS 5 N¢ Vebex Teams

3. Click Grant Access @Box to authenticate the account
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Add Box Account

o Finish Configurations @Box 2  Done

To successfully add your Box Teams account, please do the following at Box Teams and refer to the
step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The Box account must be Business, Business Plus, Enterprise, Enterprise Plus plan or Developer
account.

2. The Box account must be Admin.

Please make sure you've finished all configurations above before clicking Grant Access @Box button
below.

Grant Access @Box Cancel

4. You will be navigated to the Box website for authentication. Log in to authenticate.

=

Log in to grant access to Box

B4 Email Address

E Password

Use Single Sign On (SSO)

Forgot password

By granting QA forticasb access to Box, you are agreeing to Box's Terms of Senvice and Privacy Policy

Box will prompt you to allow or deny access.
5. Click Allow to grant FortiCASB permissions to monitor your Box application.
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After you click Allow, you will be redirected back to the FortiCASB dashboard.

You can check the installation checklist and monitoring status in the Box dashboard.

\ﬂ For more information on common installation issues, see Troubleshooting on page
I 531.

Update Box Account

1. Loginto FortiCASB with your account.

2. Goto Overview > Dashboard,
3. Click on the Box account menu, and select Update Cloud Account.

tpx Update Cloud Account

View Account Detail

Box

¢ View Change History

Delete Account

4. Click Grant Access @Box to re-authenticate the account.
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Update Box Account

o Finish Configurations @Box 2 | Done

To successfully update your Box Teams account, please do the following at Box Teams and refer to the
step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The Box account must be Business, Business Plus, Enterprise, Enterprise Plus plan or Developer
account.

2. The Box account must be Admin.

Please make sure you've finished all configurations above before clicking Grant Access @Box button
below.

Grant Access @Box Cancel

5. You will be navigated to the Box website for authentication. Log in to authenticate.

=

Log in to grant access to Box

B4 Email Address

E Password

Use Single Sign On (SSO)

Forgot password

By granting QA forticasb access to Box, you are agreeing to Box's Terms of Senvice and Privacy Policy

Box will prompt you to allow or deny access.
6. Click Allow to grant FortiCASB permissions to monitor your Box application.
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After you click Allow, you will be redirected back to the FortiCASB dashboard.

You can check the installation checklist and SaaS platform monitoring status in the Box dashboard.

\ﬂ For more information on common installation issues, see Troubleshooting on page
I 531.

Citrix ShareFile

FortiCASB offers an API-based approach, pulling data directly from Citrix ShareFile via RESTful API. Then
FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently,
FortiCASB combines these data to monitor and track Citrix ShareFile user activities, provides DLP Data
Analysis for files stored on Citrix ShareFile.

Follow the guides below to add or update the account on FortiCASB:
Add Citrix ShareFile Account on page 87

Update Citrix ShareFile Account on page 90

Add Citrix ShareFile Account

Follow these steps to add the Citrix ShareFile on FortiCASB:

1. Log into Citrix ShareFile with your account.
2. Inthe left navigation menu, click People drop down menu and then select Browse Employees.
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¥s ShareFile

Dashboard

Browse Employees
Folders >

A 5 of 5 employee licenses used. Request Plan

Changes

Inbox >

\"A B CDEFGHI JKLMNOPQRSTU

People v .

Q. search Employees
Manage Users Home

Browse Employees

MName &
Browse Clients
Shared Address Book i
Personal Address Book UA
Distribution Groups
QF

Resend Welcome Emails

F integration, forticasbX R

Settings > Administrator
SZ

3. In Browse Employees, click on the user with administrator privilege to be added on FortiCASB.

4. Scroll down to Employee User Settings, click and expand User Access section, check Select All to
include all permissions.

Employee User Settings
User Access v

nissions, please refer to the Support Knowledge Center

General

B Access company account permissions (B

Files and Folder

5. Scroll down more and click Save Changes to save the configurations.

6. Now go back to FortiCASB, go to Overview > Dashboard, click on Add New, select Citrix ShareFile,
then click Add Selected Cloud App.
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Business Unit Overview

BU MName QA Test BUID 330239 #of Cloud App 14

Google Workspace

] Office 365
including including
o B e

B ¥ v} 2

GCP Storage

Drophax Eznyte GitHub
. ® @zmail.com
wss ses
-
Q 4 +
Webex Teams Zendesk Add New
. . h .
Select Cloud Appto Add *
Google Workspace 1] Office 365 aws

including

Awss3

including
[ %]

&
A box S} 4 33
Azure Storage Box Citrix ShareFile Confluence Dropbox

X @ (%) a) A2

Egnyte Workplace GitHub GCP Storage:

i Q
4 zoom
Zendesk Zoom
Cancel

7. Enterthe ShareFile Subdomain you will use for FortiCASB: e.g. https://SUBDOMAIN.sharefile.com.
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2. IMPORTANT: Make sure the user you'll use for FortiCASB is same as the user you currently log into
ShareFile. If different, please log out before you click Next button below.

ShareFile Domain

3. Enter the ShareFile Subdomain you will use for FortiCASB: eg. https://SUBDOMAIN.sharefile.com.

Please make sure you've finished all configurations above before clicking Grant Access@ShareFile
button below.

Grant Access @ShareFile Cancel

Important: Make sure the user your are adding to FortiCASB is the same user you are currently logged
into SharefFile. If different, please log out and log back in with the right user.

8. Click Grant Access@ShareFile to add the ShareFile account. You will be re-directed to ShareFlle OAuth
page for validation.

9. Enter your ShareFile domain and credentials to sign in to complete the validation.

S
ShareFile

Enter your account’s subdomain to continue. For &)
account's URL is “mycompany.sharefile.com”, yor
“mycompany”.

kg, mycompany

citrix.

The add account process may take 15 minutes to complete. You may check the status in Overview >
Dashboard.

Update Citrix ShareFile Account

Follow these steps to update the Citrix ShareFile on FortiCASB:
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1. Log into Citrix ShareFile with your account.
2. Inthe left navigation menu, click People drop down menu and then select Browse Employees.

¥s ShareFile

Dashboard
Browse Employees
Folders >
A 5 of 5 employee licenses used. Request Plan
Changes
Inbox >
Blrs8cpopeEFGHI UKLMNOPQRS T U
People v

Q search Employees
Manage Users Home

Browse Employees

Marmes &
Browse Clients
Shared Address Book i
Personal Address Book UA
Distribution Groups
QF

Resend Welcome Emails

Fi integration, forticasbX R

Settings s Administrator
8z

3. In Browse Employees, click on the user with administrator privilege to be added on FortiCASB.

4. Scroll down to Employee User Settings, click and expand User Access section, check Select All to
include all permissions.

Employee User Settings
User Access

pecific permissions, please refer to the Support Knowledge Center

General

B Access company account permissions &

Files and Folder

5. Scroll down more and click Save Changes to save the configurations.
6. Now go back to FortiCASB, go to Overview > Dashboard
7. Click on the Citrix ShareFile account menu, and select Update Cloud Account.
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@ Update Cloud Account

Citrix ShareFile View Account Detail

[ ] 1

View Change History

Delete Account

8. Enter the ShareFile Subdomain you will use for FortiCASB: e.g. https://SUBDOMAIN.sharefile.com.

2. IMPORTANT: Make sure the user you'll use for FortiCASB is same as the user you currently log into
ShareFile. If different, please log out before you click Next button below.

ShareFile Domain

3. Enter the ShareFile Subdomain you will use for FortiCASB: eg. https://SUBDOMAIN.sharefile.com.

Please make sure you've finished all configurations above before clicking Grant Access@ShareFile
button below.

Grant Access @ShareFile Cancel

Important. Make sure the user your are adding to FortiCASB is the same user you are currently logged
into ShareFile. If different, please log out and log back in with the right user.

9. Click Grant Access@ShareFile to add the ShareFile account. You will be re-directed to ShareFlle OAuth

page for validation.
10. Enter your ShareFile domain and credentials to sign in to complete the validation.
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S
ShareFile

t's URL is "mycompany. e
“mycompany”.

kg, mycompany

cifrix
The add account process may take 15 minutes to complete. You may check the status in Overview >
Dashboard.
Confluence

FortiCASB offers an API-based approach, pulling data directly from Confluence via RESTful API. Then
FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently,
FortiCASB combines these data to monitor and track Confluence user activities, provides DLP Data Analysis.

Before adding the Confluence account to FortiCASB, configure the Confluence account to grant FortiCASB
read access permission to monitor account activities and provide other security measures on the account. Make
sure the Confluence account that will be added on FortiCASB is the same account that is configured.

Prerequisite

e The Confluence plan must be Standard, Premium or Enterprise. Free plan is NOT supported.

« The account must be the Organization and Site Admin of the Confluence site you will use on
FortiCASB.

Add Confluence account to FortiCASB:

1. Install Webhook on Confluence on page 97
2. Confluence Account Configuration on page 94
3. Add Confluence Account on page 99
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Confluence Account Configuration

Follow the instructions below to create and configure an App on Confluence:

1. Login to Atlassian Developer Console as the Organization and Site Admin.
2. Click Create App drop down menu and select OAuth 2.0 integration.

(i} Create ~

Forge app

OAuth 2.0 integration

Updated on Type

3/6/2023 10:01:48 AM OAuth 2.0

3. Fillinan App name, agree to Atllassian's developer terms, and click Create.
4. Inthe left navigation menu, click Permission.
5. In APl name, find Confluence API, then click Add.

Console / Myapps / Test_confluence /

Permissions

Add and configure your app’s APl scopes. See OAuth 2.0 (3LO) for apps.

APl name Action

Confluence API .
Get, create, update, and delete content, spaces, and more, Configure

User REST API

Get user details, such as the Atlassian Account Id.

Add

Jira platform REST API

Get, create, update, and delete issues, projects, fields, and more, Add

Jira Service Desk API

Work with Jira Service Desk-specific entities, such as requests, Add
Personal data reporting API

Report user accounts that an app is storing personal data for. Add

User identity API .

Get the profile details for the currently logged-in user, such as the Atlassian account ID and email. Configure

When the Add button turns into Configure, click Configure.
6. In Classic scopes tab, click Edit Scopes to add scopes for the Confluence API.
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Classic scopes Granular scopes

Select . Scope Name Code

Wrte Cno ne -
Write Confluence conte )
. . write:confluence-content

Manage Confluence space details

o write:confluence-zpace
""" space information

7. Select the following scopes and click Save.
+ Read Confluence space summary
« Read Confluence content properties
« Read Confluence detailed content
o Read Confluence content summary
« Read content permissions in Confluence
« Read user
o Read user groups
« Download content attachments
8. Click the Granular scopes tab, then click Edit Scopes to add granular scopes.

Classic scopes | Granular scopes

Q Search by name or code All operations v All entities

read:confluence-space.summary

Edit Scopes

Hide unselected scopes

Edit Scopes

Select  Scope Name Code

View detailed contents
5, including pages, blogposts, comments and read:content:confluence

write: content: confluence

9. Select the following scopes and click Save.
+ View audit records
+ View and download content attachments
o View user details

10. In the left navigation menu, click Permissions again, find User Identity API, then click Add.
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APl name Scopes used Action

User identity API

Gett ofile details for the currently logged-in user, such as the Atlassian account ID 1 Config... Documentation

ap  Confluence API )

ol Get, create, update, and delete content, spaces, and more. 1 Conﬁg"‘ Documentation
Brie API

A Brie AP 0 Add Documentation

] Jira API

~ 0 Add Documentation

Get, create, update, and delete issues, projects, fields, and more

A Personal data reporting API
Report user accounts that an app is storing personal data for. 0 Add Documentation

When the Add button turns to Configure, click Configure.
11. Click Edit Scopes to add the following scopes and click Save.
« View active user profile
o View user profiles
12. Go back to the navigation menu, click Authorization.
13. In Authorization type > OAuth 2.0 (3L0O), click Add.

Authorization type Action

OAuth 2.0 (3LO)

Allows your app to access APIs for Atlassian products and services on a user's behalf. Add

14. Inthe Callback URL, enter the callback URL provided by FortiCASB, then click Save Changes to save
the settings.

4. Navigate to Authorization using the left menu.
a. Find OAuth 2.0 (3LO), click Configure.
b. Fill in the Callback URL field with the url below, then click Save changes.

Callback URL:

https://www.forticasb.com/api/v1/oauth/redirect/Confluence B

15. In the left navigation menu, click Settings, then scroll down to Authentication details, make a note of
the Client ID and Secret for later in FortiCASB authentication.
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Authentication details
Use the Client ID and Secret for authentication, See the QAuth 2.0 (3LQ) guide to learn maor
Client ID
D
Secret
................................................................ H 0

Delete app

Please make sure the Confluence account that will be added on FortiCASB is the same
account that is configured.

Install Webhook on Confluence

Webhook are automated messages sent from Confluence to FortiCASB. They are much faster than API calls
and are sent automatically when targeted Confluence events are triggered.

Before Confluence can be added on FortiCASB, Webhook needs to be installed on Confluence to enable the
process.

Follow the installation guide to install Webhook on Confluence.

1. Log into your Confluence site using the Organization and Site Admin account.
2. Inthe main menu, select Find new apps.
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it & Confluence

New features
Notifications NEW
Shortcut links

Global templates and ...
PDF export language s...

Configure code macro

SECURITY
LOOK AND FEEL
DATA MANAGEMENT

ATLASSIAN MARKETPLACE

Find new apps

Manage apps

Company hub  Home

e Bl

0 Managir

Adminit:

Learn m

You can install, uf

Filter visible af

User-install

> &, Webho

Audit log s

The Universal Plugir

3. Select Webhook Manager for Confluence Cloud and install Webhook on Confluence.

& Confluence / Marketplace apps ¢ Feedback

Discover apps and integrations for Confluence

webhook ‘ Sort v [ Free for all teams ~ More Filters v Categories v

3 results

A,

Webhook Manager for Confluence Cloud
&

Integrate your Confluence with hundreds of
external applications with configurable
webhooks

Admin tools, Integrations, Messaging, Utilities

2/4 w*ir

o CLOUD SECURITY PARTICIPANT
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Slack for Confluence - Chat, Notification,
Questions

Slack integration for Confluence. Send Slack
chat natifications for changes in Confluence.
Highly customizable and fast

ntegrations, Messaging, Utilities, Workflow

3.4/4 k 523 installs

u CLOUD FORTIFIED

Page View Analytics for Confluence Cloud

Get JSM knowledge base user engagement
reports, page view and user interaction
tracking analytics report in Confluence

Charts & diagramming, Documentation, Reports, Uti..

3.7/4 r 3 358 installs

u CLOUD FORTIFIED
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Continue to Add Confluence Account on page 99to add Confluence on FortiCASB.

Add Confluence Account

After Confluence Account Configuration on page 94 and Install Webhook on Confluence on page 97
are completed, follow the steps below to create a Confluence Webhook and add Confluence account on
FortiCASB.

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard, click on Add New, select Confluence, then click Add Selected Cloud
App.
Business Unit Overview

BUName QATest BUID 330239 #of Cloud App 16

] Office 365 Google Workspace
ncluding ncluding

e =

.

Dropbax Egnyte GitHub

. « @gmail.com

Add New

3. Scroll down to fill in the Confluence Site Domain name which the Confluence account associates with,
the Client ID and Client Secret recorded down from Confluence Account Configuration. Your
Confluence site domain name is the site domain prefix.

For example: for https://mydomain.atlassian.net/, the Confluence site domain name is "mydomain”.
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5.Navigate to Settings in the left menu. Scroll down to Authentication Details, find
Client ID and Secret. Fill the account information in the fields below.

Confluence Site Domain #

You can find your Confluence Site Domain in the site URL https:/fadmin.atlassian.com/

Client ID #

Secret +

Next Step Cancel

4. Click Next Step to continue.
5. In Add Confluence Account page 2, click the Confluence link to be re-directed to Atlassian main page.

Add Confluence Account

° Finish Configurations @Confluence e Fill in Account Info 3  Done

1. Log into Confluence with the same site admin account used in the last step.
a. Click the Apps at the top navigation. Select Manage apps from the dropdown.

b. In the left navigation Settings, scroll down and find Webhooks under ATLASSIAN
MARKETPLACE. Click Add Webhook in the top right corner.

c. Enter a name and select Enabled under Status. In the Event types dropdown, select
any ones from this list of events supported by FortiCASE.

d. Fill the URL field with the Webhook URL below.

6. In the Atlassian main page, click the apps menu button and select Confluence.
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Buy now EEE .

) Switchto Atlassian Start [4 .
erprise ay trial

n Jira Software

Jira Service Management

a Jira Work Management

7. In Confluence main page, click Apps drop down menu and select Manage apps.

i = Confluence Home Recent~ Spaces~ People~ Templates

. o s ago
Once you or your admin installs an app, it -

appears here.

Learn more
Go to personal space s ago
. RECOMMENDED FOR YOU s
Q Overview
=0, Slack
® Recent 1 Have one place to stay up to date on the wor...
Jo
ﬁ Starred l Google Drive
Embed Goegle Drive files into any Confluence,
D Drafts Lucidchart 2 hours
¥ Draw and share diagrams easily with automat
Find new apps
fing

Manage apps

View app requests

8. Inthe left navigation menu, scroll down to select Webhooks.
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i 2 Confluence Home Recentv Spacesv Peoplev Apps~ Templates
Configure Code Macro -

Manage apps

ATLASSIAN MARKETPLACE
Find new apps You can install, update, enable, and disable apps here. Find new apps.
Manage apps Filter visible apps User-installed -
App requests

User-installed apps

Promotions

Webhooks > . Webhook Manager for Confluence Cloud
SEOURINY Audit log Settings
Users

The Universal Plugin Manager {v1000.0.0.8988a298a519%e) by Atlassian
Groups

Security Configuration

9. Click Add Webhook to create a Webhook.

Q Search * 0 O

Add Webhook
Description Actions
10. Fillin a name for the Webhook and enable the Webhook status.
11. Click Event types drop down menu and select the event types to monitor.
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Create a new webhook

Webhook name*

Status

URL

Event types
Attachment viewed ® Group created ® Space created x

User created X

Description

P

For the list of Webhook events supported by FortiCASB, please see Confluence Events on page 321.
12. Copy and paste the Webhook URL from the FortiCASB Add Confluence Page to the URL field.

Webhook URL:

[

Grant Access @Confluence Back

13. Click Grant Access @Confluence to continue.

14. You will be re-directed to Confluence OAuth validation site, click Authorize for drop down menu, and
select Confluence Site domain.
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This will allow Test_confluence to:
& Read Confluence space summary >

& Read Confluence content properties >

luence detalled content ]

tead Confluence content summary >

Make sure you trust Test_confluence

This app is in development mode, Development mode apps may pose a risk to
3l data. Only proceed if you know a
always see and remove access in your Atlassian account.

rust the developer. You can

test16fortinetatlassian.net v

15. Click Accept to finish adding the Confluence account. Then you will be re-directed back to FortiCASB.

It may take 15 minutes to finish adding the account. You may check the status in Overview >
Dashboard.

Update Confluence Account

Before updating the Confluence account on FortiCASB, complete the same Confluence Configurations:
Confluence Account Configuration on page 94
After the Confluence account is configured, go back to FortiCASB to update the Confluence account.

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard.
3. Click on Confluence Account and menu and select Update Cloud Account.
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oy Update Cloud Account
~
Confluence View Account Detail
* I " View Change History

Delete Account

4. Scroll down to fill in the Confluence Site Domain name which the Confluence account associates with,
the Client ID and Client Secret recorded down from Confluence Account Configuration. Your
Confluence site domain name is the site domain prefix.

For example: for https://mydomain.atlassian.net/, the Confluence site domain name is "mydomain".

5.Navigate to Settings in the left menu. Scroll down to Authentication Details, find
Client ID and Secret. Fill the account information in the fields below.

Confluence Site Domain #
You can find your Confluence Site Domain in the site URL https:/fadmin.atlassian.com/

Client ID =

Secret +

Next Step Cancel

5. Click Next Step to continue.
6. In Update Confluence Account page 2, click the Confluence link to be re-directed to Atlassian main
page.
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7.

8.

Update Confluence Account

° Finish Configurations @Confluence e Fill in Account Info 3  Done

1. Log into Confluence with the same site admin account used in the last step.

a. Click the Apps at the top navigation. Select Manage apps from the dropdown.

b. In the left navigation Settings, scroll down and find Webhooks under ATLASSIAN
MARKETPLACE. Click Add Webhook in the top right corner.

c. Enter a name and select Enabled under Status. In the Event types dropdown, select
any ones from this list of events supported by FortiCASB.

In the Atlassian main page, click the apps menu button and select Confluence.

Buy now EEE .

Switchto Atlassian Start 3

n Jira Software

Jira Service Management

a Jira Work Management

ay trial

erprise

In Confluence main page, click Apps drop down menu and select Manage apps.
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i & Confluence Home Recent~ Spaces~ People~ Templates m

- y s ago
Once you or your admin installs an app, it *2g
appears hera.
Go to personal space Learn more 5 ago
RECOMMENDED FOR YOU s
Q Overview
=L Slack
® Recent ' Have one place to stay up to date on the wor...
j0
ﬂ Starred l Google Drive
Embed Google Drive files into any Confluence...
D Drafts " Lucidchart ¢ hours
Draw and share diagrams easily with automat...
Find new apps
fing

Manage apps

View app requests

9. In the left navigation menu, scroll down to select Webhooks.

& Confluence
Configure Code Macro
ATLASSIAN MARKETPLACE
Find new apps

Manage apps

App requests

Promotions

Webhooks

SECURITY

Users

Groups

Security Configuration

Home Recentv Spaces~ Peoplev Apps~ Templates

-

Manage apps

You can install, update, enable, and disable apps here. Find new apps.

Filter visible apps User-installed

User-installed apps

> A Webhook Manager for Confluence Cloud

Audit log Settings

The Universal Plugin Manager {v1000.0.0.8988a98a519%¢) by Atlassian

10. Click Add Webhook to create a Webhook.
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Q. Search ® 0O O .

Add Webhook

Description Actions

11. Fill in a name for the Webhook and enable the Webhook status.
12. Click Event types drop down menu and select the event types to monitor.

Create a new webhook

Webhook name*

Status

URL

Event types
Attachment viewed ® Group created ® Space created x

User created X

Description

P

For the list of Webhook events supported by FortiCASB, please see Confluence Events on page 321.
13. Copy and paste the Webhook URL from the FortiCASB Update Confluence Page to the URL field.

Webhook URL:
®
Grant Access @Confluence Back
14. Click Grant Access @Confluence to continue.
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15. You will be re-directed to Confluence OAuth validation site, click Authorize for drop down menu, and
select Confluence Site domain.

This will allow Test_confluence to:

& Read Confluence space summary »

& Resd Conflusnce cortert properties H

nfluence detailed content H
# Read Confluence content summary >

& Read USer groups. >

Make sure you trust Test_confluence

in development mode. Development mode apps may pose a risk to
ata. Only proci if you kny rust the developer. You can
alw nd remove access in your Atlassian account.

Authorize for:

testi6fortinet.atlassian.net b

16. Click Accept to finish updating the Confluence account. Then you will be re-directed back to FortiCASB.
It may take 15 minutes to finish updating the account. You may check the status in Overview >
Dashboard.

Dropbox Business

FortiCASB offers an API-based approach, pulling data directly from Dropbox Business via RESTful API. Then
FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently,
FortiCASB combines these data to monitor and track Dropbox Business user activities, provides DLP Data
Analysis for files stored on Dropbox Business.
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Prerequisites

To use API access, your organization must be using one of the following Dropbox Business plans:

« Standard Plan
« Advanced Plan
o Enterprise Plan

The user account added on FortiCASB must have the following permission:
e« Team Admin

You may either use an existing account or create a new account.

After you have verified account prerequisite, follow the guides below to Add or Update the account on
FortiCASB:

Add Dropbox Business on page 111

Update Dropbox Business on page 113
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Add Dropbox Business

1. Loginto FortiCASB with your account.
2. Goto Overview > Dashboard, click on Add New, select Dropbox, then click Add Selected Cloud

App.

Business Unit Overview

#of Cloud App 14

BUName QATest BUID 330239
] Office 365 Google Workspace
including including
adt LR &9

.

3 Y v} a)

-

Drophax Egnyte GitHub GCP Storage
- » @gmail.com
ass sss
-
Q X +
Webex Teams Zendesk Add New
. . 4 .
Select Cloud App to Add
Google Workspace 1] Office 365 aws
including including
&0 L LT 1 B3
e
A box S] < =
AzureStorage Box Gitrix Share Dropba
X @ (v} ) 4
Egmyt Norkpl GitHub Gep storage
& & Q
Salesforce Vebex Teams

Y
N
8
(¢]
3

:::::

3. Click Grant Access @Dropbox to be re-directed to Dropbox website.
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Add Dropbox Account

o Finish Configurations @ Drophox 2  Done

To successfully add your Dropbox Teams account, please do the following at Dropbox Teams and refer
to the step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The Dropbox account must be Standard, Advanced, or Enterprise plan.

2. The Dropbox account muts have Team Admin permission.

Please make sure you've finished all configurations above before clicking Grant Access @Dropbox
button below.

Grant Access @Dropbox Cancel

4. Loginto authenticate. Dropbox will prompt you to allow or deny access.

Sign in to Dropbox to link with FortiCASB_Cnn

G Sign in with Google

ar

Forgot your password? m

5. Click Allow to grant FortiCASB permissions to monitor your Dropbox application.

After you click Allow, you will be redirected back to the FortiCASB dashboard.

You can check the installation result and SaaS platform monitoring status in the Dropbox dashboard.

ﬂ For more information on common installation issues, see Troubleshooting on

page 531
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Update Dropbox Business

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard
3. Click on Dropbox account menu, and select Update Cloud Account.

:} Update Cloud Account

Dropbox View Account Detail

View Change History

Delete Account

4. Click Grant Access @Dropbox to be re-directed to Dropbox website.
Update Dropbox Account

o Finish Configurations @Dropbox 2  Done

To successfully update your Dropbox Teams account, please do the following at Dropbox Teams and
refer to the step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The Dropbox account must be Standard, Advanced, or Enterprise plan.

2. The Dropbox account muts have Team Admin permission.

Please make sure you've finished all configurations above before clicking Grant Access @Dropbox
button below.

Grant Access @Dropbox Cancel

5. Login to authenticate. Dropbox will prompt you to allow or deny access.
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Sign in to Dropbox to link with FortiCASB_Cnn

G Sign in with Google

ar

Forgot your password? m

6. Click Allow to grant FortiCASB permissions to monitor your Dropbox application.
After you click Allow, you will be redirected back to the FortiCASB dashboard.

You can check the account checklist and platform monitoring status in the Dropbox dashboard.

\ﬂ For more information on common installation issues, see Troubleshooting on

page 531

Egnyte

FortiCASB offers an API-based approach, pulling data directly from Egnyte via RESTful APIl. Then FortiCASB
portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently, FortiCASB
combines these data to monitor and track Egnyte user activities, provides DLP Data Analysis for files stored on

Egnyte.
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Prerequisites

The Egnyte account must be an Administrator, all other roles are NOT supported.

After you have verified the prerequisites, continue to Add or Update the account:

Add Egnyte Account on page 115

Update Egnyte Account on page 117

Add Egnyte Account

Follow these steps to add Egnyte account on FortiCASB:

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard, click on Add New, select Egnyte, then click Add Selected Cloud App.

Business Unit Overview

BUName QA Test BUID 330239
] Office 365
including
&P
g . "
> |
< x
Dropbox Egnyt
.
-
Q 4
Webex Teams Zendesk
. .
Select Cloud App to Add
Google Workspace 1] Office 365
including including
a9 LY TR
A box S] X
Azurestorage Box Citrix ShareFile Confluence
¥ @ 0 o
GitHub
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.
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3. Enter the Egnyte Domain you will use on FortiCASB: e.g. https://DOMAIN.egnyte.com.

2. Enter the Egnyte Domain you will use for FortiCASB: eg. https://DOMAIN.egnyte.com.
Egnyte Domain

3. IMPORTANT: Make sure the user you'll use for FortiCASB is the same as the user you currently log
into Egnyte.

Please make sure you've finished all configurations above before clicking Grant Access@Egnyte
button below.

Important:. Make sure the user you’ll add on FortiCASB is the same user you are currently logged in on
Egnyte.

4. Click Grant Access@Egnyte.

5. You will be re-drected to Egnyte OAuth page to ask you to grant FortiCSB access to the Egnyte account.
Click Allow Access.

EGNX.TE

Forticasb File Server

forticasbnew would like to access your Egnyte
Account. This application will be able to:

After the Egnyte OAuth validation, the add account process may take 15 minutes to complete. You may
check the status in Overview > Dashboard.
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Update Egnyte Account

Follow these steps to udpate Egnyte account on FortiCASB:

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard
3. Click on theEgnyte account menu, and select Update Cloud Account.

si,' Update Cloud Account

View Account Detail
View Change History

Delete Account

4. Enter the Egnyte Domain you will use on FortiCASB: e.g. https://DOMAIN.egnyte.com.

2. Enter the Egnyte Domain you will use for FortiCASB: eg. https://DOMAIN.egnyte.com.
Egnyte Domain

3. IMPORTANT: Make sure the user you'll use for FortiCASB is the same as the user you currently log
into Egnyte.

Please make sure you've finished all configurations above before clicking Grant Access@Egnyte
button below.

Important: Make sure the user you’ll add on FortiCASB is the same user you are currently logged in on
Egnyte.
5. Click Grant Access@Egnyte.

6. You will be re-drected to Egnyte OAuth page to ask you to grant FortiCSB access to the Egnyte account.

Click Allow Access.
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EGN.TE

Forticasb File Server

forticashnew would like to access your Egnyte
Account. This application will be able to:

« View snd manage users

don't want to gi ount

After the Egnyte OAuth validation, the add account process may take 15 minutes to complete. You may
check the status in Overview > Dashboard.

Facebook Workplace

FortiCASB offers an API-based approach, pulling data directly from Facebook Workplace via RESTful API.
Then FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication.
Subsequently, FortiCASB combines these data to monitor and track Facebook Workplace user activities,
conducts DLP Data Analysis for files shared on Facebook Workplace.

Prerequisites

The Facebook Workplace plan must be Advanced or Enterprise, free plan is NOT supported.

The Facebook Workplace account to be added on FortiCASB must be the System Administrator user.

After you have verified the prerequisites, continue to Add or Update the account:
Add Facebook Workplace Account on page 119

Update Facebook Workplace Account on page 122
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Add Facebook Workplace Account

Follow these steps to configure Workplace account before adding the Workplace account on FortiCASB:

1. Loginto Facebook Workplace with the System Administrator account.
2. Navigate to Admin Panel on the left navigation bar and click Integrations.

@ Q, Search Workplace Add a logo
Admin Panel
Q (,: Getting Started
D g What's New
[ ]
- People
S
> a
Groups
]

Reported Content

® » Settings

' Integrations
° Admins

Security

Access Requests

il 0

Payments

3. Click Create Custom Integration, fill in the Name and Description fields, then click Create.
Create Custom Integration O

Name

Description

Describe what your integration does

Use of the APl is subject to the terms of the Workplace Platform Policy

Cancel

4. Under the Integration Details, make a note of App ID and App Secret, click Create Access Token
and copy the generated token to be used later.
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App ID ©

App Secret @

Access Token ©

Create Access Token

5. Now go back to FortiCASB, go to Overview > Dashboard, click on Add New, select Workplace, then

click Add Selected Cloud App.

Business Unit Overview

BUName QA Test BUID 330239
] Office 365
including
odH
» Si— . "
- 1
- x
Dropbaox Egnyte
.
-
Q 4
Webex Teams Zendesk
. . h
Select Cloud App to Add
Google Workspace 1] Office 365
including including
&9
A box S] K
Agurestarage Bax Citrix ShareFile Confluence
X @ (%) a)
Eamyte Workplace GitHub Gep storage

4 zoom
Zendesk Zoom
Cancel
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£
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6. Click Nexton the FortiCASB Add Workplace Account page to proceed:

FacebookWorkplace / OAuth / Add ﬁ 'u E 1 o
Add Workplace Account

Finish Configurations @Workplace Fill in Account Info Done

To successfully add your Workplace account, please do the following at Workplace and refer to the step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The Workplace plan must be Advanced or Enterprise. Free plan is NOT supported.
2. The account that will be used for FortiCASB must have System Admin role.

3. Loginto Workplace and finish the following steps:
a.Navigate to Admin Panel 3¢ on the left navigation bar and click on Integrations.
b. Click on Create Custom Integration, fill in the Name and Description fields, and click Create.
c. Then, under Integration Details, click Create Access Token and write down the generated token.

d. Keep arecord of the App ID and App Secret. These are needed in next step.

Please make sure you've finished all configurations above before clicking Next button below.

- =

7. Enterthe App ID, App Secret, and Access Token, and click Add Workplace Account.
Add Workplace Account

o Finish Configurations @Workplace e Fill in Account Info 3 ' Done

AppID

App Secret

Access Token

The add account process may take 15 minutes to complete. You may check the status in Overview >
Dashboard.
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Update Facebook Workplace Account

Follow these steps to configure Workplace account before updating the Workplace account on FortiCASB:

1. Loginto Facebook Workplace with the System Administrator account.
2. Navigate to Admin Panel on the left navigation bar and click Integrations.

@ Q, Search Workplace Add a logo
Admin Panel
Q l/: Getting Started
D O What's New
[ ]
People
-
S
L)
E Groups
U

Reported Content

® > Settings

o Admins

Security

Access Requests

il 2

Payments

3. Click Create Custom Integration, fill in the Name and Description fields, then click Create.
Create Custom Integration ]

Name

Description

Describe what your integration does

Use of the APl is subject to the terms of the Workplace Platform Palicy

Cancel

4. Under the Integration Details, make a note of App ID and App Secret, click Create Access Token
and copy the generated token to be used later.

App ID &

App Secret ©

Show
Access Token ©
Create Access Token
5. Now go back to FortiCASB, go to Overview > Dashboard.
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6. Click on the Workplace account menu, and select Update Cloud Account.
7. Click Next on the FortiCASB Update Workplace Account page to proceed:

8. Enterthe App ID, App Secret, and Access Token, and click Add Workplace Account.

The add account process may take 15 minutes to complete. You may check the status in Overview >

Update Workplace Account

o Finish Configurations @Workplace 2 | Fillin Account Info 3 | Done

To successfully update your Workplace account, please do the following at Workplace and refer to the
step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The Workplace plan must be Advanced or Enterprise. Free planis NOT supported.
2. The account that will be used for FortiCASB must have System Admin role.
3. Log into Workplace and finish the following steps:
a. Navigate to Admin Panel & on the left navigation bar and click on Integrations.
b. Click on Create Custom Integration, fill in the Name and Description fields, and click Create.
c. Then, under Integration Details, click Create Access Token and write down the generated token.

d. Keep a record of the App ID and App Secret. These are needed in next step.

Please make sure you've finished all configurations above before clicking Next button below.

Add Workplace Account

° Finish Configurations @Workplace o Fill in Account Info 3  Done

App ID
App Secret

Access Token

Dashboard.
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Github

FortiCASB offers an API-based approach, pulling data directly from Github via RESTful API. Then FortiCASB
portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently, FortiCASB
combines these data to monitor and track Github user activities, provides DLP Data Analysis for files stored on
Github.

Prerequisites

The GitHub account must be one of these organization plans: Free , Team, or Enterprise. (Personal User
account is NOT supported)

The GitHub account to be added to FortiCASB must be the Organization Owner, all other roles are not
supported.

After you have verified the prerequisites, continue to Add or Update the account:
Add GitHub Account on page 124

Update GitHub Account on page 127

Add GitHub Account

Follow the steps below to update GitHub account on FortiCASB:

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard,
3. clickon Add New, select GitHub, then click Add Selected Cloud App.

FortiCASB 24.3.b Admin Guide 124
Fortinet Inc.



Cloud Application Onboarding

Overview / Dashboard

Business Unit Overview

BUName testassign BUID 480756 #of Cloud App 1

] Office 365 +

including

poadd > Add New

® ga@casbgal.onmicrosoft.com

4. Verify that the your Github account fulfills the requirement and click Next Step.

Here is a summary of key configurations that need to be completed:

1. All GitHub Organization plans: Free, Team, Enterprise are supported. Personal User Account is NOT
supported.

2. The account you will use for FortiCASB must the Owner of the GitHub Organization. All other roles
are NOT supported.

Please make sure you have finished all configurations above before clicking the Next Step button
below.

Next Step Cancel

5. Fillin GitHub Organization Name and Username or e-mail address of the account, then click Grant
Access@GitHub.
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Add GitHub Account

° Finish Configurations @GitHub e Fill in Account Info 3  Done

GitHub Organization Name

Username or email address

6. You will be redirected to GitHub OAuth page with request to authorize FortiCASB access to the
Organization.

7. In Organization Access,
a. Click Grant to grant the user to access the organization, then
b. Click Authorize (username) to authorize the request. Then you will be re-direct back to FortiCASB.

Authorize Forticash-eu

Forticash-eu by testadmin2
wants to access your xiemFortinet account

Repository webhooks and services
Admin access

Organizations and teams
Read-only access

il

Repositories

il

v
Public and private

R Personal user data o
Full access

Organization access

£a x Grant

Cancel Authorize testadmin2

Authorizing Wil redirect to
https:/feu forticasb.com

(@) Not owned or (© Ccreated [ Fewer than10
operated by GitHub 5 months ago GitHub users
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The add account process is completed, please wait 15 minutes and check on the status of the account.

Add GitHub Account

° Finish Configurations @GitHub ° Grant Access @GitHub ° Done

FortiCASB is adding this account. The process may take up to 15 min.
You can check whether it is successfully added in the Overview > Dashboard.

Check Status

Update GitHub Account

Follow the steps below to add GitHub account on FortiCASB:

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard,
3. Click on the GitHub account menu, and select Update Cloud Account.
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o Update Cloud Account

GitHub View Account Detail

# testadming

View Change History

Delete Account

4. Verify that the your GitHub account fulfills the requirement and click Next Step.

Here is a summary of key configurations that need to be completed:

1. All GitHub Organization plans: Free, Team, Enterprise are supported. Personal User Account is NOT
supported.

2. The account you will use for FortiCASB must the Owner of the GitHub Organization. All other roles
are NOT supported.

Please make sure you have finished all configurations above before clicking the Next Step button
below.

Next Step Cancel

5. Fillin GitHub Organization Name and Username or e-mail address of the account, then click Grant
Access@GitHub.

FortiCASB 24.3.b Admin Guide
Fortinet Inc.

128



Cloud Application Onboarding

Add GitHub Account

° Finish Configurations @GitHub e Fill in Account Info 3  Done

GitHub Organization Name

Username or email address

6. You will be redirected to GitHub OAuth page with request to authorize FortiCASB access to the
Organization.

7. In Organization Access,
a. Click Grant to grant the user to access the organization, then
b. Click Authorize (username) to authorize the request. Then you will be re-direct back to FortiCASB.

Authorize Forticash-eu

Forticash-eu by testadmin2
wants to access your xiemFortinet account

Repository webhooks and services
Admin access

Organizations and teams
Read-only access

il

Repositories

il

v
Public and private

R Personal user data o
Full access

Organization access

£a x Grant

Cancel Authorize testadmin2

Authorizing Wil redirect to
https:/feu forticasb.com

(@) Not owned or (© Ccreated [ Fewer than10
operated by GitHub 5 months ago GitHub users
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The update account process is completed, please wait 15 minutes and check on the status of the account.

Google Cloud Storage

FortiCASB offers an API-based approach, pulling data directly from Google Cloud Storage via RESTful API.
Then FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication.
Subsequently, FortiCASB combines these data to monitor and track Google Cloud Storage user activities,
conducts DLP Data Analysis for files stored on Google Cloud Storage.

Prerequisites

To use FortiCASB with Google Cloud Platform, you must have a Google Workspace account, Service
Account, and the JSON private key associated with the service account. The service account must have
"Google Workspace Domain-wide Delegation" enabled and Project Owner/Organization
Administrator roles for monitoring.

Steps to Add Google Cloud Account

Configure Google Workspace Account on page 131

Configure OAuth Consent Screen on page 132

Create Service Account on page 138

Grant Service Account APl Access on page 141

Grant Service Account Owner and Organization Administrator Role on page 143
Enable required APIs on page 145

Enable activity and alert monitoring on page 147

® No kDb

Add Google Cloud Storage Account on page 148

Your Google Workspace account can be either an existing account or a new account. If you have just created a
new account, you must wait for at least 24 hours for the account to take effect before granting it access to
FortiCASB. The Google Workspace account which you connect from with FortiCASB must have the Super
Admin role.
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Configure Google Workspace Account

Use the following steps to check if your account has the Super Admin role:

1. Log into Google Admin with your Google Workspace account credentials.

2. Inthe upper-left corner, click the navigation menu , and select Directory > Users.

3. Click on the user account of interest.
Users | Showing all users as 3

Name 4 Email Status

casbga @ @qal.staging forticas Active 3 days ago 0 GB @ 7

4. Scroll down to the Admin roles and privileges section, and click on the expand button.

Groups v
A role privileges ﬁv
Roles Privileges
A v
Google apps other cloud apps

of 62 available Google services are on for casb. Turn o other cloud apps have been added to this domain
apps on or off Browse for apps Turn apps on or off
Managed devices

SETUP MOBILE DEVICE MANAGEMENT

5. Inthe Roles section, make sure that the Super Admin role has been assigned. If not, assign the Super
Admin role by clicking on the toggle switch butoon.

Roles
0 rodes assigned CREATE CUSTOM ROLE
Asigned itite T
e i ) ™
Groupn Admin .
. 4
Uner M ] .
a— » N
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Configure OAuth Consent Screen

The Google project needs to have OAuth Consent Screen created and configured to enable Google
Workspace Domain-Wide Delegation when service account is created.

Note: If you have already configured OAuth Consent Screen for the project, you can skip this section.

1. Goto Google Cloud Platform and log in with your Google Workspace account.

2. Click on the project drop-down menu > Select a project. Select an existing project you want to monitor or
create a new project by selecting New Project.

= Google Cloud Platform @ s My First Project « Q. Search products and resources

DASHBOARD ACTIVITY RECOMMENDATIONS

[ ] How Google Cloud is helping during COVID-19. Learn more

8¢ Project info H APT APls

Project name
My First Project

Requests (requests/sec)

Project 1D
stoked-sun-235717

Proiect number

ADD PEOPLE TO THIS PROJECT

- Goto project settings

& Racninirrec

3. With your project selected, search and click on OAuth Consent Screen.

Google Cloud Platform 3 ssstend =

APT Qauth Consent screen e Learn

—

4. When you get started with OAuth Consent Screen configuration, choose Internal user type, then click
CREATE.
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API

OAuth consent screen

Choose how you want to configure and register your app, including your
target users. You can only associate one app with your project.

Imemal (7]

Only available to users within your arganization. You will not need to
submit your app for verification.

) External @

Available to any test user with a Google Account. Your app will start in

testing made and will only be available 1o users you add to the list of test

users. Once your app is ready to push to production, you may need to
M‘Erl{x your app .

Let us know what you think about our OAuth experience

5. Step 1: OAuth Consent Screen:

a. Name the app and choose the user that will manage the app within the Google Cloud Platform

b. Forthe App domain, leave it as blank since it will only be for internal use.

account.

Edit app registration

@) OAuthconsentscreen — €) Scopes — €) Summary

App information

This shows in the consent screen, and helps end users know who you are
and contact you

App name *
forticasb_for_decument

The name of the app asking for consent

User support email * - I

For users to contact you with questons about their consent

BROWSE
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App domain

To protect you and your users, Google only allows apps using OAuth 1o uge
Authorized Domaing. The following information will be shown to your users
on the consent screen.

-'-_|‘::||:_' ation home page

Prowide users a link to your home page

Application privacy policy link

Provide users a link to your public privacy policy

Application terms of service link

Prowide users a link to your public tenm

c. Click +ADD DOMAIN and enter the domain of this Google Cloud Platform account.
For example, if the Google Cloud Platform account | am using is @forticasb.com, then the domain
is forticasb.com.

Authorized domains @

‘When a domain is used on the co

pre-registene

Consobe 1o check if your domaing are authorized

forticasb.com

+ ADD DOMAIN

Developer contact information

Email addresses *
testadmini @forticasb.com €

These email addresses ane for Googhe to notify you about any changes to your project

SAVE AND CONTIMUE CANCEL

d. In Developer contact information, enter the e-mail of the person managing the app.
e. Click SAVE AND CONTINUE.
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6. STEP 2: Scopes:
a. Click ADD OR REMOVE SCOPES.

Edit app registration

@ oauthconsent screen — €) Scopes — €) Summary

Scopes express the permissions you request users to authorize for your
app and allow your project to access specific types of private user data
from their Google Account. Learn more

ADD OR REMOVE SCOPES

Your non-sensitive scopes

EYCRE Scope User-facing description

Mo rows to display

& Your sensitive scopes

Sensitive scopes are scopes that request access 1o private user data.

&P1 T Scope User-facing description

Mo rows to display

& Your restricted scopes

Restricted scopes aré scopes that request access 1o highly sensitive user data.

AP P Soopé Wser-facing description

Mo rows to display

b. Select all scopes of this App and click update to apply the settings.
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¥ Update sefected scopes

& Oty sopr bor wabind A e bvbed briow o ad 8 g 1070w 1o e 1o, fed ard by e

by g R e L
B o sl e T Ly
W 1 ey e e o
B =4+ g e ey et
B swenan Vo gy bt e B
s
B o Vs ataier whrw gl e i S Uil Dt fate
armti
w
B s 1 Sacadrie Debupger
e oy
-
B o e
Loggeg AR
B o= T ——————
Loggeg AR
B s g e T i et s s
Loggeg AR
B s R — [ A —
Lo oty Dioed wred 404 ropech
B s R — T e ——
Morsiorng =ty
s
B oo e vrm mordoreg detn o Wl of o oo D wed
g e ey o
-
B ot e el it Frinc # Sk b § gecgnct o Mppic oA
-

Boen o s w- w-manu £ I

c. Review the scopes selected, then click SAVE AND CONTINUE.
Edit app registration

& Ouuhconsent screen — E) Scopes — € Summary

Scopes capress 1he pemmissions you request users fo authonize for your
app and alkow your project to acoess specilic Types of private wser data

from their Google Account. Learn mone
ADD OR REMOVE SCOPES
Your non-sensitive scopes
am 4 Scope Y- acing description
Sl YouT PrIMATY Googhs [ ]
fmAhiuseninfo Account emall address
il
S your pergonal info, 1
# sthuserinio including any perscmal infio
profile you've made publichy
endable
operad ARBOCINNE yiou with poue [ 1
personal info on Google
Service sty iam Test identity and Access .'
Manggaman L] MEnagamEss (LAM])
AP PimigsIOng
£ Your sensitive scopes

Gerehiiee SCOQEL ANE SOXEE UL PEqUEST AISERE T private uler dala

P Srope Uk o] S it

d. Review and confirm all settings are correct in the Summary page, then click BACK TO
DASHBOARD, the OAuth consent screen should now be added to the project.
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Edit app registration

@ Oauth consent screen

OAuth consent screen

User type

Internal

App name

forticasb_for_document

Support email

App logo
Mot provided

Application homepage link
Mot provided

Application privacy policy link

Mot provided

Application terms of service link

Mot provided

Authorized domains

forticash.com

Contact email addresses

Now Google Workspace Domain-wide Delegation can be enabled in Create Service Account on page 138.
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Create Service Account

For your service account, you may either use an existing or create a new service account. The service account
needs to be created in the project that has OAuth Consent Screen created.

1. Go to the Google Cloud Platform portal and log in with your Google Workspace account.

2. With the project selected, click the Navigation Menu ~— on the top left corner, go to IAM & Admin >
Service accounts.

Google Cloud Platform & autotest «

Home

IT  vPCnetwork >
PRODUCTS A
'};{ Marketplace |:
. 1AM
& Billing
Identity & Organization
API  APls & Services > Policy Troubleshooter

Support > Policy Analyzer

Organization Policies

1AM & Admin >
‘l Service Accounts |

S B ¢ @ +

Getting started Workload Identity Federation
. Labels
Compliance
Tags
Security Settings

3. Click +Create service account, then enter a Service account name of your preference and click
CREATE AND CONTINUE.
Skip the optional steps, and click Done.
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< Create service account

@ Service account details

Service t name .
[ cashqatest2 ‘

Display name for this service account

Service account ID *

[casbqatestZ b4 C‘

Email address: casbgatest2@qatest-237718.iam.gserviceaccount.com G

[ Service account description |

Describe what this service account will do

CREATE AND CONTINUE

Grant this service account access to project
(optional)
|
© Grant users access to this service account (optional)

(e J

4. In Service Accounts page, click on the service account you created to enter the Details page, keep a
record of the Service Account ID (Email).

DETAILS PERMISSIONS KEYS METRICS LOGS

Service account details

~ Name |
| casbgatest2 SAVE |
| Description SAVE |
Email

casbgatest2(@gatest-237718.iam.gserviceaccount.com

Unique ID
100432373202346694215

Service account status

Disabling your account allows you to preserve your policies without having to delete it.

& Account curre ntly active

DISABLE SERVICE ACCOUNT

Advanced settings v
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5. Click on Advanced settings drop down menu, and keep a record of the Client ID for use later in
Grant Service Account APl Access on page 141.

Advanced settings ~

Domain-wide Delegation

Granting this service account access to your organization's data via
domain-wide delegation should be used with caution. It can be reversed
by disabling or deleting the service account or by removing access
through the Google Workspace admin consaole.

LEARN MORE ABOUT DOMAIN-WIDE DELEGATION [

Client ID: 100432373202346694215 rn

VIEW GOOGLE WORKSPACE ADMIN CONSOLE [£

6. Clickthe KEYS tab, then click ADD KEY drop down menu and select Create new Key.
Then select JSON key format and click CREATE. The JSON private key will be downloaded
automatically.

< casbgatest2

DETAILS PERMISSIONS KEYS METRICS LOGS

Keys

Service account keys could pose a security risk if compromised. We recomme
service accounts on Google Cloud here (4.

Add a new key pair or upload a public key certificate from an existing key pair.

Block service account key creation using organization policies [£.
Learn more about setting organization policies for service accounts (4

ADD KEY ~

Create new ke
Key creation date Key expiration date

Upload existing key

Keep the Service Account ID and JSON key later for Google cloud authentication
I during installation.
The Client ID will be used later in Grant Service Account API Access on page 141.
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Grant Service Account APl Access

Google Administrator requires Google Workspace account with Super Admin Role to grant the service account
with APl access.

The account with Super Admin role only needs to perform this one time configuration for the Google
Workspace account to be added to FortiCASB.

1. Log into Google Admin with the same Google account.
2. Goto Security > Access and data control > API Controls, scroll down and click Manage Domain
wide Delegation.

- @ security APl controls

Manage app access to users’ Google data. Learn about app access controls

Qverview Apps on your Google Workspace Marketplace allowlist and Andreid and i0S apps on your

Alert center

Overview 0 restricted Google services

» Authentication 17 unrestricted Google services

MANAGE GOOGLE SERVICES
~ Access and data control

API controls

Client-side encryption

Settings CED
Data classification
Data protection User message L,Jn?onﬁ_g}”_e_d_th‘_@?a}”_y_aF_)F
Google Session control
Google Cloud session X .
control Domain wide delegation
Less secure apps Developers can register their web applications and other APl clients with Google to enable

to access your user data without your users having to individually give consent or their pa
» 1l Reporting

y B Billing

I MANAGE DOMAIN WIDE DELEGATION

3. Click Add new to authorize the registered client to access your user data.
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SECUrity > AFTLONUWIS » LOmain-wiage uveiegduon
[;] Home
EE Dashboard o Developers can register their web applications and other API clie
having to individually give consent or their passwords.
v & Directory
» Devices
L API clients Addnew | Download client info
» i Apps
+ Add a filter
hd @ Security
Overview MName Client ID
Alert center casb-test 117847001437565518458
» Authentication
mickyforticnp_ips_gep 106290914817318357365

» Access and data control

4. Inthe Client ID field, enter the Client ID saved from Create Service Account on page 138. Your Client ID
must be a string of numbers.

Add a new client ID

[ overwrite existing client ID @

DAuth scopes (comma-delimited) »

https://www.googleapis.com/auth/admin.directory.i

CANCEL AUTHORIZE

5. Inthe OAuth scopes field, enter:

"https://www.googleapis.com/auth/admin.directory.user, https://www.googleapis.com/auth/admin.reports
.audit.readonly".
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Grant Service Account Owner and Organization Administrator Role

The service account is created under a project of a organization in the Google Cloud account. FortiCASB
requires the service account to be granted with one of the following roles in the scope of organization level to

provide security monitoring across all projects under the organization:

1. Organization Administrator and Owner roles.
2. Basic > Viewer and Tag Viewer and Log View Accessor

Steps to Grant Service Account and Organization Roles

1. In Google Cloud Portal, first select the organization which the project is under.

Select from | - NEW PROJECT

Search projects and folders
[

RECENT STARRED ALL
Mame D
v B 7]
o o
T o (2]
- [ 2]
T o 2]

2. Clickthe Navigation Menu ~ , select IAM & admin > |IAM.
3. Click the +Grant Access button on the top.

[AM +% GRANT ACCESS -® REMOVE ACCESS

PERMISSIONS RECOMMENDATIONS HISTORY

Permissions for organization

These permissions affect this organization and all of its resources. Learn more

& 4 service accounts with highly privileged roles Owner / Editor have excess pe
Improve security by applying recommendations to these accounts.
Learn more about recommendations.

4. Inthe Add Principals > New principals field, enter the service account ID created earlier.
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Resource

ge gaTest

Add principals

Principals are users, groups, domains, or service accounts. Learn more about principals
in lAM [

Mew principals * (7]

5. In Assign roles, choose one of the options and add the appropriate roles:
a. Option 1: In the Select a role field, select Project > Owner or Viewer.

b. Thenclick+ ADD ANOTHER ROLE, select Resource Manager > Organization Administrator.

Assign roles

Roles are composed of sets of permissions and determine what the principal can do
with this resource. Learn more

- Role™ 1 1AM condition (optional) @ -
Owner h + ADD IAM CONDITION .
- Role + 1AM condition (optional) @ -
Organization Administrator - + ADD IAM CONDITION [ ]
Access to manage |AM policies and
view organization policies for
organizations, folders, and projects

-+ ADD AMOTHER ROLE

o PR

c. Option 2: In the Select a role field, select Resource Manager > Tag Viewer.
d. Thenclick+ ADD ANOTHER ROLE, select Basic > Viewer.
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e. Click+ ADD ANOTHER ROLE again, select Logging > Log View Accessor.

Assign roles

Roles are composed of sets of permissions and determine what the principal can do

with this resource. Learn more

- Role ™
| Tag Viewer - |

- Role
| Viewer - |

- Role
| Logs View Accessor - |

Ability to read logs in a view.
+ ADD ANOTHER ROLE

6. Clickthe SAVE button to finish.

Enable required APIs

After adding roles to the service account, you must make sure that the following APIs are enabled on all
projects for monitoring. This will ensure that FortiCASB can gather information from the Google Cloud.

e Cloud Resource Manager API
o App Engine Admin API

1AM condition (optional) @
<+ ADD IAM CONDITION

IAM condition (optional) @
4+ ADD IAM CONDITION

IAM condition (optional) @
<+ ADD IAM CONDITION

o Cloud Key Management Service (KMS) API

« Compute Engine API

« Cloud SQL

e Google Cloud Storage JSON API
« Cloud Storage

« Cloud SQL Admin API

« Stackdriver API
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e« Admin SDK
« Identity and Access Management (IAM) API

To enable the APls, do the following:

1. On Google Cloud Platform Consolel , first select the project to be monitored.

2. Click the Navigation Menu — in the upper-left corner, and select APls & Services > Enable APls &
services.
3. Inthe API & Services list, make sure that the required APIs are listed (enabled).
APIs & Services -+ ENABLE APIS AND SERVICES
Traffic b4 Errors b4
b " w . \" o " e .
o i A — e
| | I
i | ’
e A — “.f"“’i = 'f-*J_ﬁf.i”: ) L ﬁ - _ I
= Filter Filter
Name A Requests Errors (%) Latency, median (ms) Latency, 95% (ms)
Compute Engine API 2,063,376 0 147 253
Kubernetes Engine AP| 1,789,825 0 131 260
Cloud Key Management Service (KMS) API 1,276,851 43 49 130
Cloud Logging API 182,217 0 716 1,525
Cloud Resource Manager API 38,933 0 104 pLA
Admin SDK API 34,807 0 98 228
App Engine Admin API 31,012 72 104 247
Cloud SQL Admin API 30,942 0 400 581
Identity and Access Management (IAM) API 13,444 0 381 510
Cloud DNS API 28 0 58 121
Service Networking APl 14 0 233 487
BigQuery API
If any of the APIs is not enabled, use the below steps to enable it:
1. Go to the project to be monitored.
2. Click the Navigation Menu ~ | and select APIs & Services
3. Click Activate Cloud Console in the upper right hand corner.
4. Copy and paste the shell command to enable the required services:
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gcloud services enable \
cloudresourcemanager.googleapis.com \
appengine.googleapis.com \
cloudkms.googleapis.com \
compute.googleapis.com \
sql-component.googleapis.com \
storage-api.googleapis.com \
storage.googleapis.com \
sgqladmin.googleapis.com \
stackdriver.googleapis.com \
admin.googleapis.com \
iam.googleapis.com

Note: Repeat the steps above to enable APIs for other projects under the same
organization.

Enable activity and alert monitoring

If you would like to enable FortiCASB activity and alert monitoring, you must turn on audit logging using the
following steps:

1.

2.
3.
4

In Google Cloud Platform Console, select the project where the service account was created at.
Go to the project to be monitored.

Click on the Navigation Menu, and select IAM & Admin > Audit Logs.

Search for "Google Cloud Storage" from the list of available resources.
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Data Access audit logs configuration

The effective data access configuration below combines the configuration for the currently selected resource and the data access co

resources.
= Filter [LLN ARG ESGWIEh N )  Enter property name or valus
Service ‘T Admin Read Data Read Data Write Exempted principals
Google (] [} (/] Q
Cloud
Storage

5. Enable all log types, i.e., Admin Read, Data Read, and Data Write.

Enable/disable Data Access audit log types for selected
services.

Enabling audit logging for Google Cloud Storage
disallows authenticated browser downloads for
non-public objects. Learn more

Admin Read
Data Read
Data Write

6. Clickthe SAVE button.

Add Google Cloud Storage Account

After all the Google Cloud Storage configurations are completed, follow these steps to add your Google Cloud
Storage account on FortiCASB.

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard, click on Add New, select Google Cloud Storage, then click Add
Selected Cloud App.
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Business Unit Overview

BU MName QA Test BUID 330239 #of Cloud App 14

Google Workspace

] Office 365
including including
wadd ) &

.

B ¥ v} 2

GCP Storage

Drophasx
 @gmail.com

Q i i

Webex Teams Zendesk Add Mew
. . h .
Select Cloud Appto Add *
Google Workspace 1] Office 365 aws

including

Awss3

¢
&
A box S} 4 33
Azure Storage Box Citrix ShareFile Confluence Dropbox
x ® o o <
Egnyte ‘Workplace GitHub GCP Storage: Jira

4 zoom
Zendesk Zoom
Cancel

3. Review the key configurations list to see if you have finish all the required configurations, then click Next.
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GoogleCloudStorage / OAuth / Add
Add Google Cloud Storage Account

Finish Configurations @Google Cloud @& Fillin Account Info &P Dore

To successfully add your Google cloud account, please do the following and refer to the step-by-
step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The account must be a G Suite account . How to find out?

2. The account must have a Super Admin role assigned. If no, create one.

3. Create or configure a Service Account and keep record of Service Account ID.
4. Enable necessary APls for FortiCASB to gather info from the account.

5. Turn on Google Account Audit Log to enable FortiCASB activity and alert monitoring.

Please make sure you've finished all configurations above before clicking Next button below.

Next ‘ Cancel ‘

4. In User Email field, enter your Google Workspace account which you used to create the service account.

GCP Storage / OAuth / Add

Add Google Cloud Storage Account

0 Finish Configurations @Google Cloud e Fill in Account Info 3  Done

User Email
Service Account 1D

Upload Service Account Private Key

Choose File
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5. In Service Account ID field, enter the ID of your service account. Your service account ID should end in
".gserviceaccount.com".

6. In Upload Service Account Private Key, click Choose File to browse and upload your service
account's private key (i.e., a JSON file).

7. Click Add Google Cloud Storage Account to complete adding your Google Cloud Storage account.

Update Google Cloud Storage Account

Before updating the Google Cloud Storage account on FortiCASB, complete the same configurations using the
same Google Workspace account.

Configure Google Workspace Account on page 131

Configure OAuth Consent Screen on page 132

Create Service Account on page 138

Grant Service Account APl Access on page 141

Grant Service Account Owner and Organization Administrator Role on page 143

Enable required APIs on page 145

No akoebd-=

Enable activity and alert monitoring on page 147

After all configurations are completed, go back to FortiCASB to update the account.

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard.
3. Click on the Google Cloud Storage menu and select Update Cloud Account.

3 Update Cloud Account

GCPStorage  View Account Detail
View Change History

Delete Account

4. Review the key configurations list to see if you have finish all the required configurations, then click Next.
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Update Google Cloud Storage Account

o Finish Configurations @Google Cloud 2 | Fillin Account Info 3  Done

To successfully update your Google cloud account, please do the following and refer to the step-by-
step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The account must be a G Suite account .

2. The account must have a Super Admin role assigned. If no, create one.

3. Create or configure a Service Account and keep record of Service Account ID.
4. Enable necessary APIs for FortiCASB to gather info from the account.

5. Turn on Google Account Audit Log to enable FortiCASB activity and alert monitoring.

Please make sure you've finished all configurations above before clicking Next button below.
Next Cancel

5. In User Email field, enter your Google Workspace account which you used to create the service account.

Update Google Cloud Storage Account

° Finish Configurations @Google Cloud 9 Fill in Account Info

User Email

Service Account ID

Upload Service Account Private Key

Choose File

6. In Service Account ID field, enter the ID of your service account. Your service account ID should end in
".gserviceaccount.com"”.

7. InUpload Service Account Private Key, click Choose File to browse and upload your service
account's private key (i.e., a JSON file).
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8. Click Update Google Cloud Storage Accountto complete updating your Google Cloud Storage
account.

Google Workspace

FortiCASB utilizes and API based approach to monitor your cloud SaaS application. In this example, FortiCASB
authenticates itself to your Google Workspaces account using OAuth2.0 credentials, and then utilized the
Google Workspaces API to pull information from your cloud accounts. FortiCASB uses this information to
monitor and track Google Workspaces user activities and scan data stored in Google Drive.

Prerequisites

To use API access, your organization must be using one of the following editions (the API is enabled by
default):

« Business Edition
« Enterprise Edition

The user account installed in FortiCASB must be a Super Administrator in your Google Workspace account.
For steps on how to check if your account is a Super Adminstrator, see Google Workspace connection errors on

page 550.
ﬂ Due to Google requirements, only Google Workspace accounts with a business or
I enterprise license can use FortiCASB. Google Workspace accounts with a basic
license will be not be able to use FortiCASB.

You may either use an existing account or create a new account. Wait at least 24 hours for the new account to
take effect before granting access to FortiCASB.

There are four steps you need to setup your Google Workspace account before you can add the Google
Workspace account on FortiCASB:

1. Configure OAuth Consent Screen on page 154
2. Create Google Service Account on page 159

3. Enable Google Drive APl & Authorize Client ID on page 162
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4. Enable activity and alert monitoring on page 165

5. Add Google Workspace Account on page 166

Configure OAuth Consent Screen

The purpose to create an OAuth Consent Screen is to enable Google Workspace Domain-Wide
Delegation when a Google service account is created under a project. Furthermore, with Google Workspace
Domain-Wide Delegation enabled, the Google Drive APl OAuth scope can be authorized to be used by

the service account. This is critical in authorizing FortiCASB to retrieve data from the Google Workspace
account.

Be mindful the Google project that will be hosting the service account will play a critical role in providing the
authorization that FortiCASB needs to interact with Google Workspace account.

Note: If you have already configured OAuth Consent Screen for the project, you can skip this section.

1. Goto Google Cloud Platform Console and log in with your Google Workspace account.

2. Click on the project drop-down menu > Select a project. Select an existing project or create a new project
by selecting New Project.
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= Google Cloud Platform | &= MyFirst Project «

DASHBOARD ACTIVITY RECOMMENDATIONS

(i ] How Google Cloud is helping during COVID-19. Learn more

8® Project info H APL APIs

Project name
My First Project

Requests (requests/sec)

Project 1D
stoked-sun-235717

Proiect number

A Nodatais available for the selectad time fi

ADD PEOPLE TO THIS PROJECT

Go to project settings
proj 9

& Reennirroe :

3. With your project selected, click on navigation menu and go to APIs & Services > OAuth consent
screen.

MORE PRODUCTS A

1};{ Marketplace
& Biling
API  APIs & Services >

Enabled APls & services
'i' Support > Library

Credentials
O 1AM & Admin y o recemEs
* Getting started
m Compliance Page usage agreements
e Security »

4. When you get started with OAuth Consent Screen configuration, choose Internal user type, then click
CREATE.
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API1 QAuth consent screen

- Choose how you want to configure and register your app, including your
target users. You can only associate one app with your project.

(=]

Irrl:emal Q

B Only available to users within your arganization. You will not need to
submit your app for verification.

fa (O External @

Available to any test user with a Google Account. Your app will start in
testing made and will only be available 1o users you add to the list of test
users. Once your app is ready to push to production, you may need to

\.-'erl‘fx your app .

Let us know what you think about our OAuth experience

5. In OAuth Consent Screen page:

a. Name the app and choose a user that will manage the app within the Google Workspace account.

Edit app registration

@) OAuthconsentscreen — E) Scopes — €) Summary

App information

This shows in the consent screen, and helps end users know who you are
and contact you

App nama *
forticasb_for_decument

The name of the app asking for consent

~J

For users to contact you with questons about their consent

EROWSE

b. Forthe App domain, leave it as blank since it will only be for internal use.
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App domain

To protect you and your users, Google only allows apps using OAuth to use
Authorized Domains. The following information will be shown to your users
on the consent screen.

c. Click +ADD DOMAIN and enter the domain of this Google Workspace account.

For example, if the Google Cloud Workspace account e-mail is "security_admin@microsoft.com",
then the domain is "microsoft.com".

Authorized domains @

When a domain is used on the consent screen or in an QAuth client's configuration, it must be
pre-registered here. If your app needs to go through verification, please go to the Google Search
Console to check if your domains are authorized. Learn more about the authorized domain limit

~ Authorized domain 1 *
microsoft.com

-+ ADD DOMAIN

Developer contact information

- Email addresses *
secruity_admin@microsoft.com €

These email addresses are for Google to notify you about any changes to your project
SAVE AND CONTIMUE CAMNCEL

d. In Developer contact information, enter the e-mail of the person managing the app.
e. Click SAVE AND CONTINUE.

6. In Scopes selection page, click SAVE AND CONTINUE

7. Review and confirm all settings are correct in the Summary page, then click BACK TO DASHBOARD,
the OAuth consent screen should now be added to the project.

FortiCASB 24.3.b Admin Guide
Fortinet Inc.

157



Cloud Application Onboarding

Edit app registration

& oAuth consent screen

OAuth consent screen

User type

Internal

App name

forticash_for_document

Support email

App logo
Mot provided

Application homepage link

Mot provided

Application privacy policy link

Mot provided

Application terms of service link

Mot provided

Authorized domains

forticash.com

Contact email addresses
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Create Google Service Account

A service accountcreated for the Google Workspace account is required to add the account to FortiCASB.
The service account needs to be created in the project that has OAuth Consent Screen created to activate
Google Workspace Domain-Wide Delegation. Google Workspace Domain-Wide Delegation is necessary
for FortiCASB to visit files in Google Workspace.

Without the service account, you can still use FortiCASB. However, the features related to files in FortiCASB,

such as Discovery, will not work.

For more information regarding service accounts and domain-wide authority delegation, go to:
https://developers.google.com/identity/protocols/OAuth2ServiceAccount#delegatingauthority

Steps to create Google Service Account:

1. Gotothe Google Cloud Platform Console and log in with your Google Workspace account.

2. With the project selected, go to the Navigation Menu — > IAM & Admin > Service accounts.

= Google Cloud Platform

¢ autotest =

f Home

T vPC network
PRODUCTS A

W Marketplace
& Billing

API  APIs & Services
[ ]

W Support

O 1AM & Admin

® Getting started

fily, Compliance

N

Security

>

Pls & Services -+ ENABLE APIS AND SER

Traffic

1AM
Identity & Organization
Policy Troubleshooter

Policy Analyzer

Organization Policies
e

Workload Identity Federation
Labels
Tags

v

Settings

3. Click +Create service account, then enter a Service account name of your preference and click
CREATE AND CONTINUE.

Skip the optional steps, and click Done.
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Create service account

@ Service account details

Service account name

[ test123 ]

Display name fer this service account

Service account ID
test123-549 (@testproject-323221 iam.gserviceaccountcom X

Service account description

Describe what this service account will do

CREATE AND CONTINUE

Grant this service account access to project
(optional)
|
© Grant users access to this service account (optional)

(o JE

4. In Service accounts page, Click on the service account you created to enter the Details page, keep a
record of the Service Account ID (Email).

Service account details

Name

{ test567 SAVE ]
[ Description SAVE ]
Email

[@testproject-323221.iam.gserviceaccount.com

Unique ID
106364070592216694027

Service account status

Disabling your account allows you to preserve your policies without having to delete it.

& Account currently active

DISABLE SERVICE ACCOUNT

Advanced settings v

5. Click on Advanced settings drop down menu, and keep a record of the Client ID for use later in Enable
Google Drive API & Authorize Client ID on page 162.
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Advanced settings ~

Domain-wide Delegation

Granting this service account access to your organization's data via
domain-wide delegation should be used with caution. It can be reversed
by disabling or deleting the service account or by removing access
through the Google Workspace admin console.

LEARN MORE ABOUT DOMAIN-WIDE DELEGATION

Client 1D * |

VIEW GOOGLE WORKSPACE ADMIN CONSOLE [

6. Click the KEYS tab, then click ADD KEY drop down menu and select +Create new Key.
Then select P12 key format and click CREATE. The P12 private key will be downloaded automatically.

< test123

DETAILS PERMISSIONS KEYS METRICS LOGS

Keys

Service account keys could pose a security risk if compromised. We recommend you avoid downloading servi
here.

A

Add a new key pair or upload a public key certificate from an existing key pair.

Block service account key creation using organization policies.
Learn more about setting organization policies for service accounts

ADD KEY ~

Type Status Key Key creation date Key expiration date

No rows to display

Keep the Service Account ID and P12 private key later for Google Workspace
ﬂ authentication during installation.

I The Client ID will be used later in Enable Google Drive API & Authorize Client ID on page
162.
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Enable Google Drive APl & Authorize Client ID

1. In Google Cloud Platform Console, select the project where the service account was created at.

2. Goto Navigation Menu = > APIs & Services > Enabled APIs & services.

MORE PRODUCTS A

'\.2_./ Marketplace

& Billing

AP APIs & Servi v r |
s ervices | Enabled APls & services

Support > Library

. Credentials

1AM & Admin >

OAuth consent screen
Domain verification

Compliance Page usage agreements

)
S
@ Getting started
i,
Y Security >

. Anthos >

3. Clickon +ENABLE APIS AND SERVICES.

= GoogleCloud 2 autotest « | Q Search

API APIs & Services APIs & Services | -+ ENABLE APIS AND SERVICES |

% Enabled APIs & services

EE

Library

o Credentials Traffic

s

3 OAuth consent screen

Domain verification e

Su  Pageusage agreements mmsesss R mmmmssss, = = —msseses = s

4. Search for the Google Drive APl and enable it.
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= Google Cloud Platform $» TestProject

&

Google Drive API

Google Enterprise API

The Google Drive AP allows clients to access resources from Google Drive

ENABLE TRY THIS API [2

OVERVIEW DOCUMENTATION

5. Goto Google Workspace Admin Console and log in with the same Google Account.
6. Goto Security > Access and data control > API controls.

APIs Tor customer-owned and third-

d service accounts. Red

~ @ security

Overview
Alert center
» Authentication

- Access and data control

API controls

Client-side encryption
Data classification

Data protection

Google Cloud session
control

Less secure apps

e Settings Show this message if a user tries to use an app that can't acces:
e

~ @ security

settings

Alert center
AP controls

Data protection

nie

Security rules Learn more

» 1l Reporting Trust internal, domain-owned apps
, B siing nternal, domain-owned apps will be exempt from ac
» @ Account Apps you trust on the Google Workspace Marketplace, Android,
list
@ Rules
Domain wide delegation
[ send feedback Developers can register their web applications and other AP clients with Google to enable access to datain &
to access your user data without your users having to individually give consent or their passwords. Learn morc
© 2021 Google Inc. MANAGE DOMAIN WIDE DELEGATION

Terms of service - Billing terms
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8. Click Add new and add the Client ID from Create Google Service Account on page 159.

= Google Admin Q, Search for users, groups or settings

Security » API Controls > Domain-wide Delegation

o Developers can register their web applications and other API clients with Google to enable access to data in Google services like Gmail. You can au
access your user data without your users having to individually give consent or their passwords

API clients Add new
4+ Adda fIHE!; 7
Name Client ID Scopes
FortiCASE 826587069583-953tha... .../auth/admin.reports.audit.readonly ../auth/admin.directory.group.readonly  +5 More
frasbtest 108090966701456158.. ...fauth/admin.directory.user  hitps://www.googleapis.c om/auth/admin.reports.audit.readonly

9. Add "https://www.googleapis.com/auth/drive" to OAuth scope and click AUTHORIZE.

Add a new client ID

https://www.googleapis.com/auth/drive

OAuth scopes (comma-delimited)

CANCEL AUTHORIZE
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Enable activity and alert monitoring
To enable FortiCASB activity and alert monitoring on the Google Workspace account, audit logging needs to be
turned on by the following steps:

1. In Google Cloud Platform Console, select the same project as where the service account was created.

2. Goto Navigation Menu —> IAM & Admin > Audit Logs.
3. Search for "Google Cloud Storage" from the list of available resources.

Data Access audit logs configuration

The effective data access configuration below combines the configuration for the currently selected resource and the data access co
FESOUrCes.

= Filter (LN CRRTLGESWIEU %) Enter property name or valus

Service T+ Admin Read Data Read Data Write Exempted principals
Google ] ] (] ]
Cloud
Storage

4. Enable all log types, i.e., Admin Read, Data Read, and Data Write.
Enable/disable Data Access audit log types for selected

services.

Enabling audit logging for Google Cloud Storage
disallows authenticated browser downloads for
non-public objects. Learn more

Admin Read
Data Read
Data Write

5. Clickthe SAVE button.
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Add Google Workspace Account

After all the Google Workspace configurations are completed from previous sections, follow these steps to add
your Google Workspace account on FortiCASB.

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard, click on Add New, select Google Workspace, then click Add Selected
Cloud App.

Business Unit Overview

BUMName QA Test BUID 330239 #of Cloud App 16
] Office 365 Google Workspace
ncluding ncluding
adg s a9
« SRl . " .
b & 4 |
3 ¥ O O
Dropbaox Egnyte GitHub GCP Storage
. ® @gmail com
-
Q Y4 +
bex Teams Zendesk Add New
- -
Select Cloud App to Add X
Google Workspace 1] Office 365 aws
including including .
&0 L LY TR
A box S] < E=2
Azure Storage Box Citrix ShareFile Confluence Dropbox
X @ (v} a) <
Egryt epl: GitHub GCP Storay
& (S — Q
sap1AS vebe

Y
N
. 8
o
3

3. Review the summary of key configurations, which should be completed already in previous sections, and
click Next.
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Add Google Workplace Account

oF|'n'|shConﬁgurations@GoogleWorkaace 2 | Fillin Account Info 3  Done

To successfully add your Google cloud account, please do the following and refer to the step-by-step
tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The account must be a G Suite account.

2. The account must have a Super Admin role assigned. If no, create one.

3. Create or configure a Service Account and keep record of Service Account ID.

4. Enable necessary APls for FortiCASB to gather info from the account.

5. Turn on Google Account Audit Log to enable FortiCASB activity and alert monitoring.

Please make sure you've finished all configurations above before clicking Next button below.

4. Enterthe Service Account ID (Email) and upload the Private Key (P12 File) of the Google Workspace
account. Your service account ID should end in ".gserviceaccount.com".

Add Google Workplace Account

° Finish Configurations @Google Workplace e Fillin Account Info

Service Account |ID

@testproject-323221.iam....

Upload Service Account Private Key

Choose File

testproject-323221-8eblad5celcéd.pl?2

Add Google Workplace Account

The Service Account ID is the email generated from the service account. It is located in Service
account details.
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5. Click Add Google Workspace Account. You will be navigated to the Google website for authentication.
Make sure to use the same Google Workspace account for authentication. If you have a custom Google

Google Cloud Platform & autotest «

Home

T vPCnetwork >

FRODUCTS A

[

W Marketplace

— 1AM
& Billing
Identity & Organization
WPL APIs & Services > Policy Troubleshooter
Support > Policy Analyzer

Organization Policies

|AM & Admin » [
[

S B ¢ @ =

Getting started Workload Identity Federation
. Labels
Compliance
Tags
Security Settings
DETAILS PERMISSIONS KEYS METRICS LOGS

Service account details

Name

test123 SAVE

Description SAVE
Email

test123@testgep-198717.iam.gserviceaccount.com

Unigue [D
117496537044241707216

Service account status

Disabling your account allows you to preserve your policies without having to delete it.

@ Account currently active

DISABLE SERVICE ACCOUNT

“ SHOW DOMAIN-WIDE DELEGATION

domain, enter it here.
6. Log into authenticate. Google will prompt you to Allow or Deny access.
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FortiCASB wants to access your

Google Account

o forticasb@forticasb.com

This will allow FortiCASE to:

c

c

7. Click Allow to grant FortiCASB permission to monitor your Google Workspace application.

See and download all your Google Drive files

View your Google Drive apps

See, edit, create, and delete only the specific
Google Drive files you use with this app

View delegated admin roles for your domain

View audit reports for your G Suite domain

View usage reports for your G Suite domain

View groups on your domain

© 06 6 6 0

See info about users on your domain

You will be redirected back to the FortiCASB dashboard. You can check the installation checklist and platform
monitoring status in the Google Workspace dashboard.

©® Overview

Salesforce

Last 7 days

Google Workspace

Google Workspace

Dashboard
Discovery

Documents

Activity
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Update Google Workspace Account
Complete the same configurations using the same Google Workspace account before update the Google

Workspace account on FortiCASB:
1. Configure OAuth Consent Screen on page 154

2. Create Google Service Account on page 159
3. Enable Google Drive APl & Authorize Client ID on page 162
4,

Enable activity and alert monitoring on page 165

After all the Google Workspace configurations are completed, follow these steps to update your Google
Workspace account on FortiCASB.

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard.

3. Click on Google Workspace menu and select Update Cloud Account.

Google Workspace Update Cloud Account
including View Account Detail
&0
o View Change History
Delete Account

4. Review the summary of key configurations, which should be completed already in previous sections, and
click Next.
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Update Google Workplace Account

o Finish Configurations @Google Workplace 2  Fill in Account Info 3  Done

To successfully update your Google cloud account, please do the following and refer to the step-by-
step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The account must be a G Suite account .

2. The account must have a Super Admin role assigned. If no, create one.

3. Create or configure a Service Account and keep record of Service Account ID.
4. Enable necessary APIs for FortiCASB to gather info from the account.

5. Turn on Google Account Audit Log to enable FortiCASB activity and alert monitoring.

Please make sure you've finished all configurations above before clicking Next button below.

Next Cancel

5. Enterthe Service Account ID (Email) and upload the Private Key (P12 File) of the Google Workspace
account. Your service account ID should end in ".gserviceaccount.com".

Update Google Workplace Account

° Finish Configurations @Gaoogle Workplace e Fill in Account Info

Service Accouﬁr D

Upload Service Account Private Key

Choose File

The Service Account ID is the email generated from the service account. It is located in Service
account details.

FortiCASB 24.3.b Admin Guide

Fortinet Inc.

171



Cloud Application Onboarding

Google Cloud Platform & autotest «

Home

::: VPC network >

FRODUCTS A

[

W Marketplace

- 1AM
& Billing
Identity & Organization
RPI  APls & Services > Policy Troubleshooter
.i_ Support > Policy Analyzer
Organization Policies
B |AM & Admin r [r—
[ |
@ Getting started Workload Identity Federation
m . Labels
b Compliance
Tags
e Security Settings
DETAILS PERMISSIONS KEYS METRICS LOGS
Service account details
Name
test123 SAVE
Description SAVE
Email

test123@testgep-198717.iam.gserviceaccount.com

Unigue [D
117496537044241707216

Service account status

Disabling your account allows you to preserve your policies without having to delete it.

@ Account currently active

DISABLE SERVICE ACCOUNT

“ SHOW DOMAIN-WIDE DELEGATION

6. Click Update Google Workspace Account. You will be navigated to the Google website for
authentication. Make sure to use the same Google Workspace account for authentication. If you have a
custom Google domain, enter it here.

7. Log in to authenticate. Google will prompt you to Allow or Deny access.
8. Click Allow to grant FortiCASB permission to monitor your Google Workspace application.
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You will be redirected back to the FortiCASB dashboard. You can check the installation checklist and platform
monitoring status in the Google Workspace dashboard.

Jira

FortiCASB offers an API-based approach, pulling data directly from Jira via RESTful API. Then FortiCASB
portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently, FortiCASB
combines these data to monitor and track Jira user activities, provides DLP Data Analysis for files stored on Jira
tickets.

Before adding the Jira account to FortiCASB, configure the Jira account to grant FortiCASB read access
permission to monitor account activities and provide other security measures on the account. Make sure the
Jira account that will be added on FortiCASB is the same account that is configured.

Prerequsite

« All Jira Cloud plans are supported, including the Free plan.
« The account user must be a Site Admin of the Jira service site.

Steps to add Jira account to FortiCASB:

1. Jira Account Configuration on page 176
2. Add Jira Account on page 179
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Configure Jira Project Browse Project Permission

The Jira account that will be used to add Jira to FortiCASB needs to be granted Browse Project permission
to the Jira project to be monitored by FortiCASB. This is so that FortiCASB have sufficient permission to browse
the Jira project and the issues within the project as a site admin.

The Jira project must be a Company-managed software type to edit the access permission.

Steps to Grant Browse Project Permission to Jira Account

1. Go to your Jira project site.

HH 1‘!‘ Your work Projects Filters More

Projects

All Jira products

*  Name* Key

Auto_test SOF
a

Autotest AUT
a

Type

Company-managed software

Company-managed software

2, Search

DAIW

a daiweiproject

B rorticass FOR

Service management
Company-managed software

+ | fortiCASE_Scrum =

— Team-managed software

Choose the Jira project to be monitor by FortiCASB.

2

3. Click *** on the right of the project and select Project settings.
4. In Project settings menu, click Permissions.

5. Click Actions drop down menu and select Edit permissions

Parmission helper

Edit permissions

lse a different scheme

6. Inthe column Browse Projects, click Update.
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Browse Projects
Ability to browse projects and the

issues within thern.

Project Role

+ atlassian-

Update Remove

addons-project-

aCCaess

Group

+« administrators

+ jira-software-

users

+  mxieRessarch

7. Check Single User, and type and select the account user that will be used to add Jira to FortiCASB.

Update "Browse Projects" permission

Application access
Group
Public
Any logged in user

Service Project Customer - Portal Access

Reporter
Single user

Select...

8. Click Update to finish.

Note the single user added now is one of the user that has Browse Project permission.

Browse Projects

Ability to browse projects and the issues within them,
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Jira Account Configuration

Follow the instructions below to create and configure an App on Jira:

1. Login to Atlassian Developer Console as the Site Admin.

2. Click Create App drop down menu and select OAuth 2.0 (3LO) integration.

3. Fillin a App name, agree to Atllassian's developer terms, and click Create.

Console /
My apps
Create and manage your Forge and 3LO apps.
Search... Q Distribution status v o
App name Distribution status

I Test_jira Nat sharing

Forticasb Nat sharing

B.

===

3/15/2021 £:51:16 PM 3L0

3/8/2021 4:56:56 PM 3L0

4. Inleft navigation menu, click Permissions. In APl name > Jira API, click Add. When the Add button

turns to Configure, click Configure.
APl name

User identity API

Get the profile details for the currently logged-in user, such as the Atlassian account ID and ema

Confluence API
Get, create, update, and delete content, spaces, and more.

# Jira API
A

¢

Get, create, update, and delete issues, projects, fields, and more.

Personal data reporting AFI
Report user accounts that an app is storing personal data for.

Scopes used Action
0 Add
0 Add
0 Add
0 Add

5. In Classic scopes tab, go to Jira Platform REST API section, and click Edit Scopes.

Classic scopes Granular scopes

Jira platform REST API

Select - Scope Name Code

View lira 1ssue data

Read Jira project and issue data, search for issues, and
objects ted with issues like attachments and
worklogs

6. Check all scopes in Edit Jira Platform REST API and click Save.
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View lira issue data
Read Jira project and issue data, search for issues, and objects associated with
issues like attachments and worklogs.

Manage project settings

Create and edit project settings and create new project-level abjects (e.g. versions

and components).

Manage Jira global settings
Take Jira administration actions (e.g. create projects and custom fields, view
workflows, manage issue link types)

View user profiles
View user information in Jira that the user has access to, including usermames
email addresses, and avatars.

Create and manage issues
Create and edit issues in Jira, post comments as the user, create worklegs, and
delete issues.

Manage Jira webhooks
Register and manage Jira webhooks,

Manage development and release information for third parties in Jira
Manage development and release information for third parties in Jira.

read:fira-work

manage:jira-project

manage: jira-configuration

read:jira-user

write:jira-work

manage : jira-webhook

manage:jira-data-provider

7. Inthe left navigation menu, click Permissions again, in APl name > User Identity API, click Add.
When the Add button turns to Configure, click Configure.

APl name

User identity AP

Get the profile details for the currently logged-in user, such as the Atlassian account ID and ema

 {

Confluence API

Get, create, update, and delete content, spaces, and mare

Get, create, update, and delete issues, projects, fields, and more.

Personal data reporting AFI
Report user accounts that an app is storing personal data for.

1.Il Jira APl
A

8. Click Edit Scopes to add the View User Profile scope, and click Save

Select

View active user profile
View the profile details for the currently logged-in user.

Scope Name Code

read:me

View user profiles
Required to view users profiles

9. Inthe left navigation menu, click Authorization,in Authorization type > OAuth 2.0 (3LO), click Add.
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Authorization type Action

Allows your app to

OAuth 2.0 (3LO)
. . . Add

ccess APIs for Atlassian products and services on a user's beh

e

10. Inthe Callback URL, enter the callback URL from FortiCASB Add Jira Account page.
b. Fill in the Callback URL field with the url below, then clickSave changes.
Callback URL:

forticasb.com/api/v1/oauth/redirect/Jira rﬁ

Authorization

OAuth 2.0 authorization code grants (3LO) for apps

Configure QAuth 2.0 authorization code grants to allow your app to access data (within specific scopes) from Atlassian APls
on the user's behalf. Learn more about OAuth 2.0 authorization code grants for Jira Cloud and Confluence Cloud.

Callback URL*

forticasb.com/apifv1/oauth/redirect/Jir

Click Save Changes to save the settings.

11. In the left navigation menu, click Settings, then scroll down to Authentication details, make a note of
Client ID and Secret for later in FortiCASB authentication.

Authentication details

Use the Client ID and Secret for authentication, See the OAuth 2,0 (3L0) guide to learn maore,
Client ID

D
Secret

................................................................ n

Delete app

Please make sure the Jira account that will be added on FortiCASB is the same
account that is configured.
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Add Jira Account

After completing Jira Account Configuration on page 176, follow the steps below to add Jira account on
FortiCASB.

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard, click on +Add New, select Jira, then click Add Selected Cloud App
Overview / Dashboard

Business Unit Overview

BUName testassign

BUID 480756 #of Cloud App 1
] Office 365 +
including
poeadd > Add New

® ga@casbgal.onmicrosoft.com

3. Fillin the Jira Site Domain name which the Jira account associates with, Client ID and Client Secret
recorded down from Jira Account configuration. Your Jira site domain name is the site domain prefix.
For example: for https://mydomain.atlassian.net/, the Jira site domain name is "mydomain".

5. Navigate to Settings in the left menu. Scroll down toAuthentication Details, find Client ID and Secret.
Fill the account information in the fields below.

Jira Site Domain+
forticashjira

YYou can find your Jira Site Domain in the site URL https://your_site_domain.atlassian.net/.

Client ID =

Secret =

Next Step Cancel

4. Then click Next Step.
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5. Clickon the Jiralink to log into the Jira Domain Project page.

o Finish Configurations @Jira e Webhook Set Up 3 Done

1 Log intith the same admin account used in the last step.

a. Click the settings icon at the top right corner and selectSystem. Scroll down to the bottom of the
left menu and selectWebhook.

b. Click Create a Webhook. Enter a name and select Enabled under Status. Fill the URL field with the
Webhook URL below. Scroll down and click the Create button.

Webhook URL:

forticasb.com/client/v1/webhook/Jira/gwYEulJptCkDzA43j24XcmdJntYZ... rﬁ

Grant Access @Jira Back

6. In Jira Domain Projects page, click Settings in the upper right hand corner, and select System.

Q Search * QOO .

Settings =

ATLASSIAN ADMIN

User management

[

u Add users, groups, and manage access requests,

‘ Billing 2 e
Update your billing details, manage your subscriptions and more.

‘ .

JIRA SETTINGS

‘ System e
Manage your general configuration, global permissions, look and feel and more.

( L.

7. Inthe left menu, scroll down to the bottom of the page and select Webhooks.
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SHARED ITEMS
Filters
Dashboards
ADVANCED
Attachments

Events

WebHooks

Services

8. Click +Create Webhook.

"Precedence: bulk"

|ssue Picker Auto-complete

JaL Auto-complete

Push notifications (Android, i0Q5)
Contact Administrators Form
Contact Administrators Message
Allow Gravatars

Inline edit

Auto-update search results

9. Fillin a Name for the Webhook, and select Enabled status.

*
Name

Webhook Listener Test

Status *
Enabled
URL*
forticasb.com/client/v1/webhook/Jira/gwYEulptCkDzA43)24
You can use the following additional variables in the URL:
Read more

10. Copy the Webhook URL from FortiCASB Add Jira Account page and paste it in URL field.
11. In Events, check the issue related events as below.

Worklog
created

updated
deleted

User related events

User
created

deleted
updated

12. Click Create to finish.

Entity property
] created or updated

Issue link Issue

[[] created created

[ deleted updated
deleted

Comment Attachment
created created
updated deleted
deleted

13. Go back to FortiCASB Add Jira Account page, and click Grant Access @Jira.
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14. You will be re-directed to Jira OAuth site, click Accept to finish adding the Jira account.

A InUser, it would like to:
View

> me

Jira-App-Test cannot send data to any location

A, Make sure you trust Jira-App-Test

This app is in development mode. Development mode apps may pose a risk to
your personal data. Only proceed if you know and trust the developer. You can
always see and remove access in your Atlassian account,

Authorize for:

.atlassian.net

This 3rd party vendor has not provided a privacy policy. Atlassian's privacy policy is not applicable to the

use of this app.

0 users have consented to using Jira-App-Test on their sites,

m Cance‘

Then you will be re-directed back to FortiCABS. It may take 15 minutes to finish adding
the account. You may check the status in Overview > Dashboard.

Add Jira Account

o Finish Configurations @lJira ° Webhook Set Up ° Done

FortiCASB is adding this account. The process may take up to 15 min.
You can check whether it is successfully added in the Overview > Dashboard.

Check Status
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Update Jira Account

Before updating the Jira account on FortiCASB, complete the same configuration using the same Jira account:

Jira Account Configuration on page 176

After the Jira configuration is completed, follow these steps to update your Jira account on FortiCASB.

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard.
3. Click on Jira account menu and select Update Cloud Account.

o Update Cloud Account

Jira View Account Detail

View Change History

Delete Account

4. Fillin the Jira Site Domain name which the Jira account associates with, Client ID and Client Secret
recorded down from Jira Account configuration. Your Jira site domain name is the site domain prefix.
For example: for https://mydomain.atlassian.net/, the Jira site domain name is "mydomain".

5. Navigate to Settings in the left menu. Scroll down toAuthentication Details, find Client ID and Secret.

Fill the account information in the fields below.
Jira Site Domain =

forticasbjira

You can find your Jira Site Domain in the site URL https://your_site_domain.atlassian.net/.

Client ID =

Secret =

Next Step Cancel

5. Then click Next Step.
6. Clickon the Jiralink to log into the Jira Domain Project page.
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o Finish Configurations @Jira e Webhook Set Up 3  Done

1.Log Tntith the same admin account used in the last step.

a. Click the settings icon at the top right corner and selectSystem. Scroll down to the bottom of the
left menu and selectWebhook.

b. Click Create a Webhook. Enter a name and select Enabled under Status. Fill the URL field with the
Webhook URL below. Scroll down and click the Create button.

Webhook URL:

forticasb.com/client/v1/webhook/Jira/gwYEulptCkDzA43j24XcmdIntYZ... rﬁ

Grant Access @Jira Back

7. In Jira Domain Projects page, click Settings in the upper right hand corner, and select System.

Q Search ®* Q| .

Settings =

ATLASSIAN ADMIN

lUser managemeant &
L Add users, groups, and manage access requests.

Billing [7 ee

Update your billing details, manage your subscriptions and mare.

JIRA SETTINGS

System e
Manage your general configuration, global permissions, look and feel and more.

{
( .
{
{

8. In the left menu, scroll down to the bottom of the page and select Webhooks.
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SHARED ITEMS
Filters
Dashboards
ADVANCED
Attachments

Events

WebHooks

Services

9. Click +Create Webhook.

"Precedence: bulk"

|ssue Picker Auto-complete

JaL Auto-complete

Push notifications (Android, i0Q5)
Contact Administrators Form
Contact Administrators Message
Allow Gravatars

Inline edit

Auto-update search results

10. Fillin a Name for the Webhook, and select Enabled status.

*
Name

Webhook Listener Test

Status *
Enabled
URL*
forticasb.com/client/v1/webhook/Jira/gwYEulptCkDzA43)24
You can use the following additional variables in the URL:
Read more

11. Copy the Webhook URL from FortiCASB Jira Jira Account page and paste it in URL field.
12. In Events, check the issue related events as below.

Worklog
created

updated
deleted

User related events

User
created

deleted
updated

13. Click Create to finish.

Entity property
] created or updated

Issue link Issue

[[] created created

[ deleted updated
deleted

Comment Attachment
created created
updated deleted
deleted

14. Go back to FortiCASB Update Jira Account page, and click Grant Access @Jira.
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15. You will be re-directed to Jira OAuth site, click Accept to finish updating the Jira account.

A InUser, it would like to:
View

> me

Jira-App-Test cannot send data to any location

A, Make sure you trust Jira-App-Test

This app is in development mode. Development mode apps may pose a risk to
your personal data. Only proceed if you know and trust the developer. You can
always see and remove access in your Atlassian account,

Authorize for:

.atlassian.net

This 3rd party vendor has not provided a privacy policy. Atlassian's privacy policy is not applicable to the

use of this app.

0 users have consented to using Jira-App-Test on their sites,

m Cance‘

Then you will be re-directed back to FortiCABS. It may take 15 minutes to finish updat-
ing the account. You may check the status in Overview > Dashboard.

Add Jira Account

o Finish Configurations @lJira ° Webhook Set Up ° Done

FortiCASB is adding this account. The process may take up to 15 min.
You can check whether it is successfully added in the Overview > Dashboard.

Check Status
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Office 365 (Before 24.2.a Update)

FortiCASB offers an API-based approach, pulling data directly from Office 365 via RESTful API. Then
FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently,
FortiCASB combines these data to monitor and track Office 365 user activities, provide DLP Data Analysis for
files on Office 365.

Microsoft Online Apps Integration

Beginning in 2021, the FortiCASB version 21.2 starts supporting multiple Microsoft online apps under the same
Office 365 account.

When you add the Office 365 account on FortiCASB, if you are actively using any of these Microsoft online
apps with the same account, they will be under monitoring and protection by FortiCASB.

Supported Microsoft Online Apps and Details:

Microsoft Online Monitoring Details
Apps

Microsoft Yammer Monitors all chats and shared files.

oy

Microsoft One Drive  Monitors all files shared privately or publicly.

-,

Microsoft Monitors files in Document and "user-created”
Sharepoint Q folders.

Microsoft Teams Monitors all activities, group chats except
* personal chats and shared files.

Azure Active Monitors all user activities.

Directory Hb_

Prerequisites

There are a few prerequisite before adding the Office 365 account on FortiCASB. Please follow the steps
below.

1. Office 365 Account and License on page 188 - Create Office 365 account with
Global Administrator role.
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2. Activate Office 365 Account Audit Log on page 190 - Enable Office 365 Audit
Log to record user activities of the Office 365 account.

3. Add Admin to Sharepoint Site on page 192 - Incorporate protection on Office 365
Sharepoint sites by adding the Office 365 account to the site admin.

4. Add Office 365 Account on page 196- Activate site collection by adding the Office 365
account to FortiCASB.

New Office 365 Users

After the onboarding process is completed, all the Office 365 users under the account will be protected through
Data Scan.

However, when a new Office 365 user is added on the account, the new user's OneDrive data is not proteceted.
Please see New Office 365 User Added After Onboarding on page 203.

Office 365 Account and License

You may use an existing account or create a new account. If you create a new account, wait for at least 24
hours for the new account to take effect before granting access to FortiCASB. If you already have a Office 365
license, check with Determine the type of Office 365 license on page 190 to determine the type of Office 365
license you have.

License Requirement

1. Make sure your office 365 account license plan includes Active Directory integration. FortiCASB
requires Active Directory support for most of its features. The following Office 365 licenses support Active
Directory integration:

a.

SQ -0 20 T

Office 365 Business

Office 365 Business Essentials
Office 365 Business Premium
Office 365 ProPlus

Office 365 Enterprise E1
Office 365 Enterprise E3
Office 365 Enterprise E5
Office 365 Enterprise K1
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2. The Office 365 account Global Administrator role is required to add the Office 365 account to

FortiCASB.

3. Microsoft Entra ID P2 (formerly Azure AD P2) license is recommended. In the absence of Microsoft

Entra ID P2 License, FortiCASB's Discovery feature cannot access user entitlements which leads to the
following errors in the onboarding status. All other major functions on FortiCASB will not be affected.

The Office account doesn't have AzureAD Premium P2 license

The Office account is not a global administrator

Check if the Office AzureAD account register to Webhook
Check if FortiCASB's monitor task is enabled

User entitlements is a feature within FortiCASB that enables you to view the roles and permissions that

each user is entitled with.

There are some features that are dependent on the user entitlements provided by the Microsoft Entra ID

P2 license, for example:

1. Inthe absence of Microsoft Entra ID P2 license, FortiCASB cannot acquire permissions of the Office
365 users. As a result, in Office 365 > Users, the Advanced Permission section of the user will
show "This users has no Advanced Permission" even the user holds a global administrator role.

Cg:-:-\) FortiCloud @ Services ¥ Support ¥

Forti

Version 23.3.a
© QOverview

B DataProtection

1] Office 365

Dashboard
Files
Users
Policy
Alert

Activity

%3 Dropbox

Office 365 / User Detail

Basic Detail

MNarmne CollectionSite

Last Logir No login info provided by Office 365

Advanced Permission

This user has no Advanced Permission.

2. Without the Microsoft Entra ID P2 license, there is no sufficient data that can be retrieved to show
Privileged User in Office 365 > Users.

Office 365 / Users

User Overview

2 Total User 18| (% Privieged User

o Dormant User 18 2. GuestUser 1

Sensitive Files Files Last Login Property

For more information on how to obtain Microsoft Entra ID P2 license, go to:
https://docs.microsoft.com/en-us/azure/active-directory/fundamentals/active-directory-get-started-

premium
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4. Microsoft Enrtra Privileged Identity Management also needs to be activated. For more information,

go to: https://docs.microsoft.com/en-us/azure/active-directory/privileged-identity-management/pim-
configure

Determine the type of Office 365 license

To determine what Office 365 license you have, follow the steps below:

1.

Log into Office 365 account: https://www.office.com/.

Click on Apps button *++ | located on the top-left corner of your Office 365 home screen.
Select Admin, then you will be re-directed to Microsoft 365 admin center.

On the navigation pane, go to Billing > Your Products. It will display your Office 365 license, along with
your Microsoft Entra ID P2 license, if you have purchased it.

Your products

These are products owned by your organization that were bought from Microsoft or 3rd-party providers. Select a product to
manage product and billing settings or assign licenses.

Products  Benefits

4 items O Search

Microsoft products (4)

Product name T Assigned licenses

@ Azure Active Directory Premium P2 S 1 ews on 7/25/2022 Not available

9 Microsoft Power Automate Free 2 10000 © Active Not available

0  Office 365 E1 H 10 9 Not available

0 Office 365 E1 10 1 Not available

Activate Office 365 Account Audit Log

Office 365 audit log needs to be activated to record user and admin activities, this allows FortiCASB to monitor
activities of the Office 365 account. It may take several hours after you turn on audit log before FortiCASB
receives the audit logs from your Office 365 account.

To enable this feature, follow the steps below:

1. Log into Office 365 account as the admin user: https://www.office.com/.
2. Click on Office 365 menu option E and select Admin portal to be re-directed to Microsoft 365 admin
center.
3. In Microsoft 365 admin center, expand the left menu and click on Security, you will be re-directed to
Microsoft 365 Defender page.
FortiCASB 24.3.b Admin Guide 190
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4. In Microsoft 365 Defender, scroll down the left menu and click on Audit.
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*  Protect your employees against advanced email security threats with the Mi:

Microsoft Secure Score

Secure Score: 36.12%

112.34/311 points achieved

Microsoft Secure Score is a representation of your
organization's security posture, and your opportunity to
improve it.

Score last calculated 03/29

100%

50%

5. In Audit, click Start recording and admin activity.
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1. If you do not see this option, that means the organization has already enabled this option.

2. If you are a new tenant, this option can only appear 24 hours after the tenant creation.
6. After turning on auditing, please allow 24 hours for the auditing to become available.

Now you may activate site collection by adding the Office 365 account to FortiCASB.

When you see an error on adding Office 365 to FortiCASB you might need to wait
before auditing is enabled on Office 365 portal.

Add Admin to Sharepoint Site

Before adding your Office 365 admin account to FortiCASB, please verify that the account is one of the
Company Administrators of the Office 365 Sharepoint Sites. This is to ensure that FortiCASB is able to monitor
and protect the account's Sharepoint sites.

1. Log into Office 365 (https://office.com) with your admin account to be added to FortiCASB.

2. Click on App Launcher button at the top left corner, and select Admin.
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3. In Microsoft 365 admin center left navigation menu, click on Show all to show other options. Scroll

Apps

R Outiook
il wora
@ roverroint
B sharepoint
& vormmer
o People

All apps =

Office 365

‘ OneDrive

a Excel
u OneMNote
ﬁ Teams

ﬂ# Admin

Hg]_ Add-Ins

down to Admin Centers and click SharePoint to enter SharePoint admin center.

4. In SharePoint admin center, click on Sites drop down menu, and select Active Sties.

Microsoft 365 admin center

Home

Usars

Groups

Billing

% [ £ © &

Setup

A

Customize navigation

Show all
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SharePoint admin center

SharePoint admin centero

| fmt Home
SharePoint file activity report Datails
B Ssites A
- - Last 30 days as of November 28, 2020 (UTC)

Active sites

Deleted sites “0
=5 Policies e

20
fé; Settings
@ T sz v 11/2/20 11/9/20 11/16/20 11/23/20
O Viewed or edited © Synced Shared internally

> Migration O Shared externally

Moare features

5. InActive sties, under Primary admin column, scroll down to look for "Company Administrator".

Active sites

Use this page to manage all your sites, Learn more

+ Create | Export

O Site name URL Storage used (GB) Primary admin 7 T

Fortinet Team Site 0.0 Company Administrator

6. Click on the Site name of the user shown as "Company Administrator".

Active sites

Use this page to manage all your sites. Learn more

+ Create | Export

Site name URL Storage used (GB) Primary admin " T

Fortinet Team Site 0.01 Company Administrator

7. The Sharepoint site profile dialog will appear, then click on Membership tab.
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8. Click + Add site admins to add your account as a new site admin. In this way, FortiCASB will be able to

Fortinet Team Site
Team site (classic experience)

B View site

General Activity Membership Settings

Site info

Site name
Fortinet Team Site
Edit

Description

MNaone

Created @O

5/5/16 at 12:04 AM
by System Account

Site address

Domain

binxufortinet.sharepoint.com

Hub association
None
Edit

Template

Team site (classic experience)

monitor and protect the sharepoint site after your admin account is added to FortiCASB

Fortinet Team Site
Team site (classic experience)

B View site

General Activity

Site admins

Site owners

Site members

Site visitors

About membership and

permissions

Membership

Settings

- Add site admins

[J  MName
@
- ®

@ Company Administrator — primary

Note: If you want FortiCASB to monitor and protect other Sharepoint sites of the same domain, repeat step 6-

8 with a different Sharepoint site.

FortiCASB 24.3.b Admin Guide

Fortinet Inc.

O Search all membersh...

Email address

195



Cloud Application Onboarding

Add Office 365 Account

After all the Office 365 configurations are completed from previous sections, follow these steps to add your
Office 365 account on FortiCASB.

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard, click on Add New, select Office 365, then click Add Selected Cloud
App.

Business Unit Overview

BUMName QA Test BUID 330239 #of Cloud App 16
] Office 365 Google Workspace
ncluding ncluding
adg s a9
« SRl . " .
b & 4 |
3 ¥ O O
Dropbaox Egnyte GitHub GCP Storage
. ® @gmail com
-
Q Y4 +
bex Teams Zendesk Add New
- -
Select Cloud App to Add X
Google Workspace 1] Office 365 aws
including including .
&0 L LY TR
A box S] < E=2
Azure Storage Box Citrix ShareFile Confluence Dropbox
X @ (v} a) <
Egryt epl: GitHub GCP Storay
& (S — Q
sap1AS vebe

Y
N
. 8
o
3

3. Make sure you have completed all Office 365 configurations, and click Grant Access @Office 365.
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Add Office 365 Account

o Finish Configurations @Office 365 2 ' Done

To successfully add your Office 365 Teams account, please do the following at Office 365 Teams and
refer to the step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:
1. Please make sure the role you use to add the Office 365 account on FortiCASB is Global
Administrator.

2. Turn on Auditing in Office 365 Audit Log. So FortiCASB can receive audit logs and monitor activities
of the Office 365 account.

3. Please make sure the Office 365 account is one of the Company Administrators of the Office 365
Sharepoint Sites. So FortiCASE can monitor and protect Sharepoint's sites of this account.

Please make sure you've finished all configurations above before clicking Grant Access @Office 365
button below.

Grant Access @Office 365 Cancel

You will be redirected to the Office 365 login screen, enter your account password and log in.

4. Afterlogged in, Office 365 will prompt you to accept FortiCASB access. FortiCASB only request partial
permissions from the global administrator user.
Here is the complete list of permissions requested:

Permissions requested by

FortiCASB

Manage access reviews that you can
access

Read applications

Read audit log data

Read consent requests

Read your contacts

Read delegated permission grants
Access the directory as you

Read directory data

Read domains.

Read all files that you have access to

Have full access to all files you have
access to

Read all groups

Read all OneNote notebooks that you

FortiCASB 24.3.b Admin Guide 197
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Permissions requested by
FortiCASB

can access

Maintain access to data you have given
it access to

Read organization information
Read all users’ relevant people lists
Read your organization's policies

Read your organization's conditional
access policies

Read your organization’s identity
protection policy

Read consent and permission grant
policies

Read privileged access to Azure AD

Read privileged access to Azure AD
groups

Read privileged access to your Azure
resources

Read directory RBAC settings

Read your organization's security
actions

Read your organization’s security
events

Have full control of all your site
collections

Create, edit, and delete items and lists
in all your site collections

Read items in all site collections

Edit or delete items in all site collections
Export user's data

Sign you in and read your profile

Read all users' full profiles

Read all users' basic profiles

Read and write user profiles

Read and write your files

FortiCASB 24.3.b Admin Guide
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Permissions requested by

FortiCASB

Have full control of all site collections

Read and write items and lists in all site
collections

Read and write items in all site
collections

Run search queries
Read and write managed metadata
Read activity data for your organization

Read DLP policy events including
detected sensitive data

Read service health information for your
organization

5. Click Accept to grant permissions to FortiCASB. Office 365 may ask you to grant access to FortiCASB
three more times to confirm this process. Afterward, you will be redirected back to FortiCASB.

You can see the installation checklist and status in the Office 365 dashboard

N/ Read items in all site collections

Edit or delete items in all site collections
Export user’s data

Sign you in and read your profile

Read all users’ full profiles

Read all users' basic profiles

Read and write user profiles

Read and write your files

Have full control of all site collections
Read and write items and lists in all site collections
Read and write items in all site collections
Read items in all site collections

Run search queries

Read and write managed metadata

Read activity data for your organization

C LKL

Read DLP policy events including detected sensitive
data

N/ Read service health information for your arganization

D Consent on behalf of your organization

the account to be fully added.

FortiCASB 24.3.b Admin Guide

Fortinet Inc.

. Please allow up to 15 minutes for

199



Cloud Application Onboarding

Last 7 days v

|:| Office 365 wee Alert Overview
Status e Connected Alerts by Severity Alert Trend
500
Cloud Account = - 400 \
Checklist 4/4Pas{ Detail] ( L?;if 300 \ /\
Last Update 8/9/2021,10:4
Check if the Office account has an AzureAD Premium P2 license /
Check if the Office account is a global administrator
Check if the Office AzureAD account register to Webhook
Check if FortiCASB's monitor task is enabled

Document Overview

Update Office 365 Account

Before updating the Office 365 account on FortiCASB, complete the same configurations using the same
Office 365 account:

1. Office 365 Account and License on page 188 - Create Office 365 account with
Global Administrator role.

2. Activate Office 365 Account Audit Log on page 190 - Enable Office 365 Audit
Log to record user activities of the Office 365 account.

3. Add Admin to Sharepoint Site on page 192- Incorporate protection on Office 365
Sharepoint sites by adding the Office 365 account to the site admin.

After the Office 365 configuration is completed, follow these steps to update your Office 365 account on
FortiCASB.

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard.
3. Click on the Office 365 Account menu and select Update Cloud Account.
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I:I Office 365 Update Cloud Account
R View Account Detail
PP TR
. View Change History
Delete Account

4. Make sure you have completed all Office 365 configurations, and click Grant Access @Office 365.

Update Office 365 Account

o Finish Configurations @Office 365 2  Done

To successfully update your Office 365 Teams account, please do the following at Office 365 Teams
and refer to the step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:
1. Please make sure the role you use to update the Office 365 account on FortiCASB is Global
Administrator.

2. Turn on Auditing in Office 365 Audit Log. So FortiCASB can receive audit logs and monitor activities
of the Office 365 account.

3. Please malke sure the Office 365 account is one of the Company Administrators of the Office 365
Sharepoint Sites. So FortiCASB can monitor and protect Sharepoint’s sites of this account.

Please make sure you've finished all configurations above before clicking Grant Access @Office 365
button below.

Grant Access @Office 365 Cancel

You will be redirected to the Office 365 login screen, enter your account password and log in.
5. Afterlogging in, Office 365 will prompt you to accept FortiCASB access.

Note: FortiCASB does not request all but only partial permissions from the global administrator user.

Below is a list of permissions requested by FortiCASB.

FortiCASB 24.3.b Admin Guide
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Permissions requested
Accept for your organi

FortiCASB
App infa

This app would like to:

Read and write files in all site collectic
Read items in all site collections (prev
Read files in all site collections

Read and write all users' full profiles
Read all users’ full profiles

Read and write items in all site collect
Read all users’ full profiles

Read and write all users' full profiles
Read all groups

Read and write all groups

Read directory data

Read and write directory data

Access directory as the signed in user
Read all files that user can access
Have full access to all files user can ac
Read items in all site collections
Read all groups

Read and write all groups

Read directory data

Read and write directory data

Read activity reports for your organizi
Read activity data for your organizatic

Sign in and read user profile

CL 00 KL

Read directory data

I you accept, this app will get access to the
resources for all users in your organization,
be prompted to review these permissions.

Accepting these permissions means that yo
to use your data as specified in their terms
privacy statement. The publisher has not pr
their terms for you to review, You can chan
permissions at hitps./myapps.microsoft.col

Cancel
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Permissions
requested
by
FortiCASB

Read and
write files in
all site
collections

Read items in
all site
collections
(preview)

Read files in
all site
collections

Read and
write all users'
full profiles

Read all
users' full
profiles

Read and
write items in
all site
collections
(preview)

Read all
users' full
profiles

Read all
groups

Read and
write all
groups

Read
directory data

Read and
write directory
data

Access
directory as
the signed in
user
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6. Office 365 may ask you to grant access to FortiCASB 3 more times then you will be redirected back to

FortiCASB.

You can see the installation checklist and status in the Office 365 dashboard. Please allow up to 15 minutes for

the account to be fully updated.

New Office 365 User Added After Onboarding

When a new Office 365 user is added to the Office 365 account after the onboarding process. The new user's
OneDrive data is not accessible, thus the new user's OneDrive data do not have data scan feature.

SharePoint Site data has similar issue.

FortiCASB 24.3.b Admin Guide
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directory data
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Data 5can Status

© Insuficient Permissions
© Insufficient Permissions
& Insufficient Permissions
© Insutficient Permissions

© Insuficient Permissions

Owner

Highlight

Insufficient Permissions: Office 365 account user
used for onboarding is not one of the One Drive/
SharePoint Site Collection Administrators.

OneDrive Solution- The Office 365 service account user (the account that was used in the onboarding
process) needs to be added to the new user's OneDrive Site Collection Administrator through the FortiCASB
account update process or it needs to be manually updated in the new Office 365 user's OneDrive setting.
Please follow the instruction in Insufficient Permissions(Access Denied) Error (One Drive) on page 541

SharePoint Site Solution - The Office 365 service account user (the account that was used in the onboarding
process) needs to be added to the SharePoint Site admin group through the FortiCASB account update process
or it needs to be manually updated in the SharePoint Site Admin Center. Please follow the instruction in
Insufficient Permissions(Access Denied) Error (SharePoint) on page 544

Office 365 (After 24.2.a Update)

FortiCASB offers an API-based approach, pulling data directly from Office 365 via RESTful API. Then
FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently,
FortiCASB combines these data to monitor and track Office 365 user activities, provide DLP Data Analysis for

files on Office 365.

FortiCASB 24.3.b Admin Guide
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After 24.2.a update, Office 365 performance has been improved by supporting higher rates of files scanning by
using a dedicated service account instead of a user account. A client application needs to be registered in
Microsoft Entra ID on Azure to onboard Office 365.

Microsoft Online Apps Integration

Beginning in 2021, the FortiCASB version 21.2 starts supporting multiple Microsoft online apps under the same
Office 365 account.

When you add the Office 365 account on FortiCASB, if you are actively using any of these Microsoft online
apps with the same account, they will be under monitoring and protection by FortiCASB.

Supported Microsoft Online Apps and Details:

Microsoft Online Monitoring Details
Apps

Microsoft Yammer Monitors all chats and shared files.

oy

Microsoft One Drive  Monitors all files shared privately or publicly.

-,

Microsoft Monitors files in Document and "user-created”
Sharepoint Q folders.

Microsoft Teams Monitors all activities, group chats except
* personal chats and shared files.

Azure Active Monitors all user activities.

Directory Hb_

Prerequisites

There are a few prerequisite before adding the Office 365 account on FortiCASB. Please follow the steps
below.

1. Office 365 Account and License on page 206 - The Office 365 account and license
requirements in adding the account in FortiCASB.

2. Activate Office 365 Account Audit Log on page 208 - Enable Office 365 Audit
Log to record user activities of the Office 365 account.

FortiCASB 24.3.b Admin Guide 205
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3. Register FortiCASB with Microsoft Identity Platform on page 210-

Register an application on Microsoft Azure |dentity Management platform for Office 365 account
onboarding.

4. Add Office 365 Account on page 214- Activate site collection by adding the Office 365
account to FortiCASB.

Office 365 Account and License

You may use an existing account or create a new account. If you create a new account, wait for at least 24
hours for the new account to take effect before granting access to FortiCASB. If you already have a Office 365
license, check with Determine the type of Office 365 license on page 207 to determine the type of Office
365 license you have.

License Requirement

1. Make sure your office 365 account license plan includes Active Directory integration. FortiCASB
requires Active Directory support for most of its features. The following Office 365 licenses support Active
Directory integration:

a. Office 365 Business

Office 365 Business Essentials
Office 365 Business Premium
Office 365 ProPlus

Office 365 Enterprise E1
Office 365 Enterprise E3
Office 365 Enterprise E5
Office 365 Enterprise K1

2. Microsoft Entra ID P2 (formerly Azure AD P2) license is recommended. In the absence of Microsoft
Entra ID P2 License, FortiCASB's Discovery feature cannot access user entitlements which leads to the
following errors in the onboarding status. All other major functions on FortiCASB will not be affected.

SQ 0 20T

The Office account doesn't have AzureAD Premium P2 license

Check if the Office AzureAD account register to VWebhook
Check if FortiCASE's monitor task is enabled
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User entitiements is a feature within FortiCASB that enables you to view the roles and permissions that
each user is entitled with.

There are some features that are dependent on the user entitlements provided by the Microsoft Entra ID
P2 license, for example:

1. Inthe absence of Microsoft Entra ID P2 license, FortiCASB cannot acquire permissions of the Office
365 users. As a result, in Office 365 > Users, the Advanced Permission section of the user will
show "This users has no Advanced Permission" even the user holds a global administrator role.

cg:?) FortiCloud @ Services v @ Support

My Forti ; .
o Johainiea Office 365 / User Detail
© QOverview
Basic Detail
B DataProtection
1] Office 365 Name CollectionSite
Dashboard Emai
Files Last Logir Mo login info provided by Office365
Users
Policy
Alert Advanced Permission
Activity
%3 Dropbox This user has no Advanced Permission.

2. Without the Microsoft Entra ID P2 license, there is no sufficient data that can be retrieved to show
Privileged User in Office 365 > Users.

Office 365 / Users

User Overview

2 TotalUser 18

ssssssssssssssssssssssssssssssssss

3 CASB Fortinet o o 0 -0

For more information on how to obtain Microsoft Entra ID P2 license, go to:
https://docs.microsoft.com/en-us/azure/active-directory/fundamentals/active-directory-get-started-
premium

Microsoft Enrtra Privileged Identity Management also needs to be activated. For more information,
go to: https://docs.microsoft.com/en-us/azure/active-directory/privileged-identity-management/pim-
configure

Determine the type of Office 365 license

To determine what Office 365 license you have, follow the steps below:

1.

Log into Office 365 account: https://www.office.com/.

Click on Apps button *++ | located on the top-left corner of your Office 365 home screen.
Select Admin, then you will be re-directed to Microsoft 365 admin center.
On the navigation pane, go to Billing > Your Products. It will display your Office 365 license, along with

FortiCASB 24.3.b Admin Guide
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your Microsoft Entra ID P2 license, if you have purchased it.
Your products

These are products owned by your organization that were bought from Microsoft or 3rd-party providers. Select a product to
manage product and billing settings or assign licenses.

Products  Benefits

Microsoft products (4)

Product name T Assigned licenses  Purchased quantity  Subscription status

@ Azure Active Directory Premium P2 : 1 1 @ Active: Renews on 7/25/2022
9 Microsoft Power Automate Free 2 10000 © Active

0 Office 365 E1 o El

0 Office 365 E1 HE 1 1

Activate Office 365 Account Audit Log

Office 365 audit log needs to be activated to record user and admin activities, this allows FortiCASB to monitor
activities of the Office 365 account. It may take several hours after you turn on audit log before FortiCASB

receives the audit logs from your Office 365 account.

To enable this feature, follow the steps below:

1. Log into Office 365 account as the admin user: https://www.office.com/.

2. Click on Office 365 menu option E and select Admin portal to be re-directed to Microsoft 365 admin

center.

3. In Microsoft 365 admin center, expand the left menu and click on Security, you will be re-directed to

Microsoft 365 Defender page.

FortiCASB 24.3.b Admin Guide
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Learn how to manage Teams for remote work, with setup guidance, short

videos, and tips. @  Syncerrors: Object errors found at 12:06 PM

4. In Microsoft 365 Defender, scroll down the left menu and click on Audit.
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Assets

Devices

Endpoints

Vulnerability management

Partners and APls

Evaluation & tutorials

Configuration management

Email & collaboration

Investigations

Explorer

Review

Campaigns

Threat tracker

Exchange message trace

Policies & rules

b Reports
52 Audit
% Health

Microsoft 365 Defender

p Search

-'\ b }‘.

*  Protect your employees against advanced email security threats with the Mi:

Microsoft Secure Score

Secure Score: 36.12%

112.34/311 points achieved

Microsoft Secure Score is a representation of your
organization's security posture, and your opportunity to
improve it.

Score last calculated 03/29

100%

50%

5. In Audit, click Start recording and admin activity.
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-—

If you do not see this option, that means the organization has already enabled this option.
2. If you are a new tenant, this option can only appear 24 hours after the tenant creation.
6. After turning on auditing, please allow 24 hours for the auditing to become available.

Now you may activate site collection by adding the Office 365 account to FortiCASB.

When you see an error on adding Office 365 to FortiCASB you might need to wait
before auditing is enabled on Office 365 portal.

Register FortiCASB with Microsoft Identity Platform

In order to use identity and access management compatibilities of Microsoft Entra ID in accessing Office 365
resources, a registered FortiCASB application needs to be created first in the Microsoft Entra admin center.

Prerequisite

A Microsoft Entra ID tenant.

An Office 365 account that has Global Administrator role.

FortiCASB Application Registration

1. Signin to Microsoft Entra Admin Center with an account that has Global Administrator role.

2. If you have multiple tenants, click on Settings icon in the top menu, then go to Directories +
subscriptions to select the tenant which will register the application with.
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Portal settings | Directories + subscriptions

| Search menu

Directories + subscriptions

Appearance + startup views

Language + region

My information

Signing out + notifications

All services and resources across the Azure portal will inherit the sele

Default subscription filter (0

Mo subscriptions in fortinet (casbgal.enmicresoft.com) directory -
Switch to another directory.

Directories &
Switching directaries will reload the portal. The directory you choose

Current directory (D : fortinet (casbgal.onmicrosoft.com)

Canemritor Al Miractorioe

3. Inthe Azure search field, search and go to App registrations.

I 2 app registrations

3

All Services (38)

services

Resources

i App registrations

~ More (4)

LA
i
it
]
[}
m

4. Click New registration to create a new app registration.

o

Enter a name for the application.

6. In Supported account types, select "Accounts in this organizational directory only"to make the
application only available to users under the same tenant.

Supported account types

Who can use this application or access this API?

@ Accounts in this organizational directory only (fortinet only - Single tenant)

O Accounts in any organizational directory (Any Microsoft Entra ID tenant - Multitenant)

O Accounts in any organizational directory (Any Microsoft Entra ID tenant - Multitenant) and personal Microsoft accounts (e.g. Skype,

Khox)

O Personal Microsoft accounts only

7. Do not enter anything for Redirect URI (optional).

8. Click Register to complete the app registration.

9. After the registration is completed, you will be re-directred to the app registration's Overview pane, record

down Application (client) ID and Directory (tenant) ID.
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# Essentials

Display name : Office365leastpermission

Application (client) ID
Object 1D
Directory (tenant) ID

Supported account types : My organization only

10. From the side panel, click Certificates & secrets to see Client secrets pane. If you have not setup a

client secret yet, create a client secret and record down the Value.

Certificates (0] Client secrets (1) Federated credentials (0}

& secret string that the application uses to prove its identity when requesting a token. Also can be referred to as application password.

Mew client secret

Description Expires Value @

5/22/2026

bpn Ao RS R R R R

Continue to Add APl Permissions on page 212 to finish the rest of the configurations.

Add API Permissions

1. Click on APl Permissions from the side panel to add API permissions.

Secret ID

2. Click +Add a permission and select Microsoft Graph then select Application permissions type.

- Office365leastpermission | APl permissions =

Q'j Got feedback?

e

'C' Refrash

|f’ Search ‘ i«

= Overview

& Quickstart Configured permissions

i Integration assistant

Manage

= Eranding & properties

Applications are authonzed to call APls when they are granted permiss
all the permissions the application needs. Learn more about permissior

Add a permission | ~ Grant admin consent for fortinet

3. Search for the Microsoft Graph permissions from the table below and add them.
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Select permissions expand all
£ directory.read.all *
Permission Admin consent required

~  Directory (1)

- Directory.Read.All @
} Yes
Read directory data

4. Click +Add a permission again and select Office 365 Management APls, then select Application
permissions type.

5. Search for the Office 365 Management APls permissions from the table below and add them.

6. Click Grant admin consent for fortinet to grant consent for the API permissions for all Office 365
account users under the same tenant.

Configured permissions

Applications are authorized to call APls when they are granted permissions by users/admil
all the permissions the application needs. Learn more about permissions and consent

Add a permiszionl ~" Grant admin consent for fortinet

Office 365 Man-

Microsoft Graph agement APIs

ActivityFeed.Rea

Directory.Read.All d

ActivityFeed.Rea

Domain.Read.All dDIp

Files.ReadWrite.All ServiceHealth.R
ead

Group.Read.All

GroupMember.Read.All

PrivilegedAccess.Read.AzureA
D

PrivilegedAccess.Read.AzureR
esources

Sites.ReadWrite.All
User.Read
User.Read.All
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Microsoft Graph

InformationProtectionPolicy.Re
ad.All (This API permission is for
Azure Information
Protection)

Office 365 Man-
agement APIs

Make sure all the API permissions are in Granted for fortinet(tenant) status.

APl / Permissions name Type

~ Microsoft Graph (10)

Description

Directory.Read.All Application
Domain.Read.All Application
Files.ReadWrite.All Application
Group.Read.All Application
GroupMember.Read Al Application
PrivilegedAccessRead.AzureAD  Application
PrivilegedAccess Read. AzureRes: Application
Sites.ReadWrite All Application
User.Read Delegated

User.Read All Application

v Office 365 Management APz (3)

ActivityFeed Read Application
ActivityFeed.ReadDip Application
SenviceHealth.Read Application

Add Office 365 Account

After all the Office 365 configurations are completed from previous sections, follow these steps to add your

Read directory data

Read domains

Read and write files in all site collections
Read all groups

Read all group memberships

Read privileged access to Azure AD roles
Read privileged access to Azure resources
Read and write items in all site collections
Sign in and read user profile

Read all users’ full profiles

Read activity data for your organization
Read DLP policy events including detected sensitive data

Read service health information for your organization

Office 365 account on FortiCASB.

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard, click on Add New, select Office 365, then click Add Selected Cloud

App.
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Status

Yes

Yes

Yes

Yes

Yes

Yes

Yes

@ Granted for fortinet
@ Granted for fortinet
@ Granted for fortinet
@ Granted for fortinet
@ Granted for fortinet
@ Granted for fortinet
@ Granted for fortinet
@ Granted for fortinet
@ Granted for fortinet

@ Granted for fortinet

@ Granted for fortinet
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Business Unit Overview

BU MName QA Test BUID 330239 #of Cloud App 14
] Office 365 Google Workspace
including including
ot o X

.

33 Y (9] a)

Drophax Eznyte GitHub GCP Storage
 @gmail.com

Q i i

Webex Teams Zendesk Add New

Select Cloud Appto Add

Google Workspace 1] Office 365 aWS7
including including
P PPN Awss3
A box S] 4 3
AzureStorage Bax Citrixsharefile Confluence Dropbax
X @ (v} a) L4
Eanyt Workplsce Github P storage s
& & (o] Q
salestorce sapias ServiceNow Webex Teams
yi4 zoom
Zendesk Zoom
Cancel

3. Click Next Step if you have completed the Activate Office 365 Account Audit Log on page 208 and
Register FortiCASB with Microsoft Identity Platform on page 210.
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Add Office 365 Account

o Finish Configurations @ Office 365 2 Register An Application 3 Done

To successfully add the Office365 account, please refer to the step-by-step tutorials
and finish the following configurations at Office365:

Here is a summary of key configurations that need to be accomplished:

1. An Office 365 Global Administrator user is required to create App Registration on
Microsoft Azure AD and grant permission.

2. Turn on Auditing in Office 365 Audit Log. So FortiCASB can receive audit logs and
monitor activities of the Office 365 account.

Please make sure you've finished all configurations above before clicking the Next
button below.

Next Step Cancel

4. Fillin Application (client) ID, Directory (tenant) ID, and Client Secret Value that you have recorded
down from App Registration Creation.

As the second step, please register an application at Office 365 for FortiCASB, and
fill in the Application ID, Directory ID and Client Secret.

Please refer to the step-by-step tutorials to see how to register application.

Application (client) ID =

Directory (tenant) ID +

Client Secret

5. Click Grant Access @Microsoft to complete the add account process.

You will be redirected to Office 365 dashboard with account status. The Cloud Account value will be shown
as the Office 365 tenant ID. Please allow up to 15 minutes for the account to be fully added.
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|] Office 365 Alert Overview
Status & Connected Alerts by Severity Alert Trend
7,000
I Cloud Account faléabde- ' 6,000 ;'Il
Primary Domain { 13277 5,000 I|,-"l
Checklist 3/3 Pass Detail 1 Aerts 4000 |
Last Update 5/24/2024,4:5

“ Check if the Office account has an AzureAD Premium P2 license /
“ Check if the Office AzureAD account register to Webhook
“ Check if FortiCASB's monitor task is enabled

23

Update Office 365 Account

Before updating the Office 365 account on FortiCASB, complete the same configurations using the same
Office 365 account:

1. Office 365 Account and License on page 206 - The Office 365 account and license
requirements in adding the account in FortiCASB.

2. Activate Office 365 Account Audit Log on page 208 - Enable Office 365 Audit
Log to record user activities of the Office 365 account.

3. Register FortiCASB with Microsoft Identity Platform on page 210-

Register an application on Microsoft Azure Identity Management platform for Office 365 account
onboarding.

After the Office 365 configuration is completed, follow these steps to update your Office 365 account on
FortiCASB.

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard.

3. Click on the Office 365 Account menu and select Update Cloud Account.
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I:I Office 365 Update Cloud Account
el View Account Detail
P >
. View Change History
Delete Account

4. Make sure you have completed all Office 365 configurations, and click Next Step.

Update Office 365 Account

o Finish Configurations @Office 365 2  Register An Application 2 Done

To successfully update the Office365 account, please refer to the step-by-step tutorials
and finish the following configurations at Office365:

Here is a summary of key configurations that need to be accomplished:

1. An Office 3465 Global Administrator user is required to create App Registration on
Microsoft Azure AD and grant permission.
2. Turn on Auditing in Office 365 Audit Log. So FortiCASE can receive audit logs and

monitor activities of the Office 3465 account.

Please make sure you've finished all configurations above before clicking the Next button

below.

5. Fillin Application (client) ID, Directory (tenant) ID, and Client Secret Value that you have recorded
down from App Registration Creation.

FortiCASB 24.3.b Admin Guide 218
Fortinet Inc.



Cloud Application Onboarding

As the second step, please register an application at Office 365 for FortiCASB, and
fill in the Application ID, Directory ID and Client Secret.

Please refer to the step-by-step tutorials to see how to register application.

Application (client) ID =

Directory (tenant) ID *

Client Secret *

6. Click Grant Access @Microsoft to complete the add account process.

You can see the installation checklist and status in the Office 365 dashboard. Please allow up to 15 minutes for
the account to be fully updated.

Salesforce

FortiCASB offers an API-based approach, pulling data directly from Salesforce via RESTful API. Then
FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently,
FortiCASB combines these data to monitor and track Salesforce user activities, provides DLP Data Analysis for
files stored on Salesforce.

Prerequisites

FortiCASB supports Salesforce Small Business Essentials edition (the API is enabled by default), other
editions are not supported.

The user account added on FortiCASB must have the following permissions:

« View All Data
« View All Users
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« API Enabled

You may either use an existing account or create a new account. If you create a new account, wait at least 24
hours for the new account to take effect before granting access to FortiCASB.

The following features require "Manage Users" permission as well:
« Userlogin tracking

ﬂ « User IP address tracking
I « Geographical location tracking
« User password change tracking

Without "Manage Users" permissions, FortiCASB cannot obtain user login IPs.
Therefore, any user activity will not appear on the Activity map.

After you have verified the account prerequisite, follow the guides below to Add or Update the account on
FortiCASB:

Add Salesforce Account on page 220

Update Salesforce Account on page 223

Add Salesforce Account

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard, click on Add New, select Salesforce, then click Add Selected Cloud
App.
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Business Unit Overview

BU MName QA Test BUID 330239 #of Cloud App 14

] Office 365 Google Workspace
including

including
ot &

.

B ¥ v} 2

Dropbaox GCP Storage

.  @gmail.com
wss ses
-
Q 4 +
Webex Teams Zendesk Add New
. . h .
Select Cloud Appto Add *
Google Workspace 1] Office 365 aws
including including
) Awss3
-
A box S] X E=2
Agurestarage Bax Citrix ShareFile Confluence Dropbax
0
X @ (v a) A2
Eamyte Workplace GitHub Gep storage sira
oo o
sAPIAS Webex Teams
yi4 zoom
Zendesk Zoom

Cancel

3. Click Grant Access @Salesforce to be re-directed to Salesforce for authentication.
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Add Salesforce Account

o Finish Configurations @Salesforce 2 ' Done

To successfully add your Salesforce account, navigate to either site for authentication:

© https://login.salesforce.com

O Or use custom domain

Grant Access @Salesforce Cancel

4. Loginto authenticate. If you have a custom Salesforce domain, enter it here.

salesforce

Username

Password

] Remember me

Forgot Your Password? Use Custom Domain

Not a customer? Try for Free

Salesforce will prompt you to allow or deny access.
5. Click Allow to grant FortiCASB permissions to monitor your Salesforce application.

After you click Allow, you will be redirected back to the FortiCASB dashboard.

You can check the installation result and SaaS platform monitoring status in the Salesforce dashboard.
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ﬂ For more information on common installation issues, see "Troubleshooting on page
)\ 531"

Update Salesforce Account

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard
3. Click on the Salesforce account menu, and select Update Cloud Account.

@ Update Cloud Account

View Account Detail

Salesforce

® casbtestus@fortinet. View Change History

Delete Account

4. Click Grant Access @Salesforce to be re-directed to Salesforce for authentication.

Update Salesforce Account

o Finish Configurations @Salesforce 2  Done

To successfully update your Salesforce account, navigate to either site for authentication:

© htips://login.salesforce.com

(O Or use custom domain

Grant Access @Salesforce Cancel

5. Login to authenticate. If you have a custom Salesforce domain, enter it here.
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salesforce

Username

[ Remember me

Forgot Your Password? Use Custem Daomain

Not a customer? Try for Free

Salesforce will prompt you to allow or deny access.
6. Click Allow to grant FortiCASB permissions to monitor your Salesforce application.

After you click Allow, you will be redirected back to the FortiCASB dashboard.

You can check the installation checklist and platform monitoring status in the Salesforce Dashboard.

\{ For more information on common installation issues, see "Troubleshooting on page

531"

SAP IAS

FortiCASB offers an API-based approach, pulling data directly from SAP IAS via RESTful API. Then FortiCASB
portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently, FortiCASB
combines these data to monitor and track SAP IAS user activities such as logins, user assignments, updates
and etc.
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Prerequisite

The SAP IAS application needs to be hosted in the SAP infrastructure to add the SAP IAS account to
FortiCASB. A System Administrator needs to be created under the SAP IAS account to provide FortiCASB
with access to the account.

After you have verified the account prerequisite, follow the guides below to Add or Update the account on
FortiCASB:

Add SAP IAS Account on page 225

Update SAP IAS Account on page 230

Add SAP IAS Account

1. Loginto SAP IAS Administration Console, keep a record of the Tenant ID and the IAS Region.

w Cloud Identity Services| [Germany/Netherlands] :

(@ Home & Users & Authorizations ~ [ Applications & Resources v ¥ Identity Providers & Monitoring & Reporting

Users & Authorizations

8 = 1 3 8 4 :.i; 2 2 :+ ‘-» ﬂ:g 0

User Management User Groups Administrators Import Users Export Users Real-Time
Provisioning

Export the existing users in

Import new users or update

Configure target systems for
Manage user accounts Manage user groups Configure Authorizations existing users

real-time user provisioning

2. Inthe top menu, go to Users & Authorization > Administrators. Click Add in the top Administrators
section, and select Systems.
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@ Cloud Identity Services [Germany/MNetherlands]

(@) Home & Users & Authorizations [= Applications & Resources v +¥ Identity Providers

Administrators Add

Search
& Julian Petersohn m
&  Allen Wang >
&8 test admin >
& Test admin User >

3. In Add Administrator > System Details, Give it a System Display name, turn all Configure
Authorizations to ON, and click Save.

System Details

System Display Name

Name:* forticasb_sap_test

Configure Authorizations

Manage Applications

Authorizations to configure applications

oN Manage Corporate Identity Providers
Authorizations to configure corporate identity providers

Manage Users
Authorizations to manage, export, and import users
Read Users
Authorizations to read and export users
Manage Groups

Authorizations to manage user groups

Manage Tenant Configuration
Manage tenant configuration and authorization assignment to users

4. Now in Configure System Authentication, click Secrets to configure new secret for the system
authentication.
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S forticasb_sap_test

Configure System Authentication

Certificate

Not Configured >
Configure system certificate for authentication.

Secrets
Manage secrets for system authentication

Not Configured >

5. Click +Add to add a new secret.
Secrets @

Actions

Description Hint Expiration

No secrets configured

6. In Add Secret pop up screen, enter a description and select an expiration duration, and click Save.

Add Secret

Description:

Horecast SAP IAS test

Expire in:

MNewver

Save Cancel

7. The new Client ID and Secret will be generated. Keep a record of them later for as you will not be able to
see them again. They will be used as System Client ID and System Client Secret.

Make sure you save your client secret. You will not be able to retrieve it from the system later.

&\ Make sure you save your client secret. You will not be able to retrieve it from the system later.

Client ID:

Client Secret:

8. Now in the top navigation menu, go to Monitoring & Reporting > Audit and Change Logs
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[= Applications & Resources w +% Identity Providers I&] Monitoring & Reporting ~

Add & reporting

I[E: Audit and Change Logs I

Q @ forti| (@l TroubLe_shootin% Lo_gs st

>

>
>
9. Click +Generate to generate client credentials for audit logs.
Audit and Change Logs
Generate Client Credentials for Audit Logs

Generate Client ID and Client Secret for audit logs. The generated credentials are used to call the methods of the audit log retrieval API.

Client ID

10. The new audit log Client ID and Secret will be generated. Keep a record of them as you will not be able to
see them again. They will be used as Audit Logs Client ID and Audit Logs Client Secret later to add
the account in FortiCABS.

Client Credentials
&\ Make sure you save your client secret. You will not be able to retrieve it from the system later.

Client ID: ool fol . Col il mcim i
Client Secret:

11. Now go back to FortiCASB Add SAP IAS Account page.
12. Click Next Step on Add SAP IAS Account Page.
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2. Locate the system you just added. Under Configure System Authentication, click Secrets.
In the Secrets section, click + Add.

a. ATTENTION: After the secret is saved, keep a record of the Client ID and Client Secret
as your System Client ID and System Client Secret for the next step.

3. Inthe top navigation, go to Monitoring & Reporting > Audit and Change Logs, click +
Generate.

a. ATTENTION: Keep a record of the generated Client ID and Client Secret as your Audit
Logs Client ID and Audit Logs Client Secret for the next step.

Please make sure you've finished all configurations above before clicking Next button
below.

Next Step Cancel

13. Enter System Client ID, System Client Secret, Audit Logs Client ID, Audit Logs Client Secret,
and select the Region saved from earlier steps.

Tenant 1D

System Client ID

System Client Secret

Audit Logs Client ID
Audit Logs Client Secret

Region

Europe -eul.hana.ondemand.c... -

Add SAP IAS Account

14. Click Add SAP IAS Account to finish.

You can check the installation checklist and platform monitoring status in the SAP IAS Dashboard.
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Update SAP IAS Account

1. Log into SAP IAS Administration Console, keep a record of the Tenant ID and the IAS Region.

w Cloud Identity Services| [Germany/Netherlands] :

(@ Home £ Users & Authorizations ~ = Applications & Resources v % Identity Providers & Monitoring & Reporting ~

Users & Authorizations
& 13 8 4 & 22 & 2. e 0

User Management User Groups Administrators Import Users Export Users Real-Time
Provisioning

Export the existing users in
Import new users or update the tenant of Identity Configure target systems for
Manage user accounts Manage user groups Configure Authorizations existing users Authentication service real-time user provisioning

2. Inthe top menu, go to Users & Authorization > Administrators. Click Add in the top Administrators
section, and select Systems.

w Cloud Identity Services [Germany/Netherlands]

(@ Home & Users & Authorizations v [= Applications & Resources v +¥ Identity Providers

Administrators Add

System

Search

&8 Julian Petersohn

£ Allen Wang >
& test admin >
& Test admin User >

3. In Add Administrator > System Details, Give it a System Display name, turn all Configure
Authorizations to ON, and click Save.
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System Details

System Display Name

Name:* forticasb_sap_test

Configure Authorizations

o Manage Applications
Authorizations to configure applications

!

Manage Corporate Identity Providers
Authorizations to configure corporate identity providers
Manage Users
Authorizations to manage, export, and import users
Read Users
Authorizations to read and export users
Manage Groups
Authorizations to manage user groups
Manage Tenant Configuration

Manage tenant configuration and authorization assignment to users

4. Now in Configure System Authentication, click Secrets to configure new secret for the system
authentication.

S forticasb_sap_test

Configure System Authentication

Certificate
Configure system certificate for authentication.

Not Configured >

Secrets
Manage secrets for system authentication

Not Configured >

5. Click +Add to add a new secret.

Secrets @

Description Hint Expiration Actions

Mo secrets configured.

6. In Add Secret pop up screen, enter a description and select an expiration duration, and click Save.
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Add Secret
Description:
Horecast SAP IAS test e
Expire in:
Mewver w

Save Cancel

7. The new Client ID and Secret will be generated. Keep a record of them later for as you will not be able to
see them again. They will be used as System Client ID and System Client Secret.

Make sure you save your client secret. You will not be able to retrieve it from the system later.

& Make sure you save your client secret. You will not be able to retrieve it from the system later.

Client ID:

Client Secret:

8. Now in the top navigation menu, go to Monitoring & Reporting > Audit and Change Logs

Ei] Applications & Resources v I 4 Identity Providers - E Meonitoring & Reporting w

Add E Reporting

Iﬁ Audit and Change Logs I

Q @ forti| @ Trouble_shooting_ Lo_gs st

>

>
>

9. Click +Generate to generate client credentials for audit logs.
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Audit and Change Logs

Generate Client Credentials for Audit Logs

Generate Client ID and Client Secret for audit logs. The generated credentials are used to call the methods of the audit log retrieval API.

Client ID

10. The new audit log Client ID and Secret will be generated. Keep a record of them as you will not be able to
see them again. They will be used as Audit Logs Client ID and Audit Logs Client Secret later to
update the account in FortiCABS.

Client Credentials

&\ Make sure you save your client secret. You will not be able to retrieve it from the system later.

Client ID: co ool Lo fit el mcia v i
Client Secret:

11. Now go back to FortiCASB Update SAP IAS Account page.
12. Click Next Step on Update SAP IAS Account Page.

2. Locate the system you just added. Under Configure System Authentication, click Secrets.
In the Secrets section, click + Add.

a. ATTENTION: After the secret is saved, keep a record of the Client ID and Client Secret
as your System Client ID and System Client Secret for the next step.

3. In the top navigation, go to Monitoring & Reporting > Audit and Change Logs , click +
Generate.

a. ATTENTION: Keep a record of the generated Client ID and Client Secret as your Audit
Logs Client ID and Audit Logs Client Secret for the next step.

Please make sure you've finished all configurations above before clicking Next button
below.

Next Step Cancel

13. Enter System Client ID, System Client Secret, Audit Logs Client ID, Audit Logs Client Secret,
and select the Region saved from earlier steps.
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Tenant 1D

System Client ID

System Client Secret

Audit Logs Client ID
Audit Logs Client Secret

Region

Europe -eul.hanaondemand.c... ~

Update SAP IAS Account

14. Click Update SAP IAS Account to finish.

You can check the installation checklist and platform monitoring status in the SAP IAS Dashboard.

SAP Success Factors

FortiCASB offers an API-based approach in integrating with SAP Success Factors, pulling data directly from
SAP Success Factors via RESTful API. Authentication is done through OAUth2.0. FortiCASB uses an access
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token for API queries. FortiCASB monitors and tracks SAP Success Factors user activities, provides DLP Data
Analysis for files shared on the platform.

Follow one of the following guide to Add or Update the SAP Success Factors Account
Add SAP Success Factors Account on page 235

Update SAP Success Factors Account on page 242

Add SAP Success Factors Account

Step 1. Register OAuth Client Applicaiton on page 235
Step 2. Set Permission Scope on page 237
Step 3. Add SAP Success Factors Account on FortiCASB on page 239

Step 1. Register OAuth Client Applicaiton

1. Loginto SAP Success Factors and go to Admin Center. In the Tools box, search and go to Manage
OAuth2 Client Applications.

B eSt A‘_}-T - Admin Center

Admin Center

Tools See All Admin Alerts 2.0 See More

| |Search Tools

Time Management
| Manage OAuthZ Client Applications |

Time Valuation

Empl Export
% Employee Expo Recalculate Accruals

¥ Import Employee Data

Recalculate Absences

Import Time Sheets

Intelligent Services Center (ISC) See More

2. In Manage OAuth2 Client Applications, click Register Client Application to register a new OAuth2
Client Application.

3. Fillin an application name, e.g. FortiCASB Integration, then in Application URL, enter a url, e.g.
https://www.forticasb.com/.

Workflow

Stalled Workflows - Employee Related
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At the bottom of the page, click Generate X.509 Certificate to register a certificate.

Back to Admin Tools

Manage OAuth2 Client Applications

Register a new OAuth Client Application(* Required Fields)

Company |SFCPART000289 |

“Application Name |gotiCASB Integration |

Description

*Application URL  |https:siw forticasb.com/ |

Bind to Technical User [_]

Technical User ID ‘ ‘

*X.509 Certificate

Generate X.509 Certificate Cancel

4. In "Self Assign a new X.509 Certificate" page, enter a Common Name for the certificate, and click
Generate.

Back to Admin Tools
Manage OAuth2 Client Applications
Self Assign a new X.509 Certificate(* Required Fields)
*Comman Name(CN) [ForthASB Integration ‘
Organization(O) | ‘
Organization Unit{QU) |’ \‘
Localiy(L) | )
StatefProu(sT) | ]
Country/Region(C) | ‘
Validity(Days) |7‘ If this field is empty, use default value - 365 days.

Enable validity check [_]

@ Cancel

5. You will be re-directed back to the previous page, and the certificate values will be filled.
Click Download to download the certificate pem file as the private key for use later. Then click Register
to register the client application.
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Back to Admin Tools

Manage OAuth2 Client Applications

Register a new QAuth Client Application(* Required Fields)

Company ‘SFCPARTOODZSQ ‘

*Application Name

Description

*Application URL

Bind to Technical User

Technical User 1D

*X.508 Certificate

‘FoniCASB Integration ‘

‘hﬂps:#www.fum:asb‘comf ‘

O

TUIJREtgQONBaEtnQXdJQkFnSUVWa3NJZkRBTkIna3Fea2lHOXcwQkFRUUZBREJY TVFrd0J3WURWUVFHRXdBeEN
UQURCZ05WQkFnVEFERUpNQWNHQTFVYRUJ4TUFNUW3QndZRFZRUUIFdOF4Q1RBSE InTIZCQXNUQURFZU1Cd0
dBMVVFQXhNVIJIOXIKR2XxEUVZOQOIFbHVKR 17U 21GMGFXOXVNQIRYRFRJeE1EY3hNekISTVRAMU1Wh1hEVEISTU
RjeE16SXINVGexTVZvd1Z6RUpNQWNHQTFVRUJoTUFNUWI3QndZRFZRUUIFdOF4Q1RBSEInTIZCQWNUQURF Sk1

Generate X.509 Certificate Download

6. Click on the OAuth2 Application that you just created, the APl Key should be generated automatically,
make a record of the APl key and Company ID.

Back to Admin Tools

Manage OAuth2 Client Applications

View an existing OAuth Client Application

[ compny

Application Name o ticASB Integration |

Description

APLKeY  [MyrYONDUOMZEXMmEWZGUZY]Y 2ZTVKNTQZZDU3M|

Application URL ﬁwttvs

lwww forticash.com/ ]

Bind to Technical User

Technical User ID ‘

X.509 Certificate

UMUZ0aGXOMIVIU SFIEINVEMXVVSIRURWWE IRKAIZICZ ¥ 21ZZUVYCUJRIMJPUIIPUGJILY W1 GKIUNUOYOKRUNS Y ZaGhuLz
JLamdELzNabjFWeXd6b21rMHFCMIZpY2JWYVE INUSFVFrY112Rme3UGFyYHUzNTIIaW9xanJ Tdi8zZjcz TWIrMDBZW

Back

Step 2. Set Permission Scope

1. In SAP Success Factors > Admin Center, search and go to User Role Search.
2. Look up the User ID to be added on FortiCASB for the Roles under the user.
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Back to Admin Center

User Role Search

Use this page to search specific roles granted to users. You can select one or two access users, one permission, and one or no target users. The search result+
not consider target user. On the role detail page, the grant rules that grant the selected access user and target user is highlighted in the Grant this role to sectic

Selection

Access Users
Permission Category
Permission

Target User{optional)

Search Roles

Result

sfadmin

AlL
Detailed Calibration Permissions

click to add users

User: sfadmin

Role:

System Admin
HR Admin for Employees
PCC_Payroll_Admin

HR Admin for Contingent VWi

lorkforce

3. Go back to the Admin Center again, search and go to Manage Permission Role.
4. Look up one of the role that is under the user, e.g. System Admin, and click on it.

Admin Center
Back to Admin Center

Permission Role List

Go To Customer Community  Admin Resources  Handout Builder

Different users should have different access to the information in the application. A role controls the access rights  user (or a group) has to the application or employee data. Each role has its own set of access permissions that you define. You can also limit exactly what a group can access.

Type role name... Q

© CresteNew ) Create New Role for Exteral User

Permission Role
HR Admin for Contingent Workforce

HR Admin for Contingent Workforce (cdolan only)

Apprentice Supervisor

Apprentice
HR Admin for Employees

HR Admin for Employees (cdolan only)

Ingentis Orgmanager Service Role

On-site Supervisor

5. In Permission Role Detail, click on Permission button to configure the permission settings.
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User Type Role Type Description
Managing HR Processes and User Info

Managing HR Processes and User Info
Apprentice Supervisor

Apprentice

Managing HR Processes and User Info
Managing HR Processes and User Info
System Admin

System Admin

Role for installing and setting up the Ingentis org manager [web] for SF

On-site Supervisor

Status
ACTIVE

ACTIVE

ACTIVE

ACTIVE

ACTIVE

ACTIVE

INACTIVE

ACTIVE

INACTIVE

ACTIVE

Created From

ltems per page |10 v

Last Modified
20210523
20210523
20210523
20210523
20210523
20210523
20210523
20210523
20210523

20210523

K<

Action
Take action

Take action

Take action

Take action
Take action

Take action

Take action

Take action

Take action

Page| 2 |of8 > M

=l

=

=

=

=

=l

=

=

=

=
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Admin Center

Back to Admin Center

Permission Role Detail

1. Name and description

*Role Name: | gystem Admin
Description:
System Admin

2. Permission settings

Specify what permissions users in this role should have.
Permission...

v Permission not requiring target

General User Permission

s User Login

* Mass Create Group Permission

= Permission to Create Notes

« Live Profile Access

* SFAPI User Login

* Mobile Access

= Community Access

= Permission to Create Forms(All)
Manage Compensation

6. Scroll down and select Manage Integration Tools, click Select All to add all integration permissions,
and click Done.

Permission settings

Specify what permissions users in this role should have.© %= Access period can be defined at the granting rule level.

Manage Instance Synchronization Manage Integration Tools t= Target needs to be defined.
Manage Business Process Engine Select All .
Access to SFAPI Audit Log
Manage Integration Tools Access to SFAPI Metering Details
Access to SFAPI Data Dictionary
Intelligent Service Tools Access to Event Notification Subscription
Access to Outbound Trust Manager
Manage Data Purge Access to Event Notification Audit Log
Manage Onboarding or Manage OAuth2 Client Applications
Offboarding Allow Admin to Access OData APl through Basic Authentication

Access to OData API Audit Log

Manage OData API Basic Authentication
Access to OData APl Version Control
Access to API Center

Access to API Option Profile

OData APl Competency Rating Import

Manage Security
Manage Action Search

Manage Spot Awards

Admin Center Permissions l OData APl Competency Rating Export

A tm AAMvndn AP Bl cdndnin Neafernnl cmd Tomne +

i@ @

Now go back to FortiCASB to add the SAP Success Factors account.

Step 3. Add SAP Success Factors Account on FortiCASB

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard, click on Add New, select SAP SuccessFactors, then click Add
Selected Cloud App.
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Business Unit Overview

BU MName QA Test BUID 330239 #of Cloud App 14

] Office 365 Google Workspace
including

including
ot &

.

B ¥ v} 2

Dropbaox GCP Storage

.  @gmail.com
wss ses
-
Q 4 +
Webex Teams Zendesk Add New
. . h .
Select Cloud Appto Add *
Google Workspace 1] Office 365 aws
including including
) Awss3
-
A box S] X E=2
Agurestarage Bax Citrix ShareFile Confluence Dropbax
0
X @ (v a) A2
Eamyte Workplace GitHub Gep storage sira
oo o
sAPIAS Webex Teams
yi4 zoom
Zendesk Zoom

Cancel

3. Review the configuration list and make sure they are completed, and click Next Step.
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Add SAP SuccessFactors Account

o Finish Configurations @SAP SuccessFactors 2 | Fillin Account Info 3 | Done

To successfully add your SAP SuccessFactors account, please do the following at SAP SuccessFactors
and refer to the step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. Login SAP SuccessFactors and register an OAuth 2 Client Application. Please follow detailed
instructions in the tutorial here.

2. Make sure you download the certificate generated and store it for obtaining the Private Key for next
steps.

3. Then you need to enable all necessary APl permissions for the User’s Role . Please follow detailed
instructions and see the full list of all necssary APl permissions in the tutorial here.

Please make sure you've finished all configurations above before clicking Next button below.

Next Step Cancel

4. Enter the SAP Success Factors Company ID, APl Key saved earlier, then enter the SAP Success

Factors User ID.
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Add SAP SuccessFactors Account

° Finish Configurations @SAP SuccessFactors o Fill in Account Info 3  Done

Company ID

APl Key

User 1D

Location and Environment

X509 Certificate File

ChooseFile

5. Click Location and Environment drop down menu and select one of the location and environment:

Location and Environment

DC2-Production-Amsterdam, The Netherland (https://api2.successfactors.eu/)
DC2-SalesDemo-Amsterdam, The Netherland(https://apisalesdemo2.successfactors.eu/)

DC2-Preview-Amsterdam, The Netherland(https://api2preview.sapsf.eu/)

6. Upload the X.509 Certificate pem file saved from earlier and click Add SAP Success Factors Account.

7. Wait for 15 minutes for the account to be fully added to FortiCASB.

Update SAP Success Factors Account

Step 1. Register OAuth Client Applicaiton on page 243
Step 2. Set Permission Scope on page 245
Step 3. Update SAP Success Factors Account on FortiCASB on page 247
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Step 1. Register OAuth Client Applicaiton

1. Log into SAP Success Factors and go to Admin Center. In the Tools box, search and go to Manage
OAuth2 Client Applications.

B eSt A‘_}-T - Admin Center

Admin Center

Tools See All Admin Alerts 2.0 See More

| |Search Tools

Time Management

| Manage OAuthZ Client Applications

Time Valuation

Empl Export
% Employee Expo Recalculate Accruals

¥ Import Employee Data

Recalculate Absences

. . | rt Time Sheet:
Intelligent Services Center (ISC) See More mport fime sheets

Workflow

Stalled Workflows - Employee Related

2. In Manage OAuth2 Client Applications, click Register Client Application to register a new OAuth2
Client Application.

3. Fillin an application name, e.g. FortiCASB Integration, then in Application URL, enter a url, e.g.
https://www.forticasb.com/.
At the bottom of the page, click Generate X.509 Certificate to register a certificate.

Manage OAuth2 Client Applications

Regjster a new OAuth Client Application(* Required Fields)

Company [SFCPART000269 |

*Application Name [¢ortiCASB Integration |

Description

LTI S ———— \

Bind to Technical User [_|

Technical User ID ‘ ‘

*X.509 Certificate

Generate X.509 Certficate ["cancel |

4. In"Self Assign a new X.509 Certificate" page, entera Common Name for the certificate, and click
Generate.
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Back to Admin Tools

Manage OAuth2 Client Applications

Self Assign a new X.509 Certificate(* Required Fields)
Issued By [successFactors |

*Comman Name(CN) |Fon:|CASB Integration ‘

Organization(0) |—‘

Organization Unit(OU) | ‘

Locality(L) |—‘

State/Prou(sT) | |

Country/Region(C) |’—\‘
Validity(Days) |7‘ If this field is empty, use default value - 365 days.

Enable validity check D

5. You will be re-directed back to the previous page, and the certificate values will be filled.
Click Download to download the certificate pem file as the private key for use later. Then click Register

to register the client application.

Back to Admin Tools

Manage OAuth2 Client Applications

Register a new QAuth Client Application(* Required Fields)

Company  SECPARTO00289 |

*Application Name ‘FoniCASB Integration ‘

Description

*Application URL ‘hnps:/ﬂwwwfnni:asb‘com/ ‘

Bind to Technical User ||

Technical User ID ‘ ‘

*X.509 Certificate
TUIJREtgQONBaEinQXdJQkFnSUVWa3NJZkRBTkJna3Fea2lHOXewQkFRUUZBREJY TVFrd0J3WURWUVFHRXdBeEN
UQUACZOSWQkFnVEFERUpNQWNHQTFVRUJ4TUFNUVW3QndZRFZRUUIFdOF4Q1RBSEJnTIZCQXNUQURFZU1Cd0
dBMVVFQXhNVIJIOXIKR2XxEUVZOQOIFbHVKR 1ZUY21GMGFXOXVNQJRYRFRJEE1EY 3hNeklSTVRAMU1Wh1hEVEISTU
RjeE16SXINVGexTVZvd1Z6RUpNQWNHQTFVRUJoTUFNUWI3QndZRFZRUUIFdOF4Q1RBSEJNTIZCQWNUQURF Sk1

Generate X.509 Certificate Cancel

6. Click on the OAuth2 Application that you just created, the APl Key should be generated automatically,

make a record of the APl key and Company ID.

FortiCASB 24.3.b Admin Guide
Fortinet Inc.



Cloud Application Onboarding

Back to Admin Tools
Manage OAuth2 Client Applications

View an existing OAuth Client Application

[ company

Application Name - EortiCAS Integration |

Description

APIKey - \VFYONDUOMzgxMmEWZGUzYjY 2ZTVKNTQ2ZDU3M|

Application URL ﬁwttas-ffmmfnm:asb.caw W

Bind to Technical User

Technical User ID ‘

X509 Certificate

UMUZL0aGX0MSVIU IF I NVEMXVVSIRURWVE KK SLICZ ¥ 2IZAUVYCUJ KROMJPLIPUG LY VW1 GKZIUNUOYaKKUNS Y ZaGhuLz
JLamdELzNabjFWeXd6b21rMHFCMIZpY 2 WYVE INUSFVNFrV112Rmc3UGFyVHUzNTIlaW9xanJTdi8zZjcz TWIrMDBZW

Back

Step 2. Set Permission Scope

1. In SAP Success Factors > Admin Center, search and go to User Role Search.
2. Look up the User ID to be added on FortiCASB for the Roles under the user.

Back to Admin Center

User Role Search

Use this page to search specific roles granted to users. You can select one or two access users, one permission, and one or no target users. The search result
not consider target user. On the role detail page, the grant rules that grant the selected access user and target user is highlighted in the Grant this role to sectic

Selection
Access Users sfadmin
Permission Category AlL k4
Permission Detailed Calibration Permissions -
Target User{optional) click to add users

Search Roles

Result

User: sfadmin

Role:
System Admin

HR Admin for Employees
PCC_Payroll_Admin

HR Admin for Contingent Workforce

3. Go back to the Admin Center again, search and go to Manage Permission Role.
4. Look up one of the role that is under the user, e.g. System Admin, and click on it.
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Admin Center
Back to Admin Center Go To Customer Community  Admin Resources  Handout Builder
Permission Role List
Different users should have different access to the information in the application. A role controls the access rights a user (or a group) has to the application or employee data. Each role has its own set of access permissions that you define. You can also limit exactly what a group can access.
Type role name. Q
@ Create New () Create New Role for External User ltems perpage 10 ~ | K< Pagel 2 [of8 > M
Permission Role User Type Role Type Description Status Created From Last Modified Action
HR Admin for Contingent Worklorce Managing HR rocesses and User nfo ACTIVE 20210523 Take action g1
HR Admin for Contingent Workforce (cdolan only) Managing HR Processes and User Info ACTIVE 2021-05-23 Take action (3
‘Apprentice Supervisor Apprenice Supenvisor AcTvE 20210523 Take sction 51
Apprentics Apprenice AcTvE 20210523 Take action
HR Admin for Employees Managing HR Processes and User Info ACTIVE 2021-05-23 Take action (3
HR Admin for Employees (cdolan only) Managing HR Processes and User Info ACTIVE 2021-05-23 Take action (3
System Admin INACTIVE 2021-05-23
System Admin ACTIVE 2021-05-23
Role fo nstalling and setting up the Ingentis org. manager [web] for SF INACTIVE 20210523
onsite Supervisor on-site supervisor AcTvE 20210523 Toke action 51

5. InPermission Role Detail, click on Permission button to configure the permission settings.

Admin Center
Back to Admin Center

Permission Role Detail

1. Name and description

*Role Name: | 5y crem Admin

Description:
System Admin

2. Permission settings

General User Permis:
= User Login
* Mass Create Group Permission
« Permission to Create Notes
« Live Profile Access
* SFAPI User Login
* Mobile Access
« Community Access
« Permission to Create Forms(AlL)
Manage Compensation

6. Scroll down and select Manage Integration Tools, click Select All to add all integration permissions,
and click Done.
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Permission settings

Specify what permissions users in this role should have.© %= Access period can be defined at the granting rule level.

Manage Instance Synchronization Manage Integration Tools t= Target needs to be defined.

Select All
Access to SFAPI Audit Log

Access to SFAPI Metering Details
Access to SFAPI Data Dictionary

Access to Event Notification Subscription

Manage Business Process Engine

Manage Integration Tools

Intelligent Service Tools

Access to Outbound Trust Manager
Manage Data Purge

Access to Event Notification Audit Log

Manage OAuth2 Client Applications

Allow Admin to Access OData APl through Basic Authentication
Access to OData APl Audit Log

Manage OData API Basic Authentication

Access to OData AP Version Control

Manage Onboarding or
Offboarding

Manage Security

Manage Action Search
Access to API Center

Access to API Option Profile
OData APl Competency Rating Import

Manage Spot Awards

Admin Center Permissions l OData APl Competency Rating Export

oA AR AB

A tm AAMvndn AP Bl cdndnin Neafernnl cmd Tomne +

Now go back to FortiCASB to add the SAP Success Factors account.

Step 3. Update SAP Success Factors Account on FortiCASB

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard.
3. Click on the SAP Success Factors account menu, and select Update Cloud Account.
4. Review the configuration list and make sure they are completed, and click Next Step.
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Update SAP SuccessFactors Account

o Finish Configurations @SAP SuccessFactors 2 | Fillin Account Info 3  Done

To successfully update your SAP SuccessFactors account, please do the following at SAP
SuccessFactors and refer to the step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. Login SAP SuccessFactors and register an OAuth 2 Client Application. Please follow detailed
instructions in the tutorial here.

2. Make sure you download the certificate generated and store it for obtaining the Private Key for next
steps.

3. Then you need to enable all necessary APl permissions for the User’s Role . Please follow detailed
instructions and see the full list of all necssary API permissions in the tutorial here.

Please make sure you've finished all configurations above before clicking Next button below.

Next Step Cancel

5. Enterthe SAP Success Factors Company ID, APl Key saved earlier, then enter the SAP Success
Factors User ID.

6. Click Location and Environment drop down menu and select one of the location and environment:

Update SAP SuccessFactors Account

° Finish Configurations @SAP SuccessFactors o Fill in Account Info 3  Done

Company ID

API| Key

NDIOYTUzM]ZhNWI4NzVjYjQzN...

User ID

sfadmin

Location and Environment

DC2-SalesDemo-Amsterdam, T... ~

X.509 Certificate File

ChooseFile
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Location and Environment

DC2-Production-Amsterdam, The Netherland(https://api2.successfactors.eu/)
DC2-SalesDemo-Amsterdam, The Netherland(https://apisalesdemo2.successfactors.eu/)

DC2-Preview-Amsterdam, The Netherland(https://api2preview.sapsf.eu/)

7. Upload the X.509 Certificate pem file saved from earlier and click Update SAP Success Factors
Account.

8. Wait for 15 minutes for the account to be fully added to FortiCASB.

ServiceNow

FortiCASB offers an APl-based approach, pulling data directly from ServiceNow via RESTful API. Then
FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently,
FortiCASB combines these data to monitor and track ServiceNow user activities, provides DLP Data Analysis
for files stored on ServiceNow tickets.

Prerequisite

Before ServiceNow account can be added to FortiCASB, an OAuth APl Endpoint needs to be created at
ServiceNow to establish connection between FortiCASB and ServiceNow.

A ServiceNow Instance will be required to create an application registry for OAuth API endpoint.

Note: Only ServiceNow Istanbul or higher version is supported.

Follow these steps to configure and add ServiceNow account on FortiCASB:

1. Create ServiceNow Developer Instance on page 250
2. Create ServiceNow OAuth APl Endpoint on page 251
3. Add ServiceNow Account on page 255
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Create ServiceNow Developer Instance

If you have an existing ServiceNow developer instance, you may use it to create a ServiceNow application
registry to establish connection with FortiCASB.

If not, please create a developer instance following the steps below:

1. Loginto ServicewNow Developer Home page.
2. Click Request Instance at the right hand corner.

Q Request Instance S {’CZE' v

3. Choose an instance type listed and click Request.

Choose your release

iy f

Utah Tokyo San Diego

Release Notes -~ Release Notes -~ Release Notes ~

4. Adeveloperinstance will be created, it may take a few minutes.
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Hello, = =wsmsey  wee

Welcome to ServiceNow!

Build apps in minutes using ServiceNow's App
Engine Studio with no-code/low code
capabilities.

Setting up instance Cancel

Content available for: Utah Tokyo SanDiego Rome

5. Once the instance is created, it will provide the instance URL and credentials. Keep a record of them.
Your instance is ready!
Your instance URL: https:// service-now.com n

Username: admin
Current password:

Keep your new instance active by developing on the instance or logging into the Developer Site. If your instance is inactive for 10

days, it will be reclaimed and released for other developers to use.

Return to the Developer Site Open Instance 2

Now proceed to Create ServiceNow OAuth APl Endpoint on page 251 to finish the rest of configurations.

Create ServiceNow OAuth APl Endpoint

After a ServicewNow Developer Instance is created, a new application registry along with the OAuth Apl
Endpoint can be created under the ServiceNow developer instance.

1. Go to the ServicewNow instance created earlier in Create ServiceNow Developer Instance on page 250.

For example: https://<Instance |D>.service-now.com/
2. Log in with your ServiceNow instance credentials.
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servicenow

User name

hdmin

Passwaord

EEREEERERE

Forgot Password ?

3. Click All on the navigation menu, scroll down or search for System OAuth, and click on Application
Registry.

Servicenow Al | Favorites History  Workspaces  Admin ServiceNow 1r

Y system pauth @ b

v System OAuth
Application Registry
JWT Providers
JWT Keys
SAML2 Assertion Producers

Manage Tokens

App c£ngine Studio

Build apps fast.

Build low-code apps quickly. Create from scratch or templates. Safely scale
cross-enterpnse experiences that users love.
All on one platform.

Let's Go

4. Click on New in the upper right hand corner to create new application.
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Application Registries 7y Q, Search

©

Actions on selected rows... A m

Client ID Comments
{adfds-application-client-identifier-here}

{auth0O-application-client-id-here}

{azure-ad-application-id-here}

{zoogle-application-client-identifier-here}

ac0dd3408c1031006%07010c2ccbefbéd Used by the mobile app to allow access t...
{okta-application-client-id-here}

ff97fbb4da3313004591cc3a291b47d

3e57bb02663102004d010e=8f561307a

5c54dc934a022300ch7946ebecbecl?2

2c403f19ac$01300b303eef6c8b842d3

1624ac?3b46221009eb8191f0e41680d Used by the service WebKit HTML to PDF

5. Select and click Create an OAuth API endpoint for external clients.

sServiCenow Al Favorites  History  Workspaces  Admin OAuth application 3%

QAuth application

What kind of OAuth application?

I Create an OAuth APl endpoint for external clients

Create an OAuth JWT APl endpoint for external clients
Connect to a third party OAuth Provider
Configure an QIDC provider to verify ID tokens.

Connect to an OAuth Provider (simplified)

6. Enter an unique Name and Client Secret for the OAuth client application.

# Marme
# Client ID
Client Secret

Leave Client Secret blank to automatically
generate a string

Redirect URL
Logo URL

7. Inthe Redirect URL field, enter the Redirect URL provided by FortiCASB Add ServiceNow Account
page step 4.
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4. When you fill in the form, please follow below instructions for certain fields:
a. Keep record of Client ID and Client Secret (these are needed in next step );
b. In Redirect URL field, input Redirect URL:

Redirect URL:

https://www.forticasb.com/api/v1/oauth/redirect/ServiceNow M

8. Keep arecord of Client ID and Client Secret for use later in adding the ServiceNow account to
FortiCASB.

* Name | albert |

# Client 1D

Client Secret | sansnens |

Redirect URL |httpS:ffwm.fc-rt|'ca5b.comfapifvlfaauthfred'|re+:t.| | = ‘

Logo URL

Public Client | |

Comments

9. Leave Refresh Token Lifespan and Access Token Lifespan fields as default.

Application  Admin Experience Framewaork
Accessible from | All application scopes V.|
Active
¥ Refresh Token Lifespan | 2.640,000 |
# Access Token Lifespan | 1,800 |

10. Click Submit and go back to FortiCASB Add ServiceNow Account page.
Now the ServiceNow account is ready to be added to FortiCASB. Go to Add ServiceNow Account on page 255.
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Add ServiceNow Account

After a ServiceNow OAuth API Endpoint is created, you can now add the ServiceNow account on FortiCASB.

Follow the instructions below to add the ServiceNow account on FortiCASB:

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard, click on Add New, select ServiceNow, then click Add Selected Cloud

App.

Business Unit Overview

BUName QA Test

] Office 365
including
e P>
g . "
> |
- x
Dropbox Egnyte
.
-
Q 4
Webex Teams Zendesk
. .
Select Cloud App to Add
Google Workspace 1] Office 365
including including
&0 L LY 1 K3
A box S] X
Azurestorage Box Citrix ShareFile Confluen
X ® (%) a)
rhcplax GitHub
&> Sarg
Salesforce ServiceNo,

FortiCASB 24.3.b Admin Guide
Fortinet Inc. e
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#of Cloud App 16

Google Workspace

including

&9

(9] a)

GitHub GCP Storage

® @gmail.com

+

Add New
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3. Review the key configurations list to see if you have finish all the required configurations, and click Next.

To successfully add your ServiceNow account, please do the following at ServiceNow and
refer to the step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The account must be Admin
2. Log into ServiceNow, find System OAuth > Application Registry.
3. Click New button and select Create an OAuth APl Endpoint External Clients.
4. When you fill in the form, please follow below instructions for certain fields:
a. Keep record of Client ID and Client Secret (these are needed in next step );
b. In Redirect URL field, input Redirect URL:

Redirect URL:

https://www.forticasb.com/api/v1/oauth/redirect/ServiceNow 3

c. In Refresh Token Lifespan field, use the default value (8,640,000) ;
d. In Access Token Lifespan field, use the default value (1,800);
e. Click Submit and go back to this page.

Please make sure you've finished all configurations above before clicking Next button
below.

4. In Client ID and Client Secret fields, enter the "Client ID" and "Client Secrets" recorded earlier. In
ServiceNow url, enter your ServiceNow url.
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Add ServiceNow Account

€D Finish Configurations @ServiceNow Fill in Account Info &P Done

Client ID
Client Secret

ServiceNow url

Example: hitps:/myinstance.service-now.com

5. Click Add ServiceNow Account to add the ServiceNow account. It may take 15 minutes to finish adding
the account. You may check the status in Overview > Dashboard.

Update ServiceNow Account

Before updating the ServiceNow account on FortiCASB, complete the same configurations using the same
ServiceNow account:

Create ServiceNow Developer Instance on page 250
Create ServiceNow OAuth API Endpoint on page 251

After the ServiceNow configuration is completed, follow these steps to update your ServiceNow account on
FortiCASB.

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard.

3. Click on the ServiceNow menu and select Update Cloud Account.
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o Update Cloud Account

ServicaNow View Account Detail

# Disconnected

View Change History =~

Delete Account

4. Review the key configurations list to see if you have finish all the required configurations, and click Next.

To successfully update your ServiceNow account, please do the following at ServiceNow
and refer to the step-by-step tutorials:

Here is a summary of key configurations that need to be accomplished:

1. The account must be Admin
2. Log into ServiceNow, find System OAuth > Application Registry.
3. Click New button and select Create an OAuth APl Endpoint External Clients.
4. When you fill in the form, please follow below instructions for certain fields:
a. Keep record of Client ID and Client Secret (these are needed in next step );
b. In Redirect URL field, input Redirect URL:

Redirect URL:

https://www.forticasb.com/api/v1/oauth/redirect/ServiceNow T

c. In Refresh Token Lifespan field, use the default value (8,640,000) ;
d. In Access Token Lifespan field, use the default value (1,800):
e. Click Submit and go back to this page.

Please make sure you've finished all configurations above before clicking Next button
below.

5. In Client ID and Client Secret fields, enter the "Client ID" and "Client Secrets" recorded earlier. In
ServiceNow url, enter your ServiceNow url.
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Update ServiceNow Account

° Finish Configurations @ServiceNow o Fill in Account Info

Client ID
Client Secret

ServiceNow url

Example: https://myinstance.service-now.com

Update ServiceNow Account

6. Click Update ServiceNow Account to update the ServiceNow account.

It may take 15 minutes to finish updating the account. You may check the status in Overview > Dashboard.

Webex Teams

FortiCASB offers an APl-based approach, pulling data directly from Webex Teams via RESTful API. Then
FortiCASB portal accesses the data collected through API queries with OAuth2.0 authentication.

Subsequently FortiCASB combines these data to offer protection on Webex Teams file sharing and events
monitoring. All the files shared on Webex Teams space chats are protected against virus and monitored for
compliance violation. Events monitoring monitors for suspicious user activities or unauthorized events.
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Types of Webex account activities monitored by FortiCASB:

Admin Regular Event (Without IP)
Event (With

IP)

File Activities  Upload File
Delete File

Create User Create Memberships

Delete User Delete Memberships
Update Memberships
Participant Join Meeting
Participant Left Meeting

Prerequisites

The Webex user account should be under a Basic, Business, or Enterprise subscription plan.

Add Webex Teams

Follow the steps below to add Webex team to FortiCASB:

1. Configure WebEx admin account on page 260

2. Add Webex Teams account on page 262

Configure WebEx admin account

1. Loginto Cisco WebEx Admin with your Webex admin account
2. Click on your user profile icon drop down menu, and click Cisco Webex Control Hub.
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v = @ oyod)

dell webex i Users Billing forticash v+ |  Feedback

Cisco Webex Control Hub
Your Plan - Webex Pluso Configure advanced administrator

settings including device
e Active. Expires on Dec 19, 2020.

management, reporting, and more in
Cisco Webex Control Hub.
roy Did you know?
S If you change to an annual plan, you'll save $48.00 annually. Language

Host License(s) Add-On Features Cancel Paid Subscription

Sign Out
Automatically renews. Need toll-free dialing? Add Call Me and meetings
Billed monthl call you and your participants!

Change plan

Users 3 Licensed user(s) 2 License(s) purchased m

Yue Zhang
............ .
Payment Method 0 012022 655 S Fair Oaks AVE apt N 103 Change payment o

3. InCisco Webex Control Hub navigation menu, click on Management > Users.

4. Click on the user that will the added to FortiCASB. In Roles and Security, click on Administrator
Roles, make sure the user is a Full Administrator.
(Ask another admin to assign the role if needed.)

Cisco \Webe
Control Hub

& e Users (o)
MONITORING
Q All 3 Administrators 2  External Administrators 0 User >  Administrator Roles
«ll Analytics
- Troubleshooting First Name Last Name Display Name Email
@ forticasb et Test admin Organization Administrator Roles
MANAGEMENT - i .
Organization Administrator
@ auto_test_user
2 Users -’

© Full Administrator ©

0 orkepaces _ O ooy e @

3 Devices
28 Apps
& Functional Administrator Roles
Account
£ Organization Settings ®
(0]
senvices O]

Compliance Officer ()

(O Messaging Advanced Troubleshooting Access (0

) Meeting
%, Calling

o Hybrid

E, FortiCASB Integration

Follow the rest of the steps in Add Webex Teams account on page 262 to complete adding the Webex account
on FortiCASB.
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Add Webex Teams account

After the Webex Team configurations are completed from the previous section, follow these steps to add your

Webex Team account on FortiCASB.

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard, click on Add New, select Webex Teams, then click Add Selected
Cloud App.

Overview / Dashboard

Business Unit Overview

BUName testassign BUID 480756 #of CloudApp 1

] Office 365 +

including

peaddg > Add New

® ga@casbgal.onmicrosoft.com

3. Review the key configurations list to see if you have finish all the required configurations, click Grant
Access@Webex. Then you will be re-directed to Webex OAuth verification page.

Note: Before clicking on Grant Access@Webex, make sure you log out of Webex if you have another
account that is log in on another web page.
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Add Webex Account

o Finish Configuirations @Webex 2  Done

To successfully add your Webex account, please do the following at Webex Teams. Click to view step-
by-step tutorials.

Here is a summary of key configurations that need to be completed:

1. All Webex Teams plans: Basic, Business, Enterprise are supported.

2. Loginto Webex Control Hub > Management > Users , locate the user you will use for FortiCASB, and
make sure:

a. This user has the Full Administrator in the Admin roles.

3. Important: make sure the user you will use for FortiCASB is the same as the user you log into Webex
Teams.

a. If different, please log out and log in using the same user at Webex.

Please make sure you have finished all configurations above before clicking the Grant Access@Webex
button below.

Grant Access @Webex Cancel

4. Enter your Webex credentials and press Submit. Then go back to the FortiCASB page.

It may take 15 minutes to finish adding the account. You may check the status in Over-
view > Dashboard.

Update Webex Teams Account

Before updating the Webex Teams account on FortiCASB, complete the same configurations using the same
Webex Teams account:

Configure WebEx admin account on page 260

After the Webex Teams configuration is completed, follow these steps to update your Webex Teams account
on FortiCASB.

1. Log into FortiCASB with your account.

2. Goto Overview > Dashboard.

3. Click on the Webex Teams menu and select Update Cloud Account.
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o Update Cloud Account

Webex Teams View Account Detail

mn

View Change History

Delete Account

4. Review the key configurations list to see if you have finish all the required configurations, click Grant
Access@Webex. Then you will be re-directed to Webex OAuth verification page.
Note: Before clicking on Grant Access@Webex, make sure you log out of Webex if you have another
account that is log in on another web page.

Update Webex Account

o Finish Configurations @Webex 2  Done

To successfully update your Webex account, please do the following at Webex Teams. Click to view
step-by-step tutorials.

Here is a summary of key configurations that need to be completed:

1. All Webex Teams plans: Basic, Business, Enterprise are supported.

2. Log into Webex Control Hub > Management > Users, locate the user you will use for FortiCASB, and
make sure:

a. This user has the Full Administrator in the Admin roles.

3. Important: make sure the user you will use for FortiCASB is the same as the user you log into Webex
Teams.

a. If different, please log out and log in using the same user at Webex.

Please make sure you have finished all configurations above before clicking the Grant Access@Webex
button below.

Grant Access @Webex Cancel

5. Enter your Webex credentials and press Submit. Then go back to the FortiCASB page.

It may take 15 minutes to finish updating the account. You may check the status in Over-
view > Dashboard.
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Zendesk

FortiCASB offers an API-based approach, pulling data directly from Zendesk via RESTful API. Then FortiCASB
portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently, FortiCASB
combines these data to monitor and track Zendesk user activities and ticketing system, provides DLP Data
Analysis for files on tickets.

Prerequisite

1. FortiCASB requires the Zendesk account to be under an Enterprise plan.
2. The Zendesk account to be added to FortiCASB must have Admin Role in Support.

Account Roles and access

Product Role Access

Fe support Admin Yes

A guide Admin ()

A> explore Admin ()

“. talk Admin ~
* chat

3. AZendesk OAuth Client needs to be created to authorize access for FortiCASB REST API.

After you have verified the account prerequisite, follow the guides below to Add or Update the account on
FortiCASB:

Add Zendesk Account on page 266

Update Zendesk Account on page 270

FortiCASB 24.3.b Admin Guide 265
Fortinet Inc.



Cloud Application Onboarding

Add Zendesk Account

Step 1: Create Zendesk OAuth Client on page 266

Step 2: Add Zendesk Account on page 267
Step 1: Create Zendesk OAuth Client

1. Log into Zendesk with your sub-domain, and then with your admin account.

Signin to Zendesk

Your Zendesk subdomain

Subdomain zendesk.com

Don't remember your company's url?

Looking fer dashboard.zopim.com?

Looking fer Zendesk Sell (formerly Base)?

New to Zendesk? Sign up here |

2. Inthe left navigation pane, click Admin E scroll down to Channels, and click on APL.
3. InZendesk API page, select OAuth Clients tab, then click Add OAuth client.

+ Add y Conversations (@ H & L B
Text .
RIS Zendesk API
API
Mobile SDK

Channel Integrations Settings OAuth Clients Activity Target Failures

If you want to use a global OAuth client, create a dient in this account and submit a reguest

BUSINESSRUEES to globalize it through our developer portal.

Routing

Triggers
All QAuth clients (7)

Automations

4. Fillin a Client Name of your choice, Short Description, and an Unique Identifier which should be
populated automatically. Keep a record of the unique identifier for use later.
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Settings OAuth Clients Activity Target Failures

If you want to use a global OAuth client, create a client in this account and submit 2 request to globalize it through our developer portal,

- FortiCASB Integration

FQUiCAS integration

forticash_integration

Redirect URLS

https://

5. In Redirect URLSs, use one of the corresponding redirect url provided by FortiCASB:

Region Redirect URL

Global https://www.forticasb.com/api/v1/oauth/redirect/Zendesk
Region

European https://eu.forticasb.com/api/v1/oauth/redirect/Zendesk
Union
Region

6. Click Save, and then in Secret field, click Generate to generate the secret token.
Note:Make sure to copy down the secret token as it will only appear once.

Now go back to FortiCASB to add the Zendesk account.

Step 2: Add Zendesk Account

1. Log into FortiCASB with your account.
2. Goto Overview > Dashboard, click on Add New, select Zendesk, then click Add Selected Cloud
App.
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Business Unit Overview

BU MName QA Test BUID 330239 #of Cloud App 14
] Office 365 Google Workspace
including including
adgd &9
* Sl . - .

B ¥ v} 2

GCP Storage

Drophax Egnyte GitHub
. ® @zmail.com
wss ses
-
Q 4 +
Webex Teams Zendesk Add New
. . 4 .
Select Cloud Appto Add *
Google Workspace 1] Office 365 aws
including including o
9 LY T8
-
A box S] X 3
Azurestorage Bax Citrix ShareFile Confluence Dropbax
0
X @ (v a) A2
Eamyte Workplace GitHub Gep storage sira
& & o
Salesforce SAP 1A ServiceNow Webex Teams

4 zoom
Cancel

3. Fillin the Zendesk Sub-Domain, Unique Identifier, and the Secret Token saved from earlier, and click

Add Zendesk Account.
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Zendesk / OAuth / Add

Add Zendesk Account

° Finish Configurations @Zendesk e Fill in Account Info 3 Done

Subdomain

| forticasbde‘\j |

Unique Identifier

forticasb_integration

Secret

Add Zendesk Account

4. You will be prompt to authorize FortiCASB to access to your Zendesk account, click Allow to complete
adding the Zendesk account.

FortiCASE Integration
by fortinet

Allow FortiCASB Integration to access your Zendesk account?
FortiCASB integration

This application would be able to:

= Write all user data.
« Read all user data.

Not forticash dev?

5. Wait 15 minutes to complete adding the Zendesk account to FortiCASB.
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Update Zendesk Account

Step 1: Create Zendesk OAuth Client on page 270

Step 2: Update Zendesk Account on page 271

Step 1: Create Zendesk OAuth Client

1. Log into Zendesk with your sub-domain, and then with your admin account.

Signin to Zendesk

Your Zendesk subdomain

Subdomain zendesk.com

Don't remember your company's url?

Looking fer dashboard.zopim.com?

Looking fer Zendesk Sell (formerly Base)?

New to Zendesk? Sign up here |

2. Inthe left navigation pane, click Admin E scroll down to Channels, and click on APL.
3. InZendesk API page, select OAuth Clients tab, then click Add OAuth client.

+ Add y Conversations (@ H & L B
Text .
RIS Zendesk API
API
Mobile SDK

Channel Integrations Settings OAuth Clients Activity Target Failures

If you want to use a global OAuth client, create a dient in this account and submit a reguest

BUSINESSRUEES to globalize it through our developer portal.

Routing

Triggers
All QAuth clients (7)

Automations

4. Fillin a Client Name of your choice, Short Description, and an Unique Identifier which should be
populated automatically. Keep a record of the unique identifier for use later.
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Settings OAuth Clients Activity Target Failures

If you want to use a global OAuth client, create a client in this account and submit 2 request to globalize it through our developer portal,

- FortiCASB Integration

FQUiCAS integration

forticash_integration

Redirect URLS

https://

(=]
5. In Redirect URLSs, use one of the corresponding redirect url provided by FortiCASB:

Region Redirect URL

Global https://www.forticasb.com/api/v1/oauth/redirect/Zendesk
Region

European https://eu.forticasb.com/api/v1/oauth/redirect/Zendesk
Union
Region

6. Click Save, and then in Secret field, click Generate to generate the secret token.
Note:Make sure to copy down the secret token as it will only appear once.

Now go back to FortiCASB to add the Zendesk account.

Step 2: Update Zendesk Account

Log into FortiCASB with your account.
Go to Overview > Dashboard.
Click on the Zendesk account menu, and select Update Cloud Account.

Fill in the Zendesk Sub-Domain, Unique Identifier, and the Secret Token saved from earlier, and click
Update Zendesk Account.

5. You will be prompt to authorize FortiCASB to access to your Zendesk account, click Allow to complete
adding the Zendesk account.

AoObd -~
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FortiCASE Integration
by fortinet

Allow FortiCASB Integration to access your Zendesk account?
FortiCASB integration

This application would be able to:

= Write all user data.
« Read all user data.

Not forticash dev?

6. Wait 15 minutes to complete updating the Zendesk account to FortiCASB.

Zoom

FortiCASB offers an API-based approach, pulling data directly from Zoom via RESTful API. Then FortiCASB
portal accesses the data collected through API queries with OAuth2.0 authentication. Subsequently, FortiCASB
combines these data to monitor and track Zoom user activities, provides DLP Data Analysis for files shared
through Zoom.

Prerequisites

Make sure the Zoom account plan that will be used on FortiCASB is Pro, Business, Business Plus, or
Enterprise Zoom plans. Free plan is NOT supported.

The Zoom account user to be added on FortiCASB must be the Account Owner or Admin of the Zoom
account.

Add Zoom Account Steps

Configure Zoom Account Configuration on page 273

Create OAuth App on Zoom Account on page 274
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Configure Zoom Account Configuration

1. Loginto Zoom as the Account Owner or Admin.

2. Inthe left control pane, go to ADMIN > User Management > Roles

Zoom Products Solutions

ADMIN

~ User Management

Users

Groups

Roles

Contacts

w3

3. In Admin Role section, click on the ’ icon for Admin Role Settings.

7 Roles

Each user will belong to one of the roles below, and different roles have their unique privilege.

Role Name Description
Owner Account owner has full privileges to access and manage a Zoom account.
Admin Admins have wide range privileges 10 access and manage a Zoom account.

Members have access to basic Zoom video meeting functions but no account

Member L
management privileges.

Resources

Phone

Zmail

Language

Time Zone

Nate Farmat

4. InRole Settings tab, make sure the settings below are checked:

User and Permission Management
o Users: View
« Role management: View
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User and Permission Management

View Edit

Users

View or edit user information (6.g. assigning licenses and groups to USers)

Bulk delete, unlink, and deactivate 0

Bulk delete, unlink, and deactivate users

User advanced settings 0
View or edit advanced settings for Users.

Role management 0

View existing roles, or add and edit user roles.
*Enabling the Edit privilege automatically enables the Edit privilege for
Users.

Team Chat Management
« Chat Channels: View
« Chat messages: View
Team Chat Management

View Edit

Chatbots

Enable chatbots within Zoom Client

Chat channels 0

View or edit channels for all users in the account. This can be done via API
or directly in the admin portal.

Chat messages O

"View" enables APl access 10 all users’ chat messages in this account.
"Edit” enables APl access to send a message on behalf of any user in this
account.

Continue to Create OAuth App on Zoom Account on page 274

Create OAuth App on Zoom Account

1. Loginto Zoom as the Account Owner or Admin. (Same account as from Part 1)

2. Inthe left control pane, go to ADMIN > Advanced > App Marketplace, you will be re-directed to App
Marketplace.
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~ Advanced

App Marketplace

Branding
Security
Single Sign-0On

Integration

3. In App Marketplace, on the top right hand corner, click Develop drop down menu, and select Build App.

o

Develop ~ @ Manage a

Build App

Documentation

Developer Blog

Community Forum

4. Select OAuth app type and click Create.
5. Enter an App name of your preference,
a. Select Account-level app, and
b. Uncheck the option to publish the app on Zoom App Marketplace, and click Create.
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Create an OAuth app

App Name 12/50

Zoom_Connect

Choaose app type

© Account-level app

This app must be installed by admin and can manage all users in the account

User-managed app

This app can be installed and managed by individual users

Would you like to publish this app on Zoom App Marketplace?

() By publishing to Marketplace, your app will be available for external
users to install and use.

6. In App Credentials, keep a record of the Client ID and Client Secret.

App credentials

Use these credentials to access Zoom APIs from your app. Store these credentials securely, and avoid storing them in
public repositories.

Development

Use these credentials to test your app during the development phase. Zoom will only use these credentials to test App
Update requests.

Client ID

yDVI5ONSTHCYW2f8bgfWDA Copy

Client secret

~ Copy Regenerate

7. Copy the Redirect URL for OAuth from FortiCASB Add Zoom Account page and paste it to Redirect
URL for OAuth field.

Redirect URL for OAuth

The Development redirect URL is used to generate testable url for local testing.

https/fi forticasb.com/api/v1/oauth/redirect/Zoom

8. Scroll down to OAuth allow list, add the same redirect URL to the Add allow list, then click Continue.
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OAuth allow list

Add URLs to be allowlisted for OAuth redirection to achieve improved security. Make sure to include either the entire or
the prefix of the Redirect URL for OAuth. Learn More

Security Check

Security checks are used to prohibit others from tampering with redirected URLs.

Subdomain check C)

Only allow redirects that match the subdomain of the valid OAuth Redirect URL

Add allow lists

https:// forticasb.com/api/vi/oauth/redirect/Zoom Tar

<+ Add New List

9. Fillin the following information:

a.
b.

In Basic Information, fill in Short Description, Long Description, and Company Name.
In Developer Contact Information, fillin Name and E-Mail Address.

c. Click Continue
(Note: the app cannot be created without filling out these information)

Basic information

App name Short description (@

Zoom_Connect OAUth app for FOMICASB
12/50 23150

Long description (0
Please provide copy that focuses on the specific features and functionality of your app. Do not add jargon or exaggerated
claims on your app (&.g. "most secure” or "most popular”).

Normal ¢+ B T U S % <p» i= = &= A

.
H|

o
=

K@ I

.

This QAuth app will establish a connection between Zoom and FortiCASB.

10. In Add Feature, keep a record of the Secret Token.

Add features

Secret Token

Zoom sends the secret token in each event notification we send to your app.
Note: This secret token is used to verify event notifications sent by Zoom.

y0BXjusGSr2gPu8Tcm9vQ Copy Regenerate

FortiCASB 24.3.b Admin Guide

Fortinet Inc.

277



Cloud Application Onboarding

11. Turn on Event Subscription, then click
a. +Add new subscription, fill in a Subscription Name.

3 zoom-connect Ty

Subscription name (Optional)

MName this particular event subscription

Zoom-connect

b. Gobackto FortiCASB Add Zoom Account page, paste the client ID recorded earlier in the Client
ID field, and click Generate to generate Event Notification Endpoint URL.

b. In the left menu, navigate to Features:
i. Keep a record of Secret Token

ii. When you configure the Event Subscription, for the Event notification endpoint URL, please
generate below and fill in the field at Zoom.

ClientID+
yDVt50NsTHCYW2f8bgfWDA

Event Notification Endpoint URL
https:// forticasb.com/client/v1/webhook/zoom/new/yDVt50NsT... rﬁ

c. Copy the endpoint URL and paste it in Zoom Event notification endpoint URL and click Validate.

3y Zoom-Connect-Event Tir

Subscription name (Optional)

MName this particular event subscription

Zoom-Connect-Event

Event notification endpoint URL

Provide a URL to receive subscribed event notifications. This is for your production environment.

https:/h forticasb.com/client/v1/webhook/zoom/new/A09vTjcuSIZnshnnpOvaoiw
validate (D
12. In Add Events, click on +Add Events on Zoom and add the event types below, and click Done.

Add Events

Add events for your app to subscribe. Any corresponding scopes related to specific events will be
automatically selected.

+ 17 events added
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User User Activity Chat Channel Chat Message
User has been User has sianed in Chat Channel Chat Message
created 9 Created Sent
User has been User has signed Chat Channel Chat Message
disassociated out Deleted Updated
User has been Member Chat Message
deleted Removed Deleted
Usgr has been Member Left Chat. Message
activated Replied

User has been
deactivated

User has
accepted the
account invitation

User’s profile info
has been updated

13. In Event notification receiver, make sure All users in the accountis selected. Then click Save to
save the Event Subscription.

Event notification receiver
© Allusers in the account

Only users added this app

Save Cance|

14. Click Continue to go to the Scopes page.
15. In Add Scopes page, click +Add Scopes, then add the following scopes and click Continue.

Scope Type Scope

User View all user information/user:read:admin
View all users' team chat channels/chat_channel:read:admin
Team Chat . .
View all users' team chat messages/chat_message:read:admin
Role View all user roles/role:read:admin
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Scope Name /1D

View all users' team chat channels /chat_channeliread:admin Delete

[_;;‘. Describe how your app intends to use this particular scope

View all users' team chat messages /chat_message:read:admin Delete

[_;;‘. Describe how your app intends to use this particular scope

View all user meetings /meeting:read:admin Delete

@ Describe how your app intends to use this particular scope

View all user roles /role-read:-admin Delete

@ Describe how your app intends to use this particular scope

View all user information /userread admin Delete

@ Describe how your app intends to use this particular scope

16. Now Go back to FortiCASB Add Zoom Account Page, fill in the Zoom Client Secret and the Secret
Token from earlier, then click Grant Access @Zoom.

2. Fill in the account Information int he fields below:
Client Secret +

yDVt50NsTHCYW2f8bgfWDA

Secret Token =

yOBXju5GSr2gPu8Tcém%vQ

Grant Access @Zoom

17. You will be re-directed to Zoom OAuth authorization page to authorize sharing user information with
FortiCASB. Click Allow to authorize the sharing of information and be re-directed back to FortiCASB.
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N o

You are about to add Zoom_Connect
a Switch Account

© App can access and manage this information even when not using the app.

App can view information

Associated with your account and others you're allowed to access

1 Settings >

P\ Profile & Contact Information >

Associated with your account, others you're allowed to access, Jnd others included in that

information.
Wy Content >
#2  Participant Profile & Contact Information >
= Product Usage >

By clicking Allow, you give permission to this app to use your information in accordance . You can remove this app at any

time in My Apps.

The add account process is completed, please wait 15 minutes and check on the status of the account.

Add Zoom Account

° Finish Configurations @Zoom ° Create an OAuth App @Zoom ° Done

FortiCASB is adding this account. The process may take up to 15 min.
You can check whether it is successfully added in the Overview > Dashboard.

Check Status
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Update Zoom Account

Before updating the Zoom account on FortiCASB, complete the same configurations using the same Zoom

account:

Configure Zoom Account Configuration on page 273

After the Zoom configuration is completed, follow these steps to update your Zoom account on FortiCASB

Create OAuth App on Zoom Account

1.
2.

3.

4. Select OAuth app type and click Create.

Log into Zoom as the Account Owner or Admin. (Same account as from Part 1)
In the left control pane, go to ADMIN > Advanced > App Marketplace, you will be re-directed to App

Marketplace.

~ Advanced

App Marketplace

In App Marketplace, on the top right hand corner, click Develop drop down menu, and select Build App.

i

Branding

Security

Single Sign-On

Integration

o
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5. Enter an App name of your preference,
a. Select Account-level app, and
b. Uncheck the option to publish the app on Zoom App Marketplace, and click Create.

Create an OAuth app

App Name 12/50

Zoom_Connect

Choaose app type

© Account-level app

This app must be installed by admin and can manage all users in the account

User-managed app

This app can be installed and managed by individual users

Would you like to publish this app on Zoom App Marketplace?

() By publishing to Marketplace, your app will be available for external
users to install and use.

6. In App Credentials, keep a record of the Client ID and Client Secret.

App credentials

Use these credentials to access Zoom APls from your app. Store these credentials securely, and avoid storing them in
public repositories.

Development

Use these credentials to test your app during the development phase. Zoom will only use these credentials to test App
Update requests.

Client ID

yDVISONSTHCYW2f8bgWDA Copy

Client secret

~ Copy Regenerate

7. Copy the Redirect URL for OAuth from FortiCASB Update Zoom Account page and paste it to
Redirect URL for OAuth field.

Redirect URL for OAuth

The Development redirect URL is used to generate testable url for local testing.

https/f forticasb.com/api/vi/oauth/redirect/Zoom

8. Scroll down to OAuth allow list, add the same redirect URL to the Add allow list, then click Continue.
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OAuth allow list

Add URLs to be allowlisted for OAuth redirection to achieve improved security. Make sure to include either the entire or
the prefix of the Redirect URL for OAuth. Learn More

Security Check

Security checks are used to prohibit others from tampering with redirected URLs.

Subdomain check C)

Only allow redirects that match the subdomain of the valid OAuth Redirect URL

Add allow lists

https:// forticasb.com/api/vi/oauth/redirect/Zoom Tar

<+ Add New List

9. Fillin the following information:

a.
b.

In Basic Information, fill in Short Description, Long Description, and Company Name.
In Developer Contact Information, fillin Name and E-Mail Address.

c. Click Continue
(Note: the app cannot be created without filling out these information)

Basic information

App name Short description (@

Zoom_Connect OAUth app for FOMICASB
12/50 23150

Long description (0
Please provide copy that focuses on the specific features and functionality of your app. Do not add jargon or exaggerated
claims on your app (&.g. "most secure” or "most popular”).

Normal ¢+ B T U S % <p» i= = &= A

.
H|

o
=

K@ I

.

This QAuth app will establish a connection between Zoom and FortiCASB.

10. In Add Feature, keep a record of the Secret Token.

Add features

Secret Token

Zoom sends the secret token in each event notification we send to your app.
Note: This secret token is used to verify event notifications sent by Zoom.

y0BXjusGSr2gPu8Tcm9vQ Copy Regenerate
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11. Turn on Event Subscription, then click
a. +Add new subscription, fill in a Subscription Name.

3 zoom-connect Ty

Subscription name (Optional)

MName this particular event subscription

Zoom-connect

b. Gobackto FortiCASBUpdate Zoom Account page, paste the client ID recorded earlier in the
Client ID field, and click Generate to generate Event Notification Endpoint URL.

b. In the left menu, navigate to Features:
i. Keep a record of Secret Token

ii. When you configure the Event Subscription, for the Event notification endpoint URL, please
generate below and fill in the field at Zoom.

ClientID+
yDVt50NsTHCYW2f8bgfWDA

Event Notification Endpoint URL
https:// forticasb.com/client/v1/webhook/zoom/new/yDVt50NsT... rﬁ

c. Copy the endpoint URL and paste it in Zoom Event notification endpoint URL and click Validate.

3y Zoom-Connect-Event Tir

Subscription name (Optional)

MName this particular event subscription

Zoom-Connect-Event

Event notification endpoint URL

Provide a URL to receive subscribed event notifications. This is for your production environment.

https:/h forticasb.com/client/v1/webhook/zoom/new/A09vTjcuSIZnshnnpOvaoiw
validate (D
12. In Add Events, click on +Add Events on Zoom and add the event types below, and click Done.

Add Events

Add events for your app to subscribe. Any corresponding scopes related to specific events will be
automatically selected.

+ 17 events added
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User User Activity Chat Channel Chat Message
User has been User has sianed in Chat Channel Chat Message
created 9 Created Sent
User has been User has signed Chat Channel Chat Message
disassociated out Deleted Updated
User has been Member Chat Message
deleted Removed Deleted
Usgr has been Member Left Chat. Message
activated Replied

User has been
deactivated

User has
accepted the
account invitation

User’s profile info
has been updated

13. In Event notification receiver, make sure All users in the accountis selected. Then click Save to
save the Event Subscription.

Event notification receiver
© Allusers in the account

Only users added this app

Save Cance|

14. Click Continue to go to the Scopes page.
15. In Add Scopes page, click +Add Scopes, then add the following scopes and click Continue.

Scope Type Scope

User View all user information/user:read:admin
View all users' team chat channels/chat_channel:read:admin
Team Chat . .
View all users' team chat messages/chat_message:read:admin
Role View all user roles/role:read:admin
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Scope Name /1D

View all users' team chat channels /chat_channeliread:admin Delete

[_;;‘. Describe how your app intends to use this particular scope

View all users' team chat messages /chat_message:read:admin Delete

[_;;‘. Describe how your app intends to use this particular scope

View all user meetings /meeting:read:admin Delete

@ Describe how your app intends to use this particular scope

View all user roles /role-read:-admin Delete

@ Describe how your app intends to use this particular scope

View all user information /userread admin Delete

@ Describe how your app intends to use this particular scope

16. Now Go back to FortiCASB Update Zoom Account Page, fill in the Zoom Client Secret and the Secret
Token from earlier, then click Grant Access @Zoom.

2. Fill in the account Information int he fields below:
Client Secret +

yDVt50NsTHCYW2f8bgfWDA

Secret Token =

yOBXju5GSr2gPu8Tcém%vQ

Grant Access @Zoom

17. You will be re-directed to Zoom OAuth authorization page to authorize sharing user information with
FortiCASB. Click Allow to authorize the sharing of information and be re-directed back to FortiCASB.
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—
" =

You are about to add Zoom_Connect

a Switch Account

© App can access and manage this information even when not using the app

App can view information

Associated with your account and others you're allowed to access

1 Settings >

R, Profile & Contact Information >
Associated with your account, others you're allowed to access, ;nd others included in that
information.

iy Content >

#2  Participant Profile & Contact Information >

= Product Usage >

By clicking Allow, you give permission to this app to use your information in accordance . You can remove this app at any

time in My Apps.

The update account process is completed, please wait 15 minutes and check on the status of the account.
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Overview Features

This section covers general operations and Overview features in FortiCASB.

Forti
Version23.1
@ Overview

Drashboard
Drata Protection

Report

Audit Log

Shadow IT
Drata Pattern
Trusted List

Fabric Integration

Overview / Dashboard

Business Unit Overview

BU Name az BUID &334

Google Workspace

including

GO

Overview features are features not specific to cloud accounts. They are features that incorporate data collected
from cloud accounts onboard in FortiCASB.

Overview Topics

Activate and Generate Reports on page 292

View FortiCASB Audit logs on page 302

Shadow IT Discovery Configurations

App Events Supported by FortiCASB

on page 319

Fabric Integration Configuration on page 337
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Global Alert

Global Alert is located in Overview > Alert page. Global Alert combines all alerts from all supported cloud
applications onboard in one single view.

Overview / Alerts

Alert Overview

B DataAnalysis U Threat Protection i=  Compliance

Time Range: Last 24 hours [x]

Alert Type Policy/Pattern SaaS App Severity Object
» Compliance HIPAA - Logins I] Office 365 Information
»  Threat Protection Restricted User ﬂ Office 365 ® Alert
»  Compliance PCI - Privileged Account Activity l] Office 365 ® Critical
»  Threat Protection Unapproved Login Location l] Office 365 ® Critical
»  Threat Protection Customized office 365_customized_policy ﬂ Office 365 ® Alert
Alert Types

Alert Types - There are 3 types of alerts, Data Analysis, Threat Protection, and Compliance

Data Analysis alerts are alerts generated by Data Security Policies created in Data Protection > Policies
> Data Policies.

Threat Protection alerts are alerts generated by Threat Protection policies. For Threat Protection policy
configuration, click on the cloud application account and go to Policy > Threat Protection. For more details
see Threat Protection on page 419

Compliance alerts are alerts generated by Compliance policies. For Compliance policy configuration, click on
the cloud application account and go to Policy > Compliance. For more details see Compliance Policy on
page 420.

Click on any of the three types of alerts to filter the alert type.
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Overview / Alerts

Alert Overview

‘ B DataAnalysis ‘ © Threat Protection = Compliance

Time Range: Last 24 hours Q

Threat Protection and Compliance policies only support the following cloud applications:

Cloud
Applications

Salesforce
Office 365
Box
Dropbox
Confluence
Egnyte
GitHub

Jira

SAP IAS
ServiceNow
Webex Teams

Zoom

Alert Filters

Click on +Add Filter to filter the alerts by different types of alert attributes, then click search button to filter.
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Time Range: Last 24 hours <]

Activity Type - filter alerts by the specific cloud application account activity.
Policy/Patterns - filter alerts by the specific policy of the cloud application account.
Alert ID - each alert has its own specific alert ID.

Saa$S application - filter alerts by the cloud application account. For example, when Office 365 is selected,

Alert Type

Threat Protection

Compliance

Threat Protection

Threat Protection Custe

Compliance

Threat Protection

Threat Protection

Filters

Activity Type
Alert D

Alert Type
Country/Region
Object Mame
Policy/Pattern
Saa$s Application
Severity

Time Range

User

only Office 365 alerts are shown.

Activate and Generate Reports

FortiCASB allows you to generate C-level, Compliance, and Shadow IT reports.
C-Level reports are quarterly, monthly, or annual reports.

Compliance reports give an overview of overall compliance with policies such as HIPAA, SOX/COBIT, and

PCI.
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) Office 365

) Office 365
) Office 365
) Office 365
) Office 365

) Office 365

Severity

® (Critical

® (Critical

® Alert

® Alert

Information

® (Critical

® Alert
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Shadow IT reports highlight unsanctioned application usage.

Generate C-Level Report

1. Goto Overview > Report > C-Level from FortiCASB left navigation pane.
2. Click Generate to generate C-Level Report
3. Choose a Type (Yearly, Quarterly, or Monthly Report), select the Year, then click Generate C-Level

Report.
. L
4. Afterthe report is generated, it will be available under the Action column, click to download the
report.
Overview / Report / C-Level FHEE « 3 = | (2]
Please click Generate button to generate monthly, quaterly, or yearly C-level report.

reated Date Report Title Action

2021March

2021

7/19,10:53:10 AM 2021

[
2
x«
2
2 9:52 PM 2021 April
2

2021May

Generate Compliance Report

Compliance report are automatically generated monthly, quarterly, and yearly. You may also customized a
time frame to generate compliance reports. HIPAA, GDPR, SOX-COBIT, and PCI-DSS are generated in zip

UL

format while 1ISO 27001 and NIST800 reports are in PDF. Click on the action icon to download the report.
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S ! /, The prerequisite to generate Compliance report is to enable and configure Compliance
? Policies required by your organization. For more details on configuring Compliance
= policies, please refer to Policy Configuration on page 421.

Customized Compliance Report

After you have enabled Compliance Policies, follow the steps below to generate Compliance report.

1. Goto Overview > Report > Compliance from FortiCASB navigation pane, Click on Generate to
generate Compliance Report.

Overview / Report / Compliance EHE < 3 = o
Compliance Report is automatically generated every month, quarter and year. You can also click
) . N . GENERATE
Generate button to generate Compliance Reports during customized time range.
Created Date Report Title Action

QA Test Office365 PCI-DSS Compliance Report Jul

0:00 - Jul 16 23:37:39 UTC.zip

QA Test Box 15O 27001 Compliance Report Jul

-Jul 16 22:24:47 UTC.zip

QA Test BoxNIST800

1 Compliance Report Jul 07 07:00:00 - Jul 16 22:24:47 UTC.2ip

QA Test Box NISTB00-53 rev4 Compli

ort Jul 07 07:00:00 - Jul 16 22:24:47 UTCzip

QA Test Box GDPR Compliance Report Jul 070!

- Jul 16 22:24:47 UTCzip

2. Select a Report Type, then select a Cloud Application (Office 365, Google Workspace etc.)

Generate Report

1. Select Report Type

Select All HIPAA

PCI-DSS SOX-COBIT
GDFR NIST800-53 rev4
NIST800-171 1SO 27001

2. Select Cloud Application

Select All Salesforce
Office365 Box
Dropbox Google

2. Select Time Frame

mm/dd/yyyy -|03/20/2020

¥ Send me email notification when reports are ready.

Have you configuered email notification?

3. Select a Time Frame that is within 90 days from today.
Click Generate Now to generate the report.

5. The report will be generated with your user name, cloud application, report type, and date range as the file
title.
For example, an Office 365 PCI compliance report with a date range of 3/1/2020 to 3/14/2020 will be "
'‘User Name' Office 365 PCI Compliance Report Mar 14 00:00:00 - Mar 14 23:59:59 UTC.zip".

b
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Activate Alert Report

Alert Report keeps track of all daily security alerts and lets you download daily security report. At the end of
each month, all daily Alert report will be consolidated into one monthly report for download.

To enable Alert Report to export all daily security alerts, please enable any of the Compliance policies below to
activate the feature:

o NIST800/53 - Track all security alerts
o NIST800/171 - Track all security alerts
o 18027001 - Track all security alerts

Note: only one policy from above needs to be enabled to activate Alert Report.

Activate Alert Report through NIST800/53

1. Click on the targeted cloud account. (Salesforce, Office 365, etc.) from FortiCASB navigation menu.
2. Goto Policy > Compliance, and click NIST800-53 rev4 tab.
3. Locate the policy NIST800/53 - Track all security alerts.

v  NIST800/53 - Track all security alerts Track all security alerts ® Critical
Policy Guideline IR-5 INCIDENT MONITORING: The organization tracks and documents information system security incidents.
Enabled Off
Severity Critical -

Email Notification on m If enabled, below people will be notified when this policy is violated.

Save Changes Clear Changes

4. Enable the policy by clicking the On button.

Activate Alert Report through NIST800/171

1. Click on the targeted cloud account. (Salesforce, Office 365, etc.) from FortiCASB navigation menu.
2. Goto Policy > Compliance, and click NIST SP800-171 tab.
3. Locate the policy NIST800/171 - Track all security alerts.
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MNIST800/171 - Track all security alerts Track all security alerts ® Critical

Policy Guideline 3.6.1Establish an operational incident-handling capability for organizational information systems that includes
adequate preparation, detection, analysis, containment, recovery, and user response activities. 3.6.2Track, document,

and report incidents to appropriate organizational officials and/or authorities.

Enabled B o
Severity Critical -
Email Motification On m If enabled, below people will be notified when this policy is violated.

m Clear Changes

4. Enable the policy by clicking the On button.

Activate Alert Report through 1ISO27001

1. Click on the targeted cloud account. (Salesforce, Office 365, etc.) from FortiCASB navigation menu.

2. Goto Policy > Compliance, and click ISO 27001 tab.
3. Locate the policy ISO27001 - Track all security alerts.

» 1S0O27001 - Track all security alerts Track all security alerts ® Critical
Policy Guideline A.16.1 Management of information security incidents and improvements: To ensure a consistent and effective
approach to the management of information security incidents, including communication on security events and
weaknesses.
Enabled [ on e
Severity Critical v
Email Notification Oon m If enabled, below people will be notified when this palicy is violated.

Clear Changes

4. Enable the policy by clicking the On button.

Generate Alert Report

Daily alert report is compiled into a CSV file and made available for export. At the end of each month, all daily

reports of the that month are combined and packaged into a ZIP file and made available for download.
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An alternative option of exporting daily reports is to consolidate up-to-date daily reports of the current month
into one ZIP file.

Export Reports

1.
2

From FortiCASB navigation menu, go to Overview > Report > Alert.

In the Current Month tab, click the Cloud App drop down menu and select a cloud application

(Salesforce, Office 365, etc.).

Overview / Report / Alert

YYou need to enable one of more Compliance Policies that track all security alerts, then FortiCASB will start to export daily Alert Report. Click here to see which policy to enable and how to.

At the end of each month, FortiCASE will package all daily Activity Report in this month for you to download.

Current Month History

Cloud App: Office 3... +

ReportTitle
Office365_Alert_Report20210701_UTC.csv
Office365_Alert_Report20210702_UTC.csv
Office365_Alert_Report20210703_UTC.csv

Office365_Alert_Report20210704_UTC.csv

Size

149.56 KB

5481KB

1736 KB

1359KB

#0608 =O

Package Up-To-Date for Download

Action

L2
Option 1 - Select any of the daily report and click download button — to download the daily report.

Option 2 - Click Package Up-To-Date for Download button to combine all up to date daily reports of
the current month into one zip file. The combined ZIP file will be made available for download with .zip

extension.

Current Month History

Cloud App: Office 3...

Report Title

Office365_Alert Report20210721 UTC.csv
Offica365_Alert Report20210722_UTC.csv
Office365_Alert Report20210723_UTC.csv
Office365_Alert Report20210724_UTC.csv

Office365_Alert Report20210725_UTC.csv

Office365_Alert_Report20210726T2205Z_0si9QSKUQHWHWIrMIGMmy_w.zip

Office365_Alert_Report20210726T2205Z_ZDPQ1DpQSpOFKRLsfXUZ4wzip

Office365_Alert Report20210726_UTC.csv

Package Up-To-Date for Download

Size Action
47193KB &
34385KB £3
2833KB E3
214Bytes &
11.01KB F3
587.03KB E3
587.03KB &
229.59KB F3

3. Click History tab to export monthly security alert reports. Click the year drop down menu to select year,
and Cloud App drop down menu to select a cloud account, and all monthly security alert reports available
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of that year will be available for export.

Current Month History

Year: 2021 « Cloud App: Office 3... «

Report Title

Office365_Alert_Report202102_UTC.zip
Office365_Alert_Report202103_UTC.zip
Office3é65_Alert_Report202104_UTC.zip
Office365_Alert_Report202105_UTC.zip

Office365_Alert_Report202106_UTC.zip

Activate Activity Report

Activity Report keeps track of all daily cloud account activities and lets you download daily activity report. At the
end of each month, all daily activity reports will be consolidated into one monthly report for download.

To enable Activity Report to export all daily activities, please enable the following Compliance policy below to
activate the feature:

« NIST800/53 - Display content of audit record

Enable NIST800/53 - Display content of audit record:

1. Click on the targeted cloud account (Salesforce, Office 365, etc.) from FortiCASB navigation menu.
2. Goto Policy > Compliance, and click NIST800-53 rev4 tab.
3. Locate the policy NIST800/53 - Display content of audit record.
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» NIST800/53 - Display content of audit record Display content of audit record ® Critical

Policy Guideline AU-3CONTENT OF AUDIT RECORDS; AU-3 (1) CONTENT OF AUDIT RECORDS | ADDITIONAL AUDIT
INFORMATION; AU-12 (2) STANDARDIZED FORMATS: The information system produces a system-wide (logical or
physical) audit trail composed of audit records in a standardized format.

Enabled off
Severity Critical -
Email Notification On m If enabled, below people will be notified when this palicy is violated

m Cleer Changes

4. Enable the policy by clicking the On button.

Generate Activity Report

Daily activity report is compiled into a CSV file and made available for export. At the end of each month, all
daily reports of the that month are combined and packaged into a ZIP file and made available for download.

An alternative option of exporting daily reports is to consolidate up-to-date daily reports of the current month
into one ZIP file.

Export Report

1. From FortiCASB navigation menu, go to Overview > Report > Activity.

2. Inthe Current Month tab, click the cloud account drop down menu and select a cloud application
(Salesforce, Office 365, etc.).
All/ Report / Activity AEZO

Activity Report
You need to enable one of more Compliance Policies that track all security alerts, then FortiCASB will start to export daily Alert Report. Click here to see which policy to enable and how to.
Atthe end of each month, FortiCASB will package all daily Alert Report in this manth for you to download.

Current Month History
i v
Office365_Activity_Report20200622_UTC esv 8859KB E
Office365_Activity_Report20200623_UTC csv 146.02KB &
Office365 Alert Report2020622T18237_8iDIN7WmTOC248KWtZRoLQ zin 169K8 &
Office365 Activity_Report2020623T1919Z_0E7PZBKHSym2TGF atRbarz zip 4009KB &
Office365 Activity_Report2020623T950Z_902ne2q_Sxm9nyYvN2yybQzip 4009KB &

X
Option 1 - Select any of the daily report and click download button — to download the daily report.

Option 2 - Click Package Up-To-Date for Download button to combine all up to date daily reports of
the current month into one zip file. The combined ZIP file will be made available for download with .zip
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extension.
All / Report / Activity ABE=O
Activity Report

You need to enable one of more Compliance Policies that track all security alerts, then FortiCASB will start to export daily Alert Report. Click here to see which policy to enable and how to.
Atthe end of each month, FortiCASB will package all daily Alert Report in this manth for you to download.

Current Month History

Office365 Activity Report20200622_UTC.csv 8859KB &
Office385 Activity_Report20200623_ UTC esv 14602KB &
Officed65 Alert Report2020622T1823Z_BiDINTWmTOC248KWtZRpLQ 2D 169K8 &
Office 365 Activity_Report2020623T1919Z_oE 7PZBKHSym 2TGF atRbArgzip 4009KB &
Office365 Activity_Report2020623T950Z_902ne2q_SxmInyYvN2yybQzip 4009KB &

3. Click History tab to export monthly activity reports. Click the year drop down menu to select year, and
Cloud Applicationt drop down menu to select a cloud account, and all monthly activity reports available
of that year will be available for export.

Generate Shadow IT Report

Go to Overview > Report > Shadow IT page to download Shadow IT reports, Shadow IT reports are
generated automatically.

Click on Settings to configure notification, report format, and report generation frequency.

Shadow IT Report Settings x

Email Notification *  on [E48)
Export As * PDF "

Frequency * Hourly w

EndsBy* 07/15/2021 =

Mo End Date

Save Settings Cancel
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Customized Shadow IT Reports

Shadow IT reports with customized date range can be generated for a fixed time frame.

1. In Shadow IT page, click on Generate.

Overview / Report / Shadow IT H o =] (7]
Shadow IT Report can be automatically generated. To configure, click Settings. You can also click -
. ) ) [N TN W | SETTINGS
Generate to generate Shadow IT Reports during customized time range.

Created Date Report Title Action
2021/07/15,02:47:17 PM
2021/07/15,02:47:06 PM
2021/07/15,02:41:05 PM

2021/07/15,02:41:01 PM

2. Click on Date Range to select a time frame of the report.

Generate Shadow IT Report %

Date Range * Last 7 days

Last 24 hours

v Last 7 days

(eELEE ICRLEL |ast 30days  Cancel

Last 90 days

Custom

3. Click Generate Shadow IT Reportto generate the report.
4. After the report is generated, it will be available to download under Action column.
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View FortiCASB Audit logs

Audit logs records all administrative and user activities in FortiCASB.

To access the Audit log page, go to Overview > Audit log.

You can filter searches by using the +Add Filter option.

Overview / Audit Log

Time Range: Last 24 hours [~}

User

feashdemo@gm

ail.com

fcasbdemo@gm

ail.com

fcasbdemo@sm

ail.com

fecashdemo@gm

ail.com

Vendor

FortiCASE

FortiCASE

FortiCASE

FortiCASE

TimesStamp Operation Module Object ID Content

2024/01/23,10:40:35 A

” Login User 36241 User login successfully
2024/01/23,10:40:06 A
M Login User 36241 User login successfully
2024/01/23,10:27:03 A _
M Login User 36241 User login successfully
2024/01/23,10:19:34 A

Login User 36241 User login successfully

M

A\,

For detailed description of each operation or event, please refer to App Events
Supported by FortiCASB on page 319.

Data Analysis Logs

FortiCASB accesses your information by downloading files, scanning the downloads, then subsequently
deleting the downloads at regular intervals.

NOTE: For your privacy, FortiCASB does not retain your files. You may check to see when and which files
FortiCASB has downloaded, scanned, and deleted by clicking the Data Analysis Logs button, located at the
top-right corner.

Click on the icon below in the top right corner to access Data Analysis Logs.

R e Il =
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Data Analysis Log

Last 7days v

File Download Scan Delete Vendor

2021/07/22,05:41:48 2021/07/22,05:41:48 2021/07/22,05:41:56

PM PM PM Dropbox
2021/07/22,05:41:49 2021/07/22,05:41:49 2021/07/22,05:41:55 ) .
PM PM PM Dropbox
2021/07/22,05:41:48 2021/07/22,05:41:48 2021/07/22,05:41:50 Dropbox
PM PM PM ropbox
2021/07/22,05:41:47 2021/07/22,05:41:47 2021/07/22,05:41:50 Dropbox
PM PM PM ropbox
, . 2021/07/22,05:41:46 2021/07/22,05:41:46 2021/07/22,05:41:50
ssntest15 - Copy (3).txt Dropbox

PM PM PM

Shadow IT Discovery

FortiCASB provides features for shadow IT discovery. By integrating with FortiGate and FortiAnalyzer,
FortiCASB gives users a concrete overview of all sanctioned and unsanctioned cloud applications within the
organization. Furthermore, FortiCASB calculates a risk score for each application and gives users the ability to
control application usage.

FortiCASB's Shadow IT discovery helps users enhance the security of their cloud application environment with
the following features:

« Unsanctioned Application Discovery— FortiCASB uses logs from FortiGate and FortiAnalyzer as well
as its own discovery process to deliver a comprehensive view of risk and usage of cloud applications.

o Cloud Risk Score—FortiCASB generates a cloud risk score for each cloud application. This score is
calculated using many factors, such as but not limited to: user numbers, size of the company, multi-factor
authentication support, and service hosting location. These factors are used to generate scores in multiple
criteria, which are then aggregated into one final score.

o Access Control—Users can block or monitor certain applications using FortiCASB and FortiGate.

« Data Correlation—FortiCASB uses data from FortiGate and FortiAnalyzer, as well as its own data to
define and identify riskier activities.

Configurations and Requirements

Shadow IT discovery requires a FortiGate or FortiAnalyzer policy.
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Configuration details depend on your specific setup requirements. See the scenarios below, and find the one
which best suits your needs.

Scenario 1: Receive logs from FortiGate.

Complete the FortiGate and FortiCASB configurations in the following order:

1. FortiGate Configuration on page 304 (Complete all 3 parts)
2. Log Configuration Using FortiGate GUI on page 307
3. FortiCASB Configuration on page 313

Scenario 2: Receive logs from FortiAnalyzer.

Complete the FortiGate, FortiAnalyzer and FortiCASB configurations in the following order:

1. FortiGate Configuration on page 304 (Complete all 3 parts)
2. FortiAnalyzer Configurations on page 310
3. FortiCASB Configuration on page 313

FortiGate Configuration

Part 1 - Create SSL/SSH Inspection Profile on page 304
Part 2 - Application Control Configuration on page 305
Part 3 - Firewall Policy Configuration on page 306

Part 1 - Create SSL/SSH Inspection Profile

Log into FortiGate, go to Security Profiles > SSL/SSH Inspection.

Create a new SSL/SSH inspection profile called "deep-test".

In Protocol Port Mapping, enable Inspect all ports.

Scroll down to SSH Inspection Options, enable SSH deep scan, click Specify and enter ssh port: 22.
Scroll down to Common Options, select Allow for Invalid SSL certificates

In Common Options, enable Log SSL anomalies.

o0k~ ODdN-R
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The completed configuration should be as the following:

Edit SSL/SSH Inspection Profile

Name deep-test

Comments | Write a comment #0/255

S5L Inspaction Options

Enable SSLinspection of Multiple Clients Connecting to Multiple Servers

Protecting 55L Server

Inspection method 55L Certificate Inspection

CA certificate W Fortinet_CA_SSL

Blocked certificates @ allow [EEZY | = view Blocksd Certificates
Untrusted SSL certificates m Block | Ignore | = View Trusted CAs List
Server certificate SNI check @ m Strict | Disable

Enforce S5L cipher compliance »

Enforce SSL negotiation compliance (B

RPC over HTTPS >

Protocol Port Mapping
Inspect all ports €O
HTTPS

SMTPS

POP35

IMAPS

FTPS

DNS over TLS

Exempt from SSL Inspection
Reputable websites @ B

Web categories Finance and Banking x
Health and Wellness x
Personal Privacy x

+

Addresses +

Log SSLexemptions

55H Inspection Options

55H deep scan @O

SSH port L seecity JEH]

Common Options
Invalid SSL certificates Block | Custom
Log S5L znomalies @ ©

Part 2 - Application Control Configuration

1. Goto Security Profiles > Application Control.

2. Select default or create a new profile

3. Click All Categories drop down menu and select Monitor.
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Edit Application Sensor

111 Cloud Applications require deep inspection.
1 policies are using this profile.

Name default
Comments | Monitor all applications. 4257255
Categories

~ |All Categories
@ Monitor
@ Allow
@ Block

i

52,85 6) @~ Cloud.IT (61, &3 1) @~ Collaboration (264, &3 16)
| & 12) @~ Game (85) @~ General.Interest (231, & 7)

=" Quarantine @~ Network.Service (331) @~ P2P (54)

@~ Proxy (173) @ ~ Remote.Access (93) @~ Social.Media (118, & 32)
@ ~ Storage.Backup (161, & 20) @ ~ |Update (49) @~ Video/Audio (155, & 17)
@~ \plP (24) @ ~ 'Web.Client (24) @ - Unknown Applications

@ Network Protocol Enforcement

4. Under Options, enable Allow and Log DNS Traffic and Replacement Messages for HTTP-based
Applications.

QOptions

Block applications detected on non-default ports @ B
Allow and Log DNS Traffic | @]

Quic © XIS Eiock |

Replacement Messages for HTTP-based Applications @O

Part 3 - Firewall Policy Configuration

Goto Policy & Objects > Firewall Policy.
Create a new policy named "Shadow-IT".

Configure Security Profiles:

a.

b.
c.

To use access control, enable the Web Filter created with the URL filter set. (If you have setup web
filter profile)

Enable Application Control to allow FortiCASB to track how many cloud applications are visited.

To correlate log data with FortiCASB data, make sure Application Control is enabled, and click
SSL/SSH Inspection drop down menu to select deep-test.

In Logging Options, enable Log Allowed Traffic, and select either Security Events or All Sessions.
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The completed configuration should be as the following:

Name O l Shadoe-I |

Incoming Interface M port2 -

Outgoing Interface N portl -

Source = an x
*

IPMAC Based Access Control @ *

Destination = x
*

Schedule ® atways -

Service @ AL x
+

Acticn v ACCEPT NnlsHN

Inspection Mode

Firewall/Network Ogptions

NAT

[ o]

IP Pool Configuration Use Dutgoing Interface Address [REERCEED U0

Preserve Source Port @0

Protocel Opticns

Security Profiles
AntiVirus

Web Filter

Video Filter

DNS Filter
Application Control
P

File Filter

S5L Inspection

Decrypted Traffic b

Logging Options
Log Allowed Trafhic
Generate Logs when

Capture Packsts

Comments | Write acomment

= detaute -

»
»

© 3 defaure - &
>

N ceep-test M4

irror (O

© | Security Events

Session Starts @D

7 0r1023

Enable this policy @O

Log Configuration Using FortiGate GUI

1. InFortiGate, go to Log & Report > Log Settings.
2. Enable Send Logs to FortiAnalyzer/FortiManager.
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Remote Logging and Archiving

Send logs to FortiAnalyzer/FortiManager © Disabled

Server 52.89.162.108 Test Connectivity
Connection status ©@ Connected

Storage usage OB/OB

Analytics usage OB/OB

Archive usage 0B/OB

Upload option ISR Every Minute | Every 5 Minutes

Allow access to FortiGate RESTAPI D

Werify FortiAnalyzer certificate »

3. In Server, enter the FortiCASB receiver's |IP address.
The FortiCASB receiver IP address can be found by pressing the Device button from the FortiCASB
Shadow IT dashboard. It will be one of the following addresses:

Global and US Users 52.89.162.108 or 52.24.189.163
EU Users 54.155.112.218 or 34.240.128.139

4. Test the connectivity by clicking Test Connectivity.

You can also configure and check the connection by using the following CLI.

Please only choose one method(CLI or GUI) to configure FortiCASB
connection. If you have already done it through GUI, do not configure

it again through CLI.

Log configuration using FortiGate CLI

Obtain the Application Control ID from FortiGate:
Go to FortiGate > Security Events > Application Control > Other
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B Security

Information

1059028704

Source Interface Role
Destination Interface Role
Direction

Incident Saria

app-ctrl
signature
undefined
undefined
outgoing
258,692,689

Then continue with the log configuration using FortiGate CLI mode.

1. Login to the FortiGate's CLI mode.

2. Configure log settings for the FortiCASB device on the FortiGate.

#config log fortianalyzer setting
#set status enable
#set server <FortiCASB server IP>
#set enc-algorithm high-medium
fset upload-option realtime
#set reliable enable

#end

3. (Optional) Configure the log filter to only forward application-ctrl logs using the application control ID

obtained earlier:

#config log fortianalyzer filter
#config free-style

#edit 1

#set filter-type include
#set filter "logid <Application Control ID>"

#end

4. Test the connection using the following CLI command:
#execute log fortianalyzer test-connectivity

If the connection is successful, the FortiGate will return the following:

Registration: registered

Connection: allow

Otherwise, the FortiGate will return an error code
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FortiAnalyzer Configurations

Part 1: FortiAnalyzer Port Configuration on page 310

Part 2: FortiAnalyzer System Configuration on page 310

Part 3: Configure FortiAnalyzer on FortiGate on page 312

Part 1: FortiAnalyzer Port Configuration

This section is to provide a public IPv4 address for FortiAnalyzer and make sure the IP address with the
following ports can be accessed from the external network.

Protocols TCP Port

1.

HTTP 80
HTTPS 443
In FortiAnalyzer, go to System Settings > Network, select the interface.

€ Dashboard Network
FortiAnalyzer Fabric

@ Logging Topology Interface

@& AllADOMs
C Storage Info [+ Create New]| B Delete Search...

= Name#® Type = Members/Interface =  IP/Netmask + IPv6 Address = n
r:‘ HA . v portl Physical Interface . - /0 1
2 Admin ? O port2 Physical Interface 0.0.0.0/0.0.0.0 /0

EB Certificates

2. Then click Edit to edit the network interface.
3. Enable HTTPS or HTTP in Administrative Access. (The network connection will be tested in

FortiCASB Configuration on page 313)

Edit Network Interface x
Name portl
Alias
1P Address/Netmask
IPvé Address /0
Administrative Access HTTPS HTTP | (O PING SSH O sNMP O g\e/?\l/)ice [ FortiManager
IPv6 Administrative Access O HTTPS O HTTP [J PING [J SSH O sNMP O g\éi\?ice [ FortiManager
Status [ e}

Part 2: FortiAnalyzer System Configuration

1.

Finish all parts 1-3 in the FortiGate Configuration on page 304.

2. Goto FortiAnalyzer > System Settings, click on Administrators, select the user to be connected to

FortiCASB and press Edit.
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eatures

€3 Dashboard

25 Logging Topology
2 All ADOMs
 Storage Info

£ Network

& HA

2 Admin ~

Profile
Remote Authentication Server
Admin Settings

SAML S50

+ Create New [# Edit
O Name
admin
0O gatest
O

]

gatestl

%@ Clone

1l Delete M Move [ETableView ~ 45 Column Settings ~

Type
LOCAL

LOCAL

LOCAL

LOCAL

Profile

Super_User

Standard_User

Super_User

Standard_Use!

Click Admin Profile drop down menu and select "Standard_User" or "Super_User".

Edit Administrator
User Name
Avatar

Comments

Admin Type

Admin Profile

Administrative Domain

JSON APl Access

Trusted Hosts

Meta Fields >
Advanced Options >

Click JSON API Access drop down menu and select "Read-Write".

== Change Photo

test user issue

LOCAL

Super_User

= Remove Photo

|. Read-Write

OFF

Use the following CLI commands to add RPC-permit's read and write permissions to the user:
config system admin user
edit "user" (The FortiAnalyzer user that will be used to connect to FortiCASB.)

set rpc-permit read-write

CLI Console

Connected *

FRZVME4-2W5 # config system admin user

(user)# edit gatest

(gatest)$# set rpc-permit read-write

(gatest) #
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Part 3: Configure FortiAnalyzer on FortiGate

1. Goto FortiGate and open CLI, then enter the following command:
#config log fortianalyzer2 setting
#set status enable
#set server <FortiAnalyzor server IP>
#set enc-algorithm high-medium
#set upload-option realtime
#set reliable enable
#end

2. GotoFortiAnalyzer > Device & Groups.
3. Look for the unauthorized FortiGate device and authorize it.

Device Manager v

= @0 Add Device

Device & Groups ¥ 9 Return @ Hide T Delete [ Display Hidden Devices

1& Search... Q O  ADevice Name Model Serial Number Connecting IP
All Logging Devices (] @FAZ-VM FortiAnalyzer-DOCKER ~ FAZ-VMT 172.31.34.241
O @FGVYMO: FortiGate-VMé4-AWS FGVMO04 172.31.44.250

0O @SYSLOG Syslog-Device SYSLOG-! 3.144.153.31
O @sYSLOG Syslog-Device SYSLOG- 47.88.106.237

(] mSYSLOG Syslog-Device SYSLOG- 47.254.20.57

4. Go toback to FortiGate then execute the following command to test the connection.
fexecute log fortianalyzer test-connectivity 2

5. If the connection is successful, FortiGate will return the following:
Registration: registered
Connection: allow

The entire CLI output should look like below:

FGVMO4TMXXXXXX # execute log fortianalyzer test-connectivity 2
FortiAnalyzer Host Name: FAZAWS

FortiAnalyzer Adom Name: root

FortiGate Device ID: FGVMO4TMXXXXXX

Registration: registered

Connection: allow

Adom Disk Space (Used/Allocated): 3921305424B/53687091200B
Analytics Usage (Used/Allocated): 790079985B/37580963840B
Analytics Usage (Data Policy Days Actual/Configured): 32/60 Days
Archive Usage (Used/Allocated): 3131225439B/16106127360B

Archive Usage (Data Policy Days Actual/Configured): 55/365 Days
Log: Tx & Rx (6 logs received since 15:21:34 08/29/23)

IPS Packet Log: Tx & Rx

Content Archive: Tx & Rx

Quarantine: Tx & Rx

Certificate of Fortianalyzer valid and serial number is: FAZ-VMTMXXXXXX
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FortiCASB Configuration

1. Goto Overview > Shadow IT > Dashboard.
a. Click the Connect button, located on the top right, from the Shadow IT dashboard, then click Add

Forticiaod £ servicesw @ support .
&> Forti Overview / Shadow IT / Dashboard AREYO
@ Overview a v
© o s
B Report > I & Top Hign Risk Apps & TopClient Apps
oING 1 Dot w521
B AuditLog 2
% : 11112
Outadog 1 cam 2 Facebook @
Hootsuite : rer 1 s
2/5 : AVASTofcnare 1 116
o
Ever 1 AWS 1 Data.cor 112
After 1 LogMeln 103

b. In Device Setting, click Device Type drop down menu to select either FortiGate or FortiAnalyzer.

Add Device b
Device Type
FortiGate ~

FortiGate

FortiAnalyzer

OS5 Version

56 W

2. Enterthe Device ID. The Device ID is the Serial Number of the FortiAnalyzer or FortiGate.
For Example, on FortiAnalyzer, the Serial Number is shown in System Setting Dashboard.
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£2 Toggle Widgets ~

Ed LuggingTDpu\D
& Al ADOMs System Information o R
C Storage Info Host Name d
% Netwark Serial Number
& HA Platform Type
& Admin ~ HA Status Standalone
Administrators System Time Mon Jun 14 17:35:01 2021 PDT rd
Profile Firmware Version v6.4.3-build2201 201021 (GA) &
Remote Authentication Server System Configuration Last Backup : N/A 2 &
Admin Settings Current Administrators admin /1 in total =
SAML S50 Up Time 5 days 58 minutes 35 seconds
B8 Certificstes Administrative Domain m
Local Certificates
Operation Mode Analyzer Collector
CA Certificates

3. In OS Version, if the FortiGate or FortiAnalyzer version is 6.0 or above, select 6.0 and higher version.

4. InProtocol, select HTTP or HTTPS depending on which one is enabled in FortiAnalyzer Setting. The
port will update automatically with the HTTP/HTTPS selection.

Protocol

HTTPS ~

HTTP

HTTPS

5. Click Testto test the HTTP/HTTPS connection.
6. a. ForFortiGate, click Save to finish the device setting.

b. For FortiAnalyzer, fill in the rest of the fields, press Next, then you will be prompt to select the
FortiGate device(s) (The FortiGate device you authorized in FortiAnalyzer) to add.
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Add Device

Device Type

FortiAnalyzer

Device ID *

FAZ-VMTM23005822

05 Version

[6.0 and higher version

Protocol
HTTPS

Host

Port
443

Username

admin

Password

ADOM Mame

root

Interval

10min

Device ID

SYSLOG-AZF3IBASF

SYSLOG-CACTFTITE

c. Click Save to finish add device, then a summary page will be shown as below.
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Status Device ID Type Host Action

FGVMO4TM22002361 FORTIGATE - -

] FAZ-VMTM21007706 FORTIANALYZER 18.237.184.156 =
] FGVMO4TM22002360 FORTIGATE - -
© 54.156.122.76 FORTIGATE - -
o 11272403 FORTIGATE - -
o
°

FGVMO4TM21010966 FORTIGATE - FAZVCLTM21000881 ﬁ

—_—

Note: Please make sure the FAZ is shown under the Parent Device column.

Using Shadow IT Discovery

Access control

After analyzing an application using FortiCASB, users can use FortiGate's Web Filter to block or monitor the
application.

1. Use FortiCASB to get the host name of the traffic to be controlled.
2. Onthe FortiGate device, go to Security Profile > Web Filter.
3. Under Static URL Filter, choose the URL filter.

& Static URL Filter

Block invalid URLs (B

URL Filter O
# Edit Delete Search Q
URL Type Action Status
www.box.com Simple @ Allow @ Enable

Block malicious URLs discovered by FortiSandbox Cl
Content Filter @ ]

4. Click Create New to add a new URL filter.
5. Choose a Type.

FortiCASB 24.3.b Admin Guide
Fortinet Inc.

316



Overview Features

6. Choose an Action.
7. Set Status to Open.
8. Click OK.

New URL Filter

URL

Type Reg. Expression Wildcard
Action Block Allow Monitor
Status @©

OK  Cancel

Shadow IT Dashboard

Usage of unsanctioned cloud applications

All unsanctioned cloud applications are given a ranking based on the risk score, the number of users, and use

volume. FortiCASB uses that data to pinpoint and display the applications, clients, and sessions that are most
at risk. FortiCASB also displays the statistics and percentage of risky applications, clients, and sessions using

pie charts.
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# Usage of Unsanctioned Cloud Applications

‘a Statistics

9/40

Unsanctioned Applications

9/48

Clients

240/7234

Sessions

File insight

File insight shows the total number of sanctioned cloud applications the organization is using, the total number
of users, and the total number of files stored in each cloud application.

E File Insight

@ Files Stored Sanctioned Cloud Apps

17 2370 41059 11080 1193

Sanctioned

File Storage Users
Applications

File Insight

Office 365

Jira

GCP Storage

Eznyte

SERVICENOW
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14590
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4922
4033

2902

318



Overview Features

Top Unsanctioned Apps

The Top High Risk, Client, and Session Apps displays all applications monitored by FortiCASB. Filter the

list using the time range box on the top right.

Click on an app to display detailed information regarding the application.

£ Top High Risk Apps

Harris Media

Hosting.India.to

Molo

Fixus Host

Host4Yourself

Engage

GalaxyHostPlus

FarmLogs

Host.ag

Azendoo

App Events Supported by FortiCASB

This section shows the types of cloud account events FortiCASB supports. These types of events will be traced

2 Top Client Apps

AWS

Data.com

Do

Fortinet

Linkedin

Mixpanel

Skype

update.CRM

Azendoo

Baidu Cloud

M) Top Session Apps

Fortinet

Data.com

Skype

AWS

update.CRM

Zoom

Harris Media

Hosting.India.to

Mixpanel

Squarespace

3741

1722

658

269

249

141

140

74

60

36

at the Activity page of each cloud application, and they can also be used as criteria when configuring policy

and applying filters.

A\,

‘Q' The File Download events are monitored within the FortiCASB Audit log, go to
- Overview > Audit Log from the navigation menu.
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Box Events

Event Type Event

File/Folder Upload File
Copy File
Download File
Edit File
Move File
Preview File
Rename File
Open File
Modify File
Create Lock
Comment
Login Login Success
Login Failed
User Create User
Modify User
Delete User
Group Add Group
Update Group

Group Add
Membership

Create Metadata

Metadata ek

Update Metadata
Template

Create Metadata
Instance

Update Metadata
Instance

Collaboration

Collaboration .
Invite

Collaboration
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Event Type Event

Share

Accept

Collaboration
Role Change

Update
Collaboration
Expiration

Collaboration
Expiration

Share File

Update Shared
File

Update Shared
Expiration

Share Expiration

Confluence Events

Type

User

Group

Attachments

Label

Event
User created
User removed
User deactivated
User followed
Group created
Group removed

Attachment viewed
Attachment created
Attachment Updated
Attachment trashed

Attachment restore
Attachment removed

Label created/added

FortiCASB 24.3.b Admin Guide

Fortinet Inc.

Description
New user created in the account.
A user is deleted from the account.
A user is deactivated from the account.
A user is reactivated on the account.
Creates a new user group.
Delete user group.
File view activity via Webhook Event.

Create File/Upload File activity via
Webhook Event.

File update activity via Webhook Event.

Trash/Delete File activity via Webhook
Event.

File restore activity via Webhook Event.

File removed activity via Webhook Event.

Label create activity via Webhook Event.
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Type

Space

Page

Comment

Event

Label removed/deleted

Space created
Space updated

Space logo updated
Space removed
Page viewed

Page created

Page updated

Page moved

Page removed

Page archived

Page restored

Page trashed
Comment created
Comment updated

Comment removed

Dropbox Business Events

Login

Login Success
Login Failed
Logout

Login As User
Session Start

FortiCASB 24.3.b Admin Guide
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Description

Label removed activity via Webhook
Event.

Space create activity via Webhook Event.

Space update activity via Webhook
Event.

Space logo activity via Webhook Event.
Delete space activity via Webhook Event
Page view activity via Webhook Event.
Page create activity via Webhook Event.
Page update activity via Webhook Event.
Page move activity via Webhook Event.

Page removed activity via Webhook
Event.

Page archived activity via Webhook
Event.

Page restored activity via Webhook
Event.

Page deleted activity via Webhook Event.

Create comment under this page.
Edit comment under this page.

Delete comment under this page.
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Event Type Event

User (Member)

Group

File

FortiCASB 24.3.b Admin Guide
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Login As User
Session End

Create User

User Change
Name

User Change
Status

User Change
Admin Role

User Change
Email

Change Password
Password Restore

Password Restore
All

Add Group
Delete Group

Add Group
Member

Remove Group
Member

Group Rename
File Add

File Download
File Preview

File Edit

File Delete

File Add Comment
File Move

File Copy

File Rename

File Restore
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Event Type Event

File Share

Egnyte Events

Event Type

File

Event

File Revert
Share Link Create

Share Link Create
Password

Share Link Public
Share Link Disable

Share Link Team
Only

Share Link Set
Expiration

Share Link
Remove Expiration

Share Link View

Share Link
Download

Share Link Team
Copy

Description

Upload File
Delete File
Move File

Copy File
Add Version

Delete Version

Delete Version
(VPC)

Restore File
Rename File

Upload File
Via Link

FortiCASB 24.3.b Admin Guide
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Upload a new file

Delete an existing file
Move a file to different path
Copy file to different path

Modification in the existing file, create a new

version of the file

Delete version of the file by user

Delete version (Version Policy Control) of the file

by Egnyte System

Restore the file from trash

Change the name of the existing file

Create shared link for sharing to upload file
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Event Type Event

Folder Add Folder

Description

Upload a new folder

Delete Folder | Delete an existing folder

Move Folder Move folder to different path

Copy Folder

Copy folder to different path

Restore Folder | Restore folder from the trash

Rename

Folder
Permission oo

permission

Create
Feed

comment

Change name of the folder

Change share | Any change in user permissions on sharing the

folder

Any note/comment posted by user regarding the
file

Google Workspace Events

Login

File

FortiCASB 24.3.b Admin Guide
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Login
Success

Login
Failure

Login
Challenge

Logout
Create File

Upload
File

Edit File
View File

Rename
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Event Type Event

File
Move File
Delete File

Download
File

Preview
File

Trash File

Untrash
File

Create

User
User

Suspend
User

Unsuspend
User

Modify
User

Change
Password

Create
Data
Transfer
Request

Delete
User

Assign
Role

Unassign
Role
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GitHub Events

Event Type Event Description
Add o
User Add a member to the organization
Member

Add a person to the repository. (This
Add Outside | person is not an existing organization
Collaborator | member and does not exist in outside
collaborator)

RO Remove a member from the organization
Member

Remove a person from all of the
RO repositories where this person belongs
Outside P g .

to. (This person is not an organization

Collaborator member but an outside collaborator)

Change Change an organization member’s role
Role between owner and member
Convert To

Convert an organization member to

OLELD outside collaborator

Collaborator

Team Add Team Add team in organization
e Add member in existing team
Member
Remove
Team Remove member from team
Member
Delete Delete the team from organization
Team
ch This event contains three cases:
Pa?enngie « Add a parent team to team
Team « Change the parent team of team

« Remove the parent team of team

Ch . -

Repository ang_e Repository Visibility can be change

Privilege Repository between public and private

9 Visibility P private.
h .
ga:;]ge Change repository access base
. permission for organization members.
Permission
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Event Type Event Description
Update
;I;]eam s Role Update team’s role in the repository.
Repository
Update This event contains two cases:
People’s Update an organization member’s role in
Role In the repository and Update an outside

Repository collaborator’s role in the repository

This event contains three cases:
« Add an existing organization
member to the repository.
Collaborators | Add People « Add the person that doesn't belong
And Teams To to this organization in the repository.
In Repository | Repository (This person become an outside
collaborator)
« Add an existing outside collaborator
to the repository.

This event contains two cases:

Remove - o
« Remove an existing organization

People .
From member from the repository

. « Remove an outside collaborator
Repository .

from the repository
?gd Team Add an existing organization team into
Fispestion the repository
Remove
Team From | Remove team from the repository
Repository
File Upload File | Upload new file

Delete File Delete afile
Modify File Make changes of a file

Create

Branch Create a branch in the repository

Delete

Branch Delete a branch from repository

Create

Repository Create a repository of the organization

Delete

Repository Delete a repository of the organization
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Event Type

Jira Events

Event

Rename

Repository
Add Folder

Delete
Folder

Description
Change name of the repository
Add a new folder in the branch

Delete a folder from the branch

User
Activity

File
Activity

Issue
Activity

Comment
Activity

User login
User login
failure

User logout
Create user
Update user
Delete user

File created

File deleted

Issue
created

Issue
updated

Issue
deleted

Comment
created

Comment

FortiCASB 24.3.b Admin Guide
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Auser has logged in.

A user log in has failed.

A user has logged out.

A user has been created.

A user profile has been updated.
A user is deleted.

Afile attachment is created on the project
orissue.

Afile attachment is deleted from the project
orissue.

An issue is created.

An issue is updated.

An issue has been deleted.

A comment is created.

A comment is updated.

329



Overview Features

Event Type

Login

User

Group

Event
updated

Comment
deleted

Office 365 Events

Event Type Event

FortiCASB 24.3.b Admin Guide
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Description

A comment is deleted.

Login
Success

Login
Failed

Create
User

Delete User

Modify
User

Restore
User

Change
Password

Modify
Role

Add Group

Delete
Group

Add Group
Member

Update
Group

Add Group
Owner

Delete

330



Overview Features

Event Type Event

File

Share

FortiCASB 24.3.b Admin Guide
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Group
Owner

Set Group
Managed
By

Create
Group
Settings

Update
Group
Settings

Delete
Group
Settings

Set Group
License

Upload File
Delete File

Download
File

Modify File
Access File
Move File
Copy File

Rename
File

Edit File
Share File

Create
Anonymous
Link

Delete
Anonymous
Link

Create
Company
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Event Type Event

Link

Delete
Company
Link
Company
Link Used

Modify

Other .
License

Delete
Folder

Create
Sharing
Invitation
Edit
Company
Info

Salesforce Events

Event Type Event

Login Login Success
Login Failed

User Create User
Modify User

Change Password
Activate User
Deactivate User

Change User
Profile

Change User Role

Change User Email

Change User
Permission Set
Group Add Group
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Event Type Event

Profile

Permission Set

Feed

File

Share

Business

Add Group
Member

Update Group

Change Group
Access

Add External
Group Member
(Customer)

Invite People
Create Profile
Modify Profile

Add Permission
Set

Modify Permission
Set

Post

Modify Post
Comment
Modify Comment
Upload File

Upload New
Version

Download File
Edit File
Share File

Share File with
People

Share File with
Group

Share File via Link

Download File via
Link

Account
Modification

FortiCASB 24.3.b Admin Guide
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Event Type Event

Account Owner
Change

Contact
Modification

Contact Owner
Change

Account Create

Contact Create

SAP IAS Events

User

Login Success . -
gin =t User log in success activity.

Login Failed User log in failed activity.

Log out -
gou User log out success activity.

success

Create User Create user activity.

Delete User Delete user activity.

Activate user Activate user activity.

Deactivate Deactivate user activity.
user

Update user Update user activity.
Assign user Assign group activit
group gn group Y.

Unassign user

group Unassign group activity.
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ServiceNow Events

Event Type Event list Description

Login Success A user has logged in successfully
Login Login Failed A user login failed

Logout A user has logged out

Create User A user has been created

Delete User A user has been deleted

Modify User Modify user’s attribution
User Restore user Recover a deleted user

Change Password Change user’s login password
Add User Role Add user’s role

Delete User Role Delete user's role

Add User to Group Add a user to selected group

Remove User from Remove user from the selected
Group Group group

Add Group Role Add group’s role

Delete Group Role Delete group’s role

Upload File Upload a file in the table
Rename File Rename afile
File
Download File Download a file
Delete File Delete afile

Webex Teams Events

Event Type Event Description
User User login A user log into to Webex
Activity g 9 '
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Event Type Event Description
Create user A user is created.
Delete user A user is deleted.

Create Add someone to a room by Person ID or

. email address.
memberships

Delete Deletes a membership by ID.

memberships

Update Update a membership by ID.

memberships

Participant

joined a A participant join the meeting.
meeting

Participant
lefta A participant left the meeting.
meeting

File

ER Upload file Afile is uploaded in chat.

Delete file Afile is deleted from chat.

Zoom Events

User Create User | Auser has been created.
Update User | A user profile has been updated.

Delete User | A user has been deleted.

Activate A user has been activated on Zoom.
User
B::::tlvate A user has been deactivated on Zoom.

Disassociate

A user has been disassociated.
User
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Event Type Event Description

User Login .

Activity Success A user has log in successfully.
Logout A user has log out successfully.
Change The user password has been changed.
Password
Change The user role has been changed.
User Role

Channel Create A chat channel is created.
Channel
Delete A chat channel is deleted.
Channel
M . .

Message S::jage A chat message is sent in the chat room.
Message A chat message is replied in the chat room.
Reply
Message A chat message is updated in the chat
Update room.
Message A chat message is deleted in from the chat
Delete room.

FortiCASB only monitors messages in Team Chat Channel, but not private
messages between Zoom users

Fabric Integration Configuration

Overview

As part of the Fortinet Security Fabric, FortiCASB security alerts and logs can be shared with FortiAnalyzer to
leverage Saa$S security context.

FortiAnalyzer is a centralized security analytics that can view all Fortinet Security Fabric products in a bird's-eye
view.
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The purpose of Fabric Integration is so that other Fortinet security Fabrics such as FortiGate and FortiClient
can access FortiCASB's SaaS security alerts and provide more oversight.

Fabric Integration Procedures

FortiAnalyzer will be configured and added on FortiCASB to initiate fabric integration.
Follow these configuration guide to add and configure FortiAnalyzer on FortiCASB:

1. Add FortiAnalyzer on FortiCASB on page 340
2. Authorize FortiCASB on FortiAnalyzer on page 342

View FortiCASB Security Alerts on FortiAnalyzer

After FortiAnalyzer is configured and added on FortiCASB, FortiCASB will be recognized as a Syslog device
When Data Analysis alerts are sent to FortiAnalyzer, they will be displayed as Syslog messages.

In FortiAnalyzer, Syslog messages can be viewed in Log View > Syslog.

i logView v =

¥ Fabric > B ) Devices selected ~ ® Last 1 Hour~ 15:34:39 To 16:34:38

= FortiGate > " Add Filterl

FartiAnalyzer >
# Device ID Level Message

B Syslog v 1 SYSLOG-2CD02760 alert logid=234QNVG718e3jNbu_QQe655eouBveFTA type=Data Analysis subtype=Malware level=1

2 SYSLOG-2CD02760 alert logid=234QNVF?5801i5BDGtRoqVkplQj5LBdQ type=Data Analysis subtype=Malware level=1

B Log Browse 3 SYSLOG-2CD02760 alert logid=234QNVF216a05GBQBBSS2UPmn-mR-YQg type=Data Analysis subtype=Malware leve

B Log Group 4 SYSLOG-2CD02760 alert logid=234QNVE494CmOzvéafQzKBI8htgkPAkw type=Data Analysis subtype=Malware level=1
5 SYSLOG-2CD02760 alert logid=234QNVD7341RGsUQGeQgekWHITXZTFEw type=Data Analysis subtype=Malware leve
) SYSLOG-2CD02760 alert logid=234QNVDO003mdu3f4XgT 7WnBZGobEa7bA type=Data Analysis subtype=Malware level:
7 SYSLOG-2CD02760 alert logid=234QNVC072kfvuRhYjS1yVéJIwKiCgpDQ type=Data Analysis subtype=Malware level=1
8 SYSLOG-2CD02760 alert logid=234QNVB145jgxWCptcRVSmRMrootAXUg type=Data Analysis subtype=Malware level=
9 SYSLOG-2CD02760 alert logid=234QNVA321kTUwd3sMRTCOTOHmMZCPQHw type=Data Analysis subtype=Malware ley
10 SYSLOG-2CD02760 alert logid=234QNV9446G8Ig0GIKRBa4MTZMXBvASw type=Data Analysis subtype=Malware level
11 SYSLOG-2CD02760 alert logid=234QNV87100e5Huly4RVaObaRUohtHNQ type=Data Analysis subtype=Malware level:
12 SYSLOG-2CD02760 alert logid=234QNV7987 AqTHYErKTKglZ2LtheyAxw type=Data Analysis subtype=Malware level=1
13 SYSLOG-2CD02760 alert logid=234QNV76268kfZBKUoRFat2Ttyrnbglw type=Data Analysis subtype=Malware level=1 v
14 SYSLOG-2CD02760 alert logid=234QNV7239BaCtklkKTdyB3edWyPsxlw type=Data Analysis subtype=Malware level=1"
15 SYSLOG-2CD02760 alert logid=234QNV6756DZIBuoLnQ_6B8UKhH4kBEQ type=Data Analysis subtype=Malware level=

The Syslog details contain alert details sent from FortiCASB.

= logDetails
Date/Time 16:31:16
Destination End User ID 1

Destination Endpoint ID
Device ID

Device Name

Device Time

Level

Message

Time Stamp

Type

UEBA Endpoint ID
UEBA User ID

1
SY5LOG-2CD02760
FortiCASE
2023-04-26 23:31:16

alert
logid=2340QNVE494CmOzvéal QzKBIBhtgkPAkw type=Data Analysis subtype=Malware level=1 vd=root devid=FCASBRD eventtime=
1682550913000 tz=America/New_York srcip=44.208.39.96 policyid=8788385 poluuid=FC-ACT-254 policytype=AV Scan Policy srccountry=Unit
ed States user=3372980534 dstuser= sessionid=b53b537dd85e%f27b57 31ed5f8e9880 from=allenwangfortinet@gmail.comn to= eventtype=FOR
TICASB-FINDING httpmethod=GET severity=Critical filetype=zip filename=1199345737136_RDPKIL for azure.zip sentbyte=745263 rcvdbyte=7
45263 docsource=Baox sensitivity=false profile=1199345737136 epoch=1682551822000 filteridx=32 filtername=AV Scan filtertype=file infected
filename=119%345737136_RDPKIL for azure.zip infectedhlesize=745263 infectedhletype=zip policymode=DLP

2023-04-26 16:31:16
generic

1

1

FortiCASB Syslog Message Variables Specifications:
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Variable
Name

type

subtype
(optional)

devid
sessionid
eventtype

tz

docsource

Description
The type of alert sent from FortiCASB: Data Analysis, Threat
Protection, or Compliance.

Subtype is the Data Analysis policy's Data Pattern Category:
Personal Identity Information, Financial Information, or
Malware.

The FortiCASB product serial number of which the alert is
originated.

The alert ID of the FortiCASB security alert sent.

Event type is a static variable and will always show "FORTICASB-
FINDING".

Time Zone of the alert sent.

The cloud application where the security alert is triggered, e.g.
Salesforce, Office 365, Box, Dropbox, Google Workspace,
etc.

FortiAnalyzer Version Requirement

Fabric Integration requires FortiAnalyzer version 5.4 or later and FortiCASB license (Serial Number starts with

FCASBR or FCASBP).

Fabric Integration Port Requirement

There are two FortiAnalyzer ports that are required in Fabric Integration.

1. FortiCASB utilizes FortiAnalyzer TCP port for connection testing. A ping request is sent from FortiCASB to

FortiAnalyzer TCP port 514 when FortiAnalyzer is first added to FortiCASB.

2. FortiAnalyzer UDP port 514 is used for sending Syslog messages from FortiCASB to FortiAnalyzer.
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Please make sure FortiAnalyzer UDP port 514 and TCP port 514 are open to the
ﬂ following FortiCASB IPs depending on your region:
I FortiCASB Global(US) IP - 52.41.24.220

FortiCASB European Union IP - 34.247.192.72

Add FortiAnalyzer on FortiCASB

Collect the following FortiAnalyzer information first before configure and add FortiAnalyzer on FortiCASB.

o |P Address of the FortiAnalyzer
« FortiAnalyzer Serial Number

Steps to add FortiAnalyzer on FortiCASB

1. Goto Overview > Fabric Integration

Forti

. Overview / Fabric Integration
Version 23.1

®@ Overview

e To integrate with features on FortiAnalyzer devices,

Data Protection

Report Q, Search

Audit Log
Shadow IT Device Name
Data Pattern

Trusted List

Fabric Integration

2. Click +Add New to add new device.
For Device IP Address, it is the IP address of the FortiAnalyzer, e.g.,254.254.254.254
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Add New FortiAnalyzer

© Fitininfo

Device Name *

FortiAnalyzer Log Share

Device IP Address *

Device Serial Number *

FAZ-VMTM

2  Done

Alert To Be Sent To FortiAnalyzer *

Data Analysis

Add New FortiAnalyzer Cancel

For Device Serial Number, in FortiAnalyzer, go to System Settings. Serial Number is located in
System Information

System Settings ~

¢=» Dashboard

FortiAnalyzer Fabric

Logging Topology
AllADOMs

C & 28

Storage Info

<

Network

HA

Admin
Certificates
Log Forwarding

Fetcher Management

T EH B e

Event Log
Task Monitor
E: Advanced

=]

Toggle Widget v

System Information

Host Name

FAZAWS

| Serial Number

FAZ-NMTM

Platform Type

HA Status

System Time

Firmware Version
System Configuration
Current Administrators
Up Time
Administrative Domain

Operation Mode

FAZVM64-AWS

Standalone

Mon Apr 24 15:35:13 2023 PDT
v7.2.2-build1334 230201 (GA)

Last Backup : Tue Feb 28 18:11:40 2023
admin / 7 in total

54 days 19 hours 55 minutes 9 seconds
(o }

@ Colector

=

3. Click Add New FortiAnalyzer to finish.

FortiCASB will send a test log to FortiAnalyzer and awaiting to be authorized.

See Authorize FortiCASB on FortiAnalyzer on page 342 to authorize FortiCASB on FortiAnalyzer.
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Add New FortiAnalyzer

@ rilininfo @ pone

° FortiCASB has sent a test log to FortiAnalyzer. Thus you will find a new device with a
Connecting IP of 44.208.39.96 under Device Manager > Unauthorized Devices tab.

Once this device is authorized, you will start to see syslogs in FortiAnalyzer > Log
View > Syslog tab shortly after any alert is generated. Click here to learn how to
authorize this device.

Authorize FortiCASB on FortiAnalyzer

After FortiAnalyzer is added and configured on FortiCASB, the last step is to authorize FortiCASB on
FortiAnalyzer.

Please wait 5-10 minutes for FortiCASB device to show up in FortiAnalyzer's list of unauthorized devices.

Once FortiCASB is authorized on FortiAnalyzer, FortiCASB security logs and alerts can be shared with
FortiAnalyzer.

1. Log into FortiAnalyzer with your credentials.
2. Goto Device Manager from the main page.
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Fabric View

ﬁ )

Management

System Settings Extensions

3.

m Add Device  gp Device Group ~

@ Device & Groups v

& Search.. Q

All Logging Devices
nauthorized Devices

[# Edit | | m Delete 3] Table View ~

4. Check the FortiCASB device with Connecting IP as FortiCASB IP.

@ Add Device B Device Group ~

& Device & Groups v B Return [& Authorize @ Hide W Delete [ Display Hidden Devices

1F Search.. Q[ Device Name Model Serial Number ' Connecting IP
All Logging Devices O @SYSLOG-2CD02760 Syslog-Device SYSLOG-2CD02760 44.208.39.96
Unauthorized Devices

5. Click Authorize, and then click OK to confirm.
6. Select the device, click Edit and rename the device to "FortiCASB" or a name of your choice.(optional)
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Edit Device
Name FortiCASB
Description
IP Address 208
Serial Number SYSLOG-2CD02760 (Syslog-Device)
Firmware Version Standard Syslog
Admin User
Password sesssens

7. Now FortiCASB should be one of the authorized devices under All Logging Devices.

[# Edit | | I Delete |E|TabIeVECWVH ¢ More v~
O Device Name = IP Address < Platform < HA Status <
O @ FAZ-VMTM23002852 FortiAnalyzer-DOCKER
O B NING_HOME Syslog-Device
{[] o FortiCASE | 44.208.39.96 " Syslog-Device |
O @ SYSLOG-57ECBOSC Syslog-Device
O @ SYSLOG-602D2279 Syslog-Device
O @ SYSLOG-C6CTHE25 Syslog-Device
O @ TestSyslogDevice Syslog-Device
O ~ % FortigateFabric
O @ FortigateTest® FortiGate-VM&64-AWS

Remove Fortianalyzer from FortiCASB

When removing FortiAnalyzer from FortiCASB, FortiAnalyzer needs to be removed from FortiCASB, and
FortiCASB needs to be removed in FortiAnalyzer list of devices to completely remove the fabric integration.

1. In FortiCASB, go to Overview > Fabric Integration
2. Locate the device to be removed, click Action and select Delete Device.

FortiCASB 24.3.b Admin Guide 344
Fortinet Inc.



Overview Features

Device Serial Number Action
FAZNVMTM -
FAZ-NVMTN Update Device

Delete Device
1-2 o=

3. Click Delete Device again in the pop-up window to confirm.

A

Delete Device From FortiCASB

X

This device will be deleted immediately from FortiCASB.

Once it's deleted, you will no longer see new alerts in
FortiAnalyzer > Log View > Syslog tab. Syslogs received
previously will not be impacted.

Delete Device Do Not Delete

4. Now log into FortiAnzlyzer, go to Device Manager > All Logging Devices.
5. Locate the device with FortiCASB |IP address and delete the device.

[# Edit | | Tf Delete |E|Tab|o\f|'ow\f| : Morc-\f|
O Device Name = IP Address = Platform < HA Status =
O @ FAZ-VMTM23002852 FortiAnalyzer-DOCKER
O @NING_HOME Syslog-Device
[0 | @FortiCASB | 44.208.39.96 ' Syslog-Device |
O @ SYSLOG-57ECBO&C Syslog-Device
O @ SYSLOG-602D2279 Syslog-Device
O @ SYSLOG-C6CTEE2S Syslog-Device
O @ TestSyslogDevice Syslog-Device
O % FortigateFabric
O @ FortigateTest”™ _ FortiGate-VM6&64-AWS

will take about 5 minutes for FortiCASB to stop sending

2 After the FortiAnalyzer removal procedure is completed , it
security alerts to FortiAnalyzer Syslogs.
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Update FortiAnalyzer on FortiCASB

When updating FortiAnalyzer in FortiCASB, it allows you to rename the device in FortiCASB.
No action is required in the FortiAnalyzer side to update the FortiCASB configuration.

1. Goto Overview > Fabric Integration.
2. Forthe device to be updated, click Action and select Update Device.
3. Rename the Device Name.

Update FortiAnalyzer
@ Fiininfo 2 Done

Device Name *

FortiAnalyzer Logs Share

Device IP Address *

Device Serial Number *

FAZ-VMTM

Alert To Be Sent To FortiAnalyzer *

Data Analysis
Cancel

4. Click Update FortiAnalyzer to finish device update.

Tointegrate with features on FortiAnalyzer devices, please add new devices first in FortiCASB.

O\ Search

Device Name Device IP Address Device Serial Number Action
DaiweiAnalyzor

qgingfantest

FortiAnalyzer Log Share
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Data Protection Features

This sections covers Data Protection features in FortiCASB. Data Protection are the fundamental features of
FortiCASB where all SaaS application data are monitored and protected through Data Protection Policy and
analyzed through Files and Discovery.

Data Protection Topics

Data Protection Discovery Analytic on page 348
Data Protection Files Analytics on page 351
Data Security Policy on page 357

Predefined Data Pattern on page 381

Customized Data Pattern on page 389

Data Protection Discovery Analytic

Introduction

Discovery is located in Data Protection > Discovery. Discovery is an all-in-one analytics where all files from
the supported SaaS applications on board are analyzed and categorized with emphasis on files and users who
have access to the files that poses the most security vulnerability.

FortiCASB classifies data resides in cloud accounts as Data at Rest or Traffic Data.
Data At Rest is data uploaded onto the cloud application before the cloud account is added to FortiCASB.

Traffic Data is any data uploaded after the cloud account is added to FortiCASB and security monitoring has
been initiated.

When the cloud account is on board in FortiCASB, the files are scanned individually when there is an access
attempt. After the data scan is completed, depending on the Data Analysis policies enabled, FortiCASB will
classify the files as either sensitive data or non-sensitive files.

NP Discovery currently only supports the following cloud application

‘9' platforms:
|| Salesforce Office 365, Box, Dropbox, Google Workspace,
- Egnyte, Github, and Webex.
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All Files Overview

Overview / DataProtection / Discovery

All Files Overview

A Malware 157 Sensitive Files 1009 [# Shared Files 10132 High Risk File Owner 7

Malware are malicious softwares or files that can steal sensitive or valuable information from the cloud
accounts.

Click on Malware to review and remove malwares from cloud accounts before any data is compromised.

Sensitive Files are files that with DLP(Data Loss Prevention) data that contains personal information
identified by Data Analysis policies.

Click on the Sensitive files to show all files that have sensitive data to protect the personal identity information
from being exposed to unauthorized personnel.

Shared Files are files shared by the file creators to other users, groups, or any collaborators.
Click on Shared Files to review the cloud application files shared.

High Risk File Owner are users that are considered as high risk users who share sensitive files with other
users.

Exposure Summary

Others

Editor Wiewer

Comme._..

Exposure Summary categorizes users with access to files into different categorizes. Viewer, Editor,
Commenter, and Others are normalized share types of all cloud platforms. For more details on normalized
share types, see Appendix B - Normalized Share Types on page 557. Click on each normalized share type to
show only files shared by the specific type of user.

Top 10 File-Sharing Users are the top 10 file sharing users across all on board cloud applications.
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Top 10 File-Sharing Users File # Top 10 Users/Groups with Access to Shared Files File #
T 972 ¥ 1441
x 526 b'd 1421
Q 479 ¥ 500
(] 274 2 142
p+4 244 G 122
) 128 2 71
box 109 Q 57

Top 10 Users/Groups with Access to Shared Files are the top 10 users that are grant the most number of
file access.

Sensitive Files Exposure Overview

Sensitive Files Exposure Overview

Sensitive Files Exposure 470

® Office 365 @ Salesforce GitHub Google Workspace

Sensitive Files Exposure Overview is an intuitive graphical distribution which reveals the number of
Sensitive files shared per cloud application.

Hover the mouse over different colors to reveal the number of sensitive files shared from the targeted cloud
application.

Sensitive Files Exposure Overview

Sensitive Files Exposure 470

Salesforce
Sensitive File Exposure: 75

® Office 365 @ Salesforce GitHub Google Workspace

External Collaboration

External Collaboration Summary reveals the total number of sensitive and non-sensitive files shared to
external users/group and external domains.

External Collaboration summary only supports Office 365, Dropbox, Google Workspace, and Box.
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External Collaboration

Exposure Summary
Shared To External User Shared To External Domain
209 151
files shared to Trusted User files shared to Untrusted User
2 Sensitive 1 sensitive
207 Non-sensitive 150 Non-sensitive

Top 10 External Domains Shared To
I] gmail.com

& smail.com

I] adds-test.forticash.com

I] fortinet.com

& 123.com

&L euforticasb.com

& livemailtw

I] forticasb.com

File #

39

33

[ N T T

Not supported for All SaaS Apps

Top 10 External Users/Group Shared To
box ANONYMOUS
J

box 0726 gg change s8¢
1J anonymous

box Group 1 sse

'3

File #

73
64
50
47
41
35
31

27 .

Top 10 External Domains Shared To outlines the top 10 external domains which the cloud application files

are being shared with.

Top 10 External Users/Group Shared To depicts the top 10 external users/groups have access to the cloud

application files.

Data Protection Files Analytics

Introduction

Files is an all in one SaaS data storage security analytics located in Data Protection > Files. All files of all

cloud application on board can be accessed in Files.

When a cloud account is first added to FortiCASB, files resided in the cloud account are pulled into the Files

page. Then FortiCASB automatically updates the file status in Files page when users attempt to access files

through the cloud application account.

Files is also available in each of the cloud application except SAP IAS and Zoom.

The files bubble chart gives an overview of the files categorized by File Type, Data Analysis, Share Type,
and SaaS App. (SaaS App bubble chart is only available in the all in one Files in Data Protection.)
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Overview / DataProtection / Files EE o 3 = | Q
File Type Data Analysis Share Type SaaS App
gz exe - R, S GitHub
. exx [ 5T Dnvesr,%ﬁi:? salesforce

Others,

P o"

folder agde STE impe (cenz, A

“NarasterCa_ULF  Credit

asira,. Sirthdate Card

Jasspor £
ULk ULk

NUmbe! i sA/Germd!

Dropbox
eCloudSt

oo docx Tz forio  Kingdom ~Passport Oumer Editor Office365 Google
Yrivame Passport  Number L1 gy
aan ingdor Number Maestr /
d lsx b pLp  merCard L iSharet
" oe i sSN - Club issp jira
Card m
s Viewer
far ddresiliar Private o Webex
magic 2p xpree_rar AN Access ox
“ermamb
[AK
File Type: txt € “

File Type captures all file types regardless of readability within the scope of cloud account storage/bucket.
Click on each file type bubble to show files with the specific file type.

Data Analysis scans and captures all files that contains DLP (Data Loss Prevention) data. Each bubble
represents different Data Analysis policy.

Click on each Data Analysis bubble to show files only pertain to that Data Analysis policy.

Share Type is a normalized share type that normalized all cloud account users by grouping them together by
access permission. For more detail on normalized share type, please see Appendix B - Normalized Share
Types on page 557.

Click on each share type to see only files shared by the specific share type users.
SaaS App filters all cloud application files by cloud platform.
Click on each app bubble to filter the files by app.

Sort Cloud App Files by Filter

There are 11 filters that files can be sorted to identify the targeted files among all cloud applications:

Filters {Creator SaaS App Created Last Modified
Created
Data Analysis |] Office 365 2023/03/23,07:04:17 PM  2023/03/23,07:04:17 PM
Data Analysis Scan
. 1zhang@qga.stagingf
File Name it 8 &, Google Workspace 2023/03/23,11:57:55 AM  2023/03/23, 04:40:06 PM
J.com
File Type
Highlight 1zhang@qa.staging.f )
£, Google Workspace 2021/02/05,04:00:10 PM  2023/03/23,03:08:59 PM
Last Modified prom
Owner/Creator
£y GCP Storage 2023/03/23,12:42:49PM  2023/03/23,12:42:43 PM
Saas App
Share Type ©Y GCP Storage 2023/03/23,12:42:45PM  2023/03/23,12:42:45 PM
Target Of Exposed Files
M 2y GCP Storage 2023/03/23,12:42:44PM  2023/03/23,12:42:44 PM

For more information on Highlight and Data Analysis Scan filters, please see:
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Highlight Filter on page 354

Data Analysis Scan Filter on page 355

Example on using Files Filter

This example filters through all files for Malwares detected in the last 90 days among all cloud applications.

1. Click on +Add Filter.
2. Select Created > Last 90 days.

Created:
{Creator SaaS App

Last 24 hours

I Office 365
Last 7 days
Last 30 days IJ Office 365
Last 90 days @
Custom zhang@ga.staging.f

£ Google Workspace
2.c0m

3. Click +Add Filter again.
4. Select Data Analysis > AV Scan.

Created: Last 90 days @ | Data Analysis: AV Scan 9|

DLP China Union Pay
File Name Created

DLP MasterCard

DLP China Passport Number 2023/03/23,06:09:13 PM

DLP United Kingdom Passport Number 2023/03/23.06:09:12 PM

DLP Japan Passport Number

| DLP USA/Germany Passport Number
race 2023/03/23,11:57:55 AM

DLP Birthdate

DLP Canada Passport Number

AV Scan ace 2021/02/05,04:00:10 PM

DLP China Resident Identity

gist 2023/03/23, 12:42:49 PM
feglster DLP Spanish IBAN 103/

2NQe3wlLrO0L1svyEq: DLP Italian IBAN

- 2023/03/23,12:42:45 PM
T3vuDhK.php

5. Click Search sign and filter through all files.
6. All Malwares from the last 90 days are displayed.
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Created: Last 90 days €@  Data Analysis: AV Scan @  +Add

File Name Owner/Creator
DemoRDPKILL-1.exe Q Company Administrator

1118953543235_DemoRD
PKILL-1.exe

1107853929900_DemoRD
PKILL-1.exe

DemoRDPKILL-1.exe ¢y

RDPKIL for azure.zip

SaaS App

) office 365

box Box

box Box

) Office 365

&, Google Workspace

Created

2023/02/01,10:17:21 AM

2023/01/20,10:55:54 AM

2023/01/06, 10:41:40 AM

2023/01/03,11:25:17 AM

2023/01/17,11:52:40 AM

Last Modified

2023/02/01,10:17:21 AM

2023/01/20,10:55:54 AM

2023/01/06, 10:41:40 AM

2023/01/03,11:25:17 AM

2020/11/03,03:40:26 PM

7. Click on any one of malware to view basic details, activity, users exposed, and data pattern violation.

Basic Detail

File Name DemoRDPKILL-1.exe Q

Creator

Created Date 2023/02/01, 10:17:21 AM

Last Modified 2023/02/01,10:17:21 AM

Path Shared Documents/cucumber/cli/DemoRDPKILL-1.exe

Download Link E

Highlight &

Exposed To User/Group

Team Site Members

Highlight Filter

Owner

Write

Owner

Activity
2023/02/01
03:03:42 PM
02:44:10 PM
02:29:29 PM
02:03:36 PM
02:03:36 PM
02:02:51 PM
10:50:25 AM
10:38:21 AM

10:17:20AM

download file

download file

download file

rename file

move file

download file

download file

download file

upload file

The Highlight filter filters through all files for specific file type: Sensitive, External, and Malware.
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Highlight:
. mer
Sensitive Data

Clean Data
Malware

Below is correlated Highlight and file type with description.

Highlight Document Description

Icon Type
E Sensitive  Files with sensitive information searched and matched by
DLP policies such as Social Security Number, Visa Credit
Card number, etc.
ﬁ External Files shared with the external users/groups.
oy Malware Infectious files searched and matched by the malware
-

policies through AV scan.

Data Analysis Scan Filter

Data Analysis Scan, also called DLP Scan (Data Loss Prevention scan) identifies Personal Identification
Information(PIl) such as Driver License, Credit Card, Social Security Numbers, etc resting in the organization's
cloud account. It gives cloud administrators the opportunity to take action against possible external or internal
threat:

1. Possible network intrusion access on sensitive data.
2. Unauthorized internal storage of personal or sensitive data.
3. Detect potential malware and virus through Fortinet AV scan.

The Data Analysis scan is triggered when user activity is detected on the file resting in the cloud account. If the
file is identified to be a type of personal identification information, it will be noted in the file details.
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Created Date Last Modified Path Data Analysis Scan Highlight
cucumber/22.4b-retest/SSN14 N

2023/02/28,04:03:46 AM 2/28/2023, 4:03:46 AM @ scanned h
77585825.txt
Shared Documents/Shared Do

2023/02/27,04:03:44 PM 2/27/2023,4:03:44 PM Scan N/A @ —

uments/Apps/Yammer

Shared Documents/Shared Do
2023/02/27,04:02:53 PM 2/27/2023,4:02:53 PM Scan N/A @ -
uments/cucumber/22.4b-retes|

Documents/cucumber/22.4b-r
2023/02/27,04:02:21 PM 2/27/2023,4:02:21 PM . Scan N/A @ -
etes

cucumber/22.4b-retest/SSN14

2023/02/27,04:03:32 AM 2/27/2023,4:03:32 AM @ scanned ﬁ
77499411 txt
cucumber/22.4b-retest/55N14 ;
2023/02/26,04:03:36 AM 2/26/2023, 4:03:36 AM @ scanned h
77413015.4xt

cucumber/22.4b-retest/SSN14
2023/02/24,04:03:34 AM 2/24/2023, 4:03:34 AM @ Waiting —
77240213.txt

Data Analysis Scan Status

Data Ana- Description

lysis Scan
Status

Scanned The Data Analysis scan has completed and the scan result is
available to the administrator.

Scan N/A Data Analysis scan is not conducted on the file due to Data
Analysis Scan Limitations on page 356.

Waiting There has not been any user activity, thus the file is awaiting to be
scanned by Data Analysis.

Data Analysis Scan Limitations

Data analysis scan become unavailable or "Scan N/A" status under the following circumstances:

1. The file size exceeds 20MB.
2. The file extension is not a supported type. (See for supported file type)

3. When all Data Analysis policies are disabled, the Data Analysis Scan become unavailable. (See Policy
Configuration on page 421 for Data Analysis Policy Configuration)
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Data Security Policy

Introduction

Data Security Policy defines which DLP data patterns should be monitoring what type of files under which SaaS
applications, and what activities would trigger an alert. In addition, when a data security alert is triggered, what
action should be taken to mitigate.

In 2024, a major enhancement leveraging an Large Language Model framework with Al capability to accurately
trigger DLP alerts that match Data Security policy, false positives and false negatives are minimized while
providing better classification for text that can potentially match multiple data types.

Data Security Policy can be created in Data Protection > Policies > Data Policies.
@ FortiCloud @ Servicesw @ Support =

Forti

) Data Protection / Policies / Data Policies
Version23.3a

@ Overview

Data Security Policies define what actions should be taken when 1

B Data Protection

these policies. You can also define the actions that will be taken if
Discovery

Files

Data Security Policy Name

Policies

Data Patterns Default FortiCASE Scan-All Data Protection Policy &

Diata Policies

File types Supported by Data Security Policy

These are the file types supported by Data Security Policy:

Compressed/UnCompressed File Types

Uncompressed Microsoft Word Document
(.doc, .docx)

Microsoft Powerpoint
Document (.ppt, .pptx)

Microsft Excel Document
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Compressed/UnCompressed File Types

(-xls, .xlsx)
Text File (.txt, .rtf ,js)

Portable Document Format
(-pdf)

Compressed .Zip
.tar
Tz
.gz

.exe

NP FortiCASB DLP scan extracts and scans compressed files
‘Q' without limitation on the level of compressions.
- For example, a zipped file that is zipped multiple times
= under a zip file will still be DLP scanned.

Predefined Data Protection Policy
Default FortiCASB Scan-All Data Protection Policy is the predefined default data security policy where all
files under all onboarded SaaS accounts are monitored for all types of file activities using the 34 FortiCASB
basic predefined data patterns. For the full list of basic predefined data patterns, please see Basic Predefined

Data Patterns.

Data Protection / Policies / Data Policies

Data Security Policies define what actions should be taken when files meeting certain criteria have been identified. You can defin
these policies. You can also define the actions that will be taken if certain files have been detected.

Data Security Policy Name Enabled Last Updated Action

Default FortiCASB Scan-All Data Protection Policy & ¢ All Apps 2023/07/07,03:49:20 PM

To utilize all 147 predefined data patterns and customized data pattern, create a Customized Data Protection
policy to incorporate other predefined and customized data pattern.

Customized Data Protection Policy

Customized Data Protection policy can be created through +Add New.
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Important: When a customized data protection policy is enabled, the Default FortiCASB Scan-All Data
Protection Policy needs to be disabled to avoid two conflicting policies.

Data Security Policy Name Enabled Last Updated Action

Default FortiCASE Scan-All Data Protection Policy &) e All Apps 2023/07/07,03:49:.20 PM

Disable Data Security Policy

Edit/View Data Security Policy

View Audit Log

Data Security Policy Best Practice

1. Create a customized data protection for specific files you are monitoring. This practice can avoid
conducting DLP scan on files that are not intended to be monitored.

2. When choosing DLP Patterns, only choose the DLP patterns that needs to be protected and monitored.
This practice avoid conducting unnecessary DLP scans over time.

3. Always turn on Email Notification and Notify File Owners features to send alerts to relevant personnel
to expedite the mitigation process.

4. Take advantage of Send Alert to FortiAnalyer feature if FortiCASB is one of the security fabrics in your
organization.

Data Security Policy Match Criteria

There are eight match criteria that data security policies offers that can be customized when Customized
Data Security policy is created.

Files Created After on page 360

File Types on page 360

Access Permissions on page 360

File Activity Triggers on page 361

Files Shared With Users/Domains NOT In Trust List (Google Workspace files only) on page 361
Label Triggers on page 363
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Saa$S Applications on page 362
Data Patterns on page 362

Files Created After

Time frame of the files being targeted, only the files on the Saa$S application created after the designated day
are targeted for data scan.

Match Criteria

select the rules that FortiCASE will apply to identify files triggering this policy
Files Created After -

10/04/2023 10:46 am |

File Types

The file types being targeted for DLP scan, supported file types are doc, ppt, pptx, xlIs, xlIsx, txt, rtf, js, pdf,
zip, tar, 7z, gz, exe.

File Types =
Select All
Microsoft Word (.doc, .docx) Microsoft PowerPoint (_.ppt, .pptx)
Microsoft Excel (.xls, .xIsx) Text (.txt, .rtf, .js)
Portable Document Format (.pdf) Zip
tar Jz
£z exe

Access Permissions

The access permission option can be customized to target specific share permissions of the files.

The supported file sharing types are Private Access, Public Editable, Group Editable, Group Readable,
and Public Readable.
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Access Permissions *

Select All
Private Access
Public Editable
Group Editable
Group Readable

Public Readable

File Activity Triggers

The File Activity Triggers target specific file activities conducted on the file. Supported file activities are Create
File, Modify File, Access File, and Share File. File Activity Triggers has configurable threshold that can be
adjusted based on the number of times the activity is detected in a specified time frame.

File Activity Triggers+

Create File

Modify File
Exceed - 3

Mins ~

Access File

Exceed - 3
Ho.. ~
Share File
Exceed - 3
Days

+ times, within

+ times, within

+ times, within

I off  Threshold

- 5 +

W oif  Threshold

- 5 +

Il off  Threshold

- 5 +

Files Shared With Users/Domains NOT In Trust List (Google Workspace

files only)

The users and domains selected from the User Trust List and Domain Trust List will be monitored for files
shared between the trusted users and external users. An alert will be triggered when a file is shared by a trusted
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user/domain with an external user.

For example, when a trusted user named John Meyer shared a file with Mike Taylor who is not part of the
Trust List. An alert will be triggered.

User Trust List and Domain Trust List can be configured in Overview > Trusted List.

Files Shared With Users/Domains NOT In Trust List @
User Trust List

Select User Trust List v

Domain Trust List

Select Domain Trust List v

SaaS Applications

In SaaS Applications option, only onboarded SaaS applications will appear in this section. Selected only the
SaaS applications that will be targeted for DLP data scan.

SaaS Applicationss

Select All

& Google Workspace /& Azure Storage s AWSE3 &3 Citrix ShareFile
2y GCP Storage boy Box © Zoom = SAPIAS

& lJira ) GitHub Q@ Webex Teams ) Office 365

*r Eznyte = Confluence ServiceMow 3+ Dropbox

& Salesforce

Note: SAP IAS is not supported in Data Security policy.

Data Patterns
DLP Patterns selection determines which data patterns will be used in the Data Security Policy. Both
Predefined Data Patterns and Customized Data Patterns can be selected as the match criterias.

For more details on supported DLP patterns, please see Predefined Data Pattern on page 381 and Customized
Data Pattern on page 389.
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Data Patterns

* Financial Information (17/17 Enabled) Enable A Disable All
» Intellectual Property (7/7 Enabled) Enable A Disable All
» Legal Information (23/23 Enabled) Enable A Disable All
» Malware (2/2 Enabled) Enable A Disable All
» Personal ldentity Information ($8/98 Enabled) Enable A Disable All
» Customized (3/3 Enabled) Enable A Disable All

Label Triggers

Introduction

Label is a feature where files residing in cloud accounts can be labeled with metadata for better organization.

FortiCASB integrates labels in Data Security Policies where labels can be used as meta data to search for
specific files in DLP search, also new labels can be attached to files that are matched by the Data Security
policy criteria using Write Label to Files on page 374. However, if no label is added, the Data Security Policy will
scan all files whether it has a label or not.

Label Triggers currently only supports Google Workspace and Office 365.
Google Drive Label is a customizable label that can be attached to files in Google Drive.
For more information on Google Drive Label, please see Get Started as a Drive Labels admin.

Office 365 Sensitivity Label is part of Azure Information Protection where it can let user classify and protect
data.

For more information on Office 365 Sensitivity Label, please see Learn about sensitivity labels.
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Prerequisite

Google Workspace

1. Before using Label Triggers as match criteria, Google Drive Labels APIs needs to be enabled. Please see
Enable Google Drive Labels APl on page 367

2. If thisis your first time using Label Triggers, please first update the Google Workspace account in
FortiCASB. Please see Update Google Workspace Account on page 170.

Office 365

1. Metered API from Microsoft Graph need to be enabled to attach Sensitivity Label on Office 365 data
through FortiCASB Data Security Policy. Please see Enable Office 365 Metered API on page 368.

2. If the Sensitivity Label has Access Control enabled, FortiCASB Data Protection will not be able to scan
the file that has this Sensitivity Label. Please make sure that the Sensitivity Label does not have Access
Control enabled.

Using Label Triggers in Data Security Policy

When labels name and field/value are added in Data Security Policy, only files with the input labels names and
label field/value will be scanned by the Data Security policy.

Label Triggers @
Label Mame Label Field/Value

follow field/value format il

+ Add Another

Label Name - the name of the Google file label or Office 365 Sensitivity label.

Label Field/Value - Label Field is the field name and Value is the field value of the Google file label,
separated by "/". (Google Workspace only)

Office 365 file labels only have 1 type of label - standard label.
Google file labels have 4 different label types.

Lable Types of Label Trig-

Type gers Input Description
Standard | Label Name, Label All the file's label name, field name, and field
Label Field/Value value need to be matched.

Only the file with the same label name and
Standard Label Name. Field/ field name will be matched. If the label name
Label ’ and field name are the same, but has a value,

then the file will be ignored.
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Lable Types of Label Trig-

Type gers Input Description

Standard Label Name Only the file with the same label name and

Label without any field name/value will be matched.

Badaed Both label name and label Value need to be

Labgl Lable Name, /Value matched. If the label name is the same but
has not label value, it will not be matched.

Badaed Only the file with the same label name will be

Labgl Label Name matched. The file with the same label name

but with a value will be ignored.

Label Trigger Input Examples

1. Standard Label - Label Name, Label Field/Value (Google Workspace only)
In this example, only files with label name "Automobile” and label field/value "Honda/Accord" will be matched.

Label Triggers @
Label Mame Label FieldValue

Automobile Honda/Accord

+ Add Another

2. Standard Label - Label Name, Field (Google Workspace only)

In this example, only files with label name "Mouse" and label field name "Test" will be matched.
If the file has a label name "Mouse", but with a different field name or no field name it will not be matched.

Lastly, if it has the same label name "Mouse" and field name "Test" but has a value, the file will not be
matched.

Label Triggers @
Label Mame Label FieldValue
Mouse Test/

+ Add Another

3. Standard Label - Label Name (Google Workspace and Office 365)

In this example, only the file with the label name "Airplane” will be matched. If the file has the label name
"Airplane”, but with a field or value, the file will not be matched.
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Label Triggers @
Label Mame Label Field/MValue

Airplane follow field/value format

=]

+ Add Anather

4. Badged Label Name - Label Name/Value (Google Workspace only)

In this example, only files with the label name "New Badged Label" and value " /New Option" will be matched. If
the file has the same label name but without a label value, it will not be matched.

Label Triggers @
Label Mame Label FieldValue

New Badged Label /Mew option

=]

+ Add Another

5. Badged Label Name - Label Name (Google Workspace Only)

In this example, only file with the label name "New Badged Label 2" will be matched. If the file has the same
label name but with a value, the file will not be matched.

Label Triggers @

Label Mame Label Field/Valus
MNew Badged Label 2 follow field/value format i1}
+Add Another
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Enable Google Drive Labels API

The Drive Labels API need to be enabled for FortiCASB to collect Google Drive labels data for the purpose of
Data Security Policy configuration and Google Workspace documents' basic profile labels.

1. Log into Google Cloud Console with your Google Workspace account.

2. Click on the navigation menu button, and go to APIs & Services > Enable APIs & Services.
|

FINMED
API  APls & Services > e
Enabled APIs & services
Ea Billing Library
) Credentials
O 1AM & Admin >
DAuth consent screen
'E’ Marketplace

Page usage agreements

&

Compute Engine >

3. In APIs & Services, click + Enable APls And Services.

APT APIs & Services APIs & Services -+ ENABLE APIS AND SERVICES

<  Enabled APIs & services

1 Library

Traffic &

o= Credentials
&fs

H OAuth consent screen

Sm  Page usage agresments ‘ l [ ] s

B T Y
4. In API Library, search for "Drive Labels API", and click on Drive Labels API.
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5. Click Enable to enable the Drive Labels API.
< Product details

Drive Labels API
Google

Define label taxonomies for your organization.

ENABLE TRY THIS API [2

Enable Office 365 Metered API

Background
In order to experience Office 365 label integration in FortiCASB, Metered API from Microsoft Graph will need to
be enabled.
The consume of metered API and services in Microsoft Graph will incur expense
through the Azure subscription that it is associated with.

Enable metered APIs and services in Microsoft Graph

1. Log into Microsoft Azure with your account that is associated with an Azure subscription.

2. Launch Azure Cloud Shell by clicking .
3. Copy and execute the following CLI command, replace the parameters with your own value following the

parameters table.
az resource create --resource-group myResourceGroup --name myGraphAppBilling --resource-
type Microsoft.GraphServices/accounts --properties "{\"appId\": \"\myClientID\"}"
--location Global --subscription mySubscriptionID

Pick any name for the resource group that will be created when

myResourceGroup |, script executed.
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Parameter Description

myClientiD This is the Client ID of the the application that will be enabled.

mySubscriptionlD | This is the Azure Subscription ID that will be used for billing.

A JSON will return that looks like the following:
{

"extendedLocation": null,

"id":
"/subscriptions/<mySubscrip
tionID>/resourceGroups/<myR
esrouceGroup>/providers/Mic
rosoft.GraphServices/accoun
ts/<myGraphAppBilling>",

"identity": null,

"kind": null,

"location": "Global",

"managedBy": null,

"name": "<myGraphAppBilling>",

"plan": null,

"properties": {

"appId": "<myAppGUID>",
"billingPlanId": "123e4567-
e89b-12d3-a456-

426655440000",
"provisioningState":
"Succeeded"

}I

"resourceGroup": "<myRG>",

"sku": null,

"systemData": {

"createdAt": "2023-01-
31T00:12:20.7893671z",
"createdByType": "User",
"lastModifiedAt": "2023-01-
31T00:12:20.78936712",
"lastModifiedByType": "User"

}y

"tags": null,

"type":
"microsoft.graphservices/ac
counts"

Data Security Policy Actions

All incidents matched by the Data Security Policy will trigger the action items that are enabled.
Quarantine Files on page 370

Change Access Permission (Google Workspace Only) on page 373
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Write Label to Files on page 374
Send Email Notifications on page 377

Quarantine Files

The Quarantine File feature is designed to detect and move targeted files from the original directory to a
quarantine directory and enable users to review the files later to determine the course of action that should be
taken on the files.

At the moment, Quarantine Files feature is only available for Office
365, Google Workspace, Box, Egnyte, and Dropbox.

Types of Quarantine Files

Quarantine Files =
Malware Based on [[Ei@

If enabled, when any Malware is detected during AV scan and Ransomware Encrypted File Detection, they will be moved
from the original directory to a quarantine directory. (Office 365, Google Workspace, Box, Egnyte, Dropbox anly).

Sensitive DataBased on il

If enabled, when any Sensitive Data are detected during DLP File Scan, such files will be moved from the original directory
to a quarantine directory. (Office365, Google Workspace, Box, Egnyte, Dropbox only).

There are two types of quarantine files:

Malware Based - when enabled, any malware(including virus and ransomewares) detected by the Fortinet
Security Fabric during AV scan and Ransomeware Encrypted File Detection, will be moved from the original
directory to a quarantine directory.

Senstive Data Based - when enabled, any type of sensitive data selected in the activated Data Security policy
and detected during a DLP File Scan will be moved from the original directory to a quarantine directory.

Quarantine Directory

Files that are detected as malwares or deemed as sensitive data during AV scan or DLP file scan are moved
from the original directory to a quarantine directory.

There are two types of quarantine directories.

1. Default quarantine directory - The default quarantine directory is preconfigured by FortiCASB as
forticasb_quarantine_directory~. The quarantine directory will be placed at the root or top level of the
file owner's account.

2. Shared account quarantine directory - If the infected file is in a shared account directory, the file will be
removed from the shared account directory and placed at the root level of the file owner's account inside
the directory, "forticasb_quarantine_directory~".
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ﬂ It is recommended for the file owner to review and remove the

infected file from the quarantine directory.

Quarantine directory location by cloud account platform

Cloud Account Plat- Quarantine Directory Location

form

Google Workspace Root or top level of the file owner's account.

Office 365 One Drive  Root or top level of the file owner's account.

Office 365 SharePoint Root or top level at the SharePoint Site of the file owner.

Box Root or top level of the file owner's account.
Dropbox Root or top level of the file owner's account.
Egnyte Root or top level of the file owner's account.

Examples of quarantine directory on different cloud accounts

Quarantine directory on Office 365 One Drive

e e
Bin Xu + New v T Upload v &3 Sync #% Automate
B3 My files
O Recent .
Files

£ Shared
© RegEblkn ) Name Modified Modified By
Shared libraries

34 minutes ago
a .
. “new Yesterday at 7:07 PM

A

. forticasb_quarantine_directory~ Yesterday at 11:45 AM
All Company avx September 8
testgroup1 access August 2
-

July 21
e
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File size

4 items

9 items

15 items

2 items

27 items

1item

& 7 BX

IZsot v =v ©

Sharing
Private
Private
Private
Private
Private

Private
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Quarantine directory on Dropbox Account

£33 - o = Qs

Hi| ThuyTeamFolder T.¥ Share - b o
Home -
Files Everything else
All files Name + Modified + Members ~ S
Recents 22 aw - 2 members e
Shared

balabalatest - Only you e
File requests
Deleted files | Dbele - & Only you
Tools cheryl - Only you -
Paper
cucumber - Only you e

Hellosign o
Transfer || - Only you
Showcase

22 external_email - Only you e
App Center

22 fdbimage - 2 members e
Admin
Admin console forticasb_guarantine_directory~ - Only you s

Quarantine directory on Office 365 SharePoint Site

Home Documents Pages Site contents Edit

4+ New v T Upload ~ B Editingrid view 22 Sync Kl Exportto Excel ©oF PowerApps v #% Automate

Documents
] Name Modified Modified By - + Add column -
N
0928 Yesterday at 10:38 AM
1 Yesterday at 11:32 AM
T . . .
O forticasb_quarantine_directory~ | E Yesterday at 11:44 AM
5
Tnew Yesterday at 7:06 PM
D September 3
D September 3
B ooft @ September 3
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Quarantine directory on Egnyte account

Shared [

Status size Date modified Updated by

Change Access Permission (Google Workspace Only)

Change Access Permission is one of the action items on files found through the matching criteria of the
Data Security Policy. Currently this feature is only available to Google Workspace Application.

Change Access Permissions * @

& o

If enabled, for Google Workspace, FortiCASE can Change Access Permissions for files matching criteria defined above.

© Change to Private

(O Change to Private + Read Only For Users in Trusted List

There are two options to choose from in Change Access Permission:

1. Change to Private - when selected, the file access permission will be changed to Private.

2. Change to Private + Read Only For Users in Trusted List - when selected, the file access
permission will be changed to Private and Read-Only only to users in Trusted List.
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Trusted List is a list of users added in Overview > Trusted List through FortiCASB username or e-mail.

Overview / Trusted List

User Domain

Total Trusted Users: 3

User Applied to Cloud Apps Action
Google Workspace, Box ﬂ-ﬁ

fq6242007@gmail.com Google Workspace ﬂ.ﬁ

fq624201%@gmail.com Drophox ﬁﬁ

Write Label to Files

Write Label To Files currently only supports Google Workspace and Office 365. FortiCASB will attach labels
to files matched by the Data Security policy criteria.

Prerequisite

Google Workspace

1. Before using Write Label To Files match criteria, Google Drive Labels APIs needs to be enabled. Please
see Enable Google Drive Labels API on page 367

2. Ifthisis your first time using Label Triggers, please first update the Google Workspace account in
FortiCASB. Please see Update Google Workspace Account on page 170.

Office 365

1. Metered API from Microsoft Graph need to be enabled to attach Sensitivity Label on Office 365 data
through FortiCASB Data Security Policy. Please see Enable Office 365 Metered API on page 368.
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Using Write Labels to Files Feature

In Write Labels To Files, click On to turn on the feature. and select click +Add Another to select one of the
SaaS account to write labels to files.

Write Labels To Files = @

= o
If enabled, for Google Workspace and Office 345, FortiCASE will write Labels to files matching criteria defined above. For
Office 365, due to the limit in Microsoft's APL, writing Labels will take 24 hours to take effect.

Saas*® Label Name *©

o -

+ Add Another

Please select a vendor.
For more details on using each SaaS write to labels feature, please see
Google Workspace Write Labels on page 375

Office 365 Write Labels on page 376

Google Workspace Write Labels

After Write Lables To Files is enabled, then click +Add Another, select Google Workspace in SaaS drop
down menu, then select a label name that will attach the label to the files that are found with matching criteria.
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Write Labels To Files + )

Con 0
If enabled, for Google Workspace and Office365, FortiCASE will write Labels to files matching criteria defined above. For
Office 365, due to the limit in Microsoft's APl writing Labels will take 24 hours to take effect.

Saas” Label Name * Label Field/Value

| Google WorkSpace ~ ‘ | ‘ | follow field/value format

+ Add Another

Please input valid label pairs

Label Name - the name of the Google file label.

Label Field/Value - Label Field is the field name and Value is the field value of the Google file label,
separated by "/".

1. When Write Label To Files is enabled, FortiCASB will apply the custom label to the Google Drive files
found by the matching criteria.

2. The existing label will not be deleted, only new labels will be created.

3. If the new label name is the same as the old label name, but the label field name is different, then a new

label will be created.

4. Each file on Google Drive can have a maximum of 5 user-applied labels, please check the file before
applying this feature.

Example of Custom Label
In this example, the Google label name is "Animal", the label field is "Fish", and the label value is "Tuna"

Write Labels To Files = @

& o

If enabled, for Goozgle Workspace and Office 345, FortiCASE will write Labels to files matching criteria defined above. For

Office 365, due to the limit in Microsoft's API, writing Labels will take 24 hours to take effect.
Saas* Label Name * Label Field/Value

Google WorkSpace v Animal Fish/Tuna

+ Add Another

Office 365 Write Labels

After Write Lables To Files is enabled, click +Add Another, then select Office 365 in SaaS drop down bar,

then select a label name that will attach the label to the files that are found with matching criteria.

FortiCASB will apply the new label to file found by the matching criteria. If there is an existing label, the label

will be replaced by the label selected.

1. Write Label To File feature does not have an option to remove the current label, but it replaces the current

label with the new label selected.
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2. Due to the API limitation posed by Microsoft, the labels attached by FortiCASB will take 24 hours to take
effect.

Write Labels To Files = @

Ky o

If enabled, for Google Workspace and Office 345, FortiCASE will write Labels to files matching criteria defined above. For
Office 365, due to the limit in Microsoft's AP, writing Labels will take 24 hours to take effect.

Saas? Label Mame =

Office 365 v David_2nd_label v o

+ Add Another

Send Email Notifications

When the a data security policy is enabled, an alert will be triggered by specific user activity done on the
targeted files with certain DLP patterns.

The alert also can be sent as notification to notify the relevant personnel to take immediate actions.

Types of Alert Notification

There are two types of alert notifications that can be generated to address the alert incident.

1. Email Notification Alerts can be sent to either the FortiCASB Users or the affected File Owners
2. FortiAnalyzer Alerts in the form of Syslog messages can be sent to FortiAnalyzer.

In order to send alerts to FortiAnalyzer, a FortiAnalyer needs to be added first in Overview > Fabric
Integration.

See Fabric Integration Configuration on page 337 for more details

x Email Notification or FortiAnalyzer alerts needs to be enabled in the

Data Security Policy to send notifications.

Steps to Configure Email Notification in Data Security Policy

Go to Data Protection > Policies > Scan Policies from the main menu.

Click +Add New to create a new Data Security Policy.

After Data Security Policy Name and Match Criteria are filled, go to Action section.
In Send Email Notification, click On to enable email notifications.

AoOoDd-=
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Send Email Motifications +

Off  Notify FortiCASB Users
If enabled, below FortiCASE Users will be notified when files trigger this data security policy.

5. Enter the recipient’s e-mail address in the field below.
6. In Notify File Owners, click On to enable file owner notification.

m Off  Motify File Owners

If enabled, File Owners will be notified when their files trigger this data security policy.

FortiCASBE has detected [Activity Name] for file [File Name] that is shared as
[Exposure Mame]. This file has content of type [DLP Pattern Name].

Please make sure this file is private and not shared with users who should not
have access to this information.

7. Edit the alert notification field below. The following parameters will be send as part of the naotification to
the file owner.

a. Activity Name - the type of activity conducted on the file.

b. File Name - The file that contains the targeted DLP pattern.

c. DLP Pattern Name - the DLP pattern that triggers the alert.
8. Click Add New Data Security Policy to finish.

Example of File Owner Notification Alert

X Close * Reply “ ReplyAll e Forward = Move More~

[® Subject: Richard_Data_Security_Policy Alert-1
From: notification@forticasb.com
To:
Date: Jun 20, 2023 11:50:26 AM

Notify File Owner test:
FortiCASB has detected [411739-ServiceNow-b6c8430e2d10al4fl6catadededed3s] for file [Italy_IBAN.txt] that is shared as [No Shared]. This file has content of type [DLP CA AB Driver License Pattern]

The notification is for the DLP alerts!!!

Steps to Configure FortiAnalyzer Notification

Go to Data Protection > Policies > Scan Policies from the main menu.

Click +Add New to create a new Data Security Policies.

After Data Security Policy Name and Match Criteria are filled, go to Action section.
In Send Alerts to FortiAnalyer, click On to enable alerts to be sent to FortiAnalyzer.

AoOoDd-=
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Send Alerts to FortiAnalyzer =

(o [

fenabled, and if there iz FortiAnalyzer added in FortiCASE, Data Analysis Alerts triggered will be sent to
FortiAnalyzer.

5. Click Add New Data Security Policy to finish.

Create Data Security Policy Example

In this example, a data security policy will be created for monitoring for any malicious file containing malware or
virus. Alert notification will be sent to the FortiCASB user, file owner, and FortiAnalyzer.

1.
2.
3.

4.
5.

6.

Go to Data Protection > Policies > Scan Policies.
Click +Add New to add new data security policy.
In Data Security Policy Name, name the policy as "AV and Malware Monitor"

@ Overview
Data Security Policy Name «

B Data Protection

AV and Malware Monitor

Discovery
Files
Enabled =
Policies
on [

Data Policies

DLP Patterns

Click Enabled toggle switch button to enable the policy.
In Match Criteria section, click Files Added Within drop down menu, select "Time Frame: All Time".

Match Criteria

select the rules that FortiCASE will apply to identify files triggering this policy

Files Added Within =

Time Frame: All Time W

In File Types, click Select All.
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File Types =

Select All

Microsoft Word (.doc, .docx) Microsoft PowerPoint (.ppt, .pptx)
Microsoft Excel (xls, xlsx) Text (ot rtf, Jjs)

Portable Document Format (. pdf) Zip

tar Tz

B2 EXE

7. In Access Permissions, click Select All
8. InFile Activity Triggers, click Select All
9. In SaaS Applications, click Select All.

SaaS Applications =

Select All

& Google Workspace A\ Azure Storage aws - AWS S3 3 Citrix ShareFile
2y GCP Storage box Box Q@ Zoom &7 SAPIAS

& lira ) GitHub Q@ Webex Teams ] Office 365

¥ Egnyte % Confluence ServiceNow 22 Dropbox

& Salesforce

10. In DLP Pattern, only enable all Malware type DLP patterns and disable the rest.

DLP Patterns «

» Financial Information (0/17 Enabled) Enable All Disable All
* Intellectual Property (0/7 Enabled) Enable All Disable All
» Legal Information (0/23 Enabled) Enable All Disable All
» Malware (2/2 Enabled) Enable All Disable All
» Personal Identity Information (0/98 Enabled) Enable All Disable All

11. In Action section, turn on Quarantine Files to quarantine malwares if detected.
12. In Send Email Notification, turn on FortiCASB Users, and enter a user below to be notified.

Send Email Motifications «
B off  Notify FortiCASE Users

If enabled, below FortiCASB Users will be notified when files trigger this data security policy.

o

13. Turn on Notify File Owners alert and edit the notification contents.
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Off  Notify File Owners

fenzabled, File Owners will be notified when their files trigger this data security policy.

FortiCASE has detected the file [File Name] is a malware. This file has content of
type [DLP Pattern Name]. The file has been quarantined and moved to the
guarantine location. Please kindly review and delete the file.

14. Turn on Send Alerts to FortiAnalyzer to send alerts to FortiAnalyzer.
15. Click Add New Data Security Policy to finish.

Predefined Data Pattern

Predefined Data Pattern defines the default DLP (Data Loss Prevention) patterns and classify private and
confidential data that should be regulated in accordance to regulatory compliance requirements.

Predefined data patterns are located in Data Protection > Policies > Data Patterns > Predefined tab.

FortiCASB identifies SaaS account activities on files with these predefined data patterns and alert the
administrators.

For example, when a file containing Social Security Numbers (SSN) is accessed by a SaaS user, FortiCASB
will notify the file owner or the administrator.

In 2023, additional data patterns are added with the support through FortiGuard, resulting a total of 113 data
patterns with 3 pattern categories:

e Personal Identity Information on page 382
e Financial Information on page 387

« Malware and Ransomware on page 389
The maximum uncompressed/compressed file size that the data patterns supports is 20 MB.

For the latest data pattern updates, please refer to FortiGuard DLP updates.
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Personal Identity Information

FortiCASB scans for the Personal Identity Information data patterns during Data Security Policy scans, and

triggers an alert when the specific data pattern is accessed.

Below are different types of personal identity information that FortiCASB supports in DLP scan.

Personal Identity Number Description

DLP Birthdate Pattern
DLP SSN Pattern

DLP Polish Social Security
Number Pattern

DLP CN Resident Identity Pattern

DLP Email Address Pattern

Birthdate

United States social
security number

Poland social security
number

China resident identity
number

Email address

DLP USA/Germany Passport
Number Pattern

DLP JP Passport Number Pattern

DLP AU Passport Number Pattern

DLP UK Passport Number Pattern

DLP CA Passport Number Pattern
DLP CN Passport Number Pattern

DLP FR Passport Number Pattern
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United States and
Germany Passport
number

Japan passport number

Australia passport
number

United Kingdom
passport number

Canada passport
number

China passport number

France passport
number
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International
Bank
Account
Number
(IBAN)

Description

DLP German | Germany Bank International Bank Account

IBAN Pattern | Number

DLP Italian Italian Bank International Bank Account

IBAN Pattern | Number
DLP

Spanish Spanish International Bank Account Number

IBAN Pattern
DLP

Swedish Swedish International Bank Account Number

IBAN Pattern

DLP Swiss

Swiss International Bank Account Number

IBAN Pattern

DLP UK United Kingdom International Bank Account

IBAN Pattern | Number

Driver License Description

DLP CN Driver License
Pattern

DLP UK Driver License
Pattern

DLP US AL Driver License
Pattern

DLP US AK Driver License
Pattern

DLP US AZ Driver License
Pattern

DLP US AR Driver License
Pattern

DLP US CA Driver License
Pattern

DLP US CO Driver License
Pattern

DLP US CT Driver License
Pattern
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China driver's license number
United Kingdom driver's
license number

United States Alabama
driver's license number

United States Alaska driver's
license number

United States Arizona driver's
license number

United States Arkansas
driver's license number

United States California
driver's license number

United States Colorado
driver's license number

United States Connecticut
driver's license number
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Driver License Description

DLP US DE Driver License
Pattern

DLP US DC Driver License
Pattern

DLP US FL Driver License

DLP US GA Driver License
Pattern

DLP US HI Driver License
Pattern

DLP US ID Driver License
Pattern

DLP US IL Driver License
Pattern

DLP US IN Driver License
Pattern

DLP US IA Driver License
Pattern

DLP US KS Driver License
Pattern

DLP US KY Driver License
Pattern

DLP US LA Driver License
Pattern

DLP US ME Driver License
Pattern

DLP US MD Driver License
Pattern

DLP US MA Driver License
Pattern

DLP US MI Driver License
Pattern

DLP US MN Driver License
Pattern

DLP US MS Driver License
Pattern
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United States Delaware
driver's license number

United States Washington DC
driver's license number

United States Florida driver's
license number

United States Georgia driver's
license number

United States Hawaii driver's
license number

United States Idaho driver's
license number

United States lllinois driver's
license number

United States Indiana driver's
license number

United States lowa driver's
license number

United States Kansas driver's
license number

United States Kentucky
driver's license number

United States Louisiana
driver's license number

United States Maine driver's
license number

United States Maryland
driver's license number

United States Massachusetts
driver's license number

United States Michigan
driver's license number

United States Minnesota
driver's license number

United States Mississippi
driver's license number
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Driver License Description

DLP US MO Driver License
Pattern

DLP US MT Driver License
Pattern

DLP US ND Driver License
Pattern

DLP US NE Driver License
Pattern

DLP US NV Driver License
Pattern

DLP US NH Driver License
Pattern

DLP US NJ Driver License
Pattern

DLP US NM Driver License
Pattern

DLP US NY Driver License
Pattern

DLP US NC Driver License
Pattern

DLP US OH Driver License
Pattern

DLP US OK Driver License
Pattern

DLP US OR Driver License
Pattern

DLP US PA Driver License
Pattern

DLP US RI Driver License
Pattern

DLP US SC Driver License
Pattern

DLP US SD Driver License
Pattern

DLP US TN Driver License
Pattern
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United States Missouri driver's
license number

United States Montana
driver's license number

United States North Dakota
driver's license number

United States Nebraska
driver's license number

United States Nevada driver's
license number

United States New Hampshire
driver's license number

United States New Jersey
driver's license number

United States New Mexico
driver's license number

United States New York
driver's license number

United States North Carolina
driver's license number

United States Ohio driver's
license number

United States Oklahoma
driver's license number

United States Oregon driver's
license number

United States Pennsylvania
driver's license number

United States Rhode Island
driver's license number

United States South Carolina
driver's license number

United States South Dakota
driver's license number

United States Tennessee
driver's license number
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Driver License Description

DLP US TX Driver License
Pattern

DLP US UT Driver License
Pattern

DLP US VT Driver License
Pattern

DLP US VA Driver License
Pattern

DLP US WA Driver License
Pattern

DLP US WV Driver License
Pattern

DLP US WI Driver License
Pattern

DLP US WY Driver License
Pattern

DLP CA AB Driver License
Pattern

DLP CA BC Driver License
Pattern

DLP CA MB Driver License
Pattern

DLP CA NB Driver License
Pattern

DLP CA NL-1 Driver
License Pattern

DLP CA NL-2 Driver
License Pattern

DLP CA NT Driver License
Pattern

DLP CA NS Driver License
Pattern

DLP CA NU Driver License
Pattern
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United States Texas driver's
license number

United States Utah driver's
license number

United States Vermont driver's
license number

United States Virginia driver's
license number

United States Washington
driver's license number

United States West Virginia
driver's license number

United States Wisconsin
driver's license number

United States Wyoming
driver's license number

Canada Alberta driver's
license number

Canada British Columbia
driver's license number

Canada Manitoba driver's
license number

Canada New Brunswick
driver's license number

Canada Newfoundland and
Labrador driver's license
number

Canada Newfoundland and
Labrador driver's license
number

Canada Northwest Territories
driver's license number

Canada Nova Scotia driver's
license number

Canada Nunavut driver's
license number
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Driver License Description

DLP CA ON Driver License
Pattern

DLP CA PE-1 Driver
License Pattern

DLP CA PE-2 Driver
License Pattern

DLP CA QC Driver License
Pattern

DLP CA SK Driver License
Pattern

DLP CA YT Driver License
Pattern

Canada Ontario driver's
license number

Canada Prince Edward Island
driver's license number

Canada Prince Edward Island
driver's license number

Canada Quebec driver's
license number

Canada Saskatchewan driver's
license number

Canada Yukon driver's license
number

Financial Information

FortiCASB scans for the financial information data patterns during Data Security Policy scans, and triggers an
alert when the specific data pattern is accessed.

Financial Information Pat- .
Description
terns

DLP JCB Pattern JCB credit card number

DLP Maestro Card Pattern Maestro debit card number

DLP MasterCard Pattern Master credit card number
DLP American Express American Express credit card
Pattern number

DLP Diners Club Card Diners Cloud credit card
Pattern number

DLP Discover Card Pattern Discover credit card number

DLP China Union Pay China Union Pay credit card
Pattern number

DLP Visa Credit Card

Pattern Visa credit card number

DLP BC Global Credit Card | Korean BC credit card number
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Financial Information Pat-
terns

Pattern

DLP Carte Blanche Credit
Card Pattern

DLP Insta Payment Credit
Card Pattern

DLP Korean Local Credit
Card Pattern

DLP Laser Credit Card
Pattern

DLP Solo Credit Card
Pattern

DLP Switch Credit Card
Pattern

DLP CA Insurance Number
Pattern

DLP UK Insurance Number
Pattern

DLP VSMC Pattern

DLP Australia SWIFT Code
Pattern

DLP China SWIFT Code
Pattern

DLP Germany SWIFT Code
Pattern

DLP France SWIFT Code
Pattern

DLP Japan SWIFT Code
Pattern
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Description

Carte Blanche credit card
number

Instant payments are credit
transfers that make funds
available in a payee's account
within ten seconds of a
payment order being made.

Korean local credit card
number (Samsung, Lotte,
Hyundai, Hana, BC, NG,
Shinhan, and KB)

Laser was primarily an
electronic point of sale debit
card, but could also be used
by telephone and internet, at
ATMs and to pay regular bills
by direct debit.

Solo credit card number

Switch credit card number

Canadian Insurance number

United Kingdom Insurance
number

Victoria Secret Master Card

Australia SWIFT code number

China SWIFT code number

Germany SWIFT code
number

France SWIFT code number

Japan SWIFT code number
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Financial Information Pat-

terns Description
DLP United Kingdom United Kingdom SWIFT code
SWIFT Code Pattern number
DLP USA SWIFT Code United States SWIFT code
Pattern number

Malware and Ransomware

FortiCASB scans for malware and ransomware data patterns during Data Security Policy scans, and triggers an
alert when a malware or ransomware is detected.

Malware/Ransomware Description

Ransomware Scans for ransomware encrypted file utilizing Fortinet
Encrypted File Security Fabric.

Detection Pattern

Scans for malware and virus utilizing Fortinet Security

AV P
Scan Pattern Fabric.

Customized Data Pattern

Customized Data Pattern is user defined DLP (Data Loss Prevention) patterns and can be applied to Data
Security Policy just as Predefined Data Patterns.

Customized Data pattern is located in Data Protection > Policies > Data Patterns > Customized Data
Pattern tab.

Regex or PCRE(Perl Compatible Regular Expressions) plays the major role in determining the data pattern
that the Customized Data Pattern should search for. Regex is regular expression that combines special
character operators that can be constructed to search specific strings in files.
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Configurable Parameters in Customized Data Pattern

Name Enter a name for the data pattern.

Description Enter a description for the data pattern.
Category Select a data category from the list.
Uncompressed Specify the upper bound of an object size, in MB,
File Size for a full content scan.

Compressed File Specify the upper bound of a zip file size, in MB, for
Size a full content scan.

Regex Context Enter in a Regex to search for specific string

Exact Data Match Category

EDM (Exact Data Match) is a category of Customized DLP Data Patterns. EDM allows specific sensitive data to
be scanned by a predefined dataset and triggers an alert when a match is detected. Users can define
predefined dataset through a CSV file, upload it through Exact Data Match category when creating a
Customized Data Pattern.

Characteristics of EDM Customized Data Pattern

« There is a match only if the sensitive data is matched exactly as the predefined dataset.

« Symbols in the predefined dataset as well as ", . And" all need to have exact match as the sensitive data
scanned.

« When a matching threshold is specified in the EDM data pattern, an alert will be triggered when the
number of matched values in the CSV file is equal or greater than the matching threshold. Please see
Customized Data Pattern Example - Exact Data Match on page 392 for example.

CSV File Requirements

« The CSV files should have no header row.

« Only English (Latin script) is supported.

o A maximum of 120 rows and 30 columns are supported per data set.

o The CSVfile format is recommended to adhere to RFC-4180 standard.

« First Normal Form(1NF) recommended in data design, meaning all columns should have only scalar or
atomic values. For example, first name and last name should be separated into two separate columns,
city and zip code should be separated into two columns.

CSV File Example

This is an example where the data format fulfills the CSV file requirement for EDM Customized Data Pattern.
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. 120
Jason Valentin Jefferson Riverside CA 9250
o] 4
St.
415 W . .
Marry Baxter Willow Philadelphi PA 1911
a 8
Grove Ave
. 555 Pierce 9470
David Solace Street APT Albany CA 6
#123
1600
Thoma | Jefferso | Pennsylvani | Washingto | D | 2050
s n a Avenue n c |0
NW

Customized Data Pattern Example - Regex

The following customized data pattern will search for a Brazilian CPF, an 11 digit taxpayer identification code
issued by Brazillian Federal Reserve. This data pattern will monitor for the presence of Brazilian taxpayer
identification code in the cloud accounts.

1. Goto Data Protection > Policies > Data Pattern, and click on Customized tab.
2. Clickon +ADD NEW to add a customized data pattern.
3. In Data Pattern Name, enter "Brazil CPF".

Add Customized Data Pattern

Data Pattern Name + Brazil CPF
Description+  Brazilian taxpayer identification code with numer...
Category=  Financial Information v

4. In Description, enter "Brazilian taxpayer identification code with numerical format in xxx. xxx.xxx-xx".
5. In Category, select "Financial Information"”.
6. In Max Uncompressed File Size and Max Compressed File Size, use the default value "10MB".
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Max Uncompressed File Size (MB) « - 10 + Cannot exceed 20 M

Max Compressed File Size (MB) = - 10 + Cannot exceed 20 M

7. In Regex (PCRE), enter the regex: "\d{3)\.\d{3]\.\d{3)\-\d{2}$".

Regex (PCRE) +

8. Click Add Customized Data Pattern to finish.

Now the Customized Data Pattern is ready to be added and enabled in Data Security Policy configuration.

Data Patterns=

+ Data Patterns Customized (1/9 Enabled)

DLP Pattern Name

david_pattern

eee

t1

Leo_test

gingfanEDM2

gingfanEDM

EDM

Group-1-EDM

Brazil CPF

Data Pattern Category

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Md{3PAd{3RAd{3NAD{2}$

Severity

® Alert

® Alert

® Alert

® Alert

® Alert

® Alert

® Alert

® Alert

® Alert

Customized Data Pattern Example - Exact Data Match

Before the Customized Data Pattern can be added, create a CSV file named "Group1EDM.csv" with the

following content.

Valentin

Jason

Marry Baxter

David Solace
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9250
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a 8
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Enable All

Enabled
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#123
1600
Thoma | Jefferso | Pennsylvani | Washingto | D | 2050
s n a Avenue n cC |0
NW

The following Customized Data Pattern will utilize the Exact Data Match category and a CSV file provided to
search for a match against the sensitive data in a Data Protection Policy.

1. Goto Data Protection > Policies > Data Pattern, and click on Customized tab.
2. Clickon +ADD NEW to add a customized data pattern.
3. In Data Pattern Name, enter "Group-1-EDM".

Data Pattern Name » Group-1-EDM

Description+  Target group for EDM search

Category » Exact Data Match v

In Description, enter "Target group for EDM search".

In Category, select Exact Data Match.

In Max Uncompressed File Size and Max Compressed File Size, use the default value "10MB".
In CSV File, browse and upload the CSV file.

No o M~

CSV Files
ﬂ Grou pl EDM.csv, browse

LAST UpOate. LU/ U1y US 51 1.

Matching Threshold + - 2 +

8. In Matching Threshold, press + to select 2

Note: When the Matching Threshold value of 2 is selected, it means if there are any 2 cell values that
matched between the CSV file and the sensitive data during file scan, a DLP alert will be triggered.

For example, when both the values from the CSV file - "Thomas" and "Albany" are found in the targeted
sensitive file, a DLP alert will be triggered. If only "Thomas" is matched, then an alert will not be triggered.

9. Click Add Customized Data Pattern to finish.

Now the Customized Data Pattern is ready to be added and enabled in Data Security Policy configuration.
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Data Patterns -

+ Data Patterns Customized (1/8 Enabled)

DLP Pattern Name

david_pattern

t1

Leo_test

gingfanEDM2

gingfanEDM

EDM

FortiCASB 24.3.b Admin Guide

Fortinet Inc.

Data Pattern Category

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Data Patterns Customized

Severity

Alert

Alert

Alert

Alert

Alert

Alert

Alert

Alert

Enable All

Enabled

on [ER
on [ER
on [IE@

Disable All
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Cloud Application Features

This section covers features specific to cloud application installed on FortiCASB.

Dashboard

The cloud application dashboard shows account status, Alert Overview, Policy Overview, Document
Overview, Activity Overview, and Top 5 Policy Violation, High Risk Activities, and High Risk
Documents.

Account Status and Checklist

When the cloud account is successfully onboarded, it should show Connected status.
z* L X 1 ]
Dropbox
o> VP
Status ® Connected
Cloud Account
Checklist 4/4 Pass Detail

Last Update 12/7/2022, 3:18:28 PM History

Click on the Checklist > Details button to show the onboarding checklist. All checklist items need to be in
Pass status for FortiCASB to retrieve security data on the cloud account.

Checklist 4/4 Pass Detail / _— \ 15

Last Update 12/7/2022, 3:1
“ Check if Dropbox APl is accessible
“ Checkif the account has correct account information
=  Checkif File APIs are available
B  checkif Audit Log APIs are available
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Delete Cloud Account

Cloud account can be deleted when no longer needed. There are two ways to delete a cloud account.

1. Goto Overview > Dashboard, click on the configuration button *** and select Delete Account.

2. Gotothe cloud app drop down menu, e.g. Salesforce, click on the configuration button *** and select
Delete Account.

Forti

Version 212

@ Overview

Dashboard
Report
Audit Loz
Shadow IT
Data Pattern

Trusted List
L2 Salesforce
] Office 365
box Box
43 Dropbaox
a Google Workspace
£\ Azure Storage
8 Citrix ShareFile

& Confluence

3 Egnyte

& GCP Storage

Overview / Dashboard

Business Unit Overview

BUName QATest BUID 330239 #ofCloud App 19
Update Cloud Account
] Office 365 View Account Detail  20gle Workspace
ncluding . . ncluding
. View Change History -
e P 3]

® ga@casbal.onmicrosoft.com

>
&

Dropbax

o binxu@fortinet.com

SAP SuccessFactors

SAP SuccessFactors

® sfadmin
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» testadmin3y

Delete Account zhang@ga staging forticasb.com

rticasb.com

@ 9

Workplace GitHub

® Forticasb Integration » xiemFortinet
-y
Q 4%

» testadminl@forticasb.com » testadmin7@forticasb.com
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Note: It will take a couple hours to delete the cloud account, and during this time you will not be able to add

cation Features

@ Overview

L2 Salesforce
Dashboard
iscovery
Documents
Users
Policy
Alert
Activity

1) Office 365

box Box
%# Dropbox

& Google Workspace

Last 7days +

@ Salesforce

Status
Cloud Account
Checklist

Last Update

* Connected
bbao@forticasb.com
4/4 Pass Detail

7/28/2021, 7:39:53 PM History

Update Account  riew

Delete Account :
erity

C
1176
Alerts
o Alert 1059
e Critical 114

e Warning 2
Information 1

A prompt to delete notice will pop up, select Delete Account to confirm deleting the account.

D!

A

ete Account

FortiCASE will delete access data (called OAuth) of

this account for Salesforce. This deletion may take

up to a couple of hours.

During this time, the Cloud App will be

inaccessible. After the

can come back to this Cloud App and use it again,
for example, by adding another account to resume

access.

process is completed, you

Note that only the OAuth data is deleted at this
time. For other data, please refer to FortiCASB's

Data Retention Policy.

Delete Account

Do not Delete

another account. Please check back after a couple hours to add another cloud account.
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Files

Introduction

Files is a SaaS data storage security analytics located in each cloud application except SAP IAS and Zoom.

When a cloud account is first added to FortiCASB, files resided in the cloud account are pulled into the Files
page. Then FortiCASB automatically updates the file status in Files page when users attempt to access files
through the cloud application account.

The files bubble chart gives an overview of the files categorized by File Type, Data Analysis, and Share
Type.

Office 365 / Files - i = (2]

File Type Data Analysis Share Type
o

_LINK_LC

aperery|
5_LINK U

zip  ecc

L
5LINK ¢
pdf  ppx L -

tt doc FFICE365_SHARE_OVNEIS5_SHA

85_SHAR

is
folder PPt
e 4 L LINK_Us
o 35_LINK_;

File Type captures all file types regardless of readability within the scope of cloud account storage/bucket.
Click on each file type bubble to show files with the specific file type.

Data Analysis scans and captures all files that contains DLP (Data Loss Prevention) data. Each bubble
represents different Data Analysis policy.

Click on each Data Analysis bubble to show files only pertain to that Data Analysis policy.

Share Type is a normalized share type that normalized all cloud account users by grouping them together by
access permission. For more detail on normalized share type, please see Appendix B - Normalized Share
Types on page 557.

Click on each share type to see only files shared by the specific share type users.
Click on each app bubble to filter the files by app.

Sort Cloud App Files by Filter

There are 11 filters that files can be sorted to identify the targeted files among all cloud applications:
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Filters

Drive Owner(Site) Created Date
Data Analysis
Data Scan Status 2023/10/13, 04:05:45 PM
Date of Creation
File Mame 2023/10/13,04:05:45 PM
File Type
Highlight 2023/10/13,04:05:45 PM
Last Modification
Owner 2023/10/13,04:05:45 PM
Share Type
Target of Exposed Files 2023/10/13, 04:05:45 PM

For more information on Highlight and Data Analysis Scan filters, please see:
Highlight Filter on page 401
Data Scan Status on page 402

Example on using Files Filter

This example filters through all files for Malwares detected in the last 90 days among all cloud applications.

1. Clickon +Add Filter.
2. Select Created > Last 90 days.

Created:
{Creator SaaS App
Last 24 hours
) Office 365
Last 7 days
Last 30 days [] Office 365
Last 90 days @
zhang@qa.staging.f
Custom . & Google Workspace
J.com
3. Click +Add Filter again.
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4. Select Data Analysis > AV Scan.

Created: Last 90 days @ | Data Analysis: AV Scan 9|

File Name

register

2NQe3wlLrO0L1svyEq:
T3vuDhK.php

AV Scan

DLP China Union Pay

DLP MasterCard

DLP China Passport Number

DLP United Kingdom Passport Number

DLP Japan Passport Number

DLP USA/Germany Passport Number .
DLP Birthdate

DLP Canada Passport Number

ace
DLP China Resident Identity

DLP Spanish IBAN

DLP Italian IBAN

5. Click Search sign and filter through all files.
6. All Malwares from the last 90 days are displayed.

Created: Last 90 days €0 Data Analysis: AV Scan €@ +Add Filter

File Name
DemoRDPKILL-1exe Efp

1118953543235_DemoRD
PKILL-1.exe

1107853929%00_DemoRD
PKILL-1.exe

DemoRDPKILL-1.exe ¢y

RDPKIL for azure.zip

Owner/Creator SaaS App
Company Administrator |] Office 365
box Box
box Box
) office 365

& Google Workspace

Created

2023/02/01,10:17:21 AM

2023/01/20,10:55:54 AM

2023/01/06, 10:41:40 AM

2023/01/03,11:25:17 AM

2023/01/17,11:52:40 AM

Created

2023/03/23,06:09:13 PM

2023/03/23,06:09:12 PM

2023/03/23,11:57:55 AM

2021/02/05,04:00:10 PM

2023/03/23,12:42:49 PM

2023/03/23,12:42:45 PM

Last Modified

2023/02/01,10:17:21 AM

2023/01/20,10:55:54 AM

2023/01/06, 10:41:40 AM

2023/01/03,11:25:17 AM

2020/11/03,03:40:26 PM

7. Click on any one of malware to view basic details, activity, users exposed, and data pattern violation.
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Basic Detail

File Name DemoRDPKILL-1.exe Q

Creator

Created Date 2023/02/01,10:17:21 AM

Last Modified 2023/02/01,10:17:21 AM

Path Shared Documents/cucumber/cli/DemoRDPKILL-1.exe

Download Link F A
Highlight 8

Exposed To User/Group

Team Site Members

Highlight Filter

Owner

Write

Owner

Activity
2023/02/01
03:03:42 PM
02:44:10 PM
02:29:29 PM
02:03:36 PM
02:03:36 PM
02:02:51 PM
10:50:25 AM
10:38:21 AM

10:17:20 AM

download file

download file

download file

rename file

move file

download file

download file

download file

upload file

The Highlight filter filters through all files for specific file type: Sensitive, External, and Malware.

Highlight:

. mer
Sensitive Data

Clean Data
Malware

Below is correlated Highlight and file type with description.
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Highlight Document Description

Icon Type
E Sensitive  Files with sensitive information searched and matched by
DLP policies such as Social Security Number, Visa Credit
Card number, etc.
SO External Files shared with the external users/groups.
£ Malware Infectious files searched and matched by the malware

policies through AV scan.

Data Scan Status

Data Scan Status shows the status of DLP Scan (Data Loss Prevention scan) which identifies Personal
Identification Information(PII) such as Driver License, Credit Card, Social Security Numbers, etc resting in the
organization's cloud account. It gives cloud administrators the opportunity to take action against possible
external or internal threat:

1. Possible network intrusion access on sensitive data.
2. Unauthorized internal storage of personal or sensitive data.
3. Detect potential malware and virus through Fortinet AV scan.

The DLP scan is triggered when user activity is detected on the file resting in the cloud account. If the file is
identified to be a type of personal identification information, it will be noted in the file details.

Data Scan Status is located in any supported Cloud Application under Files:

Save Search n

Last Modified Path Data Scan Status Highlight

Birthday-2020-08-26T22_31_1 N
2024/05/15,02:54:00 PM Completed
61063497 txt ° b o b

05062024/01-ssn_txt - user te

2024/05/06,05:14:46 PM . @ completed o B
e
05062024/01-ssn_txt test - use N
2024/05/06,05:13:58 PM @ Completed o B
rtest.txt
2024/05/06,05:13:48 PM 05062024/01-ssn_txt test.txt ° Completed 1Y E
2024/05/03,03:55:00 PM - @ Completed 1Y
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Data Scan Status Description

When hover the mouse over the tooltip, it will show detailed description on the file scan status.

gdo
rive’
China
Jesiden
Identity

Path

05222024/eicar_com 1.zip
05222024/ eicarcom?2 1.zip
052420244/eicar_com 1.zip
052420244 /eicarcom2 1.zip

05282024/eicarcom?2 1.zip

List of Data Scan Status

There are 17 Data Scan statuses that reflects the current state or the result of DLP Scan. Depending on the

Data 5can Status

© Insuficient Permissions
© Insufficient Permissions
& Insufficient Permissions
© Insutficient Permissions

© Insuficient Permissions

Owner

Highlight

Insufficient Permissions: Office 365 account user
used for onboarding is not one of the One Drive/
SharePoint Site Collection Administrators.

cloud application platform, not all data scan statuses are supported in a single cloud application.

Data Scan Status

Initiating

In Scan Queue

In Progress

Completed

Cannot Be Scanned

Scan Failure

API Threshold Error

Data Protection Exceeded
Empty File

File Not Found

File Transfer Error

FortiCASB 24.3.b Admin Guide
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Data Scan Status

Insufficient Permissions
Internal Error

No Scan Policy
Unknown Error
Unsupported File Size
Unsupported File Type

Normalized Share Types

Normalized Share types categorize file access permissions of all supported cloud applications in FortiCASB.

Instead of having files retaining their share permissions from different cloud applications, all share permissions
are normalized and converted into 5 share types:

e Private Access Share Type on page 404
e Public Editable Share Type on page 406
e Group Editable Share Type on page 407
e Group Readable Share Type on page 409

e Public Readable Share Type on page 411

Private Access Share Type

Private Access Share Type is a normalized share permission that represents the supported cloud applications
share permissions that is only accessible by the file owner.

The following are the share permissions from each cloud applications that the Private Access Share Type
covers.
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Cloud Applic-

ation
AWS S3
AWS S3

Azure

Azure
Box

Box

Box

Box
Confluence
Dropbox
Dropbox
Dropbox
Egnyte
Egnyte
Egnyte
Egnyte
Github
GitHub
Github
Github
Github

Google
Workspace

Google
Workspace
Google Cloud

Google Cloud

Google Cloud

Share Permission

S3_OBJECT_OWNER_WRITE_OBJ

S3_OBJECT_OWNER_WRITE_OBJ_

PERM

AZURE_BLOBCONTAINER _
PUBLICACCESS_NONE

AZURE_BLOB_PRIVATE
BOX_SHARE_VIEWER
BOX_SHARE_OWNER

BOX_SHARE_VIEWER_UPLOADER
BOX_SHARE_PREVIEWER_UPLOADER

CONFLUENCE_SHARE_OWNER
DROPBOX_SHARE_VIEWER
DROPBOX_SHARE_OWNER
DROPBOX_LINK_PASSWORD
EGNYTE_SHARE_EDITOR
EGNYTE_SHARE_VIEWER
EGNYTE_SHARE_OWNER
EGNYTE_SHARE_FULL_ACCESS
GITHUB_REPO_READ
GITHUB_REPO_ADMIN
GITHUB_REPO_NONE
GITHUB_REPO_TRIAGE
GITHUB_REPO_MAINTAIN
GOOGLE_USER_READER

GOOGLE_USER_OWNER

GOOGLECLOUD_BUCKET_USER _
EDIT_BKT

GOOGLECLOUD BUCKET _
SERVICEACCOUNT _EDIT_BKT

22

FortiCASB 24.3.b Admin Guide
Fortinet Inc.

Description

Owner Write Object

Owner Write Object Permissions

Private Only

Private Only

Viewer

Owner

Viewer Uploader

Previewer Uploader

Users Own File

Viewer

Owner

Link_password

User Can Edit Folder content
User Can View Folder content
Users Own Folder

User has Full Access

Read

Admin

None

Triage

Maintain

User View

User Owner

User Can Edit Bucket

Service Account Can Edit Bucket

User reads Object
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Cloud Applic-

ation

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google
Workspace

Google
Workspace

Google
Workspace

Office365
Office365
Salesforce
Webex
Webex

Share Permission

GOOGLECLOUD_OBJECT_
OWNPROJECT_READ_OBJ

GOOGLECLOUD_OBJECT_PROJECT_
READ OBJ

GOOGLECLOUD_OBJECT _OWNER _
READ_OBJ

GOOGLECLOUD_BUCKET_USER _
READ_BKT

GOOGLECLOUD BUCKET _
SERVICEACCOUNT_READ_BKT

GOOGLECLOUD_OBJECT_OWNER _
OWN_OBJ

GOOGLECLOUD_OBJECT USER_
OWN_OBJ

GOOGLECLOUD_OBJECT _OWNER _
OWN_OBJ

GOOGLECLOUD_OBJECT USER _
OWN_OBJ

GOOGLE_USER_WRITER

GOOGLE_USER_COMMENTER

GOOGLE_USER_ORGANIZER

OFFICE365_SHARE_READ
OFFICE365_SHARE_OWNER
SALESFORCE_SHARE_READ
WEBEX_SHARE_OWNER
WEBEX_SHARE_DIRECT

Public Editable Share Type

Description

Own project reads Object

Project reads Object

Owner reads Object

User Can Read Bucket

Service Account Can Read Bucket

Owner owns Object

User owns Object

Owner owns Object

User owns Object

User Edit

User Comment

User TeamDrive Member

View
Owner
Viewer
202

File Direct Recipient

Public Editable Share Type is a normalized share permission that represents the supported cloud applications
share permissions that is accessible and editable by any user.

The following are the share permissions from each cloud applications that the Public Editable Share Type

covers.

FortiCASB 24.3.b Admin Guide
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Cloud Applic-

ation

AWS S3
Confluence
Dropbox
Dropbox
Egnyte

Google
Workspace

Google
Workspace

Google
Workspace

Google
Workspace

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Office365

Share Permission

S3_OBJECT_PUBLIC_WRITE_OBJ
CONFLUENCE_SHARE_EDITOR
DROPBOX_SHARE_EDITOR
DROPBOX_LINK
EGNYTE_LINK_ANYONE_DOWNLOAD

GOOGLE_ANYONE_COMMENTER

GOOGLE_ANYONE_WRITER

GOOGLE_LINK_ANYONE_
COMMENTER

GOOGLE_LINK_ANYONE_WRITER

GOOGLECLOUD_OBJECT_
ALLUSERS_OWN_OBJ

GOOGLECLOUD_OBJECT _
ALLAUTHUSERS_OWN_OBJ

GOOGLECLOUD_OBJECT _
ALLUSERS_OWN_OBJ

GOOGLECLOUD_OBJECT_
ALLAUTHUSERS_OWN_OBJ

OFFICE365_LINK_ALL_EDIT

Group Editable Share Type

Description

Public Write Object

User Can Edit File

Editor

Link_public

Link Shared with Anyone Read and

Download

Anyone Can Comment

Anyone Can Edit

Anyone With Link Can Edit

Anyone With Link Can Edit

All users own Object

All users own Object

All users own Object

All users own Object

Anyone Edit Link

Group Editable Share Type is a normalized share permission that represents the supported cloud applications

share permissions that is only accessible and editable by the group.

The following are the share permissions from each cloud applications that the Group Editable Share Type

covers.

Cloud Applic-

ation
AWS S3

Box

Share Permission

S3_OBJECT_CROSS_WRITE_OBJ
BOX_SHARE_EDITOR

FortiCASB 24.3.b Admin Guide
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Cross-account Write Object

Editor
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Cloud Applic-

ation
Box

Box
Dropbox
Egnyte
Egnyte
Egnyte

Egnyte

Egnyte

Egnyte

Egnyte

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Share Permission

BOX_LINK

BOX_SHARE_COOWNER
DROPBOX_LINK_TEAM_ONLY
EGNYTE_GROUP_SHARE_EDITOR
EGNYTE_GROUP_SHARE_OWNER
EGNYTE_LINK_DOMAIN_DOWNLOAD

EGNYTE_LINK_PASSWORD_
DOWNLOAD

EGNYTE_LINK_RECIPIENTS_
DOWNLOAD

EGNYTE_LINK_GROUP_DOWNLOAD

EGNYTE_GROUP_SHARE_FULL _
ACCESS

GOOGLECLOUD_BUCKET_GROUP_
EDIT_BKT

GOOGLECLOUD_BUCKET_DOMAIN_
EDIT_BKT

GOOGLECLOUD_BUCKET_PROJECT _

EDIT_BKT

GOOGLECLOUD_BUCKET _
ALLUSERS_EDIT_BKT

GOOGLECLOUD BUCKET _
ALLAUTHUSERS_EDIT_BKT

GOOGLECLOUD_OBJECT_GROUP_
OWN_OBJ

GOOGLECLOUD_OBJECT_DOMAIN_
OWN_OBJ

GOOGLECLOUD_OBJECT _
OWNPROJECT_OWN_OBJ

GOOGLECLOUD_OBJECT_PROJECT _

OWN_OBJ

GOOGLECLOUD_OBJECT _GROUP._
OWN_OBJ

FortiCASB 24.3.b Admin Guide
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Description

Link

Coowner

Link_team_only

Group Can Edit Folder content
Group Own Folder

Link Shared to Domain - Read and
Download

Link Shared with Password Protection -
Read and Download

Link Shared to specific User Recepients -
Read and Download

Link Shared to Group - Read and

Download

Group has Full Access

Group Can Edit Bucket

Domain Can Edit Bucket

Project Can Edit Bucket

All Users Can Edit Bucket

All Authenticated Users Can Edit Bucket

Group owns Object

Domain owns Object

Own project owns Object

Project owns Object

Group owns Object
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Cloud Applic-

ation

Google Cloud

Google Cloud

Google Cloud

Google
Workspace

Google
Workspace

Google
Workspace

Google
Workspace

Google
Workspace

Google
Workspace

Office365
Office365
Office365
Salesforce
Salesforce

Webex

Share Permission

GOOGLECLOUD_OBJECT_DOMAIN_
OWN_OBJ

GOOGLECLOUD_OBJECT _
OWNPROJECT_OWN_OBJ

GOOGLECLOUD_OBJECT_PROJECT_
OWN_OBJ

GOOGLE_GROUP_WRITER

GOOGLE_DOMAIN_WRITER

GOOGLE_LINK_DOMAIN_WRITER

GOOGLE_LINK_DOMAIN_
COMMENTER

GOOGLE_DOMAIN_COMMENTER

GOOGLE_GROUP_COMMENTER

OFFICE365_SHARE_EDIT
OFFICE365_LINK_LOGIN_EDIT
OFFICE365_LINK_USER_EDIT
SALESFORCE_SHARE_EDIT
SALESFORCE_LINK
WEBEX_SHARE_GROUP

Group Readable Share Type

Description

Domain owns Object

Own project owns Object

Project owns Object

Group Edit

People In The Domain Can Edit

People In The Domain With Link Can Edit

People In The Domain With Link Can

Comment

People In The Domain Can Comment

Group Comment

Edit

People In Organization Can Edit
People With The Link Can Edit
Collaborator

Link

File Group Recipient

Group Readable Share Type is a normalized share permission that represents the supported cloud applications

share permissions that is only readable by a specific group of users.

The following are the share permissions from each cloud applications that the Group Readable Share Type

covers.
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Cloud Applic-

ation
AWS S3
AWS S3

AWS S3

Egnyte
Egnyte
Egnyte

Egnyte

Egnyte
Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google Cloud

Google
Workspace

Google
Workspace

Google
Workspace

Office365
Office365

Share Permission

S3_OBJECT_CROSS_READ_OBJ

S3_OBJECT_CROSS_READ OBJ_
PERM

S3_OBJECT_CROSS_WRITE_OBJ_
PERM

EGNYTE_GROUP_SHARE_VIEWER
EGNYTE_LINK_DOMAIN_PREVIEW
EGNYTE_LINK_PASSWORD_PREVIEW

EGNYTE_LINK_RECIPIENTS_PREVIEW

EGNYTE_LINK_GROUP_PREVIEW

GOOGLECLOUD_OBJECT_GROUP_
READ OBJ

GOOGLECLOUD_OBJECT_
ALLAUTHUSERS_READ_OBJ

GOOGLECLOUD_BUCKET_GROUP_
READ_BKT

GOOGLECLOUD_BUCKET_DOMAIN_
READ_BKT

GOOGLECLOUD_BUCKET_PROJECT _
READ_BKT

GOOGLECLOUD_BUCKET_
ALLAUTHUSERS_READ_BKT
GOOGLE_GROUP_READER

GOOGLE_DOMAIN_READER

GOOGLE_LINK_DOMAIN_READER

OFFICE365_LINK_LOGIN_READ
OFFICE365_LINK_USER_READ
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Description

Cross-account Read Object

Cross-account Read Object Permissions

Cross-account Write Object Permissions

Group Can View Folder content
Link Shared to Domain - Read only

Link Shared with Password Protection -
Read only

Link Shared to specificUser Recepients -
Read Only

Link Shared to Group - Read Only

Group reads Object

All Authenticated users reads Object

Group Can Read Bucket

Domain Can Read Bucket

Project Can Read Bucket

All Authenticated Users Can Read Bucket

Group View

People In The Domain Can View

People In The Domain With Link Can

View

People In Organization Can View

People With The Link Can View
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Public Readable Share Type

Public Readable Share Type is a normalized share permission that represents the supported cloud applications
share permissions that is only readable by any user.

The following are the share permissions from each cloud applications that the Public Readable Share Type

covers.

Cloud Applic-

ation
AWS S3
AWS S3

AWS S3

Azure

Azure

Azure
Confluence
Egnyte
Google Cloud

Google Cloud

Google
Workspace

Google
Workspace

Office365

Share Permission

S3_OBJECT_PUBLIC_READ_OBJ

S3_OBJECT_PUBLIC_READ_OBJ_
PERM

S3_OBJECT_PUBLIC_WRITE_OBJ_
PERM

AZURE_BLOBCONTAINER _
PUBLICACCESS_CONTAINER

AZURE_BLOBCONTAINER _
PUBLICACCESS_BLOB

AZURE_BLOB_PUBLIC_READ
CONFLUENCE_SHARE_VIEWER
EGNYTE_LINK_ANYONE_PREVIEW

GOOGLECLOUD_OBJECT_
ALLUSERS_READ_OBJ

GOOGLECLOUD BUCKET _
ALLUSERS_READ_BKT
GOOGLE_ANYONE_READER

GOOGLE_LINK_ANYONE_READER

OFFICE365_LINK_ALL_READ

Description

Public Read Object

Public Read Object Permissions
Public Write Object Permissions

Public Read Access on Container Level
Public Read Access on Container and
Blob Level

Public Read Access on Blob

User Can View File

Link Shared with Anyone - Read only

All users reads Object

All Users Can Read Bucket

Anyone Can View

Anyone With Link Can View

Anyone View Link

Microsoft Online Apps Integration (Office 365 Only)

The Microsoft online application integration monitors Microsoft Yammer, Microsoft One Drive, Microsoft
Sharepoint, and Microsoft Teams.

In Files page, all shared files from Microsoft Online Application are shown with corresponding logos.

FortiCASB 24.3.b Admin Guide
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Microsoft Online Application and Logos

Microsoft Online Applic-

ation

Microsoft Yammer

Microsoft One Drive

Microsoft Sharepoint

Microsoft Teams

Azure Active Directory

Logo

2

For example, the following files are on both Microsoft Teams and Microsoft One Drive.

File Name

23-fr-passport.doc ﬁ [
19'US'§E’W&I1'JaSSL‘.D\'t,DJﬁ*‘
21'iprgass;‘.nrt,p-g',x*.
25-uk-iban.docx Hj @
20-au-passport_internaluserx/sx * -~

24-cn-unionpay.doc Efjh @

Google Drive Label Integration (Google Workspace Only)

Introduction

Drive Owner(Site)

gareport

gareport

gareport

gareport

gareport

gareport

Created Date

2021/07/14,03:25:27 PM

2021/07/14,03:25:27 PM

2021/07/14,03:25:27 PM

2021/07/14,03:25:27 PM

2021/07/14,03:25:27 PM

2021/07/14,03:25:27 PM

Last Modified

7/14/2021,3:25:27 PM

7/14/2021, 3:25:27 PM

7/14/2021, 3:25:27 PM

7/14/2021,3:25:27 PM

7/14/2021, 3:25:27 PM

7/14/2021,3:25:27 PM

Path

cucumber/rb/23-fr-passport.doc

cucumber/rb/19-us-german-passport.ppt

cucumber/rb/21-jp-passport.pptx

cucumber/rb/25-uk-iban.docx

cucumber/rb/20-au-passport_internaluserxlsx

cucumber/rb/24-cn-unionpay.doc

Google Drivel Label is a feature of Google Drive where labels can be attached to files stored in Google Drive

to provide better organization.

For more details on Google Drive Labels, please see Get Started as a Drive labels admin.

FortiCASB 24.3.b Admin Guide
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Google Drive Label Integration

FortiCASB integrates Google Drive Label in Google Workspace files' profiles to provide additional details on the

metadata of the files to give more insights.

There are two types of labels, Badged labels and Standard Labels.

Basic Detail - Badged Label

Badged Labels are critical metadata of an organization, and are the most visible labels next to the file name

when opened in Google Doc, Sheets, etc.

There is only one badged label per organization.

Basic Detail

File Name
Creator
Created Date

ast Modified

Badged Label

Standard Label
Path
Download Link

Highlight

30-Spanish_IBAN.txt

2023/10/17,02:50:36 PM
2023/10/17,02:50:36 PM

New Badged Label : New option

101620232/30-5panish_|BAN.txt
F

Basic Detail - Standard Label

Standard Labels are other metadata of an organization that can be used like tags where fields and values can

be attached for additional information.

There can be a maximum of 150 standard labels per organization.

FortiCASB 24.3.b Admin Guide
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Basic Detail

File Name 11-FL Driver License.txt
Creator

Created Date 2024/03/27,03:12:32 PM
Last Modified 2024/03/27,03:12:32 PM

Badged Label —

Standard Label Testl:: Test2 : Number: 123 Test2: Date:
Path -
Download Link k3
Highlight O E
Users

Users page displays user access privilege to cloud application and the files shared or shared by the users.

FortiCASB 24.3.b Admin Guide 414
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Office 365 / Users

User Overview
2 TotalUser 181 2. Privileged User 35 Dormant User 178 8. GuestUser 7
User Name Email Sensitive Files  Files Shared with this Us...  Files Shared by this User Last Login Property
Roy 0 0 % - Q@ ) X
testuser81 4] 0 0 -Q@
test 0 0 0 -0 2
Dunxing Zhang 0 0 0 -Q@
Click on the User Name for more details about the user.
The type of user is displayed in Property column.
Type of User Description
Privileged User Any user with specific administrative privileges. For
® a list of these specific privileges, see Administrative
It Privileges on page 416.
Dormant User Any user that has not accessed the cloud
application for at least 30 days.
Guest User ® Any user from an external company with access to
i your cloud application.
If the User page cannot retrieve privileged roles information from your Office 365
account, make sure you have Global Administrator Privileges and Azure Active
Directory Premium P2.

FortiCASB 24.3.b Admin Guide
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Administrative Privileges

Box

An admin with all of the following permissions is considered a privileged user:

« Manage users and groups
« Make calls on behalf of users
« View all data

Confluence

A user with any of the following administrator roles is considered a privileged user:

« Site Admin
e Administrator
e Trusted User

Dropbox Business

A Team Admin is considered a privileged user.

Egnyte

A user with any of the following administrator roles is considered a privileged user:

e Administrator
o Power User

Google Workspace

A user with any of the following administrator roles is considered a privileged user:
o Super Administrator
« Groups Administrator
« User Management Administrator
« Help Desk Administrator
o Services Administrator
o User Customized Administrator

Jira

A user with any of the following administrator roles is considered a privileged user:

« Site Admin
e Administrator
e Jira-Administrator

FortiCASB 24.3.b Admin Guide 416
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Github

Only the Account owner is considered as a privilege user.

Office 365

A user with any of the following administrator roles is considered a privileged user:

« global administrator

« Dbilling administrator

« password administrator

« service administrator

« user management administrator
« Exchange administrator

« SharePoint administrator

« Skype for Business administrator

SAP IAS

A user with any of the following administrator roles is considered a privileged user:

« Admin user or user with user type: Public

Salesforce

A user with any of the following administrative permissions is considered a privileged user:

« Assign Permission Sets
« Manage Sharing

« Modify All Data

« Manage Encryption Keys
« View All Data

« View All Users

ServiceNow

A user with any of the following administrator roles is considered a privileged user:

o Administrative User (Any user with admin role)

Webex Teams

A user with any of the following administrator roles is considered a privileged user:

« User Administrator
+ Read-only Administrator

FortiCASB 24.3.b Admin Guide 417
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o Support Administrator

« Device Administrator

« Sales Administrator

« Help Desk Administrator
« Full Administrator

Zoom

A user with any of the following administrator roles is considered a privileged user:

o Owner
o Admin
o Custom role user with all privileges of an Admin role.

Policy

In addition to the Data Security policy from Data Protection, there are also Threat Protection and Compliance
policies that are specific to each SaaS application.

Threat protection policies track suspicious user behavior.

Compliance policies monitor cloud accounts in compliance with various compliance standards (SOX-COBIT,
PCI, HIPAA, etc.).

e Threat Protection on page 419

e Compliance Policy on page 420

I\ To activate a policy to trigger alert, please refer to Policy Configuration on page 421.
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Threat Protection

Threat Protection policies track suspicious user behavior. For example, if a user fails to enter his or her
password correctly multiple times in a row and you have the Excessive Login Failures policy active, FortiCASB
will send you an alert.

Threat Protection feature is currently only available for Salesforce, Office 365, Box, Dropbox, Confluence,
Egnyte, GitHub, Jira, SAP IAS, ServiceNow, Webex Teams, and Zoom.

Threat protection policies

femm s

Excessive Login Triggers an alert when the number of failed
Failures logins for a user exceeds a set threshold.

Triggers an alert when passwords are

Password Change e

Triggers an alert when a change in a user's
Suspicious Movement geographic location exceeds threshold

parameters.
Unapproved Login Triggers an alert when a user logs in from an
Location unapproved geographic location.

Suspicious Activity Description

Triggers an alert when a monitored user

Restricted User o
performs select activities.

Triggers an alert when there is activity from a

SURLHE TR suspicious IP.

Triggers an alert when there is activity

Suspicious Time outside of work hours.

Triggers an alert when there is activity from

Suspicious Location . .
suspicious locations.

FortiCASB 24.3.b Admin Guide 419
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Sensitive Activity Description

Triggers an alert when a sensitive event
occurs.

Sensitive Event

Triggers an alert when a specified

Sensitive File . .
sensitive file is accessed.

Ransomware Behavior Triggers an alert when the directory's file
Detection (s) had been replaced.

Triggers an alert when a file upload exceeds
a size threshold.

Large File Upload

Compliance Policy

Compliance policies monitor cloud accounts in compliance with various compliance standards (SOX-COBIT,
PCI, HIPAA, etc.).

Only polices with VU in Alert column will generate alerts. All other compliance polices will generate data in
compliance report.
The compliance reports are designed to fulfill the compliance requirements of your organization.

For example, if a user accesses a file containing private heath information and you have the corresponding
HIPAA policy enabled, FortiCASB will add the corresponding access logs in the Compliance report.

The prerequisite to generate Compliance report is to enable and configure compliance
policies required by your organization. For more details on configuring compliance

policies, please refer to Policy Configuration on page 421.

List of Compliance policies
See Policy Configuration on page 421 for instructions/examples on setting policies.

SOX-COBIT

SOX-COBIT policies help your organization track and show compliance with the Sarbanes-Oxley (SOX) Act of
2002 using COBIT guidelines. Use these policies to monitor your cloud applications for SOX compliance, then
use the Report feature to print a report detailing compliance specifics.
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PCI-DSS

PCI-DSS (Payment Card Industry Data Security Standard) utilizes the current industry standard version 3.2.1 to
help your organization track and stay in compliant with the current industry payment standard. FortiCNP uses
these policies to monitor your cloud applications for PCI-DSS compliance, and use the Reporting feature to
generate reports.

HIPAA

HIPAA policies help your organization track and show compliance with the Health Insurance Portability and
Accountability Act (HIPAA). Use these policies to monitor your cloud applications for HIPAA compliance, then
use the Report feature to print a report detailing compliance specifics.

GDPR

GDPR policies help your organization track and show compliance with the EU General Data protection
Regulation (GDPR). Use these policies to monitor your cloud applications for GDPR compliance, then use the
Report feature to print a report detailing compliance specifics. Personal data type can be setup inside GDPR
policy configuration for monitoring.

ISO 270001

1ISO 270001 is the best-known standard in the family in providing requirements for an information security
management system (ISMS). ISO 270001 policies help your organization manage the security of assets, such
as financial information, intellectual property, employee details, and information entrusted to you by third
parties.

NIST 800-53 V4

NIST 800-53 V4 is the recommended security controls for federal information systems and organizations. It
documents security controls for all federal information systems.

NIST 800-171

NIST 800-171 can help to protect controlled unclassified information in non-federal Information systems and
organizations.

Policy Configuration

\‘é', One important note on policy configuration is that only the

policy that is turned On can trigger alerts or generate
reports.
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Enable Policy

Policy setting allows you to configure each policy depending on the requirement of your organization. Follow
the steps below to configure policies.

1. Select a cloud application from FortiCASB main dashboard.

2. Click on the Policy drop down menu, and select any type of Policy (Data Analysis, Threat Protection or
Compliance)

& Overview
Last 7 days w

} Salesforce

salesforce
Dashboard . Salesforce

Diiscovery
Status * Connected
Documents
Users Cloud Account bbao@forticash.com
Policy Checklist 4/4 Pass Detail
Drata Analysis
Last Update 7/26/2021, 10:41:30 PM History

Threat Protection
Compliance

Alert

Activity

3. Click on any policy drop down menu. For example, "Sensitive Event".

Salesforce / Policy / Threat Protection

Predefined Customized
Policy Name Policy Description Category
»  Password Change Allert when passwords are changed Access

Alert when a monitored user performs selected

»  Restricted User Suspicious Activity

activities
ESensitive Event Alert when sensitive event occurs Sensitive Activity
Enabled m Off
Severity Critical v
Event 5 Events Selected
Threshold (Times) - 2 +
Interval (minute) - 5 +
Email Notification On m If enabled, below people will be notified when this policy is violated.
Save Changes Clear Changes
FortiCASB 24.3.b Admin Guide 422
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4. Enable the policy by setting it to On.
5. Click Save Changes to complete the configuration.

The policy you set should be active after a few minutes.

Note: For Compliance Policies, only polices with @ in Alert column will generate alerts. All other

Compliance polices will still generate data in Compliance reports.

SOX-COBIT PCI-DSS HIPAA GDPR NIST SP 800-53 rev4 NIST SP3800-171 1SO 27001

FortiCASB Policy Policy Description Severity

Track changes to user account, including add, delete/deactive account, change

Enabled

Alert

»  SOX/COBIT - Track changes to user account R o ® Critical . @
of account priviledze

»  SOX/COBIT - Security Incident Definition List all active security policy, description and risk level ® Critical . .&

»  SOX/COBIT - Access to Sensitive Data Track access to sensitive data ® Critical . @

General Configuration

These are the common parameters in Policy Configuration. Every policy has different setting parameters. Not
all parameters are available in any given policy setting.

Parameter Name Description

Enabled

Severity Level

Matching
Threshold

Interval (minute)

Data Pattern

File Path Regex

Email Notification
(Notify FortiCASB
Users)

Email Notification
(Notify File Owners)

FortiCASB 24.3.b Admin Guide
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Specify whether or not the policy is enabled to trigger alert. A policy is active when it
is set to On.

The severity level for the policy, you can set the severity level as Critical, Alert,
Warning, or Information.

Specify the minimum threshold for an alert to be triggered.

For example, DLP Visa Card Policy with a matching threshold of 2 will trigger an
alert when 2 or more credit card numbers are detected.

The minimum threshold between each time the policy is triggered by the user
activity for an alert to be triggered.

For example, Sensitive Event with an interval of 5 minutes will trigger an alert
when a sensitive event occurs every 5 minutes.

Specify the DLP or customized data pattern to be associated with the policy to
protect the type of sensitive data. FortiCASB will search for the selected DLP data
pattern during Discovery scans.

Specify the targeted regular expression pattern of the cloud storage files which
FortiCASB will run DLP scan on.

When the email notification is turned on, FortiCASB users can be added to be

notified when an alert is triggered by the policy.

This feature is only available in customized Threat Protection policies. When the

policy is turned on, the file owner will be notified on the file exposure with editable
notification.
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For more details on policy configurations, please see
Threat Protection Policy Configuration on page 424
Compliance Policy Configuration on page 439

Customized Policy Configurations on page 446

Threat Protection Policy Configuration

List of all Threat Protection Policy Configuration guides

e Excessive Login Failures on page 425

e Suspicious Movement on page 426

e Unapproved Login Location on page 428
e Restricted User on page 429

e Suspicious IP on page 430

e Suspicious Time on page 431

e Suspicious Location on page 433

e Sensitive File on page 434

e Sensitive Event on page 435

e Large File Upload on page 436

e Suspicious Label Activity (Google Workspace Only) on page 437

FortiCASB 24.3.b Admin Guide 424
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Excessive Login Failures

Description

Excessive Login Failures monitors for excessive login attempts of unidentified user in a time interval.
Administrators are able to customize the threshold of number of failed login attempts and the time interval
(minutes) before an alert is generated.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.
2. Click on Policy drop down menu and select Threat Protection.
3. Locate Excessive Login Failures and click on the right arrow key  button to expand the policy.
4. Click Onin Enabled to enable the policy.
FortiCASB 24.3.b Admin Guide 425
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Alert when failed logins for a user exceeds

»  Excessive Login Failures threshold Access
Enabled oy orr |
Severity Warning -
Login Attempts - 15 +
Interval (minute) - 60
Email Motification On m f enabled, below people will be notified when this policy is violated.

Save Changes Clear Changes

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,
Information).

6. In Login Attempts, enter the threshold of the number of failed login attempts before an alert is
generated.

7. InInterval (minute), enter the time interval of the first failed login attempt of the same user.
8. Click Save Changes to save and update the configuration.

login attempts threshold within in the given time interval, an alert will be triggered in

\‘é', After the policy is enabled and configured, whenever an unidentified user exceeded the
- the alert page. For more details, please refer to Alert on page 450.

Suspicious Movement

Description

Suspicious Movement policy monitors changes in users geographical location. When the speed (mph) of
traveling between the original and the new location exceeds the maximum threshold, an alert will be generated
to inform on the unidentified cloud account intrusion.
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The policy also takes in account of the proximity distance of the new location before checking for the speed in

which the user traveled.

In exception cases, known users can be excluded from being monitored by placing them on the IP allow list.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.

2. Click on Policy drop down menu and select Threat Protection.

3. Locate Suspicious Movement and click on the right arrow key 2 button to expand the policy.

4. Click Onin Enabled to enable the policy.

. Alert when change ina user's geographic location
*  Suspicious Movement Access
exceeds threshold
Enabled By o
Severity Critica -
Velocity Settings (mph) - 800 +
Distance Tolerance (mile): | -  80.. +
Monitor Scope -
IP Allow List Start IP End IP
96.45.34.9 96.45.34.9
+ Add Another
Email Notification On m f enabled, below people will be notified when this policy is violated.
Save Changes Clear Changes

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,
Information).

6. InVelocity Setting (mph), enter the maximum speed in which a user can travel between two locations in
any given time before being viewed as suspicious movement. The most commonly used value for this
parameter is commercial flight speed, 600 mph.

7. In Distance Tolerance (mile)field, enter a proximity distance that will not be accounted for in monitoring

for suspicious movement.

For example, if you entered 50 miles, any login within 50 miles of the origin will not be taken as suspicious
movement.

InIP Allow List, enter sets of IP ranges to be excluded from being monitored for suspicious movements.
This is useful when you know the users who travel periodically.

Click Save Changes to update the configuration.

FortiCASB 24.3.b Admin Guide
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N ! ’, After the policy is enabled and configured, whenever the new user login location
? exceeded the maximum speed threshold, an alert will be sent on the illegal login, for
3 more details, please refer to Alert on page 450.

Unapproved Login Location

Description

Unapproved Login Location policy monitors for logins from block listed country.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.
Click on Policy drop down menu and select Threat Protection.

2
3. Locate Unapproved Login Location and click on the right arrow key 2 button to expand the policy.
4. Click Onin Enabled to enable the policy.

. B Alert when a user logs in from an unapproved
»* Unapproved Login Location i i Access
geographic location

Enabled 2y o

Severity Critical -

Unapproved Login 0 Countries Selected

Location

Email Notification On m If enabled, below people will be notified when this policy is violated.

Save Changes Clear Changes

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,
Information).

FortiCASB 24.3.b Admin Guide 428
Fortinet Inc.



Cloud Application Features

6. Click Unapproved Location List to select the countries. This will generate an alert whenever there is a

login attempt from the block listed countries.

7. Click Save Changes to update the configuration.

L After the policy is enabled and configured, whenever an unidentified user login from
? the block listed location, an alert will be triggered in the alert page. For more details,
3 please refer to Alert on page 450.

Restricted User

Description

Restricted User policy monitors for cloud account activities conducted by targeted users. An alert will be sent

whenever targeted user(s) performs certain activities.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.

Click on Policy drop down menu and select Threat Protection.

2
3. Locate Restricted User and click on the right arrow key > button to expand the policy.
4

Click On in Enabled to enable the policy.

v  Restricted User

Enabled

Severity

Event

Suspicious User

Email Notification

Save Changes

FortiCASB 24.3.b Admin Guide
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Alert when a monitored user performs selected . .
. Suspicious Activity
activities

o B
Alert -
3 Events Selected

1 Users Selected

On m f enabled, below people will be notified when this policy is violated.

Clear Changes
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5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,
Information).

6. In Event section, click to select Specific events then click the drop down field under it to select specific
event(s). To select all events instead, click on Select all events.

7. In Suspicious User section, click to select Specify users and click the Select User drop down field to
select user(s). To select all users instead, click Select all users.

8. Click Save Changes to update the configuration.

\‘é', After the policy is enabled and configured, whenever the targeted users perform certain

activities, an alert will be triggered in the alert page. For more details, please refer to
Alert on page 450.

Suspicious IP

Description

Suspicious IP policy monitors cloud account activities conducted by targeted IP addresses. Alerts will be sent
when any activities are performed by the targeted IPs.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.
Click on Policy drop down menu and select Threat Protection.

2
3. Locate Suspicious IP and click on the right arrow key 2 button to expand the policy.
4. Click Onin Enabled to enable the policy.
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»  Suspicious IP Alert on activity from suspicious IPs Suspicious Activity
Enabled m Off
Severity Warning -
Suspicious IP Start IP EndIP
20.190.132.42 20.190.132.42
+ Add Another
Email Notification Oon m If enabled, below people will be notified when this policy is violated.

Save Changes Clear Changes

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,
Information).

6. In Suspicious IP section, click to enter the beginning and ending IP range, and click ¥ to add. Repeat
this step to enter more IP ranges,

7. Click Save Changes to update the configuration.

A\,

~ g ¢ After the policy is enabled and configured, whenever a targeted IP performs any
? activity, an alert will be triggered in the alert page. For more details, please refer to
3 Alert on page 450.

Suspicious Time

Description

Suspicious Time policy monitors cloud account activities outside of regular working hours.

Policy Configuration

Follow the steps below to enable and configure the policy
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A w0 b=

v  Suspicious Time

Enabled

Severity

Event

Suspicious Time

Email Notification

Save Changes.

Click on Policy drop down menu and select Threat Protection.

Click On in Enabled to enable the policy.

Alert on activity outside work hours
Warning -
4 Events Selected

Start Time End Time Day
08:01 AM @ 11:47 PM Monday

+ Add Anather

Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.

Locate Suspicious Time and click on the right arrow key 2 button to expand the policy.

Suspicious Activity

on m f enabled, below people will be notified when this policy is vio

Clear Changes

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,

Information).

6. In Event section, click to select Specific events then click the drop down field under it to select specific

event(s). To select all events instead, click on Select all events.

7. In Suspicious Time section, click on Select day in week drop down menu to select a day in the week to
monitor for suspicious event. Then enter the beginning and end time of the day to monitor the event.

8. Click Save Changes to update the configuration.

A\,

~ P After the policy is enabled and configured, whenever the specific activity is conducted
? in the suspicions time frame during the target day of the week, an alert will be triggered
- in the alert page. For more details, please refer to Alert on page 450.
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Suspicious Location

Description

Suspicious Location policy monitors for cloud account activities not shown on location allow list.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.
Click on Policy drop down menu and select Threat Protection.

2
3. Locate Suspicious Location and click on the right arrow key > button to expand the policy.
4

Click On in Enabled to enable the policy.

»  Suspicious Location Alert on activity from suspicious locations
Enabled B o
Severity Alert -

Location Allow List 1 Countries Selected

Suspicious Activity

Email Motification On m f enabled, below people will be notified when this policy is violated

Save Changes Clear Changes

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,

Information).

6. InLocation Allow List, click Select Country drop down menu to select a country to be added to the

location Allow list. Click Add to finish adding the location. Repeat the same process to add more location.

7. Click Save Changes to update the configuration.

A\,

outside of the allow list locations, an alert will be triggered in the alert page. For more

details, please refer to Alert on page 450.

sq, After the policy is enabled and configured, whenever there is any cloud account activity
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Sensitive File

Description

Sensitive File policy monitors and sends an alert when targeted cloud account files are being accessed. The

location of the cloud account file path is configured through Regex.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.

Click on Policy drop down menu and select Threat Protection.

2
3. Locate Sensitive File and click on the right arrow key 2 button to expand the policy.
4

Click On in Enabled to enable the policy.

v  Sensitive File Alert when specified sensitive files is accessed
Enabled [ on et
Severity Warning -

File Path Regex cucumber/yyao/*

Email Notification On m f enabled, below people will be notified

Save Changes Clear Changes

Sensitive Activity

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,

Information).

6. In File Path Regex, enter a valid Regex of the target file path to be monitored. Here are examples of file

path Regex:
a. ".*"targets all files in the cloud account.

b. "M?:[\W\:\)(\\[a-z_\-\s0-9\.]+)+\.(txt|gif|pdf|doc|docx|xIs|xIsx)$" targets files begin with x:\ or \\ with
files ending in the following types of extensions: txt, gif, pdf, doc, docx, xls, xIsx. Here are the file

paths that will this file path Regex matches:
i. \\192.168.0.1\folder\file.pdf
ii. c:\my folden\abc abc.docx

Reference: https://www.codeproject.com/Tips/216238/Regular-Expression-to-Validate-File-Path-and-Exten

7. Click Save Changes to update the policy configuration.
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N ! ’, After the policy is enabled and configured, whenever any file targeted by the file path
? Regex is accessed on the cloud account, an alert will be triggered in the alert page. For
= more details, please refer to Alert on page 450.

Sensitive Event

Description

Sensitive Event policy monitors specific cloud account activities and triggers alerts.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.
Click on Policy drop down menu and select Threat Protection.

2
3. Locate Sensitive Event and click on the right arrow key > button to expand the policy.
4. Click Onin Enabled to enable the policy.

»  Sensitive Event Alert when sensitive event occurs Sensitive Activity
Enabled on [E@
Severity Critica -
Event 1 Events Selected
Threshold (Times) - 3 +
Interval (minute) - 5 +
Email Notification On m f enabled, below people will be notified when this policy is violated

Clear Changes

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,
Information).

6. In Event section, click to select Specific events then click the drop down field under it to select specific
event(s). To select all events instead, click on Select all events.
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7. In Threshold (Times), enter the maximum number of times the event or activity is being performed by
the same user before an alert is triggered.

8. InInterval (Minutes), specify the amount of time that the user conducts the targeted activities before
triggering an alert.

9. Click Save Changes to update the configuration.

A typical example for the policy usage is downloading or uploading multiple files in a given amount of time
would trigger an alert.

repeatedly by the same user in a given time frame, an alert will be triggered in the alert

s‘é’, After the policy is enabled and configured, whenever the specific activity is conducted
- page. For more details, please refer to Alert on page 450.

Large File Upload

Description

Large File Upload policy monitor and tracks for file size uploaded to the cloud account, an alert will be sent
when the file uploaded exceeded file size threshold.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.
Click on Policy drop down menu and select Threat Protection.

2
3. Locate Large File Upload and click on the right arrow key = button to expand the policy.
4. Click Onin Enabled to enable the policy.
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» Large File Upload Alert when file upload exceeds size threshold Abnormal Traffic
Enabled m Off
Severity Warning -
Threshold (MB) - 2 +
Email Notification on m f enabled, below people will be notified when this policy is violated.
Save Changes Clear Changes

6. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,
Information).

7. Enter the maximum file size (MB) of the file to be uploaded to the cloud account without triggering an alert.
8. Click Save Changes to update the configuration.

threshold is uploaded to the cloud account, an alert will be triggered in the alert page.

\‘é', After the policy is enabled and configured, whenever a file larger than the file size
- For more details, please refer to Alert on page 450.

Suspicious Label Activity (Google Workspace Only)

Description
Suspicious Label Activity alerts when targeted Google Drive label activities exceed threshold for specific labels.

Policy Configuration

Follow the steps below to enable and configure the policy
1. Goto Google Workspace > Policy > Threat Protection.

2. Locate Suspicious Label Activity and click on the right arrow key # button to expand the policy.
3. Click Onin Enabled to enable the policy.
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Alert when label activities exceed threshold f
v  Suspicious Label Activity . Suspicious Activity
or specific labels

Enabled BN or
Severity Alert ~
Event 1 Events Selected

4. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,
Information).

5. Click Event drop down menu and select the event(s) that would trigger the alert.
a. Attach label to file - alert will trigger if a new label is attach to the file.
b. Remove label from file - alert will trigger if an existing label is removed from the file.
c. Edit label from file - alert will trigger if an existing label is modified.

6. In Specify Label, click Label Type drop down menu to select a label Type, and fill in appropriate fills.

a. Standard Labels have Label Name, Label Field (optional), and Label Values (optional).
b. Badged Labels only have Label Name and Label Value (optional)

Specify Label @ Label Type * Label Name * Label Field Label Value
Standard Label - Automobile Toyota Camry
Badged Label hd Airplane 777

+Add Another

7. Click to select Threshold (Number of Activities) needed to trigger the alert.

Threshold (Number of 1 +

Activities)

Interval (Min) - 3 +

Email Motification m Off If enabled, below people will be notified when this policy is violated.

236900@test.com €

8. InInterval, select number of minutes between each activity to trigger an alert.
9. Click On turn on Email Notification and enter the email address to receive notification alert.
10. Click Saves Changes to finish.
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Compliance Policy Configuration

Compliance Policy Configurations offers oppurtunities to look for violation of compliance policies in cloud
account usage.

Regex is used in Compliance Policy Configurations to target specific data.

Compliance Policy - Regex Configuration on page 439
Other examples of Compliance Policy Configurations:
e SOX-COBIT - Access to Sensitive Data on page 441
e PCI - Failed Access Attempt Detection on page 442
e PCI - Privileged Account Activity on page 444

e PCI - Retention Violation for Cardholder Data on page 445

Compliance Policy - Regex Configuration

Introduction

Regex or Regular Expression is a set of pattern matching rules used in search for specific data patternsin files
located in the cloud accounts.

Here are some common search queries and the corresponding Regex:

Search Quer- Regex

ies
Specific .*.(txt|pdf|doc|docx|xIs|xIsx)$
Extension
Folder \/cucumber\/.*
File Name .*ssn.*
All Path .*
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Example on using Regex search queries

PCI - Track all cardholder data access

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.

Go to Policy > Compliance, then select PCI-DSS tab.

Goto PCI - Track all cardholder data access and click > to expand the policy.
Click on Enabled toggle switch button to enable the policy.

o~ ODd

Note: this policy generates both alert in Alert page and data in Compliance Report.

6. InFile Path Regex, enter .*.(txt|pdf|doc|docx|xIs|xIsx)$ to track all files with extensions in txt, pdf, doc,

docx, xIs, and xIsx.

Track all activities of individual user accesses to cardholder

v PCI-Track all cardholder data access

data
Policy Guideline 10.2.1: All individual user accesses to cardholder data
Enabled B o
Severity Critical v

File Path Regex *(txt|pdf|doc|docx|xls|xlsx)$

Data Pattern 3 Data Patterns Selected

Email Notification On m If enabled, below people will be notified when this policy is violated.

Save Changes Clear Changes

7. In Data Patterns, click on the field and select DLP SSN, DLP Visa Credit Card, and DLP JCB to be

monitored.
8. Click Save Changes to finish.

Now all files with extensions in txt, pdf, doc, docx, xlIs, and xIsx will look for the presences of Social Security,

Visa Credit card, and JCB card numbers.
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SOX-COBIT - Access to Sensitive Data

Description

Access to Sensitive Data policy monitors and tracks access to sensitive data located in the cloud account.
Sensitive data location can be configured through file path Regex.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.
2. Goto Policy > Compliance, then select SOX-COBIT tab.

3. Expand SOX/COBIT - Access to Sensitive Data by clicking > button.

4. Enable the policy by clicking to toggle switch button.

» SOX/COBIT - Access to Sensitive Data  Track access to sensitive data ® Critical .

Policy Guideline DS5.11 Exchange of Sensitive Data Exchange sensitive transaction data only over a trusted path or medium with

controls to provide authenticity of content, proof of submission, proof of receipt and non-repudiation of origin

Enabled B or

Severity Critical -

File Path Regex K

Data Pattern 4 Data Patterns Selected

Email Notification On m If enabled, below people will be notified when this policy is violated.

Save Changes Clear Changes

5. Click on Severity level drop down menu to select a severity level (Critical, Alert, Warning, Information).
Note: this policy generates both alert in Alert page and data in Compliance Report.

6. In File Path Regex, enter a valid Regex of the target file path to be monitored. Here are examples of file
path Regex:

a. ".*"targets all files in the cloud account.

b. "M?:[\WW]\:\)(\\[a-z_\-\s0-9\.]+)+\.(txt|gif|pdf|doc|docx|xIs|xIsx)$" targets files begin with x:\ or \\ with
files ending in the following types of extensions: txt, gif, pdf, doc, docx, xls, xIsx. Here are the file
paths that will this file path Regex matches:

i. \192.168.0.1\folder\file.pdf
ii. c:\my foldenabc abc.docx
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7. In Data Patterns, click on the field and select the data patterns (financial, personal identity information,
etc.) to be monitored.

8. Click Save Changes to upgrade the configuration.

After the policy is enabled and configured, whenever any targeted sensitive file is
) ! & accessed, an alert will be triggered in the alert page. For more details, please refer to
q Alert on page 450.
- Compliance report will also record any alerts generated by this policy, for more details,
please see Generate Compliance Report on page 293.

PCI - Failed Access Attempt Detection

Description

Privileged Account Activity policy monitors and tracks targeted users' activities on the cloud accounts. The
policy allows configuration on which user and what type of activities to be monitored.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.

2. Click on Policy drop down menu and select Compliance, then select PCI-DSS tab.

3. Locate PCI - Failed Access Attempt Detection and click on the right arrow key 2 button to expand the
policy.

4. Click Onin Enabled to enabled the policy.
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v PCl- Failed Access Attempt Detection

Policy Guideline

Track failed attempts to access cloud resources

10.2.4: Invalid logical access attempts

Enabled on |3
Severity Critica -
Login Attempts _ 3 +
Interval (minute) _ 3 +
Email Motification m Off f enabled, below people will be notified when this policy is violated.
' o
Save Changes Clear Changes

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,

Information).

Note: this policy generates both alert in Alert page and data in Compliance Report.
6. InLogin Attempts, enter the threshold for the number of failed login attempts before an alert is

generated.

7. InInterval (minute), enter the time frame for all failed login attempts before an alert is generated.
For example, given an interval of 3 minutes and login attempts of 5. If a user had more than 5 failed login
attempts in 3 minutes, an alert will be sent to inform on the suspicious login attempts on the cloud

account.

8. Click Save Changes to update the configuration.

After the policy is enabled and configured, whenever there are excessive failed login

details, please refer to Alert on page 450.

“é" attempts on the cloud account, an alert will be triggered in the alert page. For more

Compliance report will also record any alerts generated by this policy, for more details,
please see Generate Compliance Report on page 293.
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PCI - Privileged Account Activity

Description

Privileged Account Activity policy monitors and tracks targeted users' activities on the cloud accounts. The

policy allows configuration on which user and what type of activities to be monitored.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.

Click on Policy drop down menu and select Compliance, then select PCI-DSS tab.

2
3. Locate PCI - Privileged Account Activity and click on the right arrow key = button to expand the policy.
4

Click On in Enabled to enabled the policy.

v PCI - Privileged Account Activity Track activity by privileged users
Policy Guideline 10.2.2: All actions taken by any individual with root or administrative privileges
Enabled on E3
Severity Critica -
Event

0 Events Selected

Monitored User 0 Users Selected

Email Motification on m f enabled, below people will be notified when this policy is violated.

Save Changes Clear Changes

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,

Information).
Note: this policy generates both alert in Alert page and data in Compliance Report.

6. In Event section, click to select specific event(s). To select all events instead, click on Select all events.
7. In Monitored User section, and select user(s) to be monitored. To select all users, click Select all users.

8. Click Save Changes to update the configurations.

After the policy is enabled and configured, whenever there is any specific activity

M, conducted by targeted user(s), an alert will be triggered in the alert page. For more
q details, please refer to Alert on page 450.
- Compliance report will also record any alerts generated by this policy, for more details,

please see Generate Compliance Report on page 293.
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PCI - Retention Violation for Cardholder Data

Description

Check if the designated cloud storage data has exceeded the retention time set by the cardholder. The
cardholder is able to set the cloud storage file path with the designated retention time.

Policy Configuration

Follow the steps below to enable and configure the policy

1. Click on any Cloud Account drop down menu from FortiCASB dashboard, e.g. Salesforce, Office365, etc.

2. Click on Policy drop down menu and select Compliance, then select PCI-DSS tab.

3. Locate PCI - Retention Violation for Cardholder Data and click on the right arrow key > button to
expand the policy.

4. Click Onin Enabled to enabled the policy.

w  PCl-Retention Violation for Cardholder Data Checks if cardholder data have exceeded retention time ® Critical

Policy Guideline 3.1 Keep cardholder data storage to a minimum by implementing data retention and disposal policies, procedures and
processes that include at least the following for all cardholder data storage. # Limiting data storage amount and
retention time to that which is required for legal, regulatory, and/or business requirements. e Specific retention
requirements for cardhelder data. » Processes for secure deletion of data when no longer needed, » Aquarterly
process for identifying and securely deleting stored cardholder data that exceeds defined retention.

Enabled on [E3@

Severity Critical ~

File Path Regex

Retention Time (day)

- 30
Data Pattern 15 Data Patterns Selected
Email Notification On m f enabled, below people will be notified when this policy is v

Clear Changes

5. Click on Severity level drop down menu to select the severity level (Critical, Alert, Warning,
Information).
Note: this policy only generates data in Compliance Report.

6. In File Path Regex, enter a valid Regex of the target file path for the storage data under the retention
restriction. Here are examples of file path Regex:
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a. ".*"targets all files in the cloud account.

b. "M?:[\WW]\:\)(\\[a-z_\-\s0-9\.]+)+\.(txt|gif|pdf|doc|docx|xIs|xIsx)$" targets files begin with x:\ or \\ with
files ending in the following types of extensions: txt, gif, pdf, doc, docx, xls, xIsx. Here are the file
paths that will this file path Regex matches:

i. \192.168.0.1\folder\file.pdf
ii. c\my folder\abc abc.docx
7. In Retention Time (day), enter the number of days as the retention time for the cloud storage data.

8. In Data Patterns, click on the field and select the data patterns (financial, personal identity information,
etc.) that shall be under the retention restriction.

9. Click Save Changes to upgrade the configuration.

maximum retention time, Compliance report will record retention violation generated ,

\‘é', After the policy is enabled and configured, when the targeted data exceeded the
- for more details, please see Generate Compliance Report on page 293.

Customized Policy Configurations

FortiCASB allows you to create personalized policies to suit your organization needs.

To add a customized policy, select a cloud application, and go to Threat Protection > Customized, scroll to
the bottom of the page and click + Add New.

Office 365 / Policy / Threat Protection HEE o 8 (%]
Predefined Customized
+ADD NEW
Policy Name Policy Description Severity Enabled Last Updated Action
»  Test Customized Policy CPF, Chinese ® Alert L] 2021/07/19, 10:46:13

AM

2021/07/07, 11:15:24
PM

»  logintest test login ® Alert L]

2021/07/21,01:49:57

b ssn dp ® Alert L4 M

2021/07/21,04:07:31
PM

2021/07/01, 04:11:01
PM

+  test-lemooc Pereleld nformation L4

Customized policies focus on two aspects, Content Monitoring and Activity Monitoring.
Content monitoring: Content monitoring monitors and look for sensitive data in the cloud accounts.

Activity Monitoring: Activity monitoring monitors user activities for suspicions activities.
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The following example illustrate how to create a common customized policies:

Customized Policy example: Monitor file download links with Social Security
number on page 447

Customized Policy example: Monitor file download links with Social Security
number

This example generates an alert when any Salesforce text file sharing link that contains a social security
number is downloaded.

1. Enter a Policy Name and Description for the policy, e.g. "Text Files Monitors SSN".

Policy Name
Text Files Monitor SSN
Severity  Alert -
Description

Monitors text files for SSN.

Enabled [ of

2. Click on Activity drop down menu, and select the Download File option.
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Exclude Below Activities Selected

Select All (total 49)

Upload File
Download File

Delete File

Maodify File

Access File

Move File

3. In Email Notification turn on to notify FortiCASB users and File Owners.
4. In Notify FortiCASB Users field, enter the FortiCASB user which the alert should be sent to.

Email Notification [} off Notify FortiCASB Users

If enabled, below people will be notified when this policy is violated.

| X :

5. In Notify File Owners field, edit the alert content with the file name, activity name, and exposure name
parameter.

m Off  Notify File Owners

If enabled. file owners will be notified when their files trigger this data
protection policy.

FortiCASB has detected [Activity Name] for file [File
Name] that is shared as [Exposure Name]. This file has
content of type [DLP Pattern Name].

Please make sure this file is private and not shared with
users who should not have access to this information

6. Turn on Content Matching to reveal Data Patterns selection.
7. In Path field, enter .*.(txt|pdf|doc|docx|xIs|xIsx)$ to monitor all text files downloads.
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Content
Matching
B3 o If enabled, the selected Activity in Activity will be restricted to document related.

Path
*(ixtlpdfldocldocx|xls|xlsx)$

DataPattern Al Data Patterns Selected
Owner All Owners Selected

Share Level 1 Share Level Selected

8. Click on Data Patterns drop down menu, and select DLP SSN.

Select All (total 41)

DLP MasterCard

DLP China Driver License

DLP United Kingdom Passport Number
DLP SSN

DLP China Passport Number

DLP Australia Passport Mumber

9. Click on Share Level drop down menu, and select Anyone View Link.
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Path
Select All (total 9)
Owner
Pattern View
Edit
Owner
People In Organization Can View
ire Level

People In Organization Can Edit

Anyone View Link

Anyone Edit Link
,

10. Click Add Customized Policy to finish adding the policy.

Alert

FortiCASB sends you alerts when any of the enabled policy is triggered by user activity.

« Data Analysis policies pertain to the types of data stored in the cloud application.
« Threat protection policies pertain to suspicious user activity.
« Compliance policies pertain to specific regulations, such as HIPAA, PCI, and SOX.

To view alerts of each cloud application, click on a cloud application drop down menu and click on Alert.
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L o T Office 365 / Alert

Version 212

Alert QOverview

alesforce

1} Office 365

B DataAnalysis Threat Protection Compliance
Dashboard
Discovery
Tesmes Time Range: Last 24 hours @
Users
p Alert Type Policy Name Object Severity
Alert Data Analysis DLP FR Passport Number Policy B 23-fr-passport.doc ® Alert
Activity
Data Analysis DLP JP Passport Number Policy B 21-jp-passport.pptx ® Alert
Box
Data Analysis DLP CA Passport Number Policy B 22-ca-passport.bd ® Alert
Dropbox ) .
Customized alldatapattern & ga@casbgal.onmicrosoft.com ® Alert
Srrgellinr s Customized alldatapattern & ga@casbgal.onmicrosoft.com ® Alert
Azure Storage Customized alldatapattern B 21-jp-passport.pptx ® Alert
All alerts are triggered by user activities that violated the corresponding policies.
Click on the right arrow key > of an alert to show alert summary.
Alert Type Policy Name Object Severity Created
v  Data Analysis DLP FR Passport Number Policy B 23-fr-passport.doc ® Alert 2021/07/29,01:19:19 PM
Alert 1D 33ebf81f0d7 Pebecc363abf64c5712a0 Policy Name DLP FR Passport Number Policy
Object B 23-fr-passport.doc Severity ® Alert
Created 2021/07/29,01:19:19PM Last Update 2021/07/29,01:19:19 PM
Activity Type Move File User & gareport
Activity Link 1 DLP Matches 9
P 96.45.36.173 Country/Region United States, Sunnyvale
Description

File " 23-fr-passport.doc “Matches the DLP France Passport Number 9
times(s), the matched content are:
(1) ***%4463 -

To enable a policy to trigger alert, please refer to Policy Configuration on page 421.

I Daily alerts can be compiled into Alert reports for export, please see Generate Alert
Report on page 296.
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Activity

FortiCASB monitors and tracks user data traffic and activities on your cloud platforms.

The Activity page contains both a map displaying (approximate) geolocations of events and activities list.

Office 365 / Activity

Berig Sea
Mongol
China South Korea
North
Fas Pacific
Ocean
"
Recenter
Time Range: Last 24 hours @
c
User Country/Region City
qa report United States Sunnyvale
qareport United States Sunnyvale

Activity Map options

P

96.45.34.121

96.45.34.121

Date

2021/07/29, 10:29:39 AM

2021/07/29, 10:29:36 AM

Event

Login Success

Login Success

H g B Ee

nited
adom
Ireland land
Germany
Fran R
Haly
Spain
Greee
Portugal
North
Atlanti .
o Morocco
2 Libya
Mauritani
Mali Niger
e Nigeria

Object Alert

2 ga@casbal.onmicrosoft.c
om

1

2 ga@casbaal.onmicrosoft.c
om

1

Keybosrd shorsouts | Map data 82021 Google, INEGI  Terms of Use |

Acticn

« Activity—Click on an activity bubble on the map to bring up an activities at that specific location.

Office 365 / Activity

Tunitas

San Gregorio

Pescadero

Recenter

Menlo Park
Palo Alto
Redwood Park
Woodside
Stanford
Mountain
AR Mountain
Lo Valey Los Altos Hills  View
Los Trancos
Loyola

La Honda Permanente

Bellvale
West Santa
Clara
Loma Mar

Dearborn Park

Sunnyvale

Cupertino

Saratoga

Milpitas

East Foothills
Alum Rock
Santa ulara
San uose

Burbank
Fruitdale

Campbell Lick

Robertsville
Cambrian Park
Alamitos

« Move—Move the map by clicking any point on the map and dragging with your mouse.
o Zoom—Use the buttons on the bottom-right corner of the map to zoom in and out.
« Refresh—Click the Refresh button to refresh the map.
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Activity Filter Example

1. Click on +Add Filter drop down menu.

Time Range: Last 30 days +Add Filter

2. Select afilter type, "Activity".

Time Range: Last 24 hours @

User Saved search Country/Region City P s Date
. test 2041 §  United States San Jose 76.126.19.27 Jun 3,2021:
. United States San Jose 76.126.19.27 Jun 3,2021:
. Filters Unitsd States San Jose 76.126.19.27 Jun3,2021:
. Activity United States San Jose 76.126.19.27 Jun3,2021:
. Activity ID United States Fremont 76.103.229.149 Jun 3,2021:
. IP Address United States San Jose 73.202.230.250 Jun 3,2021:
. Object Name United States Fremont 76.103.229.149 Jun 3,2021:
. ) United States Fremont 76.103.229.149 Jun 3,2021:
Time Range

c Jun3,2021:

| User
. United States Fremont 76.103.229.149 Jun 3,2021:

3. Then scroll down to select a type of activity, "Access File".

Time Range: Last 24 hours @

s Activity: intry/Region
. Q ed States
. ed States

File
. ed States
Access File
. ed States
Add Folder
. ed States
. CopyFile ed States
o Delete File ed States
. Delete Folder ed States

Download File

. Edit File =d States
Maodify File
SIEN S Move File

4. Then click Search button to update the search with the filter, only "Access File" activities will be
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shown in the time range.

Time Range: Last 24 hours @  Activity: Access File @

User Country/Region City P = Date 5 Event = Object
United States Fremont 76.103.229.149 Jun3,2021 11:23:45 AM Acgess File B o ) (4).ndf
United States Fremont 76.103.229.149 Jun3,2021 11:23:45 AM Acgess File
United States Fremont 76.103.229.149 Jun3,2021 11:23:45 AM Access File ]

United States Fremont 76.103229.149 Jun3,2021 11:23:45 AM Access File ]
United States Fremont 76.103229.149 Jun3,2021 11:23:45 AM Access File ]
United States Fremont 76.103.229.149 Jun3,2021 10:47:09 AM Access File ]
United Stztes Fremont 76.103.229.149 Jun3,2021 10:47:08 AM AccassFile ]
United Stztes Fremont 76.103.229.149 Jun3,2021 10:47:08 AM AccassFile ]
United Stztes Fremont 76.103.229.149 Jun3,2021 10:47:08 AM AccessFile hs
United States Fremont 76.103229.149 Jun2,2021 42607 PM AccessFile ]

Activity Alert Correlation

One activity may trigger multiple alerts, the multiple alerts are triggered by different policies.

For example, the Google Workspace event "Upload File" triggered 4 alerts, click on the alert button to see
Alert Overview.

Time Range: Last 24 hours @ Save Search “

User Country/Region City [ s Date s Event : A Object Triggered Alerts Actions
United States Ssunnyvale 9645345 Jun3,20217:13:54 AM Uplosd File forticasd
United States Ssunnyvale 9645345 Jun3,20217:13:53 AM Create File forticasd
United States Sunnyvale 9645349 Jun3,20217:13:51 AM DeletsFile forticasd 0
United States Sunnyvale 9645349 Jun3,20217:13:51 AM DeletsFile forticasd 0
United States Sunnyvale 9645349 Jun3,20217:13:49 AM CreateFile forticasd 0
United States Sunnyvale 9645349 Jun3,20217:13:48 AM DeleteFile forticasb 0
VIEW10 w 1-60f6 « >

The Alert Overview page shows that this activity has triggered 4 different DLP policies:

DLP USA/Germany Passport Number Policy, DLP UK Passport Number Policy, DLP Birthday Policy, and DLP
SSN Policy.

Google Workspace / Alert ASEZO

Alert Overview

B DataAnalysis © Threat Protection i= Compliance
Time Range: Last 24 hours @  Alert ID: abf2b3fb841be8bd41825422b2112¢80, 7916b... @ Save Search “
Alert Type Policy Name + Object Severity - Created * Last Updated %
> Data Analysis DLP USA/Germany Passport Number Policy Alert. | ] Jun 3,20217:37:26 AM Jun3,20217:37:26 AM
> Data Analysis DLP UK Passport Number Policy Alert. |} Jun 3,20217-37:26 AM Jun3,20217:37:26 AM
> Data Analysis DLP Birthdate Policy Alert [ | Jun 3,20217:37:26 AM Jun3,20217:37:26 AM
> Data Analysis DLP SSN Policy: Alert. | ] Jun 3,20217-37:26 AM Jun3,20217:37:26 AM
1-4of4 <

Daily cloud account activities will be compiled into Activity
I reports for export, please see Generate Activity Report on
page 299.
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Microsoft App Integration (Office 365 Accounts Only)

Microsoft App integration shows the location of the files on Microsoft Yammer or Microsoft Teams Apps.

Go to Office 365 > Activity, the App Column shows the documents currently located in Microsoft Yammer
or Microsoft Teams App.

User Country/Re...  City IP Date Event App Object Alert
. 2022/12/13,  Download Fil B DemoRDP
United States  Ashburn 44,208.39.96 L
03:10:10PM e KILL-1.txt
. 2022/12/13,  Download Fil B Openshift
United States ~ Ashburn 44.208.39.96 - .
03:10:09PM e Networking....

Microsoft App  App

Logo
Microsoft
Yammer E‘
Microsoft
Teams 6

Google Third-Party App Verification (Google Workspace Accounts Only)

The third-party apps under Google Workspace are reviewed by Google to ensure compliance with Google's
security and privacy requirements. The third-party apps that are not verified by Google are subject to
restrictions. The App column in Activity reflects the Google verification status of the third-party apps.
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Date Event * App Object Alert
2023/02/07,12:00:05
Create File 7] B empty.txt 1
PM
2023/02/07,11:57:57 ] cpfl.txt_Rename.d
Create File Unidentified @
AM ocument
2023/02/07,04:03:59 B SSN-2023-02-06T
Delete File FortiCASE ()
AM 19:50:14.248436 7 txt
2023/02/06,05:37:26 B SSN-2023-02-06T
Delete File FortiCASE (i)
PM 21:40:48.195551 7 txt

Google Third-Party App Verification Status and Description

Third-Party App

Status Description

The third-party app has Not gone through Google verification

(App Name) @ process.

The third-party app can be one of the following Apps:
Unidentified i ] Google Docs, Google Sheets, Google Slides, Google
Forms, Google Drawing, etc.

App name (icon)

with no status The third-party app is verified by Google.
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Yammer Integration

FortiCASB Yammer integration allows you to monitor and inspect all the files posted on Yammer by users
within your organization. All users within your organization that is also a Yammer user, will show as "Yammer

Licensed" on FortiCASB.

From FortiCASB control panel, go to Office 365 > Users to see the FortiCASB users that are also on Yammer,

notice that all Yammer user will have the Yammer icon E‘ under Property.

Office 365 / Users

User Overview

2 Total User 12| 2 Privileged User

Name: qa report(qga@casbaal.onmicrosoft.com) @
User Name Email

qareport ga@casbgal.onmicrosoft.com

Dormant User

Sensitive Files

61236

2. GuestUser

Files Shared with this User

15610

Files Shared by this User  Last Login

# % B SO

Property

15614  2021/07/30,10:50:12 AM w

All Yammer uploaded files by the Yammer Licensed user are able to be viewed in FortiCASB Office 365

Documents. All Yammer files can be distinguished through File Name column with E‘ icon in Office 365 >

Documents in FortiCASB.

Office 365 / Documents

File Name
unshare-anonymous-link-view/ ¢
share-group-read/ @
share-internal-user-write/ @y
share-external-user-read/ @y

share-company-link-view/ @

share-anonymous-link-view/
Yammer/ E‘ 6

vyao/

yyao/ @b

Drive Owner(Site)

ga report

gareport

qareport

ga report

gareport

qareport

Company Administrator
Company Administrator

qa report

Created Date

2021/07/27,11:29:02 AM

2021/07/27,11:28:51 AM

2021/07/27,11:28:40 AM

2021/07/27,11:28:28 AM

2021/07/27,11:28:17 AM

2021/07/27,11:28:06 AM

2021/07/27,11:27:55 AM

2021/07/27,11:27:04 AM

2021/07/27,11:26:33 AM

Last Modified

7/27/2021,11:29:02 AM

7/27/2021,11:28:51 AM

7/27/2021,11:28:40 AM

7/27/2021,11:28:28 AM

7/27/2021,11:28:17 AM

7/27/2021,11:28:06 AM

7/27/2021,11:27:55 AM

7/27/2021,11:27:04 AM

7/27/2021,11:26:33 AM

Path
cucumber/yyao/unshare-anonymous-link-view
cucumber/yyao/share-group-read
cucumber/yyao/share-internal-user-write
cucumber/yyao/share-external-user-read
cucumber/yyao/share-company-link-view
cucumber/yyao/share-anonymous-link-view
Shared Documents/Apps/Yammer

Shared Documents/cucumber/yyao

cucumber/yyao

When clicking on a Yammer uploaded file name, you can view detailed file information such as creator, created
date, last modified, date, file path, and etc.
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Prerequisites

Yammer integration in FortiCASB requires enforcing Office 365 identity in Yammer. When turning this setting
on, it may disrupt Yammer users’ access to Yammer, especially those who do not have Office 365 account,
they will be locked out of Yammer. Therefore, before making this change, please inform your Yammer users to
do the following:

« Make sure that all Yammer users have Azure AD account. You can figure out who does not have an Azure
AD account by comparing the list of users on Yammer with the list of users in Office 365. From Yammer,
go to Settings > Edit Network Settings > Export Users to export all users.

« Help the Yammer users who do not have Azure AD account to get Azure AD account before enforcing
Office 365 identity.

You need to be a global administrator on Office 365 and be synchronized to Yammer as verified
administrator to enforce Office 365 identity in Yammer.

From your Yammer account, go to Settings > Edit Network Settings > Admins to verify your Yammer
admin account is synchronized to Office 365 global administrator account. Below is a screen shot of a synced
admin in Yammer:

Admins

Current Admins

Change Status of
Microsoft 365 Admins

FortiCASB 24.3.b Admin Guide 458
Fortinet Inc.



Cloud Application Features

Enforce Office 365 Identity in Yammer

1. Log into Yammer with your Yammer admin account.
2. |If you are using the new Yammer, go to Settings > Edit Network Admin Settings in the upper right

hand side.
e " ©

Settings X

G

New Yammer D 0 ©

4

Yammer

Edit settings
I Edit network admin settings I

Themes

e m*
Office ;__ \\fj Il 275
| =W
= . N\ E

View all

If you are using the old Yammer, go to Settings > Network Admin at the upper left hand side.
3. Click Security Settings under Content and Security.
4. Scroll down to Office 365 Identity Enforcement, click on Enforce Office 365 identity checkbox.
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Users

*4 Invite Users What happens when someone tries to login to an application from outside this IP range?
~L Remove Users

P . O Allow logi

@ Account Activity LI

& Blaock Users @ Deny login (waming: this will disable the iPhone, Android and windews Phone applications for all users)
i Bulk Update Users

B Export Users External Messaging

Profile Fields @ I - . " 5
i @ Allow users in this network to participate in groups or conversations in other networks, but don't allow external users to

participate in groups or conversations in this network.
Content and Security

W Monitor Keywords O Don't allow users in this network to participate in groups or conversations in other networks, and don't allow external
users to participate in groups or conversations in this network.

= .
| B Security Settings | Office 365 Identity Enforcement

¥ Export Network Data

& Bxport User Data Whenever enfarcing Office 365 |denpty, be mindful that this setting replaces any existing Yammer S50 setup and ensures
that users log in to Yammer with their Office 365 accounts. Learn More

- Data Retention

© Content Mode Enforce Office 365 identity

Status: Committed

[ Black Office 365 users without Yammer licenses

Office 365 Connected Yammer Groups

Once your organization has committed to enforcing Office 365 identity and has one Office 365 tenant associated with a
single Yammer network, connected groups will be enabled for this network. Learn More

Status: Enabled Connected Groups are turned on for this network.

Save

5. A confirmation message will ask you to select the appropriate level of enforcement.

Select the Most Appropriate Level of Enforcement *®

Committed Enforcement

All of your Yammer users have an Azure Active Directory (AAD) account.

~ Temporary 7-Day Enforcement

You're testing the enforcement of Office 365 identity on your network.

Once you save this change, you won't be able to undo it without help from
Yammer Support, and your users won't be able to log in using their Yammer
usernames and passwords anymaore,

O Log out all users: This may interrupt the warkday! If you choose this option, all
Yammer users will have to sign themselves back in to Yammer. Here's an email
template you can use to spread word of the change before you save your
settings.

Cancel Okay

6. Select Committed Enforcement and press okay.

Note: Once you made this change, you will not be able to undo it, your users will not be able to log in with
their Yammer user accounts anymore, only Yammer users with Azure Active Directory accounts will be
able to log in to Yammer moving forward.

7. Click Save to save your settings.

8. Go back to Security Settings after at least 15 minutes, and check the status under Office 365
Connected Yammer Groups, it should be enabled.
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Office 365 ldentity Enforcement
Whenever enforcing Office 365 wentity, be mindful that this setting replaces any existing Yammer 550 setup and ensures
that users leg in to Yammer with their Office 365 accounts, Learn More

Enforce Office 365 identity

Status: Committed

Block Office 365 users without Yammer hcenses

Office 365 Connected Yammer Groups

single Yammer network. conneéctéd groups will be enabled for this network, Learn Mare

Status: Enabled Connected Growps are turned on for this network.

Yammer License Verification

After enforcing Office 365 identity on all Yammer users, you can verify the Yammer user has integrated into
FortiCASB through Microsoft Office Administrator. You must be the Office 365 global administrator in order to
verify the user license info. Follow these steps to verify the user credentials:

1. Loginto Office 365 (https://www.office.com/) as the global administrator.

2. Click on Admin to access Microsoft 365 admin center.

3. On the left control panel, expand Users and select Active Users.

4. Click on any licensed user, and the user profile will pop up.
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Display name 1 Username Licenses M@ Choose columns

aaaa b. cdefg Unlicensed
acappadonia Unlicensed
O achow-ad-admin Q Unlicensed
achow-adfs-admin : Unlicensed
Admin Unlicensed
Office 365 E1
AlvinXie : Unlicensed
auto_test : Unlicensed
bao : Unlicensed
(] | qQ Microsoft Power Automate Free | Azure Active Directary Pr

5. Inthe user profile, Select Licenses and Apps tab, and expand Apps section.

Account Devices Licenses and Apps Mail OneDrive

Select location *

United States V

Licenses (3) A

Azure Active Directory Premium P2
0 of 1 licenses available

Microsoft Power Automate Free
9999 of 10000 licenses available

Office 365 E1
0 of 10 licenses available

Apps (30) v

6. Scroll all the way down, and you will see Yammer Enterprise checkbox. The user needs to have
Yammer Enterprise checked in order to be integrated with FortiCASB.
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Project for Office (Plan E1)
Office 365 E1

SharePoint (Plan 1)
Office 365 E1

[

Skype for Business Online (Plan 2)
Office 365 E1

[

Sway
Office 365 E1

N

To-Do (Plan 1)
Office 365 E1

[

Whiteboard (Plan 1)
Office 365 E1

N

Yammer Enterprise
Office 365 E1

[

7. Repeat step 4-6 on all Yammer users.

Yammer File Path

After Office 365 identity is enforced in Yammer, all files uploaded to Yammer will be relocated to the folder
Shared Document/Apps/Yammer/ in the user SharePoint. FortiCASB will retrieve all the files metadata
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through this file path on SharePoint. Therefore, please keep this file path without changing it to let FortiCASB
obtain file metadata in Yammer. This is the Yammer file path shown in FortiCASB.

Office 365 / Documents / Profile

Basic Detail

File Name

Creator

Created Date

21-jp-passport.pptx E‘ Q
ga@casbgal.onmicrosoft.com

2021/07/26,01:55:34 PM

Last Modified 2021/07/26,01:55:36 PM

Path Shared Documents/Apps/Yammer/2 1-jp-passport.pptx
Download Link &

Highlight B

FortiCASB 24.3.b Admin Guide
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FortiCASB APlIs

FortiCASB service endpoints supports HTTP requests through the use of REST APIs. This section contains
documentation for FortiCASB REST API service endpoints. FortiCASB provides one endpoint with single
authentication token to simplify developer experience. All the service endpoints can be accessed through a
single access/bearer token. The HTTP requests provide access to valuable FortiCASB cloud resources. All
FortiCASB REST APIs, such as Get, POST, etc. require access/bearer token in assembling HTTPS requests.

Request Authorization Methods

There are 3 methods of acquiring the access/bearer token from FortiCASB to assemble a REST API request to
access FortiCASB resources.

1. Client Credential

Client credential can be used to generate access/bearer token to form request headers. First, you will need to
log into FortiCASB and generate a FortiCASB credential, please follow the guide in Generate API Credential on
page 41. This is only a one-time process, and only one credential is necessary to generate access/bearer token.

After you have acquired a client credential, it can be used permanently to assemble the request header to
obtain an access/bearer token as long as the client credential is not revoked.

Follow the example in Get Credentials Token on page 469 to use client credential to assemble HTTPS POST
request header to acquire access/bearer token.

2. Username and Password

Another method of acquiring access/bearer token is through your FortiCASB account username and password.
Follow the example in Get Authorization Token on page 467 to assemble HTTPS POST request header to
acquire access/bearer token using your username and password.

3. Refresh Token

The use of refresh token requires one of the two methods above. Once you get the response through client
credential or username/password, you may use the refresh token in the response body to acquire more bearer
tokens without using client credential or user/name password. Follow the example in Post Refresh Token on
page 470 to generate access/bearer token using refresh token. The refresh token will expire 8 hours after
generated.
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Fabricate Request Header and Body

After acquiring access/bearer token, use the bearer token to assemble a REST API request. Like all other REST
APIT requests, FortiCASB operate through a secured channel: URI request with HTTPS protocol. The details of
the request parameters are determined by the specific REST API specification.

You may take a closer look in each REST API specification to determine what additional fields are necessary to
fulfill the request. Request body is an optional field, depending on the API specification, some parameters may
be required and others are optional.

Send Request

There are 5 request headers that are often used in FortiCASB REST API requests. The first 3 are default
request headers.

Request Header Description

Host The domain name of the REST service endpoint or the IP address

Authorization Access/bearer token generated earlier through one of the get token
methods

Content-Type This default header is set as "application/json"

Company ID The company ID of the company which the username or the credential is
originated from. Company ID can be obtained from Get Resource Map on
page 472.

Role ID Role ID is the login user ID, can be obtained through Get Resource Map on
page 472.

Business Unit ID Business unit ID is the ID of the business unit which the user is entitled to

access. Business unit ID can be obtained through . Alternatively, it can also
be obtained from the REST API Get Resource Map on page 472

When you have assembled the request header and body, the request is ready to be sent to the REST endpoint.
Here is a GET request example in HTTPS:

GET /api/vl/country/list? HTTP/1.1

Host: www.forticasb.com

Authorization: Bearer
eyJ0eXAi01iJKV1IQiLCIhbGciOiJIUZzI1INiJ9.eyJzY29wZSI6IkFQSSIsImlzcyI6ImZhdXRoLXN1cnZlc
1IsImhvc3Qi0lsiRkNXUCJALCJ1eHAIOFEIODYSMTUXN]QsImFpZCI6InFhImNhc2IxQGAtYWlsImNvbSJ
9.Hh2yVHEEd73BJ31rEjB2C-iclodmMigEPIwtuRwCObo

Content-Type: application/json
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REST API Response

After you sent the request to FortiCASB service endpoint, you will receive a response header and a response
body. The above request calls for the list of countries, and here is a part of the response in JSON format:

"id" : "US" ,
"country":"United States of America"

API Throttling

API throttling refers to the limit that FortiCASB sets on the number of requests in a range of time to prevent the
application sending too many requests. The API throttling of FortiCASB is 100TPM (times per minute),
meaning there can have 100 requests in one minute.

Get Authorization Token

Description
Get FortiCASB access token by the FortiCASB username and password.
URL

lapil/v1/auth/token
Method: POST

Request Header

Key Value Type Description
Content-Type application/x-www-form-urlencoded String
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Request Body Parameters

Name Required Value Description

grant_type Required password

username Required <username> FortiCASB account user name
password Required <password> FortiCASB account password

Sample Request

Request URL POST https://www.forticasb.com/api/vl/auth/token

Request Header Content-Type: application/x-www-form-urlencoded
Request Body grant_type: password

username: XXXXXXXXXX
password: XXXXXXXXXX

Response Variables

Name Type Description

access_token String Access token returned

refresh_token String Refresh token returned

token_type String Type of token

expires String Timestamp of when the token will expire

Sample Response

—_

"token type": "bearer",

"expires": 1.585002117836E12,

"access_token":
"eyJ0eXAi01JKV1IQiLCIhbGciOiJIUzIINiJS.eyJzY29wZSI6IkFQSSIsImlzcyI6ImZhdXRoLXN1c
nzlciIsImhvc3Qi0lsiRkNXUCJALCI1leHAIOjE1ODUWMDIXMTcs ImFpZCI6InFhImNhc2IxQGdtYWls
LmNvbSJ9 . TFfhF3jRDnoj1W96gFOuMnxvAhdwU55IQd06tpkOpHO",

"refresh token": "I4WnuRUYOxHEsoNMDvmurqg
J45VHyuxa4DRWgbmevl1YB1YT1yL2TUAASVRRNNYOyySRWEWw62j0cAM8yxadB5kU8CGbTrty2kgSD7nf
bmYEaPNQIBIi5Mv7jq0fHkn0Z2-5243CwISyWF3pfGygvYogqaL0 YC5np5AKSPP3S49KhA"

—
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Get Credentials Token

Description

Get the FortiCASB OAuth 2.0 bearer token by the credentials generated on FortiCASB. Before using this API,
first generate a credential on FortiCASB through Generate API Credential on page 41.

URL

lapi/v1/auth/credentials/token/

Method: POST

Request Headers

Key Value Type Description
Authorization Basic <FortiCASB credentials> String Authorization credential

generated by FortiCASB
Content-Type application/x-www-form-urlencoded String

Request Body Parameters

Name Required Value Description
grant_ Required client_credentials
type

Sample Request

Request URL POST https://www.forticasb.com/api/vl/auth/credentials/token/

Request Header Authorization: Basic aleddbf4-6840-4bb7-9789-acffd4ffac02
Content-Type: application/x-www-form-urlencoded

Request Body grant_type=client credentials

Response Variables

Name Type Description
access_token String Access token returned
refresh_token String Refresh token returned
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Name Type Description
token_type String Type of token
expires String Timestamp of when the token will expire

Sample Response

{

"token type": "bearer",

"expires": 1.585248581336E12,

"access token":
"eyJ0eXAi0iJKV1IQiLCJIhbGciOiJIUzIINiJ9.eyJzY29wZSI6IkFQSSIsImlzcyI6ImZhdXRoLXN1c
nZ1lciIsImhvc3QiOlsiRkNBUOIiXSwiZXhwIjoxNTglMjQ4NTgxLCIThaWQiOiJxYS5]YXNiMUBnbWEp
bC53b201£Q.PVEdrQ7NJYdYTuOPmIQNNUJITWG3ZmW-1iw2ux 8LLCM",

"refresh token": "I4WnuRUYOxHEsoNMDvmuronKCCut-
9FKHZOT4Pfuancwh46UUz51rXDK98bRmMDKREAg05VOmjbN8zrcvsyatl9DvuuSOBfhQ4Kztmwu5Vrho
M13tpglU feWjs866PcMix9BUO2DYRzLXWucyjiyyT7uHZMwakKhpsOvbiWm9gzg3XpCej—
yeX7ze0TNrWSG3WLh5n5sydUSNMNI Stt-WycO05Z2QLAFvRmgjnl-8HzO0"

Post Refresh Token

Description

Get refresh token uses the short-lived refresh token from past access token requests (Get Authorization
Token or Get Credentials Token) without having to use credentials or username/password.

URL

lapi/v1/auth/token/refresh

Method: POST

Request Header

Key Value Type Description
Content-Type application/x-www-form- String
urlencoded
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Request Body Parameters

Name Required Value Description
grant_type Required  refresh_token

refresh_token Required  <Refresh Token> Refresh
token
generated
from the past
Get
Authorization
Token and
Get
Credentials
Token
request
responses.

Sample Request

Request POST https://www.forticasb.com/api/vl/auth/token/refresh
URL

Request Content-Type: application/x-www-form-urlencoded
Header

Request grant type: refresh token
Body refresh token: 27j0cAM8yxadB5kU8GbTrty2kgSD7nfbmYEaPNQ

Response Variables

Name Type Description
access_token String Access token returned
token_type String Type of token

expires String Timestamp of when the

token will expire

Sample Response

{
"token type": "bearer",
"expires": 1.585002361532E12,
"access_token":
"eyJ0eXAi01JKV1IQiLCIhbGciOiJIUzIINiJS.eyJzY29wZSI6IkFQSSIsImlzcyI6ImZhdXRoLXN1c
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nZlciIsImhvc3Q0i01siRkNXUCJALCJ1leHAiOjE1ODUWMDIZNJEsImFpZCI6InFhLmNhc2IxQGdtYWls
LmNvbSJ9.Y7RGkrRnohvigqCbPFILGNchYGMiEIK2W1jPgSbffskO"

—

Get Resource Map

Description

Get the user and account basic information from FortiCASB, including the company ID, role ID, user name,
bushiness unit IDs, etc.

Company ID (companylD), role ID (roleld), and business unit ID (buld) are the response variables that you
will need to call many other FortiCASB REST APIs.

URL

lapilv1/resourceURLMap
Method: GET

Request Headers

Key Value Type Description

Authorization Bearer <Authorization String  Authorization credential generated by FortiCASB
Token>

Content-Type application/json String

Sample Request

Request URL GET https://lwww.forticasb.com/api/v1/resourceURLMap

Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json

Response Variables

Name Type Description
resourceURL String API request endpoint
roleld Long Login user identity
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Name Type Description

username String Login user name

buMapSet.companyld Long Company ID (companyld) of which the business unit is
under.

buMapSet.buld Long Business unit ID (buld) of which the user account is under.

buMapSet.buName String Business unit name

Sample Response

[

"resourceURL":"https://qgal.staging.forticasb.com",
"roleId":1,
"username":"casb gacasbl",
"buMapSet": [
{
"buName" :"research authentication",
"companyId":6,
"buld":238187

"buName":"aaa",
"companyId":6,
"buld":6384

Post Alert List

Description

Get cloud service account alert details.
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URL

lapilv1/alert/list

Request Method: Post

Request Headers

Key Value

Authorization Bearer
<Authorization
Token>

Content-Type application/json

companyid <Company ID>

roleld <User ID>

buld <Business Unit

ID>

Request Body Parameters

Name

service

startTime

endTime

skip

limit

user

policy

FortiCASB 24.3.b Admin Guide
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Required

<Cloud Service>

Required

Required

Required

Required

Optional
Optional

Type
String

String

Integer

Integer

Long

Type
String

long

long

integer

integer

List<String>

List<String>

Description

Authorization credential generated by
FortiCASB

Company ID of which the business unit is
under, can be obtained through Get Resource
Map on page 472.

Login user ID, can be obtained through Get
Resource Map on page 472.

The targeted business unit ID on FortiCASB.
Business unit ID can be obtained through .
Alternatively, it can also be obtained from the
REST API Get Resource Map on page 472

Description

Cloud service name such as
Salesforce, Office365, etc.

Timestamp, filter to get open alert
time after start date

Timestamp, filter to get open alert
time before start date

Indexes in a result set. Used to
exclude response from the first N
items of a resource collection.

Maximum number of return items
Filter to search user email

Filter to search alert id
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Name
activity
objectidList
objectName
severity
status
idList
alertType
countryList

asc

desc

Sample Request

Request URL

Request Header

FortiCASB 24.3.b Admin Guide
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Required Type Description

Optional List<String> Filter to search alert by activities
Optional List<String> Filter to search alert by object identity
Optional String Filter to search alert by object name
Optional List<String> Filter to search alert by severity
Optional List<String> Filter to search by status

Optional List<String> Filter to search alert by alert IDs
Optional List<String> Filter to search alert by alert types
Optional List<String> Filter to search alert by countries
Optional String Sort and display all alerts by

ascending order. The optional string
parameters provide sort options:
"policyName": sort by the policy
names that triggered the alert.
"severity": sort by the severity levels
of the alert.

"createTimestamp": sort by the alert
creation time.

"timestamp": sort by the last updated
alerts.

Optional String Sort and display all alerts by
descending order. The optional string
parameters provide sort options:
"policyName": sort by the policy
names that triggered the alert.
"severity": sort by the severity levels
of the alert.

"createTimestamp": sort by the alert
creation time.

"timestamp": sort by the last updated
alerts.

POST https://www.forticasb.com/api/vl/alert/list

Authorization: Bearer <Authorization Token>
Content-Type: application/json

buid: 6384

service: Salesforce

rolelId:36241

companyId: 62598
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Request Body

Response Variables

Name

buld
companyld
id

object
objectType
objectid
severity

serviceld

FortiCASB 24.3.b Admin Guide
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Type
Long

String
String
String
String
String
String
String

"service":"Salesforce",
"startTime" :1583792777000,
"endTime":1583879177000,
Wil g Wi

"user": [

}I

"policy": [

JI

"activity": [

JI

"objectid": [

1,

"severity": [

}I

"status": [

JI

"city": [

JI

"idList": [

1,

"alertType": [

}I

"asc":"severity",
"desc":"",

"end dt":"2020-03-10T15:26:17-0700",
"start dt":"2020-03-09T15:26:17-0700",
"id list": [

1,

"skip":0,

"limit":20

Description
Business ID
Company ID
Alert ID

Object name that triggered the alert

Object type of alert
Object id that triggered the alert
Severity of the alert

ID to distinguish different account of the cloud service
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Name Type Description

violationActivity String Activity violation that triggered alert
displayOperation String Operation that triggered alert

createTime long Timestamp of when the alert is created in UTC
updateTime long Timestamp of when the alert is updated in UTC
policyName String Violation policy name

policyld String Name of the policy that alert is triggered by
policyCode String ID of the policy that alert is triggered by
contextName String Context name of violation policy

userld String ID of the user who trigger the alert

eventld String ID of the event

eventldList Array List id of the events

service Application Cloud service

resultDesc String Description for violation context
geolLocationList Array Place where the activity occurred.

alertType String Classification of the alert

alertSubType String Sub classification of the alert

defineType String Type of policy, predefined or customized

state String Alert state

totalPage long Total page of alert results

skip integer Indexes in a result set. Used to exclude a response from

the first N items of a resource collection.

limit integer Maximum number of return alerts in one page
totalCount integer Total number of activities on file

user String The registered user name of FCASB
userName String The registered user email of FCASB

Sample Response

"data": [

{
"buld":6384,
"companyId":"6",
"timestampUUID":"203A8gR797nn390d6CQhOH6D] rdiGx9A",
"id":"203A8gR797nn390d6COhOH6D] rdiGx9A",
"objectType":"USER",
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"objectId":"0050P000006d7J10ATI",
"user":"0050P000006d7J1QAT",
"userName" :"0050P000006d7J1QAI",
"severity":"Alert",
"applicationId":"00DOPO00000Db1XUAS",

"violationActivity":"SALESFORCE MODIFY PERMISSION SET",

"displayOperation":"Modify Permission Set",

"createTime":1583830347799,

"updateTime":1583830347000,

"policyName":"Restricted User",

"policyId":"16615",

"policyCode":"FC-ACT-010",

"contextName" :"Restricted User",

"userId":"0050P000006d7J1QAT",

"eventId":"203A8hk004-akeXpvvQdWBzRhXAwDyJw",

"eventIdList": [

"203A8hk004-akeXpvvQdWBzRhXAwWDyJw"

]I

"service":"Salesforce",

"resultDesc":"hit the rule: all user include and all
include",

"matches":0,

"geoLocationList": [

1,

"alertType":"Threat protection",

"defineType":"Predefined",

"state":"Open"

"buId":6384,

"companyId":"6",

"timestampUUID" :"203A8gR796Xvf-yGgqIQvSPwS7831UnKA",
"id":"203A8qR796XvE-yGqIQvSPwS7831UnKA",
"objectType":"USER",
"objectId":"0050P000006d7J1QATI",
"user":"0050P000006d7J1QAI",

"userName" :"0050P000006d7J1QATI",
"severity":"Alert",
"applicationId":"00DOP0O00000Db1XUAS",

event

"violationActivity":"SALESFORCE MODIFY PERMISSION SET",

"displayOperation":"Modify Permission Set",

"createTime" :1583830347798,

"updateTime":1583830347000,

"policyName":"Restricted User",

"policyId":"16615",

"policyCode":"FC-ACT-010",

"contextName":"Restricted User",

"userId":"0050P000006d7J1QAT",

"eventId":"203A8hk003U7DBS8g5ScusgpxwM TUTw",

"eventIdList": [

"203A8hk003U7DBS8g5ScuSgpxwM TUTw"

] r

"service":"Salesforce",

"resultDesc":"hit the rule: all user include and all
include",

"matches":0,

"geoLocationList": [
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1,

by

1,

"alertType":"Threat protection",
"defineType":"Predefined",
"state":"Open"

"buld":6384,
"companyId":"6",

"timestampUUID" :"203A8gR661F8irdySGQZ2gT5Bx0k3plg",

"id":"203A8gR661F8irdySGQZ2gT5Bx0k3plg",
"objectType":"USER",
"objectId":"0050P000006d7J10AI",
"user":"0050P000006d7J1QAI",

"userName" :"0050P000006d7J1QAT",
"severity":"Alert",
"applicationId":"00DOP0O00000Db1XUAS",

"violationActivity":"SALESFORCE MODIFY PERMISSION SET",

"displayOperation":"Modify Permission Set",
"createTime":1583830347664,

"updateTime" :1583830347000,
"policyName":"Restricted User",
"policyId":"16615",
"policyCode":"FC-ACT-010",
"contextName":"Restricted User",
"userId":"0050P000006d7J1QAI",
"eventId":"203A8hk002J2FkUSUIQ]jaCHtr9UDBLXQ",
"eventIdList": [
"203A8hk002J2FkUSUIQjaCHtr9UDBLXQ"

]I

"service":"Salesforce",

"resultDesc":"hit the rule: all user include and all event

include",
"matches":0,
"geoLocationList": [
]I
"alertType":"Threat protection",
"defineType":"Predefined",
"state" :"Open"

"totalPage":0,
"limit":20,
"skip":0,
"totalCount":6

Get Business Unit Info

Description

Get details of the business unit.
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URL

lapil/v1/businessUnit/info

Method: Get

Request Headers

Key Value Type Description

Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>

Content-Type application/json String

buld <Business Unit ID> Long The targeted business unit ID on FortiCASB.

Business unit ID can be obtained through .
Alternatively, it can also be obtained from the
REST API Get Resource Map on page 472

companyld <Company ID> Integer  Company ID of which the business unit is under, can
be obtained through Get Resource Map on page
472.

roleld <User ID> Integer  Login user ID, can be obtained through Get

Resource Map on page 472.

Sample Request

Request URL GET https://www.forticasb.com/api/v1/businessUnit/info
Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
buid: 6384

companyId: 62598
roleId: 36241

Response Variables

Name Required Type Description
companyld Required Long Company ID
companyName Required String The registered parent

company name in FortiCASB
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Name Required Type Description

buld Required Long Business unit ID
displayName Required String Business unit display name
region Required String Registered region
companyEmail Optional String Registered email

primary Optional Boolean Is primary or not

users Optional long Number of users

Sample Response

{
"companyId":6,
"companyName":"ga",
"buId":6384,
"displayName":"aaa",
"region":"global",
"companyEmail":"",
"primary":false,
"users":0

Get Country List

Description

Get a list of all countries.

URL

lapilv1/country/list
Method: GET

Request Headers

Key Value Type Description
Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>
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Key Value Type Description

Content-Type application/json String

companyld <Company ID> Integer  Company ID of which the business unit is under, can
be obtained through Get Resource Map on page
472.

roleld <User ID> Integer  Login user ID, can be obtained through Get

Sample Request

Request URL

Request Header

Response Variables

Name Type
id String
country String

Sample Response

[

by

"id" : "AU" ,
"country":"Australia"

"id" g "CN" ,
"country":"China"

"id" : "DE",
"country":"Germany"

"id" g "ES"’
"country":"Spain"

"id" : "JP",
"country":"Japan"

FortiCASB 24.3.b Admin Guide
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Resource Map on page 472.

GET https://www.forticasb.com/api/v1/country/list

Authorization: Bearer <Authorization Token>
Content-Type: application/json

roleld: 36241

companyId: 62598

Description
The country code, represents "Country" for filtering alerts

The country name, represent "Country Name" for filtering alerts
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"id" g "US",
"country":"United States of America"

by

Post Dashboard Risk

Description

Get all risk trend data of all monitoring accounts in the business unit.

URL

lapil/v1/dashboard/risk

Method: Post

Request Headers

Key Value Type
Authorization Bearer String
<Authorization
Token>
Content-Type application/json String
buld <Account Number> Long
timeZone <Time Zone> String
companyld <Company ID> Integer
roleld <User ID> Integer

FortiCASB 24.3.b Admin Guide
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Description

Authorization credential generated by FortiCASB

The targeted business unit ID on FortiCASB.
Business unit ID can be obtained through .
Alternatively, it can also be obtained from the
REST API Get Resource Map on page 472

Numeric representation of time zone of the user, ex.
+0800

Company ID of which the business unit is under, can
be obtained through Get Resource Map on page
472.

Login user ID, can be obtained through Get
Resource Map on page 472.

483



FortiCASB APIs

Request Body Parameters

Name Required Type Description

startTime Required long Timestamp, starting time of filtered
open alerts

endTime Required long Timestamp, ending time of filtered
open alerts

Sample Request

Request URL POST https://www.forticasb.com/api/v1/dashboard/risk

Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
roleld: 36241
companyId: 62598
buid: 6384
timezone: -0700

Request Body {
"startTime":1585518361548,
"endTime":1585604761548

Response Variables

name String Cloud service name

id String Risk sequence number

key String The time that the risk was detected
value long The risk number on this date

Sample Response

{
"data": [
{
"name" : "Box",
"values": [
{
"id":"o",
"key":"2020-03-10T18:00:00+0000",
"value":0
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by
{
"id"."1",
"key":"2020-03-10T18:30:00+0000",
"value":0
}
1
}!
{

"name":"Salesforce",
"values": [

{
"id":"0o",
"key":"2020-03-10T18:00:00+0000",
"value":0
}I
{
W@l g Wiw
"key":"2020-03-10T18:30:00+0000",
"value":0
}
]
}I
{

"name" : "Dropbox",
"values": [

{
"id":"o",
"key":"2020-03-10T18:00:00+0000",
"value":0
}!
{
"igdT."1i",
"key":"2020-03-10T18:30:00+0000",
"value":0
}
]
}I
{

"name" :"Google",
"values": [

{
"id":"o",
"key":"2020-03-10T18:00:00+0000",
"value":0
}I
{
"idm.min,
"key":"2020-03-10T18:30:00+0000",
"value":0
}
]
}I
{

"name":"Office365",
"values": [

{
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"id":"o",
"key":"2020-03-10T18:00:00+0000",
"value":0

}I

{
"ig"."1",
"key":"2020-03-10T18:30:00+0000",
"value":0

Post Dashboard Statistics

Description

Get crucial statistics data from the cloud service in the business unit.

URL

lapi/v1l/dashboard/statistics

Method: POST

Request Headers

Key Value Type
Authorization Bearer String
<Authorization
Token>
Content-Type application/json String
buld <Business unit ID>  Long
timeZone <Time Zone> String
service <Salesforce> String

FortiCASB 24.3.b Admin Guide
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Description

Authorization credential generated by FortiCASB

The targeted business unit ID on FortiCASB.
Business unit ID can be obtained through .
Alternatively, it can also be obtained from the
REST API Get Resource Map on page 472

Numeric representation of time zone of the user, ex.

+0800.

Cloud service account
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Key Value Type Description

companyld <Company ID> Integer Company ID of which the business unit is under, can
be obtained through Get Resource Map on page
472.

roleld <User ID> Integer Login user ID, can be obtained through Get

Resource Map on page 472.

Request Body Parameters

Name Type Description
startTime long Timestamp, starting time of filtered open alerts
endTime long Timestamp, ending time of filtered open alerts

Sample Request

Request URL POST https://www.forticasb.com/api/vl/dashboard/statistics

Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
timeZone: +0800
Service: Salesforce
buid: 6384
roleld: 36241
companyId: 62598

Request Body {
"startTime" :1583865778729,

"endTime" :1583952178729

Response Variables

Name Type Description

topRiskUsers List Top risk users in a time period
topRiskObjects List Top risk objects in a time period
topHitPolicies List Top hit policies in a time period
topRiskEventType List Top risk event type in a time period
topRiskPositions List Top risk positions in a time period
topActivityPositions List Top activity positions in a time period
alertTrend List The trend of alert in a time period
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Name Type Description

usageTrend List The trend of usage in a time period

riskSeverity List The risk severity statistics

name String Position of the alert

id String Corresponding ID number of the event, policy, risk user, risk

object, risk position

key String The event name, risk user name, policy name, activity name,
alert name, risk object name, trend time

value long The number of the statics items

Sample Response

{
"topRiskUsers": [
{
"id":"0050P000006k18GQAQ",
"key":"yue zhang",
"value":2

1,
"topRiskObjects": [
{
"id":"0690P000006mwkbQAA",
"key":"SSN2020-03-11T17:00:24.7467Z.txt",
"value" :4

by

"id":"0690P000006mwl1PQAQ",
"key":"CA Driver2020-03-

11T17:00:30.133Z.txt",
"value":4

"id":"0690P000006mwl1oQAA",
"key":"CN_ Passport2020-03-

11T17:00:32.4647.txt",
"value":4

"1d":"0690P000006mwkgQAA",
"key":"CNID2020-03-11T17:00:25.632Z.txt",
"value":3

"id":"0690P000006mwlUQAQ",
"key":"CN Driver2020-03-
11T17:00:30.566%.txt",
"value":3
}
J ’
"topHitPolicies": [
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"id":"16615",
"key":"Restricted User",
"value":35

"id":"16598",
"key":"DLP UK Passport Number Policy",
"value":4

"id":"16601",

"key":"DLP USA/Germany Passport Number
Policy",

"value":4

"id":"16599",
"key":"DLP AU Passport Number Policy",
"value":3

"id":"16603",
"key":"DLP CA Driver License Policy",
"value":3
}
} ’
"topRiskEventType": [
{
"id":"202",
"key":"Upload File",
"value":76

"id":"238",
"key":"Post",
"value":4

}!

{
"idm"."214",
"key":"Login Success",
"value":2

}I

{
"id":"239",

"key":"Comment",
"value":1

}

JI

"topRiskPositions": [

{
"name" :"United States of America",
"key":"US",
"value":83

}

I

"topActivityPositions": [
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"name" :"United States of America",
"key":"US",
"value":35

}

JI

"alertTrend": [

{
"id":"o",
"key":"2020-03-10T21:00:00+0000",
"value":0

}

}I

"usageTrend": [

{
"id":"o",
"key":"2020-03-10T21:00:00+0000",
"value":0

}

JI

"riskSeverity": [

{
WiglV g wEW,
"key":"Alert",
"value":82

"idll . "l",
"key":"Critical",
"value":1

Get Dashboard Summary

Description

Get dashboard summary.
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URL

lapilvil/dashboard/summary

Method: Get

Request Headers

Key Value Type Description

Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>

Content-Type application/json  String

buld <Business Unit Long The targeted business unit ID on FortiCASB.
ID> Business unit ID can be obtained through .

Alternatively, it can also be obtained from the
REST API Get Resource Map on page 472

companyld <Company ID> Integer Company ID of which the business unit is under,
can be obtained through Get Resource Map on
page 472.

roleld <User ID> Integer Login user ID, can be obtained through Get

Resource Map on page 472.

Sample Request

Request URL GET https://www.forticasb.com/api/vl/dashboard/summary

Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
companyId: 6
buid: 6384
companyId: 62598
roleld: 36241

Response Variables

Name Type Description
loginUser String The login user e-mail.
alertsCount long Number of alerts in the last 30 days
activitiesCount long Number of activities in the last 30 days
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Name Type Description

fileScannedCount long Number of files scanned in the last 30 days

Sample Response

{
"loginUser":"ga.casbl@gmail.com",
"alertsCount":3220,
"activitiesCount":9514,
"fileScannedCount":340

Post Dashboard Usage

Description

Get all activity usage trend data of all the monitoring cloud accounts in the business unit.

URL

lapilvi/dashboard/usage
Method: Post

Request Headers

Key Value Type Description

Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>

Content-Type application/json String

buld <Business Unit ID> Long The targeted business unit ID on FortiCASB.

Business unit ID can be obtained through .
Alternatively, it can also be obtained from the
REST API Get Resource Map on page 472

timeZone <Time Zone> String Numeric representation of time zone of the user, ex.
+0800.
companyld <Company ID> Integer Company ID of which the business unit is under, can

be obtained through Get Resource Map on page
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Key Value Type Description
472.
roleld <User ID> Integer Login user ID, can be obtained through Get

Resource Map on page 472.

Request Body Parameters

Name Type Description
startTime long Timestamp, starting time of filtered open alerts
endTime long Timestamp, ending time of filtered open alerts

Sample Request

Request URL POST https://www.forticasb.com/api/vl/dashboard/usage

Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
timeZone: +0800
buid: 6384
roleId: 36241
companyId: 62598

Request Body {
"startTime":1583865778729,
"endTime":1583952178729

Response Variables

Name Type Description

name String Cloud service name

id String Usage sequence number

key String The time that the usage was detected
value long The usage number at the date

Sample Response

{

"data": [
{
"name": "Box",
"values": [
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{
Wigg WEWw,
"key": "2020-03-10T18:30:00+0000",
"value": O
}
]
}I
{

"name": "Salesforce",
"values": [

{
"id": "0o",
"key": "2020-03-10T18:30:00+0000",
"value": O
}
1
by
{

"name": "Dropbox",
"values": |

{
"id": "o",
"key": "2020-03-10T18:30:00+0000",
"value": O
}
1
}I
{

"name": "Google",
"values": [

{
"id": "O",
"key": "2020-03-10T18:30:00+0000",
"value": O
}
]
}I
{

"name": "Office365",
"values": [

{
Wigmg WEWw,
"key": "2020-03-10T18:30:00+0000",
"value": O
}
]
}
1
}
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Get Event

Description

Get activity events definition from FortiCASB.

URL

lapilv1/event

Method: Get

Request Headers

Key Value
Authorization Bearer
<Authorization
Token>
Content-Type application/json
service <Cloud Service>
companyid <Company ID>

roleld <User ID>

Sample Request

Request URL

Request Header
service:

Content-Type:
roleId: 36241
companyId:

FortiCASB 24.3.b Admin Guide
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Description

Authorization credential generated by FortiCASB

Cloud service name such as Salesforce, Office365,
etc.

Company ID of which the business unit is under, can
be obtained through Get Resource Map on page
472.

Login user ID, can be obtained through Get
Resource Map on page 472.

GET https://www.forticasb.com/api/v1/event

Authorization: Bearer <Authorization Token>
Salesforce
application/json
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Response Variables

Name Type
id integer
name String
nameEnum OperationNameEnum
value String
category String
searchField String
Sample Response
[
{
"id":202,

b

"name" :"Upload File",
"nameEnum" : "UPLOAD FILE",
"value":"202",
"category":"FILE",
"searchField":"activity"

"id":203,

"name" :"Download File",
"nameEnum" : "DOWNLOAD FILE",
"value":"203",
"category":"FILE",
"searchField":"activity"

"id":206,

"name" :"Upload New Version",
"nameEnum" : "UPLOAD NEW VERSION",
"value":"206",
"category":"FILE",
"searchField":"activity"

FortiCASB 24.3.b Admin Guide
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Description

The activity id, represents "Activity ID" for
filtering alerts and activity

Name of the activity operation, represents
"Activity Name" for filtering alerts and activity

The activity operation type, represents
"Activity" enum for filtering alerts and activity

The activity ID, represents "Activity" for
filtering alerts and activity

The category of activity, represents "Activity
Category" for filtering alerts and activity

The search field of the filter
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Get Filter List

Description

Get all users created filter lists in the specific cloud service under the targeted business unit.

URL

lapilviffilter/list

Method: Get

Request Headers

Key Value Type Description
Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>
Content-Type application/json String
buld <Business Unit ID> Long The targeted business unit ID on FortiCASB.
Business unit ID can be obtained through .
Alternatively, it can also be obtained from the
REST API Get Resource Map on page 472
service <Cloud Service String Cloud service name such as Salesforce, Office365,
Name> etc.
companyld <Company ID> Integer  Company ID of which the business unit is under, can
be obtained through Get Resource Map on page
472.
roleld <User ID> Integer  Login user ID, can be obtained through Get

Resource Map on page 472.

Sample Request

Request URL

Request Header

FortiCASB 24.3.b Admin Guide
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GET https://www.forticasb.com/api/v1/filter/list

Authorization: Bearer <Authorization Token>

Content-Type: application/json
buid: 6384

service: Office365

roleId: 36241

companyId: 62598
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Response Variables

Name Type Description

id Integer The serial number

name String The filter name that user created
filter String The filter that the user saved
source String The filter source page

Sample Response

"id":36156,

"name":"casb test",

"filter":"{\"selectPolicyObject\":[],\"selectFileTypeObject\":
[1,\"selectShareTypeObject\":[],\"selectSensitiveDataObject\":
[1,\"selectOwnerObject\":[], \"selectShareToInternalObject\":
[1,\"selectShareToGuestObject\":[], \"selectUserObject\":
[1,\"selectSharedUserObject\":[],\"selectActivityObject\":
[{\"id\":2,\"name\":\"Upload
File\",\"category\":\"FILE\"}], \"selectSeverityObject\":
[1,\"selectAlertTypeObject\":[],\"selectStatusObject\":
[1,\"selectCountryObject\":[],\"ipList\":[], \"selectAuditOperateObject\":
[1,\"selectAuditModuleObject\":[], \"selectAuditVendorObject\":
[1,\"isShare\":false,\"isLink\":false, \"isNewFinding\":false,\"isViolation\":
false,\"isSuccess\":null,\"object\":\"\",\"selectedHistoryPeriod\":
{\"time\":\"Last 24 hours\",\"displayTime\":\"Last 24
hours\"}, \"selectedPeriod\": {\"start dt\":\"2020-03-10T23:38:45.069Z\",\"end_
dt\":\"2020-03-11T23:38:45.069Z\",\"value\": {\"time\":\"Last 24
hours\",\"displayTime\":\"Last 24 hours\"}}}",

"source":"alert"

Get Service History

Description

Get cloud service OAuth history of the business unit.

FortiCASB 24.3.b Admin Guide 498

Fortinet Inc.



FortiCASB APIs

URL

lapilvi1/service/history/{application}

Method: GET

Request Headers

Key Value Type Description

Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>

Content-Type application/json String

buld <Business Unit Long The targeted business unit ID on FortiCASB. Business unit
ID> ID can be obtained through . Alternatively, it can also be
obtained from the REST API Get Resource Map on page
472
application <Cloud Service String Cloud service application name such as Salesforce,
application> Office365, etc.
companyld <Company ID> Integer  Company ID of which the business unit is under, can be

obtained through Get Resource Map on page 472.

roleld <User ID> Integer  Login user ID, can be obtained through Get Resource Map
on page 472.

Sample Request

Request URL GET https://www.forticasb.com/api/v1/service/history/Salesforce
Request Header Authorization: Bearer <Authorization Token>

Content-Type: application/json

buid: 6384

companyId: 62598
roleId: 36241

Response Variables

Name Required Type Description

id Required long The OAuth history ID

buld Required Long Business unit ID

application Required String Cloud service application name
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Name Required

scanld

Optional

actionStatusCode Optional
message Optional
date Optional
lastStep Optional
casbUser Optional
cloudUser Optional

Sample Response

"id":31289,

Type
String

String

String

long

String
String

String

"scanId":"SALESFORCEVb-gvLgmSLCWw8U BShevw",

"buld":6384,
"application":"SALESFORCE",
"actionStatusCode":"Success",
"message":"",
"date":1583432356528,
"lastStep":"Update OAuth Data",
"casbUser":"ga.casbl@gmail.com",
"cloudUser":"yuezhang@yue.com"

"id":31267,

"scanId":"SALESFORCEVb-gvLgmSLCWw8U BShovw",

"buId":6384,
"application":"SALESFORCE",
"actionStatusCode":"Success",
"message":"",

"date":1583378643280,
"lastStep":"Update OAuth Data",
"casbUser":"ga.casbl@gmail.com",
"cloudUser" :"mhuang@fortinet-uk.com"

"id":24433,

"scanId":"SALESFORCEVb-gvLgmSLCWw8U BShevw",

"buld":6384,
"application":"SALESFORCE",

FortiCASB 24.3.b Admin Guide
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Description

Application name + company
name

The user name that is
registered with this cloud
service

The returned message of cloud
service status history

Timestamp, the time that
processed this step

The last process step

The user email that is used in
FortiCASB

The user name that is
registered in this cloud service
account
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"actionStatusCode":"Success",
"message":"",
"date":1582918837831,
"lastStep":"Update OAuth Data",
"casbUser":"ga.casbl@gmail.com",
"cloudUser":"yuezhang@yue.com"

"id":16572,
"scanId":"SALESFORCEVb-gvLgmSLCWw8U BShevw",
"buld":6384,

"application":"SALESFORCE",
"actionStatusCode" :"Success",

"message":"",

"date":1582585855516,

"lastStep":"Save OAuth Data",
"casbUser":"ga.casbl@gmail.com",

"cloudUser" :"mh20170918@126.com"

Get Application Status

Description

Get the cloud service information and authentication status under the same business unit.

URL

lapilv1/application/status
Method: Get

Request Headers

Key Value Type Description
Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>
Content-Type application/json String
FortiCASB 24.3.b Admin Guide 501

Fortinet Inc.



FortiCASB APIs

Key Value Type
buld <Business Unit ID> Long
companyld <Company ID> Integer
roleld <User ID> Integer

Sample Request

Request URL

Request Header

Response Variables

Name

service

applicationid

applicationStatus

cloudAccount

FortiCASB 24.3.b Admin Guide
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Description

The targeted business unit ID on FortiCASB.
Business unit ID can be obtained through .
Alternatively, it can also be obtained from the
REST API Get Resource Map on page 472

Company ID of which the business unit is under, can
be obtained through Get Resource Map on page

472.

Login user ID, can be obtained through Get

Resource Map on page 472.

GET https://www.forticasb.com/api/v1/application/status

Authorization: Bearer <Authorization Token>
Content-Type: application/json

rolelId: 36241

companyId: 62598

buid: 84

Required

Required

Required

Required

Required

Type
String

String

int

String

Description

Cloud
service
account
such as
"Salesforce",
"Office365",
etc.

The id of the
cloud service
account.

The
onboarding
status of the
cloud service
account.

Cloud
service
account
username.
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Sample Response

"companyId": 62598,

"buld": 84,

"service": "AWSS3",
"applicationId": "239187241191",
"update": false,

"enable": true,
"applicationStatus": "RUNNING",
"lastUpdate": 1680311539918,
"cloudAccount": "239187241191"

"companyId": 62598,

"buld": 84,

"service": "SAPSuccessFactors",
"applicationId": "SFCPART000289",
"update": false,

"enable": true,
"applicationStatus": "RUNNING",
"lastUpdate": 1705083754298,
"cloudAccount": "sfadmin"

"companyId": 62598,
"buld": 84,
"service": "CitrixShareFile",

"applicationId": "a4205de9-cab5b-8c96-4cb3-802ffe209b84",

"update": true,

"enable": true,

"applicationStatus": "RUNNING",
"lastUpdate": 1705070917370,
"cloudAccount": "testadminl@forticasb.com"

Get Severity

Description

Get all alert severity definitions from FortiCASB.

FortiCASB 24.3.b Admin Guide
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URL

lapilv1/severity

Method: GET

Request Headers

Key Value Type Description

Authorization Bearer <Authorization Token> String Authorization credential
generated by FortiCASB

Content-Type application/json String

companyld <Company ID> Integer Company ID of which the
business unit is under, can be
obtained through Get
Resource Map on page 472.

roleld <User ID> Integer Login user ID, can be obtained
through Get Resource Map on
page 472.

Sample Request

Request URL GET https://www.forticasb.com/api/v1/severity

Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
roleId: 36241
companyId: 62598

Response Variables

Name Type Description

id String The severity code, represents "Severity" code filter in filtering alerts

name String The severity name, represents "Severity" name filter for filtering
alerts

Sample Response

[

n"idn: |l1ll,

FortiCASB 24.3.b Admin Guide
Fortinet Inc.

504



FortiCASB APIs

"name":"Critical"

"id" : "2",
"name":"Alert"

"idll . IV3",
"name" :"Warning"

"id" : "4",
"name" :"Information"

"idll : H5",
"name" :"Pass"

Get Status

Description

Get status definition from FortiCASB system.

URL

lapilvi1/status

Method: Get

Request Headers

Key Value Type Description
Authorization Bearer <Authorization String Authorization credential generated by
Token> FortiCASB

Content-Type application/json String

companyld <Company ID> Integer Company ID of which the business unit is
under, can be obtained through Get Resource
Map on page 472.

roleld <User ID> Integer Login user ID, can be obtained through Get

Resource Map on page 472.
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Sample Request

Request URL GET https://www.forticasb.com/api/v1/status

Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
companyId: 62598
roleId: 36241

Response Variables

Name Type Description
id String Status ID
name String Service Status

Sample Response

[

"id" : "l",
"name" : "New"

"id" : "2",
"name":"In progress"

"id" : "3",
"name" : "Resolved"

"id" : "4",
"name" :"Discard"

Get User List

Description

Get details of all users of the cloud services under the same company and business unit.
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URL

lapilv1/profile/user/list

Method: Get

Request Headers

Key Value Type Description
Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>
Content-Type application/json String
companyid <Company ID> Integer  Company ID of which the business unit is under, can
be obtained through Get Resource Map on page
472.
roleld <User ID> Integer  Login user ID, can be obtained through Get

Resource Map on page 472.

buld <Business Unit ID> Long The targeted business unit ID on FortiCASB.
Business unit ID can be obtained through .
Alternatively, it can also be obtained from the
REST API Get Resource Map on page 472

service <Cloud Service> String Name of the cloud service such as Salesforce,
Office365, etc.

skip <Skip Number> Integer Indexes in a result set. Used to exclude response
from the first N items of a resource collection.

limit <Limit per Page> Integer  Maximum number of return items per page.

Sample Request

Request URL GET https://www.forticasb.com/api/v1/profile/user/list

Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
companyId: 62598
roleId: 36241
service: Salesforce
buid: 8
companyid: 7
skip: 0
limit: 2
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Response Variables

Name Required Type Description

companyld Required String Company ID

userld Required String The user identity

origUserld Required String The original user
identity

deleted Required boolean The current user
information deleted or
not

createdDate Required long Timestamp, user

created date

service Required Application Cloud service name
isActive Required boolean User active status
buld optional Long Business unit ID
createdByld optional String The ID which created
this user
lastModifiedDate optional long Timestamp, the last

time that this user has
been modified

lastModifiedByld optional String The last user id that
modified this user
information

lastLoginDate optional long Timestamp, the last

time that this user
login into FortiCASB

systemModstamp optional long Timestamp of the
system
email optional String The email of the

registered user

userName optional String The user name of the
registered user

name optional String This user's name
firstName optional String This user's first name
lastName optional String This user's last name
userType optional UserTypeEnum User type
profileld optional String This user's profile ID
userRoleld optional String This user's role ID
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Sample Response

"companyId": "7",

"buIld": 8,

"userId": "0050P000006kOBcQAM",
"origUserId": "0050P000006kOBcQAM",
"deleted": false,

"createdDate": 1492555111000,
"createdById": "0050P000006d7J0QAI",
"lastModifiedDate": 1583370489000,
"systemModstamp": 1545262127000,

"email": "xxxxxxx@gmail.com",
"userName": "xxxxxxx@guest.hotmail.com",
"name": "forti3 net3",

"firstName": "forti3",

"lastName": "net3",

"service": "SALESFORCE",
"lastLoginDate": 1545262127000,
"userType": "CsnOnly",

"isActive": true,
"profileId": "00e0OPO00000JYKPQA4"

"companyId": "7",

"buIld": 8,

"userId": "0054U000009GCaMQAW",
"origUserId": "0054U0000009GCaMQAW",
"deleted": false,

"createdDate": 1595303943000,
"createdById": "0050P000006d7J1QAI",
"lastModifiedDate": 1595303943000,
"systemModstamp": O,

"email": "xxxxx@salesforce.com",
"userName": "xxxxxx(@00d0p000000dblxuas",
"name": "Platform Integration User",
"lastName": "Platform Integration User",
"service": "SALESFORCE",
"lastLoginDate": O,

"isActive": true,

"profileId": "00e0P000000a7HVQAY"

Get Data Security Policy List

Description

Return all FortiCASB Data Security Policies and details from Data Protection.
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URL

lapilv1/scan/policyllist

Method: Get

Request Headers

Key Value Type Description

Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>

Content-Type application/json String

buld <Business Unit Long The targeted business unit ID on FortiCASB. Business
ID> unit ID can be obtained through . Alternatively, it can also
be obtained from the REST API Get Resource Map on
page 472
companyld <Company ID> Integer Company ID of which the business unit is under, can be

obtained through Get Resource Map on page 472.

roleld <User ID> Integer Login user ID, can be obtained through Get Resource
Map on page 472.

Sample Request

Request URL GET https://lwww.forticasb.com/api/vi/scan/policy/list
Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
buid: 6384

service: Salesforce
rolelId: 36241
companyId: 62598

Response Variables

Name Type Description
name String Data Security Policy name.
category String Category of the policy
code String Policy code for identifying the policy
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Sample Response

{

"data":

{

"datas": [

{

"selectAllFileTypes": false,

"selectAllAccessPermissions": false,

"selectAllFileActivities": false,
"selectAllSaasApps": true,
"filesAddedWithin": {

"name": "ALL TIME",
"displayName": "All Time",
"code": 6

"customizedPatterns": [],
"permitQuarantine": true,
"notifyUsers": false,
"usersToNotify": [],
"notifyOwners": false,

"fazLog": false,

"startTime": O,
"changeAccessPermission": false,
"changeAccessPermissionType": O,
"writeLabels": false,

"id": 1,

"companyId": "62598",
"bizUnitId": 84,

"name": "data security test",
"predefined": false,

"enabled": true,

"lastUpdated": 1702402793153

"selectAllFileTypes": false,

"selectAllAccessPermissions": false,

"selectAllFileActivities": false,
"selectAllSaasApps": true,
"filesAddedWithin": {

"name": "ALL TIME",
"displayName": "All Time",
"code": 6

"customizedPatterns": [],
"permitQuarantine": true,
"notifyUsers": false,
"usersToNotify": [],
"notifyOwners": false,

"fazLog": false,

"startTime": O,
"changeAccessPermission": false,
"changeAccessPermissionType": O,
"writeLabels": false,

TielWg 35,

"companyId": "62598",
"bizUnitId": 84,
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"name": "Default FortiCASB Scan-All Data Protection
Policy",
"predefined": true,
"enabled": false,
"lastUpdated": 1699312350281
}
1,
"totalPage": O,
"limit": O,
"skip": O,
"totalCount": 2
}I
"code": O,
"msg": "success",
"httpCode": 200

Get Threat Protection Policy List

Description

Return all FortiCASB Threat Protection Policies and details of the specified cloud service account.

URL

lapilv1/policy/tpList
Method: Get

Request Headers

Key Value Type Description

Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>

Content-Type application/json String

buld <Business Unit Long The targeted business unit ID on FortiCASB. Business
ID> unit ID can be obtained through . Alternatively, it can also
be obtained from the REST API Get Resource Map on
page 472
service <Salesforce> String Cloud service account

FortiCASB 24.3.b Admin Guide
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Key Value Type Description

companyld <Company ID> Integer Company ID of which the business unit is under, can be
obtained through Get Resource Map on page 472.

Sample Request

Request URL GET https://www.forticasb.com/api/v1/policy/tplist
Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
buid: 6384

service: Office365
companyId: 62598

Response Variables

Name Type Description

name String Threat Protection Policy name
policyCategory String Category of the policy

policyld String Policy Id for identifying the policy

Sample Response
[

"policyId": 179,

"name": "Excessive Login Failures",

"service": "OFFICE365",

"description": "Alert when failed logins for a user exceeds
threshold",

"type": "Access",

"severity": "Alert",

"enable": true,

"threshold": 1,

"interval": 2,

"alert": true,

"lastUpdatedBy": "",

"lastUpdated": 1696375132181,

"enableWorkflow": true,

"operatorType": "trigger",
"workflowSubject": "Policy '%s' added to workflow",
"workflowMessage": "Policy '%$s' was added to your workflow. You

will be notified when the alert's status changes.",
"enableEmail": false,

"emailSubject": "%s Alert",
"emailMessage": "An event matched '%s'. Please verify sensitive
information is not exposed.",
"policyCategory": "Threat protection",
"regexPattern": ".*",
"receivers": [],
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"vi: {
"velocity": true,
"vs": O,
"vd": 0

}I

"object": {

"nameMatch": true,
"extension": true,

"contextMatch": false,

"objSize": false,
"objNum": false,
"mFile": [],

"mContext™: ".*",

"sizeThreshold": 10.0,
"zipThreshold": 0.0,

"numThreshold": 50,
"size": [],
"num" : []

by

"isSelectAllEvents": false,
"isSelectAllUsers": false,

"dataPatterns": [],

"enableActivityMatching":
"enableContentMatching":
"allDatapattern": false,
"policyCode": "FC-ACT-001",

"storageConfig": {},
"enableCreatorEmail":

Get Compliance Policy List

Description

Return all FortiCASB Compliance Policies and details of the specified cloud service account.

FortiCASB 24.3.b Admin Guide
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URL

lapilv1/policy/cList

Method: Get

Request Headers

Key Value Type Description

Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>

Content-Type application/json String

buld <Business Unit Long The targeted business unit ID on FortiCASB. Business
ID> unit ID can be obtained through . Alternatively, it can also
be obtained from the REST API Get Resource Map on
page 472
service <Salesforce> String Cloud service account
roleld <User ID> Integer Login user ID, can be obtained through Get Resource

Map on page 472.

companyld <Company ID> Integer Company ID of which the business unit is under, can be
obtained through Get Resource Map on page 472.

Sample Request

Request URL GET https://www.forticasb.com/api/v1/policy/cList
Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
buid: 6384

service: Office365
companyId: 62598
roleid: 36241

Response Variables

Name Type Description
name String Compliance Policy name
policyCategory String Category of the policy
policyld String Policy Id for identifying the policy
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Sample Response

[

"policyId": 31054,

"name": "HIPAA - Access to EPHI Data",

"service": "OFFICE365",

"description": "Track access to EPHI data",

"type": "HIPAA",

"severity": "Critical",

"enable": true,

"exposure": "",

"threshold": 30,

"interval": 60,

"alert": true,

"lastUpdatedBy": "fcasbdemo@gmail.com",

"lastUpdated": 1631078491154,

"guideline": "Audit Controls (§ 164.312 (b)) Implement procedural
mechanisms that record and examine activity in information
systems that contain or use electronic protected health
information.",

"enableWorkflow": true,

' added to workflow",

"workflowMessage": "Policy '$s' was added to your workflow. You
will be notified when the alert's status changes.",

"enableEmail": false,

"workflowSubject": "Policy '$%s
$s

"emailSubject": "%s Alert",

"emailMessage": "An event matched '%s'. Please verify sensitive
information is not exposed.",

"policyCategory": "compliance",

"regexPattern": ".*",

"receivers": |

"ggin@fortinet.com"
}I
"isSelectAllEvents": false,
"isSelectAllUsers": false,
"contentMatching": {
"enable": false,
"fileExtExclusion": false,
"fileSize": O,
"compressedFileSize": 0,
"filePaths": [
]I
"filePathsExclusion": false,
"ownersExclusion": false,
"exposureExclusion": false
}I
"enableActivityMatching": true,
"enableContentMatching": true,
"allDatapattern": false,
"policyCode": "FC-ACT-047",
"isolateMalwareFile": false,
"storageConfig": {},
"enableCreatorEmail": false

FortiCASB 24.3.b Admin Guide

Fortinet Inc.

516



FortiCASB APIs

Post Document Profile Summary

Description

Return all document profile summaries of the specified cloud service account.

URL

lapilv1/profile/document/summary

Method: Post

Request Headers

Key Value

Authorization Bearer

Type
String

<Authorization

Token>

Content-Type application/json String

buld <Business Unit Long
ID>

service <Salesforce> String

roleld <User ID> Integer

companyld <Company ID> Integer

Sample Request

Request URL

Request Header

Request Body

FortiCASB 24.3.b Admin Guide
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POST https://www.forticasb.com/api/v1/profile/document/summary

Authorization: Bearer <Authorization Token>

Content-Type:
buid: 6384

Description

Authorization credential generated by FortiCASB

The targeted business unit ID on FortiCASB. Business
unit ID can be obtained through . Alternatively, it can also
be obtained from the REST API Get Resource Map on

page 472

Cloud service account

Login user ID, can be obtained through Get Resource

Map on page 472.

Company ID of which the business unit is under, can be
obtained through Get Resource Map on page 472.

application/json

service: 0Office365
companyId: 62598

roleid: 36241

{
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"limit": 10,

"skip": O,
"filterDataList": [
{
"name": "File Type",
"valueList": []
}I
{
"name": "Sensitive Data",
"valueList": [],

"byOthers": false,
"byAll": false

"name": "Share Type",
"valueList": [],
"byOthers": false,
"byAll": false

Response Variables

Name Type Description

name String Data type of the file.

bubbleList String List of file types in the bubble diagram.
id String The id of the file type.

Sample Response

{
"data": [
{

"name": "File Type",

"bubbleOther": {
"name": "Non-Extension",
"id": "Non-Extension",
"size": 1

}I

"bubbleTotal": {
"name": "With-Extension",
"id": "With-Extension",
"size™: 20198

by

"bubbleList": [

{
"name": "7z 014tix27s33cczubidvbhzeeq3kspwwgpa",
"id": "7Z_014TIX27S33CCZUBI4VBHZEEQ3KSPWWQPA",
"size": 2

"name": "exe 014tix27g4xmeysomhibdzllu3s7z65piw",
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"id": "exeiol4TIX2 7TQ4XMEYSOMHIBDZLLU3S7Z65PIW",
"size": 2
}I
]
}I
{
"name": "Sensitive Data",
"bubbleOther": {
"name": "Non-Extension",
"id": "Non-Extension",
"size": O

}I
"bubbleTotal": {
"name": "With-Extension",
"id": "With-Extension",
"size": 80545
}y
"bubbleList": [
{
"name": "DLP US WA-1 Driver License Pattern",
"id": "1545",
"size": 1

"name": "Share Type",
"bubbleOther": {
"name": "Non-Extension",
"id": "Non-Extension",
"size": 0
}I
"bubbleTotal": {
"name": "With-Extension",
"id": "With-Extension",
"size": 15427
}I
"bubbleList": [
{
"name": "Anyone Edit Link",
"id": "OFFICE365 LINK ALL EDIT",
"size": 1

"name": "SaaS App",

"bubbleOther": {
"name": "Non-Extension",
"id": "Non-Extension",
"size": 0O

}I

"bubbleTotal": {
"name": "With-Extension",
"id": "With-Extension",
"size™: 20199

}y
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"bubbleList": [
{
"name": "Office365",
"id": "OFFICE365",
"size": 20199

}
I
"code": O,
"msg": "success",
"httpCode": 200

Post Document Profile List

Description

Return all document profile details of the specified cloud service account.

URL

lapilv1/profile/document/fileList

Method: Post

Request Headers

Key Value Type Description

Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>

Content-Type application/json String

buld <Business Unit Long The targeted business unit ID on FortiCASB. Business
D> unit ID can be obtained through . Alternatively, it can also
be obtained from the REST API Get Resource Map on
page 472
service <Salesforce> String Cloud service account
roleld <User ID> Integer Login user ID, can be obtained through Get Resource

Map on page 472.

companyld <Company ID> Integer Company ID of which the business unit is under, can be
obtained through Get Resource Map on page 472.
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Sample Request

Request URL

Request Header

Request Body

Response Variables

Name
filename
fileld

service

Sample Response

{

"data": {
"datas": [
{
"fileId":
"fileName":
"buld": 84,
"serviceId":

POST https://www.forticasb.com/api/v1/profile/document/fileList

Authorization: Bearer <Authorization Token>

Content-Type: application/json
buid: 6384

service:

Office365

companyId: 62598
roleid: 36241

{

"limit": 1,
"skip": O,
"filterDatalList": [
{
"name": "File Type",
"valueList": []
}I
{
"name": "Sensitive Data",
"valueList": [],

Type
String
String
String

"byOthers": false,
"byAll": false

"name": "Share Type",
"valueList": [],
"byOthers": false,
"byAll": false

Description
The name of the file

The Id of the file.

The cloud service account provider that host the file.

"74c3£925-34bc-49da-8b88-d5£5973b1272",

"EMD232add3.txt",

"companyId": "62598",

"service":
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by

"vendorCode": "Office365",

"path": "011220248/EMD232add3.txt",

"lastModifiedUser": "",

"lastModifiedUserName": "",

"docCreatedAt": "2024-01-13T00:02:53.000z",

"docLastUpdatedAt": "2024-01-13T00:02:53.0002",

"link": "/download/Office365/users/null/74c3£925-34bc-49da-
8b88-d5£5973b1272",

"size": 4224,

"dlp": false,

"exposure": false,

"sharing": false,

"sensitive": false,

"malware": false,

"isLink": false,

"resourceType": "users",

"isDelete": false,

"folder": false,

"location": false,

"root": true,

"states": [

"SCANNING"

i

"processedResult": "Data scan is in progress.",

"pathInfo": {}

} 14

"totalPage": 20202,
"limit"™: 1,

"skip": O,
"totalCount": 20202

"code": 0,
"msg": "success",
"httpCode": 200

Post C-Level Report Summary

Description

Return all C-Level reports instances generated on FortiCASB.
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URL

lapilv1/report/clevel/page

Method: Post

Request Headers

Key Value Type Description

Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>

Content-Type application/json String

buld <Business Unit Long The targeted business unit ID on FortiCASB. Business
ID> unit ID can be obtained through . Alternatively, it can also
be obtained from the REST API Get Resource Map on
page 472
roleld <User ID> Integer Login user ID, can be obtained through Get Resource

Map on page 472.

companyid <Company ID> Integer Company ID of which the business unit is under, can be
obtained through Get Resource Map on page 472.

Sample Request

Request URL POST https://www.forticasb.com/api/v1/report/clevel/page
Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
buid: 6384

service: 0Office365
companyId: 62598
roleid: 36241

Request Body {
"skip": O,
"limit": 1
}
Response Variables
Name Type Description
filename String C-Level report name.
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Name Type Description
date String Date the C-Level report generated.
id String Id of the C-Level report.

Sample Response

{
"data": {
"datas": [
{
"id": 3840,
"name": "2024 Annual",
"date": "2024-01-13T00:29:14.5562Z",
"cLevel": true,
"status": "completed success",
"finished": true,
"timezoneOffset": 0
}
1,
"totalPage": O,
"limit": 1,
"skip": O,
"totalCount": 617
}I
"code": O,
"msg": "success",
"httpCode": 200

Post Compliance Report Summary

Description

Return all Compliance reports instances generated on FortiCASB.
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URL

lapilv1/report/compliancef/filtered

Method: Post

Request Headers

Authorization credential generated by FortiCASB

Key Value Type Description
Authorization Bearer String

<Authorization

Token>

Content-Type application/json String

buld <Business Unit Long
ID>

roleld <User ID> Integer

companyld <Company ID> Integer

Sample Request

Request URL

Request Header

Content-Type:

buid: 6384

The targeted business unit ID on FortiCASB. Business
unit ID can be obtained through . Alternatively, it can also
be obtained from the REST API Get Resource Map on
page 472

Login user ID, can be obtained through Get Resource
Map on page 472.

Company ID of which the business unit is under, can be
obtained through Get Resource Map on page 472.

POST https://www.forticasb.com/api/vi1/report/compliance/filtered

Authorization: Bearer <Authorization Token>
application/json

service: Office365
companyId: 62598

roleid: 36241

Request Body {

"skip": O,

"limit":

"timezoneOffset": "-0800",
"reportTypes": [],

"cloudApps":
"scheduled":
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Response Variables

Name Type Description

name String Compliance report name.

date String Date the Compliance report generated.
id String Id of the Compliance report.

Sample Response

{
"data": {
"datas": [
{
"id": 129593,

"name": "SAAS Box PCI-DSS Compliance Report December 2023
UTC.zip",
"generator": "SAAS",

"date": "2024-01-01T01:21:23.858z",
"available": true,
"complete": true,
"scheduled": true
}
I
"totalPage": O,
"limit": 1,
"skip": O,
"totalCount": 4655
}I
"code": O,
"msg": "success",
"httpCode": 200

Post Shadow IT Report Summary

Description

Return all Shadow IT reports instances generated on FortiCASB.
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URL

lapilv1/report/shadowlt/page

Method: Post

Request Headers

Key Value Type Description

Authorization Bearer String Authorization credential generated by FortiCASB
<Authorization
Token>

Content-Type application/json String

buld <Business Unit Long The targeted business unit ID on FortiCASB. Business
ID> unit ID can be obtained through . Alternatively, it can also
be obtained from the REST API Get Resource Map on
page 472
roleld <User ID> Integer Login user ID, can be obtained through Get Resource

Map on page 472.

companyid <Company ID> Integer Company ID of which the business unit is under, can be
obtained through Get Resource Map on page 472.

Sample Request

Request URL POST https://www.forticasb.com/api/v1/report/shadowlt/page
Request Header Authorization: Bearer <Authorization Token>
Content-Type: application/json
buid: 6384

service: 0Office365
companyId: 62598
roleid: 36241

Request Body {
"skip": O,
"limit": 1
}
Response Variables
Name Type Description
name String Shadow IT report name.
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Name Type Description
date String Date the Shadow IT report generated.
id String Id of the Shadow IT report.

Sample Response

{

"data": {
"datas": [
{
"id": 512,
"name": "SAAS Shadow IT Report 2023-11-06-14-47-42.pdf",
"generator": "SAAS",

"date": "2023-11-06T22:47:42.0862",
"available": true,
"complete": true
}
1s
"totalPage": O,
"limit": 1,
"skip": O,
"totalCount": 217
}I
"code": O,
"msg": "success",
"httpCode": 200

Get Alert Report Summary

Description

Return all alert reports instances generated with specification on the year generated and if is generated on a
monthly basis.
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URL

lapilv1/report/alert/reportList

Method: Get

Request Headers

Key Value

Authorization Bearer

Type Description

String Authorization credential generated by FortiCASB

<Authorization

Token>

Content-Type application/json String

buld <Business Unit Long The targeted business unit ID on FortiCASB. Business

ID>

unit ID can be obtained through . Alternatively, it can also
be obtained from the REST API Get Resource Map on

page 472

roleld <User ID> Integer Login user ID, can be obtained through Get Resource
Map on page 472.

companyid <Company ID> Integer Company ID of which the business unit is under, can be
obtained through Get Resource Map on page 472.

service <Salesforce> String Cloud service account

year <Year> Integer Year the report generated.

isMonthly <True> Boolean  True if the report is monthly, false if the report is not a

Sample Request

Request URL

Request Header

FortiCASB 24.3.b Admin Guide
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GET https://lwww.forticasb.com/api/v1/report/alert/reportList

Authorization: Bearer <Authorization Token>
Content-Type: application/json

buid: 6384

service: Salesforce

companyId: 62598

roleid: 36241

isMonthly: false

year: 2024
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Response Variables

Name Type Description

name String Alert report name.

size String The size of the Alert report.
timestamp String Date the Alert report generated.

Sample Response

{

"data": [
{
"name": "Salesforce Alert Report20240101 UTC.csv",
"size": 14108,
"timestamp": "Jan 2, 2024, 9:18:06 PM"
b
{
"name": "Salesforce Alert Report20240102 UTC.csv",
"size": 15990,
"timestamp": "Jan 3, 2024, 9:18:09 PM"
}I
{
"name": "Salesforce Alert Report20240103 UTC.csv",
"size": 15116,
"timestamp": "Jan 4, 2024, 9:18:06 PM"
}
]I
"code": 0,
"msg": "success",

"httpCode": 200
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Troubleshooting

Information and solutions for the following problems are included in this section:

Getting Started

« | have a new account but no license
« | have renewed my license, but cannot use it.

Salesforce

e | getan OAuth Request error.

Office 365

« | get aAdd Site Collection Admin errors on page 536.

o | getaAdd Users errors on page 538

« | getaAdd Groups errors on page 538

o | get a System Automatic Sync NOT Completed error on page 539

« | get alnsufficient Permissions(Access Denied) Error (One Drive) on page 541
| get aInsufficient Permissions(Access Denied) Error (SharePoint) on page 544

Dropbox Business

e | getan OAuth Request error.

Google Workspace

« | can't connect Google Workspace to FortiCASB.
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All SaaS Applications

o | getan API Throttling Limitation Message (All Apps) on page 550

Getting Started Issues

Information and solutions for the following problems are included in this section:

« New account with No License Error on page 532

« Renew License error on page 533

New account with No License Error

Please check on your primary FortiCloud account to see if the license is present with these steps:

1. Loginto FortiCloud https://support.fortinet.com/ with your primary FortiCloud account.
2. From the top main menu click on Asset > Manage/View Products.
3. Check and see if the licenses you purchased is shown in the product list.

FortiCASB 24.3.b Admin Guide
Fortinet Inc.

532


https://support.fortinet.com/

Troubleshooting

er Sermce & Support Horme [Tal A 1 Dow i Feecdback RS - 2

Wiew

Products

4. If you find your license on the list, then you can add the license through creating a company. Please see
Company Management on page 23.

5. If you do not see the license you purchased is on the list, please contact FortiCloud support.

Renew License error

When you have renewed your license but cannot find it on your FortiCASB Dashboard, follow these steps to see
if the license appears in your FortiCloud account.

1. Loginto FortiCloud https://support.fortinet.com/ with your primary FortiCloud account.

2. From the top main menu click on Asset > View Account Service.

3. Check and see if the license/contract you purchased is shown in the product list.

FortiCioud e

Customer Service & Support Home Assistance Download Feedback a
Account : ] )

- Fortinet Account Level Services F"tEfi

Service

Service Name Serial Number Description Registration Date

FortiAnalyzer Cloud FortiAnalyzerCloud 2020-02-25

FortiCWP CloudsStorage Protection 2020-04-15

FortiCWP Workload Guardian 2020-04-15

FortiManager Cloud FortiManagerCloud 2019-11-24

4. |f you do not see the license/contract you purchased is on the list, please contact FortiCloud support.
5. If yourlicense is on the list, then it only need to be assigned to the company/business unit on FortiCASB.
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Salesforce

OAuth Request errors

If an error occurs, an error message will be displayed on the Salesforce panel.

The following sections show some common error messages, as well as possible solutions:

If your error message says "Saas application APl gateway not accessible", go to Saas application API
gateway not accessible error on page 534

Saas application APl gateway not accessible error

FortiCASB requires users to have three specific Salesforce permissions. To check your Salesforce permissions,

follow these steps:

1.

From your Salesforce menu, go to Setup > Manage Users > Users.

2. Click on the profile of the integrated user.

For example, if the integrated user is listed as a "System Administrator", click on System Administrator

under "Profile".
@4'7_& e e

Home Chatter +

X
Take Salesforce with you wherever you go. Y
Run your business from any mobile device with the Salesforcel Mobile App.
All Users Help for this Page @
On this page you can create, view, and manage users.
3& , In addition, download SalesforceA to view and edit user details, resst passwords, and perform other administrative tasks from your mobile devices: /S | Android
Lightning Experience View: [All Users v | Edit|Create New View
Migration Assistant Al8ICIDIEIFIGIHIIIYKILIMINIOIPIQIRISITIUIVIW|X|Y|Z|Omer AN
Swich tothe moden, inteligent
Salesforce. New User| | Reset Passworats)| | Add Muttpe Users
Action Full Name + Alias Username Last Login Role Active  Profile Manager
B —————————— v Catier Free User
ST e B —— 9152017 5118 P v CSislem Administiator >
| v Anaitcs Cloud Intearatin User
Force.com Home < v Anaiics Cloud Securty User
New User | Reset Password(s) | Add Muttipe Users
Administer
G e AIBICIDIEIFIGIHIIIIKILIMINIOIPIQIRISITIUIVIWIX|YZ| Oter AN
Users
‘Aﬂa;mn Manager
Mass Emal Users
Roles
Permission Sets
Profies
Publc Groups
Queves
Login Hitory
Identiy Verifcation History
) Manage Apps
+ Manage Terrtories
» Company Profile

3. Make sure you have the "API Enabled", "View All Data", and "View All Users" permissions enabled.

If you have all these permissions and still encounter the error, your organization could have reached
Salesforce's daily API request limit. To check if you have reached this limit, follow these steps:
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1. From your Salesforce menu, go to Setup > Company Profile > Company Information.
2. Check "API Requests, Last 24 Hours" to see if you have reached your maximum limit.

If you have reached this limit, wait for the next 24 hour period to try again.

S ! /, Salesforce enforces API call limits based on a per-organization basis, not a per-user
? basis. If your organization has multiple applications sharing Salesforce API requests,
3 please consolidate usage between applications.
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Office 365

| get a Add Site Collection Admin errors on page 536.

« | getaAdd Users errors on page 538

o | getaAdd Groups errors on page 538

« | get a System Automatic Sync NOT Completed error on page 539

o | get alnsufficient Permissions(Access Denied) Error (One Drive) on page 541

« | getalnsufficient Permissions(Access Denied) Error (SharePoint) on page 544

Add Site Collection Admin errors

The following sections show some common causes for this error, as well as possible solutions.

« If your azure domain does not end in ".onmicrosoft.com", follow the steps in Customized SharePoint homepage
URL on page 536 to allow collection manually.

Customized SharePoint homepage URL

FortiCASB's "Add Site Collection Admin" feature currently only supports the default azure domain format

(abc.onmicrosoft.com).

If you have a custom SharePoint homepage URL, you will have to allow collection manually.

1. Go to Microsoft 365 Admin Center, click on show all in the navigation pane, then click SharePoint.

Microsoft 365 admin center

| & Home
8 Users v
' Groups v
Fa Roles
B Resources S
B Billing v
2 su pport ~
’Jé? Settings ~
ﬂ Setup
b~ Reports ~
% Health v
Admin centers
@ Security

@ Compliance
@ Azure Active Directo..

@3 Exchange

& SharePoint

W5 Teams
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-+ Add cards

Microsoft Teams

Support remote workers with
Teams

Learn how to manage Teams for remote work, with setup guidance, short videos, and
tips.

@ Teams is on for your organization

@ Check setup status for new Teams users

Finish seti

Start by setting up your ¢

We'll help you setupa m
as possible to help you av

Go to guided setup

User management

User management

Add, edit, and remove user accounts, and reset passwords.
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2. In SharePoint Admin Center navigation pane, click More features. Under User profiles, click Open.

SharePoint admin center

@ Home
B Sites
Active sites

Deleted sites

E Policies

ﬁs Settings

% Content services
G Migration

More features

S5 OneDrive admin center

f Customize navigation

Show less

User Profiles

;;’ People
Manage User Properties

L:g My Site Settings

Setup My Sites

User Profiles

More features

————

e —

Access familiar features from the classic SharePoint admin center.

Term store

Create and manage term sets to help users enter

data consistently. Learn more

Open

BCS

Manage connections to data sources like Azure SQL
databases or WCF web services. Learn more

Open

3. InUser Profiles, click Manage User Profiles.

Manage User Profiles}] Manage User Sub-types

User profiles

Add and remove admins for a user's OneDrive,
disable OneDrive creation for some users, and
more. Learn mare

Open

Secure store

Create and set the credentials for Target
Applications used for BCS connections. Learn more

Open

Manage Audiences | Manage User Permissions | Manage Policies

4. Find the user, click on user account name, then select Manage site collection owners.

Use this page to manage the user profiles in this User Profile Service Application. From this page you can also manage a user's personal site.

Total number of profiles: 16

Find profiles

|[ Find

=New Profile | ¥ Delete | View: | Active Profiles ~| | [PManage Sub-types | Select a sub-type to filter the list of profiles: | Default User Profile Subtype v

[J] Account name
i-0 embershinl
Edit My Profile

Delete
Manage Persanal Site

Manage site collection owners

Preferred name

5. Inthe Site Collection Administrators box, enter your admin username, then click Ok.
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site collection owners

Primary Site Collection User name

Administrator ga report; & BB

Specify the administrator for this

site collection. Only one user login

can be provided; security groups

are not supported

Site Collection belle; ga report:

Administrators

Site Collection Administrators are &
) B2

given full control over all Web

sites in the site collection. They
may also receive site use
confirmation mail. Enter users

separated oy semicolons,

1 _

FortiCASB can now audit this user's OneDrives. Repeat steps one through four for each user you wish to audit.

Add Users errors

example, in this case, FortiCASB will monitor the 37 users that were added successfully, even
if this error is not corrected.

\ﬂ Even if such an error occurs, FortiCASB will still monitor users that do not trigger this error. For

The following sections show some common causes for this error, as well as possible solutions.

« If these users have never logged into their Office 365 accounts before, go to Adding users with new Office 365
accounts on page 538.

Adding users with new Office 365 accounts

Office 365 activates a new user's SharePoint portal when he or she logs in for the first time. For a brand new 0365
account, log into the account once to activate the portal, then add the user in FortiCASB.

Add Groups errors

Some groups do not generate or manipulate files. FortiCASB will not monitor these groups. FortiCASB will also not
monitor groups the site administrator does not have permission to monitor.
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A\,

b [ 4
? Even if such an error occurs, FortiCASB will still monitor groups that do not trigger this error.

System Automatic Sync NOT Completed error

When you received the error "System Automatic Sync NOT Completed. Some users and documents Not been
synced on .." on Office 365 Dashboard, click View Error Message to see the details.

Forticm & Services v @ Support v yue:

& Forti Office365 / Dashboard N

@ Overview
System Automatic Sync NOT Completed. Some user and documents have NOT been synced on 06-10-2021, 20:00. View Error Message

Ou Office365

Last 7days w
Dashboard

The error messages contains a list of users using the same Office 365 account, but have not been granted with
permission to be monitored by FortiCASB.

This error Will Not prevent FortiCASB from providing account monitoring and protection for the Office 365 account.
However, DLP (Data Analysis) scan can not be performed on the list of users' Office 365 OneDrive Accounts.

To fix the error, please follow the instruction in Manually Activate Sites Collection on page 539 to add the global
administrator or sharepoint administrator to the Site Collection Administrators to grant users to be connected to
FortiCASB.

Manually Activate Sites Collection

Follow these steps to make OneDrive data accessible:

1. Log into https://admin.microsoft.com/ using your global administrator account.
2. Inthe left pane, under Admin centers, click SharePoint.

FortiCASB 24.3.b Admin Guide 539
Fortinet Inc.


https://admin.microsoft.com/

Troubleshooting

Microsoft 365 admin center

p Setup Fortinet_Inc

b Reports e
Finish adding your organization’s domain to Office 3¢
% Health v

S mEr —|— Add cards (6 more available)

o Microsoft Teams

@ Compliance

FR Support remote workers with

& Azure Active Directo... Teams

g EaiE Learn how to manage Teams for remote work, with setup guidance, short videos,
and tips.

® SharePoint

W Teams Q Teams is on for your organization

i= Al admin centers © Check setup status for new Teams users

3. After SharePoint admin center pop-up, click More features, and open User profiles.

SharePoint admin center

More features

& Home Access familiar features from the classic SharePoint admin center.
B Sites v
Term store User profiles
% Policies e B
Create and manage term sets to help users enter Add and remaove admins for a user's OneDrive,
data consistently. Learn more disable OneDrive creation for some users, and
@ Settings more. Learn more
Oz Content services e
el
&> Migration

I I More features

Search Apps
& OneDrive admin center Help users find what they're looking for. Learn Configure SharePoint Store settings, monitor app
more usage, manage app licenses, and more. Learn more

4. In User Profiles page, under People, select Manager User Profiles.

User Profiles

iﬁ People
Manage User Properties || Manage User Profiles| Manage User Sub-types | Manage Audiences | Manage User Permissions

Manage Policies

L:& My Site Settings

Setup My Sites

5. InFind profiles box, enter a licensed user under the global account administrator and click Find.
6. Right click on the account name and select Manage site collections owners.
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14

Use this page to manage the user profiles in this User Profile Service Application. From this page you can also manage a user's personal site.

Total number of profiles; 9

Find profiles [new [ FAnd ]

@i New Profile | X Delete | View: | Active Profiles v| | [PManage Sub-types | Select 3 sub-type to filter the lst of profiles: | Default User Profile Subtype ¥

O Account name preferred name E-mail address.

(S e — === gbdev1.onmicrosoft.com - new user newuser@forticasbdev1.onmicrosoft.com
Edit My Profile
Delete

Manage Persanal site

Manage site collection owners

7. Inthe field for Site Collection Administrators, add the global or sharepoint administrator account's user name
or e-mail address and press Enter.

site collection owners

FrMary 218 Welnecuoen LI Hanme.
Administrator new user: & EE

Specify the administrator for this
site collection. Only one user login
can be provided; security groups
are not supported.

Site Collection New user:
Administrators

Site Collection Administrators are |- WEE
. WS

given full control over all Web

sites in the site collection, They

may also receive site use

confirmation mail, Enter users

separated by semicolons.

8. Click on Ok button to complete adding the global or sharepoint administrator as one of the site collection
administrators.

Insufficient Permissions(Access Denied) Error (One Drive)

Insufficient Permissions(Access Denied) error is one of the Data Scan Status in Office 365 > Files page. This
guide is targeted on the files in Microsoft OneDrive account.
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.
gdo
rive

<hina

Residen:
Identity

Path

05222024/ eicar_com 1zip
05222024 /eicarcom?2 1zip
052420244/ /eicar_com 1.zip
052420244/eicarcom2 1.zip

05252024/eicarcom?2 1zip

Data Scan Status

@ Insufficient Permissions
@ Insufficient Permissions
€ Insufficient Permissions
@ Insufficient Permissions

@ Insufficient Permissions

Owner

Highlight

lInsufficient Permissions: Office 365 account user
used for onboarding is not one of the One Drive/
SharePoint Site Collection Administrators.

Root Cause Analysis

The file resided in OneDrive is not accessible for data scan, thus returning the "Insufficient Permissions" error. This error
occurs when the Office 365 service account used for the FortiCASB onboarding process is not part of the new Office 365
user's OneDrive Site Collection Administrators.

Solution 1: Update Office 365 Account

In FortiCASB, update the Office 365 Account and follow the instructions to update the account. The service account
should be added automatically to the new user's OneDrive Site Collection Administrator when the account is
successfully updated.

Last 7 days

] Office 365 =
Update Account
Status ® Connected Delete Account
Cloud Account
Checklist 4/4 Pass Detail
Last Update 9772023, 5:45:13 PM Histary
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Solution 2 - Add Admin Account to One Drive Site

The service account or the Office 365 account used in the FortiCASB onboarding process needs to be added to the new
Office 365 user's OneDrive site collection administrator.

By completing this configuration, the data stored in OneDrive will be accessible for FortiCASB data scan.

1. Log into the new user's Office 365 account, click on the Apps menu *** and select OneDrive.
2. Clickon the setting icon in the top right corner.

. P
Fle]l? (»

3. In Settings, click OneDrive setting.

Settings X

OneDrive

[Onelrive settings]

Restore your OneDrive
Get the OneDrive apps
Sync this OneDrive

4. Click More Settings, inside Manage access, click Site Collection administrators.

i3 @ OneDrive
More Settings

[ Notifications ——

[@] Maore Settings _
Access requests and invitations

Site collection administrators

Manage guest expiration
Run sharing report

5. Check to see if the Office 365 service account used for FortiCASB onboarding is one of the Site Collection
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Administrators. If not, add the account in the list and click Ok.

Permissions » Site Collection Administrators e

Site Collection Administrators

Site Collection Administrators are

given full contro
sites in the site co

confirmation mail. Enter users

separated by semicolons,

Ok Cancel

Insufficient Permissions(Access Denied) Error (SharePoint)

Insufficient Permissions(Access Denied) error is one of the Data Scan Status in Office 365 > Files page. This
guide is targeted on files on Microsoft SharePoint sites.
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gdo
rive
<hina
Qesiden:
Identity

.ng,w_ Owner

Path Data Scan Status Highlight

05222024 /gicar_com 1.zip € Insufficient Permissions -

Insufficient Permissions: Office 365 account user

05222024 eicarcom?2 1.zi Insufficient Permissions

P e used for onboarding is not one of the One Drive/
052420244/ /eicar_com 1zip © Insufficient Permissions @ SharePoint Site Collection Administrators.
052420244,eicarcom2 1.zip € Insufficient Permissions —
05252024 /eicarcom? 1.zip & Insufficient Permissions -

Root Cause Analysis

The file resided on the Microsoft SharePoint Site is not accessible for data scan, thus returning "Insufficient
Permissions" error. This error occurs when the Office 365 service account used for the FortiCASB onboarding process is
not one of the SharePoint Site's admins.

Solution 1: Update Office 365 Account

In FortiCASB, update the Office 365 account and follow the instructions to update the account. The service account
should be added automatically to the Sharepoint Site Administrators when the account is successfully updated.

Solution 2 - Add Admin Account to SharePoint Site Admin Group

Before adding an administrator account to the SharePoint Site admin group, please verify that the account is one of the
Company Administrators, and this account will be used for Office 365 onboarding process on FortiCASB.

1. Log into Office 365 (https://office.com) with your account to be added to FortiCASB.

2. Click on the App Launcher button i atthe top left corner, and select Admin.
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Apps

ﬁ Outlook
ﬂ Word
& PowerPoint
Q SharePoint

Office 365

. CneDrive

a Excel
u OneMote
$ Teams

E‘ Yammer

B Admin

;.‘{Q Paople

All apps >

3. In Microsoft 365 admin center left navigation menu, , click on Show all to show other options. Scroll down to

Hé]_ Add-Ins

>

Admin Centers and click SharePoint to access SharePoint admin center.

Microsoft 365 admin center

Home

Users

Groups

Billing

“ 0 4 o B

Setup

Y

Customize navigation

Show all

4. In SharePoint admin center, click on Sites drop down menu, and select Active Sties.

FortiCASB 24.3.b Admin Guide

Fortinet Inc.

Admin centers

Security

Compliance

Endpoint Manager

Azure Active Directory

Exchange

SharePoint

Teams

All admin centers
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SharePoint admin center

I A Home

B3 Sites
Active sites
Deleted sites

= posces

{E& Settings

BE Content services

& Migration

Bn  Advanced

Fartinet_Inc
f\
+ Add cards
Search active sites
e
-
Site search
v
O search
v

Meszage

30 u

& Sh

5. In Active sties, under Site name column, scroll down to look for the targeted site name.

=1 Home

£ Seng

B Costert v
G Migrate

U Atvinoed

= More et

Active sites
o iy pag Bo port snd SEer wies snd changs pis tingr
ity Expo = Tric wbwy
SHie name " L
P r—

prgfanieati

e T

sl i el ey

Ay g bt

wru gy’

loama Chanrel sites

s g _pamamatat!

Saorage wued (GE) Primary sdmin

Al rcasp owran
& Ertasp D
) B Gavamp paran

QL0 M Cavap Dwran

6. Click on the Site name, the SharePoint site profile dialog will appear, then click Membership tab.

qingfantestiging)

Private group

I=9 Emnail D View se

qingfantestiging)

Gemeral Bectivit

Membsership

A Dwlete

Settings

-@ Woold you ke bo sdd Microaoft Teams fo this group!

Bagic info
Haamay
ginglantestigngl
Description
gingtantestiging)
Echit
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Ermnil addresee

Primary

Aljases

Edn

Al Tiarmd

Oeher info

Created

3424 ot 224 PM
by qinglanies
from SharePoint start page

T

X
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7. Click +Add site admins to add the Company Administrator account (the account to be added on FortiCASB) as a
new site admin. In this way, FortiCASB will be able to monitor and protect the sharepoint site after the company
administrator account is added to FortiCASB.

gingfantest{ging)
Privale group
] Delete

= Ermail 9 Viewsite [a]

gingfantest{qing)

General Activity Membership Settings

Owners ~+ Add site admins 2 Search all membersh
haemibers

j—l Harme Emad addigds
Site sdming

SdE CanErs -L ] Bini Xu

Sdte members
gingfantest(ging) Cwners  senaaay

00

Sdg wesntors

abiout membership and
pefmesfitng

x Note: If you want FortiCASB to monitor and protect other Sharepoint sites of the same

domain, repeat step 6-7 with a different Sharepoint site.
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Dropbox Business

+ OAuth Request error on page 549

OAuth Request error

Please check the user role of the account used to log in to Dropbox Business. This account must have "Team Admin"
Permissions.
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Google Workspace

Google Workspace connection errors

If FortiCASB will not connect to your Google Workspace account, one common reason is because your Google account
is not a Super Administrator and does not have the correct permissions.

To check if your Google account is a Super Administrator, go to https://admin.google.com/, and log in with your Google

account.

If your interface is the same as the one shown below, you are a Super Administrator.

Go gle Admin [, Search for users, groups, and settings (e.g. setup billing)

L3 Home
2 Users
- Company profile
=) Billing
m Reports
Apps f::
= oups
- Group: Company profile
Update information
a Admin roles about your company
[  Device management
@ Security 0
By  Domains
Support
FoN App Enaine apps

° Nice job, you're all done! <

Your Google Cloud account is now ready!

Get G Suite services

CLOSE SET UP

= v i,

Billing Reports Apps Device management

View charges and Track usage of services Manage apps and their Secure corporate data
manage licenses settings on devices

Data migration

MORE CONTROLS

If you are not a Super Administrator, either ask the Super Administrator to grant you Super Administrator permissions or
use the Super Administrator's Google account to link to FortiCASB.

If you're unsure who your administrator is, contact your IT department, help desk, or the manager who gave you the

account.

»

Due to Google requirements, only Google Workspace
accounts with a business or enterprise license can use
FortiCASB. Google Workspace accounts with a basic license
will be unable to use FortiCASB.

API Throttling Limitation Message (All Apps)

For all cloud applications onboard, there is a limitation of the number of files that FortiCASB Data Scan can process at

any given time.
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When there are too many files uploaded to a cloud application simultaneously, the following API throttling message will
appear in Dashboard to notify that the number of files have exceeded the number of API requests that FortiCASB can

handle.
& Services ¥ @ Support v -
Overview / Dashboard HEIE o 2 = | (7]
o Due to the high volume of files, FortiCASB is encountering API throttling limitations of [SaaS App Name1, Name2, Name 3]. FortiCASB will intelligently adjust its API call frequency x

accordingly. If this message persists please contact the SaaS App providers to increase AP| request quotas.

Solution

Please wait for awhile until FortiCASB adjusts its API calls' frequency or until all API calls have completed.

If the message persists, please reach out to the Cloud Application vendor to increase the API request quotas.
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Appendix A - Amazon Policy Usage

Communication between AWS and FortiCASB requires granting FortiCASB with permissions to access AWS account
resource configuration settings. The method is done through creating custom policy on AWS in JSON format in AWS for

Below are lists of the AWS services/policies used and the corresponding reasoning to be used in FortiCASB.

FortiCASB Basic Permission

Service Policy in JSON Format

RDS "rds:Describe*"
"rds:DownloadDBLogFilePortion"
"rds:ListTagsForResource"

"rds:ModifyDBInstance"

EFS "elasticfilesystem:Describe*"

ELB "elasticloadbalancing:Describe™"

"elasticloadbalancing:ModifylLoadBalancer

Attributes"
Certificate "acm:List*"
Manager "acm:Describe*"
CloudFront "cloudfront:List*"

"cloudfront:Get™*"
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Permission Purpose

1. FortiCASB Resource List
2. RDS profile

3. RDS Topology

4. RDS Risk assessment

1. Allow autofix feature of RDS Risk
assessment policy "RDS instances
should not be publicly accessible".

1. FortiCASB Resource List

2. EFS profile
3. EFS Risk assessment

1. FortiCASB Resource List

2. Listener, Load Balancer, Target
Group profile

3. ELB Topology

4. ELB Risk assessment

1. Allow autofix feature of ELB Risk
assessment policy "ELB/ALB deletion
protection should be enabled".

1. FortiCASB Resource List

2. ACM Certificate profile

3. ACM Certificate Risk assessment

1. FortiCASB Resource List
2. CloudFront profile
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EKS

KMS

Lambda

SQS

1AM

"cloudfront: UpdateDistribution”

"eks:ListUpdates"
"eks:DescribeUpdate”
"eks:DescribeCluster”
"eks:ListClusters"

"kms:List*"
"kms:Describe*"
"kms:Get*"

"kms:EnableKeyRotation"

"lambda:List*"

"lambda: GetPolicy"

"sgs:ReceiveMessage"
"sqs:GetQueueUrl"

"sgs: GetQueueAttributes"
"sgs:ListQueueTags"
"sgs:ListQueues"
"sqs:ListDeadLetterSourceQueues”

"sqgs:TagQueue"
"sgs:UntagQueue”
"sgs:ChangeMessageVisibility
"sqgs:ChangeMessageVisibilityBatch"
"sgs:CreateQueue"
"sgs:DeleteMessage"
"sgs:DeleteMessageBatch"
"sgs:DeleteQueue”
"sqs:PurgeQueue”
"sqgs:SendMessage"
"sqgs:SendMessageBatch"
"sgs:SetQueueAttributes”
"iam:List*"
"iam:SimulateCustomPolicy"
"iam:GenerateCredentialReport"
"ilam:Get*"
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3. CloudFront Risk assessment

1. Allow autofix feature of CloudFront
Risk assessment policy "CloudFront
should use secure ciphers for
distribution".

1. FortiCASB Resource List

2. EKS profile
3. EKS Topology

. FortiCASB Resource List
. KMS Key profile
. KMS Risk assessment

W N =

1. Allow autofix feature of KMS Risk
assessment policy "KMS key rotation
should be enabled".

1. FortiCASB Resource List

2. Lambda profile

3. Lambda Risk assessment

—_

. FortiCASB Resource List
. SQS profile
. SQS Risk assessment

w N

1. FortiCASB Notification’s integration
with AWS SQS service

1. FortiCASB Resource List
2. 1AM profile
3. |AM Risk assessment
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Redshift

Elastic Container
Service

EC2

CloudWatch Logs

Glacier

CloudFormation

S3

"iam:SimulatePrincipalPolicy"

"iam:UpdateAccountPasswordPolicy"

*1

"redshift:Describe

"redshift:Describe*"
"redshift:ModifyClusterParameterGroup

"ecs:Describe*" "ecs:List*"

"ec2:Describe*
"ec2:SearchTransitGatewayRoutes
"ec2:GetTransitGatewayAttachmentPropagations
"ec2:GetTransitGatewayRouteTablePropagations

"ec2:GetTransitGatewayRouteTableAssociations

"ec2:ModifySnapshotAttribute”
"ec2:RevokeSecurityGroupEgress
"ec2:RevokeSecurityGrouplngress"

"logs:Get™"
"logs:Describe*"
"logs:FilterLogEvents"

"glacier:ListVaults"
"glacier:GetVaultAccessPolicy"

"cloudformation:ListStack*"
"cloudformation: GetTemplate"
"cloudformation:DescribeStack*"

"s3:GetBucket*"
"s3:GetReplicationConfiguration”
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1. Allow autofix feature of Redshift Risk
assessment policy "Password
requirements should be enforced".

1. FortiCASB Resource List
2. Redshift profile
3. Redshift Risk assessment

1. Allow autofix feature of Redshift Risk
assessment policy "Redshift database
should use SSL for connections".

1. FortiCASB Resource List
2. ECS profile
3. ECS Topology

1. FortiCASB Resource List

2. VPC, Route Table, Subnet, Network
ACL, Security Group, Machine Image
(AMI), EC2, EBS volume, EBS snapshot
profile

3. VPC, Subnet, Network ACL, Security
Group, EC2 Topology

4. VPC, Subnet, Security Group, AMI,
EC2, EBS Risk assessment

1. Allow autofix feature of EBS Risk
assessment policy "EBS snapshots
should not be publicly accessible".

2. Allow autofix feature of Security
Group Risk assessment policy "Default
Security Group should block all inbound
traffic".

1. Feature "Traffic" on FortiCASB

. FortiCASB Resource List
. Glacier profile

W N =

. Glacier Risk assessment

. FortiCASB Resource List
. CloudFormation profile
. CloudFormation Risk assessment

W N -

—

. FortiCASB Resource List
2. S3 bucket profile
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Pinpoint Email
ISES

CloudTrail

"s3:GetLifecycleConfiguration”
"s3:GetlnventoryConfiguration”
"s3:ListBucket"
"s3:ListBucketMultipartUploads
"s3:GetAccountPublicAccessBlock"
"s3:ListAllMyBuckets"
"s3:GetObjectVersion"
"s3:GetObjectVersionTagging"
"s3:GetObjectAcl”
"s3:GetObjectVersionAcl"
"s3:HeadBucket"
"s3:ListMultipartUploadParts"
"s3:GetObject”
"s3:GetAnalyticsConfiguration
"s3:GetObjectVersionForReplication"
"s3:ListBucketByTags"
"s3:ListBucketVersions"
"s3:GetAccelerateConfiguration”
"s3:GetObjectVersionTorrent"
"s3:GetEncryptionConfiguration”
"s3:GetObjectTagging”
"s3:GetMetricsConfiguration"
"s3:GetObjectTorrent"

"s3:PutBucketVersioning"
"s3:PutBucketAcl"
"s3:PutBucketPolicy"
"s3:PutObjectAcl"
"s3:PutObjectVersionAcl"

"ses:List*"
"ses:Get*"

"cloudtrail: GetTrailStatus"
"cloudstrail:LookupEvents"
"cloudtrail:DescribeTrails"
"cloudtrail:ListTags"
"cloudtrail: GetEventSelectors"

"cloudtrail: StartLogging"
"cloudtrail:UpdateTrail"
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3. S3 Risk assessment
4. Feature "Buckets" on FortiCASB

1. Allow autofix feature of S3 Risk
assessment policy "S3 buckets should
not be publicly available".

. FortiCASB Resource List
. SES profile
. SES Risk assessment

W N =

. FortiCASB Resource List

. CloudTrail profile

. CloudTrail Risk assessment

. Feature "Activity" on FortiCASB

A WO DN -

1. Allow autofix feature of CloudTrail
Risk assessment policy "CloudTrail
bucket should not be publicly
accessible".
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Elasticsearch "es:List*" 1. FortiCASB Resource List
Service "es:Describe*" 2. ElasticSearch profile
3. ElasticSearch Risk assessment
Route 53 "route53:ListTrafficPolicyVersions" 1. FortiCASB Resource List
"route53:GetHealthCheck" 2. Route53 profile
"route53:ListHostedZonesByName" 3. Route53 Risk assessment

"route53:GetHostedZoneCount"
"route53:GetHealthCheckLastFailureReason"
"route53:ListVPCAssociationAuthorizations"
"route53: GetReusableDelegationSetLimit"
"route53:ListTagsForResources"
"route53:GetAccountLimit"
"route53:GetGeolocation"

"route53: GetTrafficPolicy"
"route53:ListQueryLoggingConfigs"
"route53:GetCheckerlpRanges”
"route53:ListGeolLocations"

"route53: GetTrafficPolicylnstance”
"route53:ListHostedZones"
"route53:ListTagsForResource"”
"route53:ListHealthChecks"
"route53:GetHostedZone"
"route53:ListResourceRecordSets"

"route53: GetHealthCheckCount"
"route53:ListReusableDelegationSets"
"route53:ListTrafficPolicylnstancesByHostedZone"
"route53:GetHostedZoneLimit
"route53:ListTrafficPolicylnstances”
"route53: GetTrafficPolicylnstanceCount"
"route53:GetChange"
"route53:ListTrafficPolicies"
"route53:GetQueryLoggingConfig"
"route53:GetHealthCheckStatus"
"route53:GetReusableDelegationSet"
"route53:ListTrafficPolicylnstancesByPolicy"

SNS "sns:Get*" 1. FortiCASB Resource List
"sns:*" 2. SQS profile
3. SQS Risk assessment
"sns:*" 1. FortiCASB Notification’s integration
with AWS SNS service
CloudWatch "cloudwatch:Describe*" 3. CloudWatch Risk assessment
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Appendix B - Normalized Share Types

Introduction

Every cloud application has its own standardized share types for accessing cloud resources. The naming convention of
these file sharing types are unique and platform independent.

To provide file sharing insights based on all cloud applications on board, FortiCASB normalized share types are created
to standardized the share types among different cloud application platforms. Share types with similar file access
permission are grouped together under a FortiCASB normalized share type.

Normalized Share Types and Associated Cloud App Share Types

FortiCASB
Normalized
Share Types

Cloud Application
Share Types

Description

Cloud Application Supported

Editor

Viewer

Commenter

Private
Access

Others

File collaborator,
Editor, Project
Editor, Edit Link
Access, etc.

File Viewer, Group
Viewer, Project
Viwer, View Link
Access, etc.

User Commenter,
Group Commenter,
etc.

Private User, Private
Team, Private Group

Previewer, Uploader,
Triager, File
Recipient

FortiCASB 24.3.b Admin Guide
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Any user, group, or anyone who
can edit the file.

Any user, group, project, who
can view the file.

Anyone who can make a
comment on the file.

Any private user, group, domain

that can access the file privately.

Any non ordinary access to the
file include but not limited to file
previewer, uploader, recipient,
etc.

Salesforce, Office 365, Box, Dropbox,
Github, Google Workspace, AWS S3,
Google Cloud Storage, Egnyte

Salesfoce, Office 365, Box, Dropbox,
Github, Google Workspace, AWS S3,
Google Cloud Storage, Azure, Egnyte

Google Workspace

Dropbox, Azure, Egnyte

Salesforce, Box, Google Workspace,
Dropbox, Github, WebEx, Egnyte
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Data Retention Policy

Primary Storage

Secondary Stor-
age

Data Retention
with Active
License

Retention period
after license
expired

Company and
Business Unit cloud
account data

Audit logs, admin
logs, and user
activities

Cloud account
activities and alerts

Cloud account users
metadata

Cloud file data,
documents, e-mail
attachments, etc.

Cloud accounts
OAuth data

C-Level, Compliance
reports, etc.

Encrypted and stored
at AWS RDS and
Elasticsearch
Database

Encrypted and stored
at AWS RDS and
Elasticsearch
Database

Encrypted and stored
at AWS RDS and
Elasticsearch
Database

Encrypted and stored
at AWS RDS and
Elasticsearch
Database

Encrypted and stored
at AWS RDS and
Elasticsearch
Database

Encrypted and stored
at AWS RDS and
Elasticsearch
Database

Encrypted and stored
at AWS RDS and
Elasticsearch
Database
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AWS RDS and
Elasticsearch backup
snapshots

AWS RDS and
Elasticsearch backup
snapshots

AWS RDS and
Elasticsearch backup
snapshots

AWS RDS and
Elasticsearch backup
snapshots

AWS RDS and
Elasticsearch backup
snapshots

AWS RDS and
Elasticsearch backup
snapshots

AWS RDS and
Elasticsearch backup
snapshots

Data will not be
removed

Data will not be
removed

1 year

Data will not be
removed

Data will not be
removed

Data will not be
removed

Data will not be
removed

Data will not be
removed

Data removed after
90 days

Data removed after
90 days

Data removed after
90 days

Data removed after
90 days

Data removed after
90 days

Data removed after
90 days

558



Data Retention Policy

FortiCASB 24.3.b Admin Guide 559
Fortinet Inc.



End User License Agreements

End User License Agreements

Product License Agreement

The parties to this agreement are you (the end-customer) and Fortinet, Inc. ("Fortinet"). CAREFULLY READ THE
FOLLOWING LEGAL AGREEMENT (THE OR THIS “AGREEMENT” OR “EULA”). USE OR INSTALLATION OF
FORTINET PRODUCT(S) AND ANY UPDATES THERETO, INCLUDING HARDWARE APPLIANCE PRODUCTS,
SOFTWARE AND FIRMWARE INCLUDED THEREIN BY FORTINET, AND STAND-ALONE SOFTWARE PRODUCTS
SOLD BY FORTINET (TOGETHER, THE "PRODUCTS") CONSTITUTES ACCEPTANCE BY YOU OF THE TERMS IN
THIS AGREEMENT, AS AMENDED OR UPDATED FROM TIME TO TIME IN FORTINET’S DISCRETION BY
FORTINET PUBLISHING AN AMENDED OR UPDATED VERSION. FORTINET SHALL NOT BE BOUND BY ANY
ADDITIONAL AND/OR CONFLICTING PROVISIONS IN ANY ORDER, RELEASE, ACCEPTANCE OR OTHER
WRITTEN CORRESPONDENCE OR OTHER WRITTEN OR VERBAL COMMUNICATION

UNLESS EXPRESSLY AGREED TO IN AWRITING SIGNED BY THE GENERAL COUNSEL OF FORTINET. IF YOU
DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, DO NOT START THE INSTALLATION PROCESS
OR USE THE PRODUCTS. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, YOU SHOULD
IMMEDIATELY, AND IN NO EVENT LATER THAN FIVE (5) CALENDAR DAYS AFTER YOUR RECEIPT OF THE
PRODUCT, IMMEDIATELY NOTIFY FORTINET LEGAL LEGAL@FORTINET.COM OF REQUESTED EULA
CHANGES.

1. License Grant.

This is a license agreement between you and Fortinet, not a sales agreement. The term "Software", as used throughout
this Agreement, includes all Fortinet and third party firmware and software provided to you with, or incorporated into,
Fortinet appliances and any stand-alone software provided to you by Fortinet, with the exception of any open source
software contained in Fortinet’s Products which is discussed in detail in section 15 below, and the term “Software”
includes any accompanying documentation, any updates and enhancements of the software or firmware provided to
you by Fortinet, at its option. Fortinet grants to you a non- transferable (except as provided in section 5 ("Transfer") and
section 15 ("Open Source Software") below), non-exclusive, revocable (in the event of your failure to comply with these
terms, in the event of termination, or in the event Fortinet is not properly paid for the applicable Product) license to use
the Software solely for your internal business purposes (provided, if (a) agreed by Fortinet in writing, (b) you are
authorized by Fortinet in writing to provide managed service provider services (‘“MSSP”) to your end-customers, and (c)
you pay for an MSSP license, then you may use the Software and/or Software embedded in Fortinet Hardware to
provide those services, subject to the other restrictions in this Agreement), in accordance with the terms set forth in this
Agreement and subject to any further restrictions in Fortinet documentation (including license term restrictions), and
solely on the Fortinet appliance, or, in the case of blades, CPUs, platform, devices or databases, on the single blade,
CPU, platform, device or database on which Fortinet installed the Software, or, for stand-alone Software, solely on a
single computer running a validly-licensed copy of the operating system for which the Software was designed unless and
except set forth in the published documentation otherwise. For clarity, notwithstanding anything to the contrary, all
licenses of Software to be installed on blades, CPUs, platforms, devices or databases are licensed per blade, solely for
one blade and not for multiple blades that may be installed in a chassis, per CPU, per platform, per device, or per
database basis, up to the blade, CPU, platform, device, database number defined in the license and as applicable and
in accordance with the documentation. The Software is "in use" on any appliances, blades, CPUs, platforms, devices, or
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databases when it is loaded into temporary memory (i.e. RAM), accessed, downloaded, installed, or used on an
appliance, blade, CPU, platform, device, or database. You agree that, except for the limited, specific license rights
granted in this section 1, you receive no license rights to the Software.

2. Limitation on Use.

You are prohibited from and may not attempt to, and, if you are a corporation, you are responsible to prevent your
employees and contractors from attempting to: (a) modify, translate, reverse engineer, decompile, disassemble, create
derivative works based on, sublicense, or distribute the Software; (b) rent or lease any rights in the Software in any form
to any third party or make the Software available or accessible to third parties in any other manner (except as expressly
permitted for MSSP partners); (c) transfer assign or sublicense right to any other person or entity (except as provided in
section 5): (d) remove any proprietary notice, labels, or marks on the Software, Products, and containers; (e) use the
Software to determine, or disclose the results of, any benchmarking or performance measurements; (f) interfere with a
platform for use of the Software; (g) use the Software on a device not owned and controlled by you; (h) use automated
means to access online portions of the platform for the Software; (i) use the Software for third- party training,
commercial time-sharing or service bureau use or (except as expressly set forth in this Agreement) use the Software to
provide services to third parties, (j) share non-public features or content of the software with any third party; (k) access
the software in order to build a competitive product or service, to build a product using similar ideas, features, functions
or graphics of the software, or to copy any ideas, features, functions or graphics of the software; or, (I) engage in web
scraping or data scraping on or related to the software, including without limitation, collection of information through any
software that simulates human activity or any bot or web crawler.

3. Proprietary Rights.

All rights (including copyrights, trade secret, patent and other intellectual property rights), title, interest in and to the
Software and any Product, and any copy thereof remain with Fortinet. You acknowledge that no title or other intellectual
property rights in the Software or other Products is transferred to you and you will not acquire any rights to the Software
or other Products except for the specific limited license as expressly set forth in section 1 (“License Grant”) above. You
expressly agree and acknowledge that Fortinet owns, retains, and shall retain all intellectual property rights in and to,
and you have no intellectual property rights in and to, the Products and the Software other than the License Grant. You
agree to keep confidential all Fortinet confidential information and only to use such information for the purposes for

which Fortinet disclosed it.

4. Term and Termination.

The term of the license is the shorter of (a) the term as set forth in the ordering documents, other Fortinet
documentation, or per Fortinet practices or policies (such as with evaluation or beta licenses or subscription or other
term licenses) and (b) for the duration of Fortinet's copyright in the Software. Fortinet may terminate this Agreement,
and the licenses and other rights herein, immediately without notice if you breach or fail to comply with any of the terms
and conditions of this Agreement or for other reasons as stated in Fortinet’s other documentation. You agree that, upon
such termination, you will cease using the Software and any Product and either destroy all copies of the Fortinet

documentation or return all materials to Fortinet.
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5. Transfer.

If you are a Fortinet contracted and authorized reseller or distributor of Products, you may transfer (not rent or lease
unless specifically agreed to in writing by Fortinet) the Software to one end user on a permanent basis, provided that: (i)
you ensure that your customer and the end user receives a copy of this Agreement, is bound by its terms and conditions,
and, by selling the Product or Software, you hereby agree to enforce the terms in this Agreement against such end user,
(i) you at all times comply with all applicable United States export control laws and regulations, and (iii) you agree to
refund any fees paid to you by an end user who purchased Product(s) from you but does not agree to the terms
contained in this Agreement and therefore wishes to return the Product(s) as provided for in this Agreement. Further, if
you are a non-authorized reseller of Products and Services, you are not authorized to sell Product(s), Software or
Services, but, regardless, by selling Product(s), Software or Services, you hereby agree you are bound by the restrictions
and obligations herein and are bound to: (i) ensure that your customer and the end user receive a copy of this
Agreement and are bound in full by all restrictions and obligations herein (ii) enforce the restrictions and obligations in
this Agreement against such customer and/or end user, (iii) comply with all applicable United States export control laws
and regulations and all other applicable laws, and (iv) refund any fees paid to you by a customer and/or end user who
purchased Product(s) from you but does not agree to the restrictions and obligations contained in this Agreement and
therefore wishes to return the Product(s) as provided for in this Agreement. Notwithstanding anything to the contrary,
distributors, resellers and other Fortinet partners (a) are not agents of Fortinet and (b) are not authorized to bind Fortinet
in any way. Fortinet’s license, warranty, and support is only available for Products that you purchased directly from an
authorized Fortinet channel partner. Products not purchased from an authorized Fortinet channel partner are not
eligible, will not be supported, and may be blocked from registration.

6. Limited Warranty.

Fortinet provides this limited warranty for its product only to the single end-user person or entity that originally
purchased the Product from Fortinet or its authorized reseller or distributor and paid for such Product. The warranty is
only valid for Products which are properly registered on Fortinet’s Support Website, https://support.fortinet.com, or
such other website as provided by Fortinet, or for which the warranty otherwise starts according to Fortinet’s policies,
and any support is only valid for products properly purchased through authorized distributors and resellers. The warranty
periods discussed below will start according to Fortinet’s policies posted at http://www.fortinet.com/aboutus/legal.htmi
or such other website as provided by Fortinet. It is the Fortinet distributor’'s and reseller’s responsibility to make clear to
the end user the date the product was originally shipped from Fortinet, and it is the end

user’s responsibility to understand the original ship date from the party from which the end user purchased the product.
All warranty claims must be submitted in writing to Fortinet before the expiration of the warranty term or such claims are
waived in full. Fortinet provides no warranty for any beta, donation or evaluation Products. Fortinet warrants that the
hardware portion of the Products ("Hardware") will be free from material defects in workmanship as compared to the
functional specifications for the period set forth as follows and applicable to the Product type ("Hardware Warranty
Period"): (a) a three hundred sixty-five (365) day limited warranty for the Hardware products; (b) for FortiAP, the warranty
herein shall last from the start of the warranty period as discussed above until five (5) years following the product
announced end-of-life date Hardware; (c) for FortiSwitch Hardware appliance products other than the FortiSwitch-5000
series, the warranty herein shall last from the start of the warranty period as discussed above until five (5) years
following the product announced end-of-life date Hardware. Fortinet's sole obligation shall be to repair or offer
replacement Hardware for the defective Hardware at no charge to the original owner. This obligation is exclusive of
transport fees, labor, de- installation, installation, reconfiguration, or return shipment and handling fees and costs, and
Fortinet shall have no obligation related thereto. Such repair or replacement will be rendered by Fortinet at an
authorized Fortinet service facility as determined by Fortinet. The replacement Hardware need not be new or of an
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identical make, model, or part; Fortinet may, in its discretion, replace the defective Hardware (or any part thereof) with
any reconditioned Product that Fortinet reasonably determines is substantially equivalent (or superior) in all material
respects to the defective Hardware. The Hardware Warranty Period for the repaired or replacement Hardware shall be
for the greater of the remaining Hardware Warranty Period or ninety days from the delivery of the repaired or
replacement Hardware. If Fortinet determines in its reasonable discretion that a material defect is incapable of
correction or that it is not practical to repair or replace defective Hardware, the price paid by the original purchaser for
the defective Hardware will be refunded by Fortinet upon return to Fortinet of the defective Hardware. All Hardware (or
part thereof) that is replaced by Fortinet, or for which the purchase price is refunded, shall become the property of
Fortinet upon replacement or refund. Fortinet warrants that Software as initially shipped by Fortinet will substantially
conform to Fortinet's then-current functional specifications for the Software, as set forth in the applicable
documentation for a period of ninety (90) days ("Software Warranty Period"), if the Software is properly installed on
approved Hardware and operated as contemplated in its documentation. Fortinet's sole obligation shall be to repair or
offer replacement Software for the non-conforming Software with software that substantially conforms to Fortinet's
functional specifications. This obligation is exclusive of transport fees, labor, de-installation, installation,
reconfiguration, or return shipment and handling fees and costs, and Fortinet shall have no obligation related thereto.
Except as otherwise agreed by Fortinet in writing, the warranty replacement Software is provided only to the original
licensee, and is subject to the terms and conditions of the license granted by Fortinet for the Software. The Software
Warranty Period shall extend for an additional ninety (90) days after any warranty replacement software is delivered. If
Fortinet determines in its reasonable discretion that a material non- conformance is incapable of correction or that it is
not practical to repair or replace the non-conforming Software, the price paid by the original licensee for the non-
conforming Software will be refunded by Fortinet; provided that the non-conforming Software (and all copies thereof) is
first returned to Fortinet. The license granted respecting any Software for which a refund is given automatically
terminates immediately upon refund. For purpose of the above hardware and software warranties, the term “functional

specifications” means solely those specifications authorized and published by Fortinet that expressly state in such
specifications that they are the functional specifications referred to in this section 6 of this Agreement, and, in the event
no such specifications are provided to you with the Software or Hardware, there shall be no warranty on such Software.

7. Disclaimer of Other Warranties and Restrictions.

EXCEPT FOR THE LIMITED WARRANTY SPECIFIED IN SECTION 6 ABOVE, THE PRODUCT AND SOFTWARE ARE
PROVIDED "AS-I1S" WITHOUT ANY WARRANTY OF ANY KIND INCLUDING, WITHOUT LIMITATION, ANY IMPLIED
WARRANTY, IMPLIED OR EXPRESS WARRANTY OF MERCHANTABILITY, OR WARRANTY FOR FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN
ANY TERRITORY WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE
LIMITED TO NINETY (90) DAYS FROM THE DATE OF ORIGINAL SHIPMENT FROM FORTINET. EXCEPT AS
EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE RISKAS TO THE
QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF THE PRODUCT.
NOTWITHSTANDING ANYTHING TO THE CONTRARY, THE HARDWARE WARRANTY PERIOD DISCUSSED
ABOVE DOES NOT APPLY TO CERTAIN FORTINET PRODUCTS, INCLUDING FORTITOKEN WHICH HAS A 365
DAY WARRANTY FROM THE DATE OF SHIPMENT FROM FORTINET’S FACILITIES, AND THE SOFTWARE
WARRANTY DOES NOT APPLY TO CERTAIN FORTINET PRODUCTS. YOU HEREBY ACKNOWLEDGE AND AGREE
THAT NO VENDOR CAN ASSURE COMPLETE SECURITY AND NOTHING HEREIN OR ELSEWHERE SHALL BE
DEEMED TO IMPLY A SECURITY GUARANTEE OR ASSURANCE, AND FORTINET DISLAIMS LIABILITY
REGARDING YOUR WEB BROWSER’S REQUIREMENTS OR ANY THIRD PARTY DEVICE OR APPLIANCE USED
TO OPERATE THE SOFTWARE.
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The warranty in Section 6 above does not apply if the Software, Product or any other equipment upon which the
Software is authorized to be used (a) has been altered, except by Fortinet or its authorized representative, (b) has not
been installed, operated, repaired, updated to the latest version, or maintained in accordance with instructions supplied
by Fortinet, (c) has been subjected to abnormal physical or electrical stress, misuse, negligence, or accident; (d) is
licensed for beta, evaluation, donation, testing or demonstration purposes or for which Fortinet does not charge a
purchase price or license fee; or (e) is procured from a non- authorized reseller or non-authorized distributor. In the case
of beta, testing, evaluation, donation or free Software or Product, the end user acknowledges and agrees that such
Software or Product may contain bugs or errors and could cause system failures, data loss and other issues, and the end
user agrees that such Software or Product is provided “as-is” without any warranty whatsoever, and Fortinet disclaims
any warranty or liability whatsoever. An end user’s use of evaluation or beta Software or Product is limited to thirty

(30) days from original shipment unless otherwise agreed in writing by Fortinet. For clarity, notwithstanding anything to
the contrary, all sales are final and no provision in this EULA entitles you to return Products, other than as expressly set
forth herein.

8. Governing Law.

Any disputes arising out of this Agreement or Fortinet’s limited warranty shall be governed by the laws of the state of
California, without regard to the conflict of laws principles. In the event of any disputes arising out of this Agreement or
Fortinet’s limited warranty, the parties submit to the jurisdiction of the federal and state courts located in Santa Clara
County, California, as applicable, and agree that any controversy or claim arising out of or relating to this Agreement
shall be determined in the federal and state courts located in Santa Clara County, California, as applicable.

9. Limitation of Liability.

TO THE MAXIMUM EXTENT PERMITTED BY LAW AND NOTWITHSTANDING ANYTHING TO THE CONTRARY,
FORTINET IS NOT LIABLE UNDER ANY CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY, INFRINGEMENT
OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY LOSS OF USE OF THE PRODUCT OR SERVICE OR ANY
DAMAGES OF ANY KIND WHATSOEVER, WHETHER DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
(INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF GOODWILL, LOSS OF PROFIT, LOSS OF
OPPORTUNITY, LOSS OR DAMAGE RELATED TO USE OF THE PRODUCT OR SERVICE IN CONNECTION WITH
HIGH RISK ACTIVITIES, DE- INSTALLATION AND INSTALLATION FEES AND COSTS, DAMAGE TO PERSONAL OR
REAL PROPERTY, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, COMPUTER SECURITY
BREACH, COMPUTER VIRUS INFECTION, LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON, OR
INTEGRATED WITH ANY PRODUCT INCLUDING ANY PRODUCT RETURNED TO FORTINET FOR WARRANTY
SERVICE) RESULTING FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING
OUT OF ANY BREACH OF THE LIMITED WARRANTY IN SECTION 6 ABOVE, EVEN IF FORTINET HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE LIMITED
WARRANTY IS, AT FORTINET'S SOLE AND ABSOLUTE DISCRETION: REPAIR, REPLACEMENT, OR REFUND OF
THE DEFECTIVE OR NON-CONFORMING PRODUCT AS SPECIFICALLY STATED IN SECTION 6 ABOVE;
PROVIDED, HOWEVER, IN NO EVENT SHALL ANY END-CUSTOMER REMEDIES UNDER THIS EULA AND ANY
SUPPORT AGREEMENT EXCEED THE AMOUNT PAID TO FORTINET FOR THE SPECIFIC APPLICABLE
DEFECTIVE OR NON-CONFORMING PRODUCT AT ISSUE.

FortiCASB 24.3.b Admin Guide 564
Fortinet Inc.



End User License Agreements

10. Compliance with Laws, including Import/Export Laws and FCPA.

You are advised that the Products may be subject to the United States Export Administration Regulations and other
import and export laws; diversion contrary to United States law and regulation is prohibited. You agree to comply with all
applicable international and national laws that apply to the Products as well as end user, end-use, and destination
restrictions issued by U.S. and other governments. For additional information on U.S. export controls see
https://www.bis.doc.gov. Fortinet assumes no responsibility or liability for your failure to obtain any necessary import
and export approvals and licenses, and Fortinet reserves the right to terminate or suspend shipments, services and
support in the event Fortinet has a reasonable basis to suspect any import or export violation.

You represent that neither the United States Bureau of Industry and Security nor any other governmental agency has
issued sanctions against you or otherwise suspended, revoked or denied your export privileges. You agree not to use or
transfer the Products for any use relating to nuclear, chemical or biological weapons, or missile technology, unless
authorized by the United States Government by

regulation or specific written license. Additionally, you agree not to directly or indirectly export, import or transmit the
Products contrary to the laws or regulations of any other governmental entity that has jurisdiction over such export,
import, transmission or use. Furthermore, you hereby agree that, for any orders that you place with Fortinet whereby
any legal or regulatory requirements may apply to Fortinet such as requirements related to the International Trafficin
Arms Regulations, or Buy American Act, or the Trade Agreements Act: you are responsible to ensure the Purchase
Order submitted to Fortinet by you and/or any partners clearly states the specific requirement in writing, or otherwise
Fortinet is not bound by any such requirements. You represent that you understand, and you hereby agree to comply
with, all applicable laws including but not limited to the U.S. Foreign Corrupt Practices Act . You represent that you
hereby agree that you and your employees have not accepted, and will not accept, anything of value, including money,
meals, entertainment, paid-for travel, beta, testing, evaluation, donation or free Products and/or related services, or
anything else of value, in exchange for Fortinet maintaining current business or for new business opportunities. You
represent and warrant to Fortinet that you and your employees, consultants, agents and representatives will not use
Fortinet’s products and services to engage in, or support in any way, violations or abuses of human rights, including
those involving censorship, surveillance, detention, or excessive use of force. You agree you and your employees will be
responsible to comply in full with all laws and policies applicable to any and all dealings with Fortinet in general and its
distributors, resellers and partners.

11. U.S. Government End Users.

The Software and accompanying documentation are deemed to be "commercial computer software" and "commercial
computer software documentation," respectively, pursuant to DFAR Section 227.7202 and FAR Section 12.212, as
applicable. Any use, modification, reproduction, release, performance, display or disclosure of the Software and
accompanying documentation by the United States Government shall be governed solely by the terms of this
Agreement and shall be prohibited except to the extent expressly permitted by the terms of this Agreement and its
sSuccessors.

12. Tax Liability.

You agree to be responsible for payment of any sales or use taxes imposed at any time on this transaction.
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13. General Provisions.

Except as specifically permitted and required in section 5 (“Transfer”) above, you agree not to assign this Agreement or
transfer any of the rights or obligations under this Agreement without the prior written consent of Fortinet. This
Agreement shall be binding upon, and inure to the benefit of, the successors and permitted assigns of the parties. The
United Nations Convention on Contracts for the International Sales of Goods is expressly excluded. This Agreement
and other Fortinet agreements may be amended or supplemented only by a writing that refers explicitly to the
agreement signed on behalf of both parties, or, for this Agreement, as otherwise expressly provided in the lead-in above
Section 1 above, provided, notwithstanding anything to the contrary and except for this Agreement which may be
amended or updated as expressly provided in the lead-in above Section 1 above, for any amendment or other
agreement to be binding on Fortinet, such amendment or other agreement must be signed by Fortinet’'s General
Counsel. No waiver will be implied from conduct or failure to enforce rights nor effective unless in a writing signed on
behalf of the party against whom the waiver is asserted. If any part of this Agreement is found unenforceable, that part
will be enforced to the maximum extent permitted and the remainder shall continue in full force and effect. You
acknowledge that you have read this Agreement, understand it, and agree to be bound by its terms and conditions.
Notwithstanding anything to the contrary, this EULA constitutes the entire agreement between Fortinet and its end-
customers and supersedes any and all prior representations or conflicting provisions, such as limitations of liability,
warranties, or otherwise in any and all purported end customer agreements, whether entered into now or in the future.
In the event of a conflict between this EULA and another agreement, this EULA shall prevail unless the conflicting
agreement expressly states that it replaces this EULA, expressly referring to this EULA, and is agreed to in writing by
authorized representatives of the parties (which, in the case of Fortinet, is Fortinet’s General Counsel).

14. Privacy.

You agree to Fortinet’s collection, use, disclosure, protection and transfer of your information, as set forth in the Fortinet
privacy policy on the Fortinet web site (http://www.fortinet.com/about-us/privacy.html), including (a) Fortinet’s use of
the Customer information to send information regarding Fortinet products and services; and (b) Fortinet’s disclosure of
your information to provide assistance to law enforcement, governmental agencies and other authorities or to allow
Fortinet to protect its Customers’ and/or end users’ rights.

15. Open Source Software.

Fortinet’s products may include software modules that are licensed (or sublicensed) to the user under the GNU General
Public

License, Version 2, of June 1991 (“GPL”) or GNU Lesser General Public License, Version 2.1, of February 1999 (“LGPL”")
or other open source software licenses which, among other rights, permit the user to use, copy, modify and redistribute
modules, or portions thereof, and may also require attribution disclosures and access to the source code ("Open Source
Software"). The GPL requires that for any Open Source Software covered under the GPL, which is distributed to
someone in an executable binary format, that the source code also be made available to those users. For any Open
Source Software covered under the GPL, the source code is made available on this CD or download package. If any
Open Source Software licenses require that Fortinet provide rights to use, copy or modify any Open Source Software
program that are broader than the rights granted in this agreement, then such rights shall take precedence over the
rights and restrictions herein. Fortinet will provide, for a charge reflecting our standard distribution costs, the complete
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machine-readable copy of the modified software modules. To obtain a complete machine-readable copy, please send
your written request, along with a check in the amount of US $25.00, to General Public License Source Code Request,
Fortinet, Inc., 899 Kifer Rd, Sunnyvale, CA 94086 USA. To receive the modified software modules, you must also
include the following information: (a) Name, (b) Address, (c) Telephone number, (d) E-mail Address, (e) Product
purchased (if applicable), (f) Product Serial Number (if applicable). All open source software modules are licensed free
of charge. There is no warranty for these modules, to the extent permitted by applicable law. The copyright holders
provide these software modules “AS-1S” without warranty of any kind, either expressed or implied. In no event will the
copyright holder for the open source software be liable to you for damages, including any special, incidental or
consequential damages arising out of the use or inability to use the software modules, even if such holder has been
advised of the possibility of such damages. A full copy of this license, including additional open source software license
disclosures and third party license disclosures applicable to certain Fortinet products, may obtained by contacting
Fortinet’s Legal Department at legal@fortinet.com.
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